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Topics Covered
• What is Internet, Sample Internet connections, History of

Internet, How big is the Internet, Connections, Surf  up,
Picking your resources, Book marking your resources,
Searching the Internet, Advanced Search Technique,

Objectives
Upon completion of this lesson, you should be able to:
• Define Internet
• Connect to the Internet
• Start surfing the net
• Pick up your required resources
• Book mark your resources
• Learn search techniques of Internet
The Internet is a computer network made up of thousands of
networks worldwide. No one knows exactly how many
computers are connected to the Internet. It is certain, however,
that these number in the millions.
No one is in charge of the Internet. There are organizations
which develop technical aspects of this network and set
standards for creating applications on it, but no governing body
is in control. The Internet backbone, through which Internet
traffic flows, is owned by private companies.
All computers on the Internet communicate with one another
using the Transmission Control Protocol/Internet Protocol
suite, abbreviated to TCP/IP. Computers on the Internet use a
client/server architecture. This means that the remote server
machine provides files and services to the user’s local client
machine. Software can be installed on a client computer to take
advantage of  the latest access technology.
An Internet user has access to a wide variety of  services:
electronic mail, file transfer, vast information resources, interest
group membership, interactive collaboration, multimedia
displays, real-time broadcasting, shopping opportunities,
breaking news, and much more.
The Internet consists primarily of a variety of access protocols.
Many of these protocols feature programs that allow users to
search for and retrieve material made available by the protocol.

What is the Internet?
In essence the Internet is a term used to describe thousands of
computers, spanning over 65 countries. Some people may liken
this to a single entity, but this is not true. The Internet is
transitory, ever changing, reshaping and remolding itself.
Ordinarily a collection of thousands of computers world wide
might not attract so much attention. However people are using
this new medium in ways that simply was not possible a mere
five years ago.

Here is a short list of things the Internet has been used for in
the last few years.
• Two Chinese students in Beijing alert the world to a dying

girl mysterious illness, thanks to the Internet. Doctors from
around the world help the Chinese doctors diagnose and
save her life.

• A man in New York, yearning for a fresh start explores the
possibilities of living in Santa Cruz, without leaving his
home.

• A boy in Canada learning how to use computers becomes a
cyber pen-pal with a girl in Japan.

• From war torn Bosnia appeals for food and medical supplies
issue forth via email and newsgroups.

• A man in Iowa locates a lost family member, now living in
Brazil.

• A Judge calls the Internet “The single most important
advancement to freedom of speech since the writing of the
Declaration of Independence”

• A college student sent email to his/her parents asking for
more money, corresponds via email with his/her professors
and works on a project, collecting data from questionnaires
sent out via email.

Just how were all these things made possible? The Internet.
The single largest telecommunications system ever conceived by
humankind.
There are four basic building blocks to the Internet, Hosts,
Routers and Clients and Connections. Hosts and Clients are
explained later in the chapter, but for now, be content to know
that unless you have very special circumstances, in most cases
your computer falls under the “Client” category. Data is sent
from your computer in the form of  a “packet”. You can liken a
packet to be similar to an envelope; it surrounds your data and
contains both a return and destination address. Your computer
handles the packets for you, it’s all done in the background,
without your knowledge.
A Router is a special device. Basically routers sit at key points on
the Internet and act like traffic cops at an intersection of
hundreds of streets. The Router basically reads the destination
address on the packets being sent by your computer and then
forwards the packet to the appropriate destination. In some
cases your data will travel through several routers before
reaching its ultimate destination.

Sample Internet Connections
Connections. This is a catch all term describing how you can
connect from one point to another point. As an end user, your
only concern is that the connection is good, but for a network
engineer, this can mean several different types of technologies,
including;

LESSON 1:
Internet Basics-2
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• Dial Up Phone Lines
• Fiber Optics
• ISDN
• Frame Relay
• Satellite Links
Fortunately, for this author and you, we do not need to know
anything about the connection other than it exists.
Complex, and unbelievably intricate, the Internet is so vast
most governments are still struggling to figure out how to
integrate it into their lives. But how did it all start?

History of the Internet
In response to a need for secure computer to computer
communications, DARPA, the Defense Advanced Research
Projects Administration, commissioned a study in computer to
computer technologies back in the early 1970’s. From this
beginning the Internet was born. During the next 20 years the
Internet was used solely as a combination of military and
academic network, linking computers first nationwide, then
ultimately world wide. The idea behind the Internet is really very
simple and can be conceptualized thusly;

Simple Connections
Two computers are connected via a single wire. In order for one
computer to talk to the other, it sends a signal requesting
permission to speak. If  the other computer is busy, it replies
with the equivalent of a “Please wait, I am busy” otherwise it
replies, granting permission. Since both computers know what
the other one is talking about, by virtue of the fact they are
running similar software, the data can be passed from computer
to computer.
In the previous example this is very straight forward and trivial.
Now however, instead of a single wire, we replace the
connection with the Internet, which can be many dozens of
computers between the two computers wishing to talk.

Sample Internet Connections 2
Now the situation appears to be more complex, or is it?
Computer A and Computer B wish to talk to each other, but
there is nearly 3000 miles between them. Using the Internet, the
number of places through which the data has to travel is really
transparent to the user.

In effect, the link between Computer A and Computer B can
take many paths. It can travel hundreds or even thousands of
miles out of the way in order to reach the other computer. All
you need to know is that it will get there.
As the 1980’s progressed the face of  computing changed
significantly, and with it, the Internet. More and more
commercial and personal computers were going on-line, until,
they exceeded the number of the original users.
The 1990’s signaled the start of  the “connected” era, with the
end of the cold war, and improvements in military
communications, the original Military users of the Internet left
for other communications systems. The Internet was left much
as it is today, a collection of  internationally based users and
computers.
With improvements on the desktop, there arose a need for
better graphics on the Internet. The Internet up to this point,
had been largely a text only system.
The graphics capabilities implemented were called HTML, and a
means was invented to allow users to view these HTML files in
their graphic format. With the Internet largely in place, all that
was needed was to invent the transmission mechanism. That
mechanism was dubbed the World Wide Web, or Web for
short.

How Big is the Internet?
It’s difficult to judge the size of  the Internet. People and
systems are being added daily. However, it is estimated that in
the United States alone, 27.5 million people are connected to the
Internet.
There are over 150,000 unique domain names in the US alone.
Some of the largest Internet Search Engines have over 30
million web documents listed, with an annual growth rate
exceeding 28%.
In the newsgroups there are over 15,000 distinct and different
groups in which to exchange ideas and conversation.
There are 65 countries currently connected to the Internet.

Getting Started
Getting connected to the Internet is fairly simple, but there are a
number of steps you need to take before hand.
The first requirement will be to locate an Internet Service
Provider (ISP) in your area. This is a company through which
you can access the Internet. Prices and features will vary, so
calling around, shopping for the best price is recommended.
Typically, your local ISP will offer you a monthly package which
will include; email and web access, download/upload
capabilities, and newsgroups. If these terms don’t seem to be
familiar to you, do not be concerned. It will all be explained in
this book. If your ISP doesn’t offer all of these, then continue
shopping!
Once you have found an ISP and signed their service agreement,
next you will need to install some software on your computer.
In many cases your ISP will help you with that installation.
Below is a list of the software that your ISP will install. (note
it’s a generic list, you just need to be aware that these items are
going to be put on your computer)
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• Telecommunications Software, including Winsock, or other

Internet protocol transceiver software.
• A World Wide Web Browser.
• An Email program.
Optionally your ISP may also install or give you;
• An FTP Program.
• A Newsgroup Reader
With all this software installed, you will be ready to access the
Internet.
Once you are ready, it’s now time to connect to the Internet.
How is this accomplished? Well it’s simple really. Your
computer will dial a local number, which is provided by your
ISP. Once you have logged into your ISP, you are connected to
the Internet.

Sample Connections 2
Figure above shows a typical connection scenario, with your
personal or work computer connecting to the Internet via your
ISP’s server. Your ISP may go through several connections with
other servers before reaching the “main backbone” of  the
Internet, the exact route is not information needed by the
typical user.
There are two classes of computers on the Internet, HOSTS
and CLIENTS. Unless you have a permanent link to the
Internet and your machine is always connected and on-line, then
you are probably a client and not a host. As a client to the
Internet, you should have the following abilities; (If you don’t,
talk to your Internet Service Provider)
• Send Email
• Upload/Download Files
• Access the World Wide Web
Email is the ability to write a message to someone, using a mail
program, and use the Internet as a means of delivering that
message. Email is not a free service. The cost of  your email is
covered in your service charge to your provider.
Contrary to popular opinion, and to the opinion of some “so-
called” experts that have received nationwide TV airtime, email
is NOT instantaneous. When you send a message to someone
it leaves your computer and travels first to your Service Provider,
from there your email may travel through several other HOST
computers until it reaches its final destination. The time it takes
to transit from one host to another varies depending upon
how busy the network is at the time you sent it.
Upload/Download Files: Upload/Download are two
different faces on the same coin. Basically it refers to moving a

file, either from a host computer to your client computer or
from your client computer to some host computer.
Access the World Wide Web. Representing the latest in Internet
technology, the Web blends the best and not-so-best of  the
textual information with the graphical capabilities of  today’s
desktop systems. On the Web you will find information
relating to almost any conceivable topic. (This freedom of
speech issue is what has sparked such controversy and resulted
in the infamous Communications Decency Act, which was later
overturned as unconstitutional by the courts.)

Surf’s up!
You’ve made your first connection to your Internet Service
provider, and now you are ready to begin surfing. The question
is where do you start?
Most web browsers, when you invoke (run) them, will come up
to a default webpage. That is, they will automatically take you to
a specific place on the Internet, a place that’s been pre-
programmed by the browser company or your ISP, for you.
When you are surfing the web, you can choose from millions of
websites to visit. Your browser has several ways of  allowing
you to do this.
Navigator has two distinct ways of allowing you to surf to any
location, assuming you already know the URL you need.
There is the File|Open Location option from the main menu
and there is the location window on the menu bar. All you need
do in either spot is enter the URL you require and away you go.
Explorer has an address window, and the File|Open menu
option to perform the same functions.
I-Comm has the File|Open menu option.
All of  these perform virtually the same function. You enter the
address of the location you wish to visit and the browser will
take you there.

Picking your First Resources
The first step to insuring a more productive life on the
Information Superhighway is picking some resources and
bookmarking them. In order to locate a particular resource on
the Internet you will need to know its address. An address can
be considered the location of a resource, and all items, including
you, have an address if they are on the Internet. Just as you
have an email address which is different from everyone else, so
too, can there be sites within sites, resources within resources.
Each type of resource has a slightly different format address and
name, but the three most common addresses you will have to
deal with are EMAIL, FTP and WWW addresses.
An email address goes to a specific person. i.e.

Joan Q. Public@anysite.com
The FTP address usually addresses a system as a whole unit. i.e.

ftp.anysite.com
The WWW address is similar to an FTP address in as much as
it reaches out to a system, but it also specifies exactly where on
the system to go. i.e.
http://www.anysite.com/mypage.html
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While the addresses for FTP sites and Email addresses are
simply called “addresses”, a WWW address is called a URL or
Universal Resource Locator. For a more detailed description of
the term URL, see our glossary.
There are numerous resources on the net which everybody
needs from time to time. The big problem is knowing which
resource you need. While everyone has certain specific needs,
there are a few common resources which everyone should use.
The first type of resource you should pick concerns searching
the Internet. Basically there are two types of Search Engines,
Web Crawlers and Directories.

Web Crawlers
A Web Crawler (sometimes called a spider) is an automated
search engine. When someone submits a resource(website) to
the search engines it sends a small, but powerful program back
to the site of the submission which scans the site for more
resources. If it finds additional resources, it catalogs them as
well as the original resource. The advantage of this is you can
find information in a site, even if the site is not dedicated to
that specific type of information. For example, locating
information on Airplanes in a site about NASA space activities.
The main drawback to this type of search engine is the tendency
to catalog too much information.
A couple of examples of the best crawlers are;
HotBot  (http://www.hotbot.com/)
Infoseek  (http://ultra.infoseek.com/)
Alta Vista (http://www.altavista.digital.com/)

Directories
Directories are the Yellow Pages of  the Internet. They contain
only that information which has been submitted to them. Here
you will find vast listings of resources, but if the person
submitting the information didn’t include all of the description
of his/her site, you may not find what you are looking for.
A couple of examples of Directories are;
YAHOO! ( http://www.yahoo.com )
Linkstar (http://www.linkstar.com/)
InfoHiway ( http://www.infohiway.com/way/index.html)
The directories may not be as up to date, but when you are
looking for specific information, it’s usually easier to try a
directory first. If that fails to yield results, try one of the search
engines.

Bookmarking Your Resources
Nearly all of the Internet web browsers available today have a
feature which is like an automated address book. Some call it
“Hot Listing”, others call it “Book Marking”. In any case, the
effect is the same. Bookmarking allows you to grab a copy of a
URL and store it so that you can easily go back to the site at a
future time.
Below we have provided instructions for bookmarking using
two popular Internet web browsers;

Navigator (Version 2.0/3.0)
• Go to the First Page of the Site.
• Click on the Menu Option labeled “BookMarks”

• Move the mouse pointer down to the option labeled “Add a
Bookmark” and click on it.

Explorer (Version 3.0 or better)

• Go to the First Page of the Site.
• Click on “Favorites” in the button bar, then select “Add to

Favorites”.
•  University home page
• Go to the First Page of the Site.
• Click on the “Hot Site” button, this opens the “Hot List”

Dialog box.

Click on “Add” button, then press “Done” to close the dialog

Box.
Navigator’s BookMarks are added to the main menu, which has
a limitation to the maximum number of  elements. You will
ultimately have a “More BookMarks...” entry at the bottom of
the menu, which will take you to a another window where you
can locate and manipulate your BookMarks. We will delve into
Bookmark management in further detail in a later chapter.
We suggest that you take the time to bookmark the links
provided above. These are some of the best places on the net
for finding other web sites.
To use a bookmark, open either the Bookmark menu, or click
on the Hot list and select the site you wish to go to. For I-
Comm users, you need to click on the button marked “Goto”.
Navigator users will find themselves at the new site simply by
selecting the option on the menu.

Searching the Internet
By now you should have several sites bookmarked. So what’s
the next step? Simple, now its time to start looking for
information. We have several search engines bookmarked but
that’s only the first step.
What can you search for? Nearly everything! It would be
improper to state that the Internet contains the sum total of all
human knowledge, however its getting there very quickly.
Use one of your new BookMarks and surf over to one of the
search engines. Here you will be presented with a webpage,
which has a field in which you can enter terms to look for. All
of  these systems have a help section or FAQ clearly marked, so
if you get into trouble, you can either hit your “back” button or
try the site help file.
You begin your search by entering some sort of  search criteria
into an editable field on your screen, then pressing the search
button.
Searching the Internet for some particular information can be
both a frustrating experience and a rewarding one. Its best to
start with a particular search engine or directory, looking for
what you need. Remember that there is a considerable overlap
between the contents of one engine and another, so you will
find similar references among them.
Let’s say we are looking for information on a 1977 Jeep CJ-5,
perhaps a supplier of parts for that automobile. Going to a
search engine like Yahoo, you can search their database, but the
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real question becomes what keyword do you use? Yahoo allows
only one keyword, or a phrase in their advanced search options.
Start by looking for “CJ-5”, but in all likelihood, you won’t find
it. It’s way too specific. You need to exercise care in picking
search terms. For example, looking for items that weigh a “ton”
will also return references to “Washington”, “Alexander
Hamilton” etc.
Having not found anything listed under CJ-5, or perhaps
finding listings, but of the wrong type, widen your search by
looking for “Jeep”. Here you may find several dealers of Jeeps,
perhaps even the parts supplier you need. You may also find
someone’s Homepage where they write about owning a jeep.
As you can see, the steps to finding your desired information
are;
• Start Specific, (i.e. Search for “CJ-5”.)
• Broaden your search if you don’t find any reference. (i.e.

Search for “Jeep”)
• Broaden further if  you still don’t find anything. (i.e. Search

for “Automotive”)

Advanced Search Techniques
Searching for simple things like “Jeep” or “Washington” is very
easy for most people. A problem arises however when you need
to search for something specific, but requires more than one
word.
Most Search Engines and Directories provide for advanced
searching, but their methods vary from system to system.
Primarily two types of advanced searches are supported, Phrase
searches and Boolean Searches. Each of these types of searches
have their strengths and weaknesses. Set up a couple of
hypothetical items we want to search on and look at how we can
accomplish them using the two techniques.

Phrase Searching
Perhaps the easiest of the advanced techniques, phrase searching
allows you to search on multiple words for one topic. For
example searching on information concerning Dr. Martin
Luther King Jr., You might be inclined to search on Martin
Luther King.
Looking over your results in a typical Search Engine, you would
be surprised to discover that searching on Martin Luther King
returned pages for Martin Luther King, BB King, Kings in
general, the Christian reformation, Martin Landau. In other
words the Search Engine took your three words; Martin,
Luther, and King and assumed you were looking for web pages
with references to any of these words in them.
If you want a Search Engine to do a phrase search you need to
inform the search engine that the words you are looking for
need to by grouped together. So don’t search for Martin Luther
King, instead search for “Martin Luther King”. By enclosing the
keywords within quotes you are basically informing the search
engine that all three words have to be present on the page and
in close proximity to one another.
Some Search Engines will allow phrase searching, others will
not. When in doubt, look on the main page of the search
engine for either a help file link or for their FAQ.

Boolean Searching
Named after an English mathematician, Boolean searching
refers to a form of logic applied to the search. Basically a
Boolean search requires some additional words to be used, for
example searching on the words “Cancer” and “treatment”.
This type of search allows you to exclude websites which may
be about Cancer, the constellation, or the horoscope sign.
Boolean Searches require using certain keywords, while these
keywords may vary from search engine to search engine, the
concepts are the same.
AND - Search on Term1 AND Term2
OR - Search on Term1 OR Term2
NOT - Search on Term1 but NOT Term2
An example of AND searching could be;
Washington and Lincoln - Look for webpages which contain
both words “Washington” and “Lincoln”.
Washington or Lincoln - Look for webpages which contain
either the word “Washington” OR the word “Lincoln”, or
both.
Washington not Lincoln - Look for webpages which contain the
word “Washington” and do not contain the word “Lincoln”.
Some systems have the ability to group Boolean terms using
parenthesis. i.e.;
(Washington and Lincoln) not Roosevelt - Look for webpages
which contain the words “Washington” and “Lincoln” but do
not contain the word “Roosevelt”.
Washington and not George - Look for webpages which
contain the word “Washington”, and do not have the word
“George” in them.
 Boolean searching, given these simple, yet powerful, capabilities
allows someone to quickly narrow their searches so that the
results of a search may quickly pinpoint the information they
need. The more terms you are able to add to the search
specification, the finer the results you will have in the search
engines.
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Topics Covered
• Hypertext on the web, Pages on the web, Retrieving

documents on the web, Anatomy of  a URL, Web Browser,
Plug ins, Web browser, The Toolbar, Specifying a Home page
in Navigator, Specifying a home page, Saving an image from
the web, Printing a page, Browsing the Internet, Navigator
controls, Multimedia on the web.

Objectives
Upon completion of this lesson, you should be able to:
• Retrieve documents on the web
• Work on Web browser
• Specify a home page in Navigator
• Save images from the web
• Learn Navigating controls
• Know about multimedia on the web
The World Wide Web is a system of  Internet servers that
supports hypertext to access several Internet protocols on a
single interface. The World Wide Web is often abbreviated as
the Web, WWW, or W3.
The World Wide Web was developed in 1989 by Tim Berners-
Lee of the European Particle Physics Lab (CERN) in
Switzerland. The initial purpose of  the Web was to use
networked hypertext to facilitate communication among its
members, who were located in several countries. Word was
soon spread beyond CERN, and a rapid growth in the number
of both developers and users ensued. In addition to hypertext,
the Web began to incorporate graphics, video, and sound. In
recent years, the use of  the Web has now reached global
proportions.
Almost every protocol type available on the Internet is accessible
on the Web. Internet protocols are sets of rules that allow for
intermachine communication on the Internet. The following
major protocols are accessible on the Web:
• E-mail (Simple Mail Transport Protocol or SMTP)

Distributes electronic messages and files to one or more
electronic mailboxes

• Telnet (Telnet Protocol)
Facilitates login to a computer host to execute commands

• FTP (File Transfer Protocol)
Transfers text or binary files between an FTP server and client

• Usenet (Network News Transfer Protocol or NNTP)
Distributes Usenet news articles derived from topical
discussions on newsgroups

• HTTP (HyperText Transfer Protocol)
Transmits hyptertext over networks. This is the protocol of
the WWW.

Many other protocols are available on the Web. To name just
one example, the Voice over Internet Protocol (VoIP) allows
users to place a telephone call over the Web.
The World Wide Web provides a single interface for accessing all
these protocols. This creates a convenient and user-friendly
environment. It is no longer necessary to be conversant in these
protocols within separate, command-level environments. The
Web gathers together these protocols into a single system.
Because of  this feature, and because of the Web’s ability to
work with multimedia and advanced programming languages,
the World Wide Web is the fastest-growing component of  the
Internet.

Hypertext: The Motion Of The Web
The operation of  the Web relies primarily on hypertext as its
means of  information retrieval. HyperText is a document
containing words that connect to other documents. These
words are called links and are selectable by the user. A single
hypertext document can contain links to many documents. In
the context of  the Web, words or graphics may serve as links to
other documents, images, video, and sound. Links may or may
not follow a logical path, as each connection is programmed by
the creator of the source document. Overall, the WWW
contains a complex virtual web of connections among a vast
number of documents, graphics, videos, and sounds.
Producing hypertext for the Web is accomplished by creating
documents with a language called HyperText Markup Language,
or HTML. With HTML, tags are placed within the text to
accomplish document formatting, visual features such as font
size, italics and bold, and the creation of hypertext links.
Graphics may also be incorporated into an HTML document.
HTML is an evolving language, with new tags being added as
each upgrade of the language is developed and released. The
World Wide Web Consortium, led by Tim Berners-Lee,
coordinates the efforts of standardizing HTML.

Pages On The Web
The World Wide Web consists of  files, called pages or Web
pages, containing information and links to resources
throughout the Internet.
Web pages can be created by user activity. For example, if  you
visit a Web search engine and enter keywords on the topic of
your choice, a page will be created containing the results of your
search. In fact, an increasing amount of information found on
the Web today is served from databases, creating temporary
Web pages “on the fly” in response to user queries.

Access to Web pages may be accomplished by

• Entering an Internet address and retrieving a page directly
• Browsing through pages and selecting links to move from

one page to another

LESSON 2:
INTERNET BASICS-2
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• Searching through subject directories linked to organized

collections of  Web pages
• Entering a search statement at a search engine to retrieve

pages on the topic of your choice

Retrieving Documents On The Web: The URL
URL stands for Uniform Resource Locator. The URL specifies
the Internet address of a file stored on a host computer
connected to the Internet. Every file on the Internet, no matter
what its access protocol, has a unique URL. Web software
programs use the URL to retrieve the file from the host
computer and the directory in which it resides. This file is then
displayed on the monitor connected to the user’s local machine.
URLs are translated into numeric addresses using the Internet
Domain Name System (DNS). The numeric address is actually
the “real” URL. Since numeric strings are difficult for humans to
use, alphneumeric addresses are employed by end users. Once
the translation is made, the Web server can send the requested
page to the user’s Web browser.

Anatomy of a URL
This is the format of the URL:

protocol://host/path/filename
For example, this is a URL on the home page of the House
Committee on Agriculture of  the U.S. House of
Representatives:

http://www.house.gov/agriculture/schedule.htm
This URL is typical of addresses hosted in domains in the
United States.

Structure of this URL
1. Protocol: http
2. Host computer name: www
3. Second-level domain name: house
4. Top-level domain name: gov
5. Directory name: agrictulture
6. File name: schedule.htm
Note how much information about the content of the file is
present in this well-constructed URL. <> Other examples:
telnet://library.albany.edu - the University at Albany library text-
based catalog  ftp://ftp.uu.net/graphics/picasso - a file at an ftp
site
Several top-level domains (TLDs) are common in the
United States:
 com   -   commercial enterprise
 edu   -   educational institution
 gov   -   U.S. government entity
 mil   -   U.S. military entity
net   -   network access provder
org   -   usually nonprofit organizations
In addition, dozens of domain names have been assigned to
identify and locate files stored on host computers in countries
around the world. These are referred to as two-letter Internet
country codes, and have been standardized by the International
Standards Organization as ISO 3166. For example:

ch    -   Switzerland
de    -   Germany
jp    -   Japan
uk    -   United Kingdom
It had been proposed that new top-level domains be added to
the existing domain names. The U.S. Government has formed
the Internet Corporation for Assigned Names and Numbers
(ICANN) to work out these and other issues relating to
domain names.

How to Access The World Wide Web: Web Browsers
To access the World Wide Web, you must use a Web browser. A
browser is a software program that allows users to access and
navigate the World Wide Web. There are two types of  browsers:

Graphical
Text, images, audio, and video are retrievable through a
graphical software program such as Netscape Navigator and
Internet Explorer. These browsers are available for both
Windows-based and Macintosh computers. Navigation is
accomplished by pointing and clicking with a mouse on
highlighted words and graphics.
You can install a graphical browser such as Netscape Navigator
in your Windows-based or Macintosh machine. Navigator is
available for downloading on the Netscape Web site: http://
home.netscape.com/. Microsoft’s Internet Explorer is available
from the Microsoft Web site: http://www.microsoft.com/. To
use these programs to access the Web, you need an ethernet
connection or a dialup connection known as a SLPP or PPP. The
latter may be obtained from an Internet Service Provider. For
more information, see How to Connect to the Internet.

Text
Lynx is a browser that provides access to the Web in text-only
mode. Navigation is accomplished by highlighting emphasized
words in the screen with the arrow up and down keys, and then
pressing the forward arrow (or Enter) key to follow the link.
This browser is available through your personal VAX or UNIX
account on campus. For more information, see Guide to Using
Lynx.

Extending the Browser: Plug-Ins
Software programs may be configured to a Web browser in
order to enhance its capabilities. When the browser encounters a
sound, image or video file, it hands off the data to other
programs, called plug-ins, to run or display the file. Working in
conjunction with plug-ins, browsers can offer a seamless
multimedia experience. Many plug-ins are available for free.
File formats requiring plug-ins are known as MIME types.
MIME stands for Multimedia Internet Mail Extension, and
was originally developed to help e-mail software handle a variety
of binary (non-ASCII) file attachments. The use of MIME has
expanded to the Web. For example, the basic MIME type
handled by Web browsers is text/html associated with the file
extention .html.
A common plug-in utilized on the Web is the Adobe Acrobat
Reader. The Acrobat Reader allows you to view documents
created in Adobe’s Portable Document Format. These
documents are the MIME type application/pdf and are
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associated with the file extension .pdf. When the Acrobat
Reader has been configured to your browser, the program will
open and display the file requested when you click on a
hyperlinked file name with the suffix .pdf. The latest versions
of the Acrobat Reader allow for the viewing of documents
within the browser window.
Web browsers are often standardized with a small suite of
plug-ins, especially for playing multimedia content. Additional
plug-ins may be obtained at the browser’s Web site, at special
download sites on the Web, or from the Web sites of  the
companies that created the programs. The number of available
plug-ins is increasing rapidly.
Once a plug-in is configured to your browser, it will
automatically launch when you choose to access a file type that it
uses.

Web Browsers
• A web browser is a software program used to access the

World Wide Web.
• A browser (also known as client software) retrieves data from

remote web servers and displays a web page.

• The two most popular browsers come from Netscape and
Microsoft.
 

Browsers basically work the same way. Once you know one, you
can easily learn the other.
Anatomy of  a Web Browser: The Toolbar 
The most useful buttons on your browser toolbar include:
Back-Returns you to the previous page.
Forward - Returns you to a page you have backed up from
Home -Takes you to a home page specified in the browser
preferences. Reload or Refresh-Downloads the web page from
the server again. Stop- Stops the browser from loading the
current page.
Print - Lets you make a hard copy of the current document or
frame loaded in your browser.

More Web Browser Anatomy
Access indicator icon (upper right) - When animated, it tells you
the browser is retrieving data. Status bar (lower left) - Reports
on the progress of the data download.
Go menu - Lets you select a web page you have previously
accessed.Text-only mode (Images button) -Prevents graphics
from loading, providing a faster way to access web pages.
 

Specifying a Home Page in Navigator
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On the browser Menu bar, click Options, select General
Preferences, then select the Appearance tab.
In the Browser Starts With text-box, type the address of the
web page you want as your start-up page. the box.
Click OK.
 

Specifying a Home Page in Explorer
Go to the web page you want to use as your start-up page.
On the browser menu bar, click View, select Options, then select
the General tab.
In the address Text box, type in the address of the web page
you want as your  Start-up page. Click Use Current

Saving an Image from the Web

 

Move your cursor over the graphic
Windows users: Click the right mouse button. A pop-up box
appears.Macintosh users: Click and hold the mouse button. A
pop-up box appears.Save the image to your hard drive by
selecting a Save option.
You can accept the current file name or rename the file. (Graphic
files are usually in .gif or .jpg format.)

Printing a Web Page
Most browsers have a Print button on the toolbar that lets you
print a web page.
Some web pages are divided into multiple sections called
frames. You can only print one frame at a time.
To print a particular frame, first select it by clicking it.Then click
the Print button or select Print Frame from the File menu.

Browsing the Web
Moving around and between web pages is known as browsing
(or navigating, or sometimes “surfing the web”). You can
browse web pages in several different ways.

Hyperlinks
Almost all web pages have hyperlinks. These links connect:
• One page to another part of the same page (useful if it is a

really large page)
• One page to another page somewhere on the web
• A page to a file, such as a sound clip, video, a spreadsheet or a

Word document
These links to other pages can be links to things stored
anywhere on the internet. Hypertext links are indicated by
underlined text highlighted in blue (usually). Hyperlinks are also
frequently in the form of buttons, graphics or pictures.
To find hyperlinks on a page move your mouse pointer over
the page and where there is a hyperlink the pointer will turn into
a hand with a pointing finger.
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In the example below, both the graphic and the underlined text
link to the same page. You could click either to follow the link.

As you surf  around the web, Internet Explorer remembers
where you have been. You will notice that hypertext links you
previously selected are now coloured purple. Internet Explorer
does this to remind you that you have already visited the page
identified by this link.

Note: Sometimes website designers prevent Internet Explorer
from re-colouring links in this way in order to preserve the
colour scheme they have created for their website. In the
example above for instance, the hypertext link Mortgage mirth
or misery? is always black.

Navigation controls
The designer of a website will usually put a lot of thought into
creating ways for you to move around the site. There is no set
way for navigation controls to appear on web pages. However,
as you browse websites, you will notice that some of the
following controls are used regularly.
• Navigation panels
Often hyperlinks to the main sections of a website will be
grouped into panels at the top or left-hand side of the web
page. When you click links from these panels, the main body of
the web page changes but the panel remains.

• ·List boxes
Another commonly used device is the list box. You can select
what area of the site you want to go to by clicking the down
arrow on the list box and scrolling through the hyperlinks to
the available areas. When you have selected an area, click the Go
button next to the box (SpeedKey: Return).

Note: In the example above, you can also use a list box to
change which city the weather is displayed for. In this case, only
that part of the web page would be affected. The rest would
look the same.
• Forms (text boxes and buttons)
A form is a web page where you can enter information easily.
Forms are used to collect information to enable you to search
databases, send messages to the website owner, play games and
so on.
Some forms may be very simple. For example, most websites
have search engines, consisting of a text box for you to type
search text into and a Search button for you to submit the
request. Objects such as text boxes and buttons are called
controls.

Other forms may be more complex, using several text boxes,
list boxes, option buttons and so on, but they all work on the
same principle: type the information into the boxes and press
the button to send it.

• To move between controls use the mouse or press Tab
• To submit the form, click the button or press Return

• Multimedia content
Some websites may contain hyperlinks to sections with sound,
video and animation. Depending on how the website is
designed, you may be prompted to download a plug-in file to
browse this kind of content. A plug-in is an application that
extends Internet Explorer’s features.

Multimedia on the Web
Sound, video, animation, and 3D interactive video are referred
to as multimedia.Some multimedia, called streaming media,
plays as soon as you access a web page.Others require that you
download the multimedia file to your computer first.
Multimedia files often requires that your browser use a plug-in
program.

Plug-Ins
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Plug-ins are small software programs that extend the capabilities
of your browser by enabling it to play sounds and video clips
or do other functions, such as automatically decompressing files
that you download.
Plug-ins may come with your browser software or can be
downloaded from websites.
Some plug-ins enable streaming audio or video, which lets you
hear or view a multimedia file before it has completely
downloaded to your computer.

Notes



12

E
-M

E
D

IA

Topics Covered
• What is HTML, The components of HTML, A short history

of HTML, Understanding Basic HTML, HTML editors,
Name your document, Opening a document in a browser,
Elements of a good web design.

Objectives
Upon completion of this lesson, you should be able to:
• Know the Internet & World Wide Web
• What is Web page?
• What is Home page?
• Learning the first steps in creating a website
• How to define web site goals
• Setting Goals & objectives
• How to plan for your website.

What is HTML?
• H-T-M-L are initials that stand for HyperText Markup

Language. Let us now break it down :
• Hyper: is the opposite of linear. Initially the computer

programs had to move in a linear fashion. HTML does not
hold to that pattern and allows the person viewing the
World Wide Web page to go anywhere, any time they want.

• Text: is what you will use i.e english letters.
• Mark up: is what you will do. You will write in plain

English and then mark up what you wrote.
• Language: the language is plain English.
In other words, HTML is not a programming language.
Instead, HTML is used to define and classify different parts of
your webpage according to their function –in other words
indicating which part is the title of the document, which part is
a subheading, which part is the name of the author and so on.

The Components of HTML
The HTML document is composed of the following
components:
• Tags
• Attributes
Tags and attributes work together to identify different
document parts & tell the browser how to display them.
Tags identify document parts by specifying that a chunk of
information be displayed as a paragraph or that another chunk
of  information be displayed as a heading.
Attributes are optional parts of tags and modify or more
thoroughly specify information in tags such as color, alignment,
height, or width.

A short History of HTML and the World Wide Web

The evolution of HTML involved more than changes to the
tags and attributes. You’ll see that its variety of uses and
resulting popularity have changed the nature of HTML from
functional information resource to a marketing tool. HTML did
not evolve as an entity on its own; it took the efforts of many
people to bring the technology to what it is today.
Physicists at CERN (Centre European pour la Recherche
Nucleaire) , a European particle physics laboratory, needed an
easy way to share information over their network. In 1980, Tim
Berners-Lee developed the initial program that allowed paes to
links to one another. A decade later, development moved into
the realm of  text-only hypertext browsers, and the World wide
web was born. In 1992, CERN maade the system and he
software available to the rest of the world through the Internet.
At that time, the Internet was used primarily for academic
research and so the fledgling Web was extended to other
academic research centers and universities throughout the world,
including the National Center for Supercomputing Applications
(NCSA) at the University of Illinois at Urbana-Champaign. The
World Wide Web (with a hyphen) was named in late 1990 by
Berners –Lee.

Understanding Basic HTML Tools
For your first documents, you need only two basic tools: an
HTML editor and a web browser.
• An HTML editor is the program you use to create and save

your HTML documents.
• A Web Browser is the program you use to view and test your

HTML documents.

HTML Editors
In general, the HTML editors fall into two categories:
1. Text- or code-based, which allow you to see the HTML code

as you’re creating documents.
2. WYSIWYG (What You See Is What You Get), which show

the results of code, similar to the way it will appear in a
browser, as you’re formatting your document

Using the Text Editor to write an HTML document.
You will write the HTML document on the word processor,
like Notepad, WordPad etc. When you are finished creating the
HTML document, you’ll then open the document in a browser,
like Netscape Navigator. The browser will interpret the HTML
commands for you and display the Web page.
Let’s get into the programs you will use to write your HTML
document. Keep this in mind: HTML documents must be text
only. When you save an HTML document, you must save only
the text, nothing else.
When you use NotePad, WordPad etc. the file is saved in text-
only format without your doing any additional work.

The Word Processor

LESSON 3:
Language Of The Internet
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When you write to the word processor you will need to follow a
few steps:
1. Write the page as you would any other document.
2. When you go to save the document , always choose SAVE

AS.
3. When the SAVE AS box pops up, you will need to save the

page in a specific format. Look at the SAVE AS dialogue box
when it pops up: Usually at the bottom, you find where you
will be able to change the file format.

4. If you have a PC, save your document as ASCII TEXT
DOS or just TEXT. Either one will work.

NotePad, WordPad, and SimpleText already save in text-only
format so if you use one of them as your word processor,
you’ll get the correct format simply by saving your document.

How To Name Your Document
What you name your document is very important. You must
first give your document a name and then add a suffix to it.
That’s the way everything works in HTML. You give a name
and then a suffix.
Follow this format to name your document:
1. Choose a name like abc.
2. Add a suffix. For all HTML documents, you will add either

“.htm” or “.html”.
“.html” tells the computer that this file is an HTML document.
When we get into graphics, you’ll see a different suffix. All files
used on the Web will follow the format of  “name.suffix.”
Always.

Opening the Document in the Browser
Once you have your HTML document on the floppy disc or
your hard drive, you’ll need to open it up in the browser. It’s
easy enough. Follow the steps along.
1. Under the FILE menu at the very top left of this screen,

you’ll find OPEN…..

2. Click on it. The following dialog box appears in which you
must type in the HTML filename & then click OK.

The browser will now display the file on the screen.
How to look at the source code of an HTML document
from the browser window ?
Here’s how you look at an HTML document (known as the
“source code”):
1. When you find a page you like, click on VIEW at the top of

the screen.
2. Choose DOCUMENT SOURCE from the menu.

Sometimes it only reads SOURCE.
3. The HTML document will appear on the screen with the

HTML source code.

Elements of a good Web page design
A good web page must include the following four processes:
1. Planning
2. Organizing
3. Creating
4. Testing
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Planning Documents
HTML focused on making information easily available. The
resulting World Wide Web and corporate intranets were
primarily used to provide information to those who needed it.
In this manner, HTML was visitor-centered, that means
authors focused on determining what their audience wanted
and then provided that information.
However, as Web Technologies became popular, they evolved
into a marketing tool for millions of companies, organizations
and individuals worldwide. Rather than strictly providing
information, the purpose of many websites is now to tell the
visitors what the company wants them to know, to persuade
them to purchase a product or service, and to keep them
coming back to more. As a result, HTML development has now
shifted now to being simultaneously visitor-centered and
author-centered. Now, you not only need to consider what your
visitors want to know, you also need to consider what
information your organization wants to provide.
Therefore before starting to produce the HTML documents,
you need to do some planning. You need to determine what
your visitors want and what your organization wants to
provide.

What Do Your Visitors Want?
Whenever a visitor visits a website, he normally has a specific
interest in that. So during the planning phase of a website, you
must think about what visitors are expecting to see at your site.
To know about this in detail, you can start with your customers
needs. For Example, they might want a general information
about you, your company, or our products and services. Or they
might want information about the contact names,
troubleshooting advice, safety information, prices, schedules,
order forms and so on.
So the developer of a website must list out the vistors needs in
the planning phase.

What Do You Want to Provide?
You must figure out what you want to include. For this you
must take a look at the materials you already have in hand. For
Example, marketing materials often include information about
the company, products, and services suitable for use on a
Website.
If you don’t have access to marketing materials, ask yourself a
few questions:
i. What do I want people to know about my organization?

What is the corporate mission statement? What are my
company’s goals?

ii. What are my company’s products or services? How do they
help people use them?

iii. How do customers order our products?
iv. Is repair history or safety information so positive that I want

to publicize it?
v. Can I include product specifications?
vi. Do I want to include information about employees? Do

their skills and experience play a big role in how well our
products are made or sold?

vii.Can I provide information that is more timely, useful or
effective than other marketing materials such as brochures or
pamphlets, provide?

After you answer these and any other questions that are helpful
in your situation, you should be able to develop a list of what
you want to provide.
Note: Getting a consensus before you start to build a website is
always a good rule to follow.

Planning for Maintenance
Although maintaining your documents after you create them
and throughout their existence on your site is a separate phase
in the lifecycle of documents, you also need to include
maintenance in the planning phase. This is particularly the case
if you answer yes to any of the following questions:
• Will more than one person be involved in developing the

content?
• Will more than one person play an active role in maintaining

the site?
• Will your site include more than about 20 HTML

documents?
• Will you frequently add or modify a significant number of

pages- say more than 20-25 percent of the total number of
documents.

Planning for Content Maintenance
If you depend on others for the content, you need to make
arrangements at the outset for how you will obtain updates.
Will content providers actually develop and update the Web
pages, or will they simply send you new information via e-mail?
You need to plan accordingly. Planning now how you will
handle content revisions and updates will save out time and
grief later.

Planning for Site Maintenance
Regardless of whether you or someone else will maintain the
site you develop, you need to carefully document the
development process and include the following information:
• The site’s purpose and goals.
• The process where you determined content
• Who provides content?
Documenting the development process will help those who
maintain the site to keep everything up-to-date.

Organizing your Documents
After you decide what information to include in your site, you
need to determine how you will arrange individual HTML
documents.
There are three types of Organization at your disposal:
• Hierarchical
• Linear
• Webbed

Creating Documents

Create a Master document
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A master HTML document contains the necessary structure tags
as well as general document format you want to use. When you
create a master HTML document, you establish the look of the
site before you start adding content. Include the elements that
you want to appear on every page such as the following:
• The background
• Repeating images
• The corporate logo
• Icons
• Footer Information
Placing these elements in the master document will help you
develop them only once, and not every time you start a new
document.

Select Images
Determine which images or illustrations are available before you
start developing individual pages. Having an idea of what
images you want to include will help you determine page layout
and you can avoid rearranging pages later.

Create Important Pages First
Websites, by nature, are always “ under Construction”. You’ll
find that you’re constantly updating content, adding new pages,
or removing pages. If you create a few of the important pages
first, test them and publish them, you can eliminate the task of
polishing many pages later. You can then add and modify pages
as needed after you create an initial few.

Testing Documents
Testing an HTML document involves viewing your documents
in multiple browsers with a variety of system settings. The
purpose is to see how your documents will appear to your
visitors, to check readability and usability and to root out any
layout or formatting problems.
You’ll want to test for those issues on your local computer
before you publish your pages on the WWW or on the intranet.
In doing so, you can get the general idea of what your visitor is
likely to see.

Home Sweet Home Page
When you browse the World Wide Web you’ll see the term
home page often. Think of a home page as the starting point
of a website. Like the table of contents of a book or magazine,
the home page usually provides an overview of what you’ll find
at the website. A site can have one page, many pages or a few
long ones. If there isn’t a lot of information, the home page
may be the only page. But usually you will find at least a few
other pages.

Web pages vary wildly in design and content, but many use a
traditional magazine format. At the top of the page is a
masthead or banner graphic, then a list of items, such as articles,
often with a brief description. The items in the list usually link
to other pages on the site, or to other sites. Sometimes these
links are highlighted words in the body of the text, or are
arranged in a list, like an index. They can also be a combination
of both. A web page may also have images that link to other
content.
How can you tell which text are links? Text links appear in a
different color from the rest of the text—typically in blue and
underlined. When you move your cursor over a text link or over
a graphic link, it will change from an arrow to a hand. The
hypertext words often hint at what you will link to.
When you return to a page with a link you’ve already visited, the
hypertext words will often be in a different color, so you know
you’ve already been there. But you can certainly go there again.
Don’t be surprised though, if the next time you visit a page it
looks different and the information has changed. The Web is a
dynamic medium. To encourage visitors to return to a site,
some web publishers update pages often. That’s what makes
browsing the Web so exciting.

A Home (Page) of Your Own
In the 60s, people asked about your astrological sign. These
days, they want to know your URL, since having a Web address
is almost as important as a street address. Your website is an
electronic meeting place for your family, friends and potentially,
millions of people around the world. Building your digital
domain is easier than you may think. Best of all, you may not
have to spend a cent. The Web brims with all kinds of free
services, from tools to help you build your site, to free graphics,
animation and site hosting. All it takes is some time and
creativity.
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Page Design
Think of your home page as the starting point of your
website. Like the table of contents of a book or magazine, the
home page is the front door. Your site can have one or more
pages, depending on how you design it. If there isn’t a lot of
information just yet, your site will most likely have only a home
page. But the site is sure to grow over time.
While web pages vary dramatically in their design and content,
most use a traditional magazine layout. At the top of the page
is a banner graphic. Next comes a greeting and a short
description of the site. Pictures, text, and links to other websites
follow.
If  the site has more than one page, there’s typically a list of
items-similar to an index-often with a brief description. The
items in the list link to other pages on the website. Sometimes
these links are highlighted words in the body of the text. It can
also be a combination of  both. Additionally, a web page may
have images that link to other content. The structure of a site
typically looks something like the diagram to the right.
Before you start building your site, do some planning. Think
about whom the site is for and what you want to say. Next,
gather up the material that you want to put on the site: write
the copy, scan the photos, design or find the graphics. Draw a
rough layout on a sheet of paper.

Some Tips
While there are no rules you have to follow, there are a few
things to keep in mind:
• Start simply. If  you are too ambitious at the beginning, you

may never get the site off the ground. You can always add to
your site later.

• Less is better. Most people don’t like to read a lot of  text
online. Be brief and break long paragraphs into smaller
chunks.

• Use restraint. Although you can use wild colors and images
for the background of your pages, make sure your visitors
can read the text easily.

• Smaller is better. Most people connect to the Internet with
a dial-up account. Since it can take a long time to download
large image files, keep the file sizes small. For tips how to do
this, review our graphics article.

• Have the rights. Don’t put any material on your site unless
you are sure you can do it legally. Read Learn the Net’s
copyright article for more about this.

Assignments
1. Define Internet? Is World Wide Web different from

Internet, or is it the same?
2. How big is the Internet?
3. Write methods to search the Internet?
4. What is hypertext?
5. Explain the components of an URL?
6. What is a web browser? What are the different kinds of

browser?
7. How can you customize your browser according to your

needs?
8. What are the commonly used plug ins for multimedia in the

Internet?
9. What is HTML? Identify its components?
10.Give the names of some commonly used HTML editors?
11.What is home page?

Summary
This week, we tried to open ourselves to the Internet, that’s the
purpose of the Basics of Internet 1 –2, in this chapter, we learnt
about the language of  the web, where we look in to HTML.
Know the intricacies of it and learn about home page, which
will be our prime focus, as at the end of this course, you will be
able to make your own personal home pages
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Topics Covered
• Introduction to Internet, World Wide Web, Defining Web

Site Goals, Setting Goals & Objectives, Web site planning

Objectives
Upon completion of this lesson, you should be able to:
Know the Internet & World Wide Web
• What is Web page?
• What is Home page?
• Learning the first steps in creating a website
• How to define web site goals
• Setting Goals & objectives
• How to plan for your website.
The internet is a global network of interconnected computers.
Rumours that it stared  life  as a sinister US military experiment
may be somewhat  exaggerated, although a computer network
called ARPANET run by the US Defense Department from
1969 was a primary component of the super network which
would eventually become  the internet, and the US government
was definitely interested in a network that could withstand
nuclear attack. In fact the first talk about the internet can be
traced back to 1962, when J.C.R Licklider of  MIT wrote a
number of memos about his ideas of a  ‘Galactic Network’
linking computers worldwide.
 (see www.isoc.org/internet/history.brief.html)
ARPANET aged rapidly under the weight of  new technology
and the volume of traffic it was managing. The National Science
Foundation (NSF) finally came to the rescue, assigning five
supercomputers to handle the ever-increasing load. In 1990
when ARPANET ended its reign, NSFNET took over.
Today, NSFNET is phasing itself  out, with a variety of
commercial and noncommercial networks taking up the
cyberspace slack. New networks sponsored by local phone
companies and regional providers are springing up around the
globe, constantly expanding the scope of Internet traffic. In a
short quarter of  a century, the Internet has grown from just
four-computers in the DoD’s into an worldwide presence of
incalculable importance.

So What is World Wide Web?
The world wide web is a user-friendly interface  on the  internet.
It was developed by Tim Berners Lee (www.w3.org/people/
Berners-Lee) in 1990-91, and caught on in 1993, when a freely
available web browser called Mosaic,written by  Marc Anderson
and Eric  Bina, started the ‘Web Revolution’.(Mosaic went on to
become Netscape Navigator and Andresson went to become
very rich.) Berners Lee is  sometime mistakenly credited with
inventing the internet. But his actual achievement was perhaps
more socially significant: he recognized that the internt was ‘too
much of a hassle  for  a non computer expert’

Berners Lee’s idea was to create a set of  agreed protocols and
standards so that documents could be stored on Web Servers
anywhere in the world., but could be brought up  on  a
computer screen by anyone who wanted them, using a simple
address. Central to Berners Lee’s dream was the use of
hyperlinks,  so that Web pages would be full  of  highlighted
words or phrases, which would be links to other relevant pages
elsewhere.
This is precisely why the Web is exploding in popularity because
of  its simple, graphical nature and easy accessibility. Before 1989
only a relatively small community of individuals had the skill to
understand and use the Internet. But when the Web was born,
suddenly anyone could do it. Instead of cryptic commands, the
Web employed simple point and-click techniques already used in
standard online help screens. That is, you could click a visible
link and “jump” to the referenced document regardless of its
location.

What is a Web page?
Web page is simply a document written in the Web-formatting
language, HTML. It can be one to many screens in length. Now
a days that the commercial nature of  the Web is being exploited,
Web pages are also used to advertise products, companies, and
services. Most corporations are scrambling to create a strong
Web presence in an effort to lure even a small percentage of  the
Web citizenry to their goods.

What is a Home Page?
Some Web documents are described using the generic term
home page. The most commonly referenced home page is the
opening document to particular Web site, signifying the top of
the site hierarchy and providing a generalized table of contents
in the form of  links. For e.g. the home page of  University is
(see figure below)

Surf The Web: Top Ten Tips

Despite the promise of  high-speed broadband service, most
people still access the Web with a dial-up account. Waiting for
web pages to download can be frustrating, as is trying to find
specific information in a sea of  data. To make Web surfing a
more satisfying and productive experience, we offer these tips:
• Get a faster connection.
If  you are still using a 28.8 Kbps modem, it’s time to upgrade.
Most people these days access the Web at twice that speed-new
modems offer access at 56 Kbps. Better yet, consider getting a
high-speed service such as DSL or cable modem. It may cost a
bit more, but it will greatly improve your satisfaction.

LESSON 4:
The First Step-1
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• Use the Stop button.
When you access a website, what you are actually doing is
downloading digital files. You can see how the download is
progressing by looking at the status bar located in the lower left-
hand corner of your web browser. If you get tired of waiting,
click the Stop button to view the files that have already
downloaded. Then you can decide if you want to continue. If
you do, click the Reload or Refresh button.

• Increase your cache.
Files you download are stored in a cache (pronounced like
“cash”) on your hard drive. That way when you return to a site,
you don’t have to download the files again from the server,
just access them locally from your cache. After a while though,
the cache becomes full. Your web browser automatically deletes
old files as you continue to surf  the Web. But if  you visit many
of  the same sites regularly, you can speed up access by caching
more of  them. To do this, increase the size of  your cache. 10
Mb is optimal.
If you use Netscape Navigator 4.0 or a later release, under the
Edit menu, choose Preferences, then click on Advanced. Now
click on Cache. In the appropriate box, increase the cache size.

With Explorer 5.0 or later, under the Tools menu, select
Internet Options. Next, on the General tab, click on Settings.
Use the slider to increase the cache
•  Save keystrokes by using Bookmarks or Favorites.

Web addresses or URLs can be unwieldy. Worse, if  you type
them wrong, you get an error message. To avoid these
problems, save the addresses of sites you want to revisit.
• Use the Find feature of  your web browser.
Once you’ve accessed a web page, use the Find feature to quickly
locate a particular term that interests. Why take the time to scroll
through the entire document?

• Pick two search engines and learn how they work.
The difficulty of finding specific information is by far the
biggest complaint we hear. Although dozens of  search engines
are available, pick two, then take the time to learn them well.
•  Choose your own home page.
Both Netscape Navigator and Microsoft Internet Explorer set
their respective sites as the default home page when you launch
your web browser. If you want to begin your surfing by reading
a daily newspaper or better yet, Learn the Net, why not start
there first? Open a new window.

While you are downloading one web page, you can access
another by opening a second browser window. With Navigator,
go to the File menu and choose New, then Navigator
Window. With Internet Explorer under the File menu select
New, then Window . A word of  caution: Although you can
open multiple windows, this will slow down your computer,
so don’t go overboard. Remember to close the additional
windows to free up disk space.
•  Surf during off-peak hours.
Most commuters experience rush hour, when highways bog
down with traffic. The same phenomenon happens on the
Internet, usually in the late afternoon and early evening, when
people log on to check e-mail, chat and play games. If you want
to avoid the slowdown, go online in the morning or late at
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night, when traffic is

lighter.
• View sites in text-only mode.
Sure, web designers spend a great amount of time creating
wonderful graphics, but it can take quite a while to download
large graphic files. To speed things up, turn off  the images in
your web browser.
With Internet Explorer 5.0 or later versions, under the Tools
menu, select Internet Options, then click the Advanced tab.
Now uncheck Show Pictures.
Thoughtful designers will include something called an ALT
tag, a written description of the image. If you want to see a
particular image, click on the tag with your right mouse button
and select View Image. For Mac users, just hold down the
mouse button over the graphic. You can also click the Image
button in Navigator to load all the images.

The First Step In Creating Your Own Websites

Defining Web Page Goals
The first important step (that is often neglected) in the web site
creation process, is to determine the purpose of your web site.
Too often a web site lacks the focus of  a clear purpose and
visitors are quickly confused and give up. Think about sites you
visit and have moved on promptly. Despite technology related
matters as the cause of  your action, it’s more likely than not,
you clicked away because the site did not quickly and effectively,
convey its purpose to you
It’s an established fact that Internet surfers today are increasingly
impatient and intolerable. Your visitor will not spend their
precious time trying to figure out what your site is about (and
more importantly, how it’s going to of  benefit to them - site’s
goals).
A web site with a well defined purpose stands out and a visitor
should instantly recognize it without effort.
Clearly defining the purpose of your web site, before its
creation, will ensure that your web site is optimized to achieve
the required purpose. After all, you can only meet your goals
when you know what they are.

For your part, you need to focus and understand why you
are having this web site?
You might be trying to:
• provide a service
• sell a product
• present information on a topic
• make an announcement
• inform people about yourself
• create a forum that addresses a certain issue
• deliver news on a particular subject
Consider devoting a page to your site’s purpose. Some sites do
this through a mission statement or a dedicated page explaining
the purpose of the site. It will effectively address why the site
was created, what it’s about and what it hopes to achieve for the
user (site’s goal). This is a very efficient method to combine two
of  your site’s objectives
Having a clearly defined purpose will benefit you also when it
comes time to submit your site to directories. They will ask you
to provide a limited description of  your site. You must be able
to quote an effective, one-liner.
Don’t ever mislead or trick people thinking your site is
something it’s not. This is a counter-productive measure that
will not get you far and will likely backfire, one way or another.

Setting site goals and objectives
The success of any web site can only be measured on the goals
of it. Having no goals will not mean your site is a failure but
simply just an achievement! You may have made it your goal to
have your own web site and that’s fine but you’re still going to
have goals set for your site.
As with the site’s intended purpose, we have to get focused and
have a clear and complete understanding of what we want this
site to achieve.
With any general goal-setting we undertake, there must be some
variables to set on goals on. Therefore, our goals must be:
• Specific: Describes what you want to accomplish with as

much detail as possible.
• Realistic: Goals you know you are actually capable of

obtaining.
• Challenging: Takes energy and discipline to accomplish

rewarding goals.
• Prioritized: Sets goals by time and importance into clearly

specified target completion dates.
• Measurable: Describes your goal in terms that can clearly be

evaluated
Writing down your goals creates the roadmap to your success.
Although just the act of writing them down can set the process
in motion, it is also extremely important to review your goals
frequently. Remember, the more focused you are on your goals
the more likely you are to accomplish them.
With respect to the development of your site, the principal
question is:
What do you want this site to accomplish? (For you and your
visitors/clients)
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Every site will have different objectives while every site owner
will have set different goals also. Any site will have varied
reasons for existence. These could be:
• Product brand awareness
• To market detailed product information
• Providing product ordering information
• To sell a certain quota of  a product within a given time

period
• To target international communities
• Provide the latest new product or service information to

customers
• Reduce distribution costs of promotional material
• Market yourself
• To make money from an online business
It’s clear that a business orientated site will be more objective in
its goals than a site of a personal nature but the site must have
a reason for existing.
We also want a way of knowing if  our site is performing its
goal(s) as intended. It would be beneficial to the site’s owner to
get visitor feedback. A simple way is simply ask or gauge from
visitors through a feedback form or a survey.
We also suggested in determining site purpose study, to
dedicate a page in the form of a mission statement. If you
decide to do this, you can list your site goals and objectives here
also. That way, your visitors will clearly know what your site is
trying to do for them!

Website Content Ddevelopment
What type of content is your intended target audience expecting
to find? You should already have a good idea of who your
target audience is. The site is being created to fill its purpose and
interact with people that will have some interest in the theme of
the site.
How can we now develop our website’s content to benefit
our targeted audience?
We have to place ourselves in their shoes and ask, “what will I
come to this site for?” We must:
• figure out the psychology of our likely visitors to make our

site appeal
• provide useful content our visitors may want and even

expect
• think of ways we can keep our visitors at our site and how

we can entice them back again
We also have to:
• make a good first impression
• establish need, honesty and reliability
• make our content (information) clear and concise
• provide good organization so our visitors can find

information easily
• make our site interesting
By understanding the make-up of our visitor, knowing how we
can appeal to their needs and interests in an effective way and by

creating a good first impression through a confirmation of their
expectations, you stand a much higher chance of success as
determined by the goals of the site.
You might find it hard to get started on your content process
so the best way to kick things off is to see what is already out
there on the web. We are only interested in sites of  similar
nature as your intended theme so search for potential
competing sites for ideas.
I stress you don’t copy information you find but get ideas on
how these sites offer their content. Principally of interest, we
want to:
• study what they offer
• see how they layout their content
• analyze site structure (navigation of pages)
• notice ways they engage their audience
note outbound links to other complementary sites
Be objective while researching sites and always think, “how can I
expand on this and make my site better”. Be critical but honest
and open-minded when researching other sites. Act like you are
a web surfer looking for information this site is offering. Did
they (the site):
• make a good first impression with you?
• better inform you with their content?
• address and answer your needs?
• use clear and simple language that was understandable?
• convey honesty and friendliness?
• make it easy for you to find what you were looking for?
• offer reasons to return to the site again?
These are just some of the more important checks you should
carry out when evaluating these sites.
Understand no single approach is right so collectively make
notes of  things you liked, disliked and more importantly, how
you can improve on these ideas. You will quickly form ideas on
what you should be offering with your own site when carrying
out this type of research.
Gather ideas attained from other sites and integrate them with
your own ideas to develop content for your site. Be original,
informative and helpful and your site will be a winner.

Web Page Content
Before you attempt to write the content of a web page, you
should first understand the purpose of your page. Don’t make
people guess what it’s about. Conveying its purpose in a
descriptive title at the start of the page is a good idea.
Decide what you want on the page and then write a draft copy.
It might help if you act like you are writing for a speech or as if
you were talking to somebody about what’s on your page.
Don’t worry too much at this stage what and how much text
you write as you’ll likely need to edit later to keep only relevant
text and discard anything non-essential. You should aim for
200 to 500 words in your web page.
You have to ensure the document is clear so that it may be
more easily understood. Using clear and simple language
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promotes effective communication and benefits people whose
native language differs from your own.
You should also appreciate your document is a standalone page
on the web (but within the context of you web site). People
may search for information exactly what your page is about. A
web surfer might enter your site through this page but we have
to use specific keywords within your text to match with a related
search query.
By keeping your page focused on one topic and using the
selected keyword or keyphrase within your text, your page
stands a better chance of being ranked higher in search engines
for that specific query.
There are lots of theories and opinions regarding ‘page
optimization’ through use of  keywords. We will likely explore
this important area elsewhere but you have to understand its
importance. We are principally writing for our human readers so
we must still produce a well written, well edited web page
document.
You should also understand the web page’s relationship with
the rest of your site. How does this page relate with other pages
if somebody enters your site through any page other than your
home page? You may have to consider some page navigation
links within the pages if it forms a series etc (like much the
planning section you are reading here).
The visitor entering via a web page within your site will not first
see your home page. Commonly only your home page will
convey the meaning of your web site so you should add some
context within your pages to address the theme of your web
site in general.
Some of the many considerations in writing quality and
effective content for your web pages are:
• Simplicity - always strive for simplicity in your content.

Readers should grasp your message immediately through use
of  easy to understand wording. Web readers scan pages so
provide easily digestible chunks (sentences/paragraphs) of
text.

• Benefits - always focus on the benefits for your reader.
People are only interested in what’s in it for them so you
must clearly convey the reader’s benefits through use of  lists
and well constructed bolded headlines.

• Linkage - support your text with links to other pages
(within your own site or elsewhere) for further details.

• Personality - try and write in a friendly manner while
maintaining a professional appearance. Convey empathy in
your writing by making you text less impersonal. By making
your content interesting and ‘connecting’ with your reader,
you visitor will better understand, enjoy and respond to your
content.

Writing quality and effective web content is a skilled job. You
can ably do this yourself  by reading more on the web, learning
by common mistakes and practicing writing yourself. You can
read more web content writing tips here to further your
understanding of good web writing principles.

The following section takes a first look at web design styling
considerations and how to present content information to your
audience.

Web design style and web site styling

Web site style is defined through page layout, design and
personalization of  your site’s web pages.
This section takes a first look at web design styling
considerations and how to present content information to your
audience.
We need to blend in with our target audience so once they
arrive, they will feel right at home. Styling is really the
combination of determining audience and content
considerations. Now we know what our visitors are expecting
when they arrive at our site, how are we going to present our
site to them? In the need to envisage design thoughts for our
site, we should appreciate:
• simplicity is king; always.
• web surfers are most comfortable with standard design

techniques that they are used to.
When writing web page content, the document usually becomes
part of  a larger collection. It’s important that the site follows a
common structure so all documents are available in a logical
place. Bear in mind each individual document will likely have its
own structural considerations.
The style of a document helps a reader to browse through it, in
order to find the information they are looking for. All
documents should share the same style (i.e. all your pages
should be of uniform design throughout the site). This makes
it easier to understand any particular document, and to jump to
related information.
Using the same template to create all documents will ensure
each element is used for the same function in all documents.
This also helps maintaining the documents in the long term
because all documents share the same markup (page coding)
style.
Once your visitor has made a decision to stay, draw their
attention to what you feel they should see first; in other words,
guide them through your site. Styling is personal but you must
make it appealing to your target audience for effective results.
It’s beneficial to surf  around to get ideas from other sites on
how they present site content to their audience. It’s best to
research sites of similar nature as your own as the content will
be comparable. Remember, your site must have its own unique
identity which is why you can’t copy exact content and design
from other sites.
As previously mentioned in this series, no one single approach
is right. All web sites should reflect their own personality in the
theme they are projecting. Styling is personal to the site owner
and by being creative and working within accepted design
considerations mentioned above, your site will be working to
the full potential of its goals.
Next we look at web design budgetary considerations.
Knowing how much capital (money) you can commit to with
the start up of your site, will determine what is possible to get
online.
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Lesson 4 – Assignment

1) Trace the history of  Internet and World Wide Web?
2) Define the goals of your personal home page?
3) What’s the objective of  your personal home page?

Summary
This lesson gave you a brief  history of  Internet and World
Wide Web. Then we moved on to setting your websites goals
and objective. Finally we ended the lesson with the checklist for
the planning for your website. I hope you understood the
topics covered. Before we go the next lesson, following are the
reference books & websites for this lesson, if you intend to
learn more.
http://www.learnthenet.com
http://www.techsoup.org/

Notes
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Topics Covered
• Planning for the website, knowing your audience, specifying

site/page design critique, computer lab with introduction to
HTML, your first web page.

Objectives
Upon completion of this lesson, you should be able to:
• Planning for your home page?
• Knowing your audience.
• Specifying your site/page design
• Introduction to HTML
• Saving and viewing HTML pages
• HTML tags
• Your first web page

Keys of Building Web Sites
Planning a Web site is a two-part process: first you gather your
development partners, analyze your needs and goals, and work
through the development process outlined here to refine your
plans. The second part is creating a site specification document
that details what you intend to do and why, what technology
and content you’ll need, how long the process will take, what
you will spend to do it, and how you will assess the results of
your efforts. The site specification document is crucial to creating
a successful site, as it is both the blueprint for your process and
the touchstone you’ll use to keep the project focused on your
agreed goals and deliverables

Planning
Web sites are developed by groups of  people to meet the needs
of  other groups of  people. Unfortunately, Web projects are
often approached as a “technology problem,” and projects are
colored from the beginning by enthusiasms for particular Web
techniques or browser plug-ins (Flash, digital media, XML,
databases, etc.), not by real human or business needs. People are
the key to successful Web projects. To create a substantial site
you’ll need content experts, writers, information architects,
graphic designers, technical experts, and a producer or
committee chair responsible for seeing the project to
completion. If your site is successful it will have to be genuinely
useful to your target audience, meeting their needs and
expectations without being too hard to use.
Although the people who will actually use your site will
determine whether the project is a success, ironically, those very
users are the people least likely to be present and involved when
your site is designed and built. Remember that the site
development team should always function as an active,
committed advocate for the users and their needs. Experienced
committee warriors may be skeptical here: these are fine
sentiments, but can you really do this in the face of
management pressures, budget limitations, and divergent

stakeholder interests? Yes, you can - because you have no choice
if  you really want your Web project to succeed. If  you listen
only to management directives, keep the process sealed tightly
within your development team, and dictate to imagined users
what the team imagines is best for them, be prepared for failure.
Involve real users, listen and respond to what they say, test your
designs with them, and keep the site easy to use, and the project
will be a success

Know Your Audience
The next step is to identify the potential readers of  your Web
site so that you can structure the site design to meet their needs
and expectations. The knowledge, background, interests, and
needs of users will vary from tentative novices who need a
carefully structured introduction to expert “power users” who
may chafe at anything that seems to patronize them or delay
their access to information.
A well-designed system should be able to accommodate a range
of users’ skills and interests. For example, if the goal of your
Web site is to deliver internal corporate information, human
resources documents, or other information formerly published
in paper manuals, your audience will range from those who will
visit the site many times every day to those who refer only
occasionally to the site.

Site/Page Design Critiques
Each member of a site development team will bring different
goals, preferences, and skills to the project. Once the team has
reached agreement on the mission and goals of the project,
consensus on the overall design approach for the Web site
needs to be established. The goal at this stage is to identify
potential successful models in other Web sites and to begin to
see the design problem from the site user’s point of  view.
Unfortunately, production teams rarely include members of  the
target audience for the Web site. And it is often difficult for
team members who are not already experienced site designers to
articulate their specific preferences, except in reference to existing
sites. Group critiques are a great way to explore what makes a
Web site successful, because everyone on the team sees each site
from a user’s point of  view. Have each team member bring a list
of a few favorite sites to the critique, and ask them to introduce
their sites and comment on the successful elements of each
design. In this way you will learn one another’s design
sensibilities and begin to build consensus on the experience that
your audience will have when they visit the finished site.

Content Inventory
Once you have an idea of  your Web site’s mission and general
structure, you can begin to assess the content you will need to
realize your plans. Building an inventory or database of existing
and needed content will force you to take a hard look at your
existing content resources and to make a detailed outline of
your needs. Once you know where you are short on content you

LESSON 5:
The First Step–2
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can concentrate on those deficits and avoid wasting time on
areas with existing resources that are ready to use. A clear grasp
of your needs will also help you develop a realistic schedule and
budget for the project. Content development is the hardest,
most time-consuming part of  any Web site development
project. Starting early with a firm plan in hand will help ensure
that you won’t be caught later with a well-structured but empty
Web site.

Developing a Site Specification
The site specification is the planning team’s concise statement
of core goals, values, and intent, to provide the ultimate policy
direction for everything that comes next. Designing a
substantial Web site is a costly and time-consuming process.
When you’re up to your neck in the daily challenges of  building
the site, it can be surprisingly easy to forget why you are doing
what you are, to lose sight of your original priorities, and to not
know on any given day whether the detailed decisions you are
making actually support those overall goals and objectives. A
well-written site specification is a powerful daily tool for judging
the effectiveness of a development effort. It provides the team
with a compass to keep the development process focused on
the ultimate purposes of the site. As such, it quickly becomes a
daily reference point to settle disputes, to judge the potential
utility of new ideas as they arise, to measure progress, and to
keep the development team focused on the ultimate goals.
At minimum, a good site specification should define the
content scope, budget, schedule, and technical aspects of the
Web site. The best site specifications are very short and to the
point, and are often just outlines or bullet lists of the major
design or technical features planned. The finished site
specification should contain the goals statement from the
planning phase, as well as the structural details of the site.

Goals and Strategies

• What is the mission of your organization?
• How will creating a Web site support your mission?
• What are your two or three most important goals for the

site?
• Who is the primary audience for the Web site?
• What do you want the audience to think or do after having

visited your site?
• What Web-related strategies will you use to achieve those

goals?
• How will you measure the success of your site?
• How will you adequately maintain the finished site?
• Production issues
• How many pages will the site contain? What is the

maximum acceptable count under this budget?
• What special technical or functional requirements are needed?
• What is the budget for the site?
• What is the production schedule for the site, including

intermediate milestones and dates?
• Who are the people or vendors on the development team

and what are their responsibilities?

These are big questions, and the broad conceptual issues are too
often dismissed as committees push toward starting the “real
work” of  designing and building a Web site. However, if  you
cannot confidently answer all of these questions, then no
amount of design or production effort can guarantee a useful
result.

Avoiding “scope creep”
The site specification defines the scope of your project - that is,
what and how much you need to do, the budget, and the
development schedule. “Scope creep” is the most prevalent
cause of  Web project failures. In badly planned projects, scope
creep is the gradual but inexorable process by which previously
unplanned “features” are added, content and features are
padded to mollify each stakeholder group, major changes in
content or site structure during site construction are made, and
more content or interactive functionality than you originally
agreed to create is stuffed in. No single overcommitment is
fatal, but the slow, steady accumulation of  additions and
changes is often enough to blow budgets, ruin schedules, and
bury what might have been an elegant original plan under
megabytes of muddle and confusion.
Don’t leap into building a Web site before you understand
what you want to accomplish and before you have developed a
solid and realistic site specification for creating your Web site.
The more carefully you plan, the better off you will be when
you begin to build your site.
One excellent way to keep a tight rein on the overall scope of
the site content is to specify a maximum page count in the site
specification. Although a page count is hardly infallible as a
guide (after all, Web pages can be arbitrarily long), it serves as a
constant reminder to everyone involved of  the project’s
intended scope. If  the page count goes up, make it a rule to
revisit the budget implications automatically - the cold realities
of budgets and schedules will often cool the enthusiasm to
stuff in “just one more page.” A good way to keep a lid on
scope creep is to treat the page count as a “zero sum game.” If
someone wants to add pages, it’s up to them to nominate
other pages to remove or to obtain a corresponding increase in
the budget and schedule to account for the increased work
involved.
Changes and refinements can be a good thing, as long as
everyone is realistic about the impact of potential changes on
the budget and schedule of a project. Any substantial change to
the planned content, design, or technical aspects of a site must
be tightly coupled with a revision of the budget and schedule
of the project. People are often reluctant to discuss budgets or
deadlines frankly and will often agree to substantial changes or
additions to a development plan rather than face an awkward
conversation with a client or fellow team member. But this
acquiescence merely postpones the inevitable damage of not
dealing with scope changes rationally.
The firm integration of schedule, budget, and scope is the only
way to keep a Web project from becoming unhinged from the
real constraints of  time, money, and the ultimate quality of  the
result. A little bravery and honesty up front can save you much
grief  later. Make the plan carefully, and then stick to it.
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Internet Business Ideas
What Internet Business would you like to create and promote?
The Internet is a wonderful medium for business. You have
the entire world as your market, you can operate from anywhere
within it and if  you choose your product or service carefully, you
have low operating costs. Once you start thinking along these
lines and particularly compared to ‘real world’ costs and
limitations, you’ll begin to understand how there’s nothing like
it. So think objectively how you can become a success in this
remarkable opportunity.
The creation of your own web site should be built on a theme
or topic that appeals to you passionately or that you are very
knowledgeable about. Whilst you can start an Internet business
site on any conceivable topic, one that fits the above criteria will
yield more enjoyment and/or success. I have listed some web
site starter ideas below to stimulate your thinking process.
• Cooking With everyone in a hurry these days, provide a

resource to address people’s busy lifestyles in food
management, planning and recipes etc. How do you do it
successfully?

• Computer :Computing and the Internet are opening up to
different generations now, target the right market with
tutorials and resources and you could be on to something
big!

• Crafts:Share your unique way of craft-making or interest
about your favorite craft.

• Culture:From or have some involvement in an unique
culture? Be the leading knowledge on it!

• Entertainment:Your local area may benefit from an
informative entertainment site, special events in your town
or surrounding areas, etc.

• Exercise: We are all probably guilty of  not doing enough of
it, or done correctly; could your program or expertise benefit
others in some way?

• Fashion:A fashion guru or got your finger of the fashion
pulse? Be a fashion source!

• Gardening:A real green fingers? Tell the world your love or
special interest and share some of your gardening secrets, a
very popular but difficult subject to master! Be the answer!

• Handy Work:Maybe you can offer great tips for fixing things
around the house. Who couldn’t use your expert experience?

• Interior Decorating •Some are good at it, most are not; make
it simple for the mass that are not, provide tips, tutorials and
resources from your hard earned experience)

• Men’s Issues (have a large circle of  friends? What problems
come up all the time [other than women!], address these
problems in your own site and you could be onto a winner.

• Movies :Enjoy going to the movies? Or now with home
entertainment the buzz, share your knowledge or expertise
in this area.

• Music :Music lovers will adore you for building a resource site
for music lyrics, musical instruments and where to get them,
music reading tips, etc... this is a big area.

• Office Organization: You’ll find that people who run a busy
office are always looking for ways to improve the office
atmosphere. You can show how to organize, prepare
paperwork, manage and distribute work load, etc.

• Parenting Tips:First time parents need all the help they can
get, how can your parenting experience help them?

• Pets :Exotic breeds, training, care etc.
• Problem solver:Who doesn’t have a problem? The greatest

success can be providing an answer to people’s problems.
Think about the people’s problems around you and how
you could address their needs.

• Retirement:It’s a growing [no pun intended] area. How
should we prepare for it, what do need to know. Provide
information about successful retirement, best retirement
locations in the world, money management, etc.

• School Work helper:Be an inspiration to many who might
need your expert help!

• Special Interest:Perhaps you’re a huge fan of  a certain
collectible item and would like to provide a list of resources
about the item.

• Sports :Who doesn’t like some sports? Be a knowledge king
or queen in your passionate field. Sharing help, knowledge
and resources in your field of interest could be a help to
thousands?

• Time management:Lead a busy lifestyle but have it under
control? Share your secrets and help others, help themselves;
this is an area that is getting more important in life.

• Volunteer :Your free time will be valuable to your
organization. You can a site for your favorite organization
and help fulfill it’s purpose on the Net. Web-Designz gives
special consideration to such groups.

• Women’s Issues:Have a large circle of  friends? What
problems come up all the time [other than men!], address
these problems in your own site and you could be onto a
winner. And the list goes on...

Computer Lab
Let’s Get Started
At  first here are the basic requirements, what you need:
1. A browser like Netscape Navigator, Microsoft Internet

Explorer, or Opera. If  you’re looking at this page, you
obviously have one. I would also suggest using a browser
that supports images. If  you surf with LYNX or CELLO, or
another text-only browser, then try upgrading to one of the
browsers noted above. Each name is linked to the download
site for that browser.

2. A word processor. If you have access to Windows
“Notepad” or “WordPad” programs or the MAC “Simple
Text” program, use that to get started.

What is HTML?

H-T-M-L are initials that stand for HyperText Markup
Language (computer people love initials and acronyms - you’ll
be talking acronyms ASAP). Let me break it down for you:
· Hyper is the opposite of linear. It used to be that computer

programs had to move in a linear fashion. This before this,
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this before this, and so on. HTML does not hold to that
pattern and allows the person viewing the World Wide Web
page to go anywhere, any time they want.

• Text is what you will use. Real, honest to goodness English
letters.

• Mark up is what you will do. You will write in plain English
and then mark up what you wrote. More to come on that in
the next Primer.

• Language because they needed something that started with
“L” to finish HTML and Hypertext Markup Louie didn’t
flow correctly. Because it’s a language, really — but the
language is plain English.

Beginning to Write
You will write the HTML document on the word processor, or
Notepad, WordPad, or Simple Text. When you are finished
creating the HTML document, you’ll then open the document
in a browser, like Netscape Navigator. The browser will interpret
the HTML commands for you and display the Web page.
Let’s get into the programs you will use to write your HTML
document. Keep this in mind: HTML documents must be text
only. When you save an HTML document, you must save only
the text, nothing else.

Creating a new html Document
Creation of an HTML document is carried out in much the
same way as you create any plain text document. The steps
involved are:

Open the Text editor.

Start the new document. ( If you are using Windows or
Macintosh, choose File —> New. If  you are using Unix, type vi
or pico to start the editor.
Enter the HTML code and text you want to include.
Save the document. If you are using Windows or Macintosh,
choose File—> Save or File—> Save As.

Saving an html document
If you are not using text-only editor such as Notepad or
TeachText, verify that the file type is set to Text or ASCII (or
HTML, if  that’s an option). If  you are using word-processing
programs to create HTML documents, save your documents as
HTML, Text Only, ASCII, DOS Text, or Text with Line Breaks
depending on the word processor you are using.
Name the file with an htm or html extension.
Use only letters, numbers, hyphens (-), underscores (_), and
periods (.) in your filename. Many browsers also accept spaces in
the file names; however avoid using spaces as spaces often make
creating of links difficult.
Save the document and the rest of the documents and files
associated with a particular project in one folder. This will make
using links, images and other advanced effects easier.

Viewing an html document
Viewing of the HTML documents that you create is as simple
as opening them from your local hard-drive in your browser.
The steps involved are:
Choose File © Open, and type the local file name or browse
your hard drive until you find the file you want to open. Your
particular menu commands might be File—> Open Page or

File—> Open File both are same.
Select the file, and click OK to open it in your browser.

Tags and attributes

HTML is made up of  Tags and Attributes, which work
together to identify document parts and tell browsers how to
display them. Tags distinguish between information that is to
be displayed as paragraph or heading etc.
Attributes are optional parts of  Tags, which specify information
in Tags, such as color, alignment, height, width etc.
HTML Tags
HTML works in a very simple, very logical, format. It reads like
you do, top to bottom, left to right. That’s important to
remember. HTML is written with TEXT. What you use to set
certain sections apart as bigger text, smaller text, bold text,
underlined text, is a series of tags.
Think of  tags as commands. Let’s say you want a line of  text to
be bold. You will put a tag at the exact point you want the bold
lettering to start and another tag where you want the bold
lettering to stop. If  you want just a word to be italic, you will
place a start italic tag at the beginning of the word and an end
italic tag at the end of the word. Is this making sense so far?
Your First Exercise-writing Your First Page
You will start every page with this tag: <HTML>
That makes sense. You are denoting that this is an HTML
document.
Your next tags will always be these: <TITLE> and </
TITLE>
 see the very top of  this page? I mean way up top. Above the
file -edit-view menus. The colored bar up there. Right now it
reads “basic html: Tags” that’s the title of  the page and that’s
what you are denoting here. Whatever you put between these
two tags will show up in the title bar way at the top.
Finally, you’ll end every page you write with this tag: </
HTML>
Get it? You started the page with HTML and you will end the
page with /HTML. That makes sense again
Example of basic HTML document Structure...
<html>
<head><title>Title goes here</title></head>
<body>Body goes here</body>
</html>
Note: Extra spaces and line breaks (blank lines) will be
ignored when the HTML is interpreted... so add them if
you wish to do so.
Whatever falls between the TITLE tags will be the title of the
document, when the page is viewed it is usually found in the
title bar at the top of the screen. (On Windows Machines, this
is to the left of the maximize/minimize buttons at the very top
of  the window.)
[Note: You may NOT use other tags within the TITLE tags
(Example: You cannot have the code read: <title><b>title goes
here</b></title>.]
Example of how titles are viewed...
In Microsoft Internet Explorer...
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Whatever you place between the BODY tags will fall into the
major area of the document window, and therefore it is the
largest part of your HTML document.
Try it Yourself!
Try typing this:
<html>
<head><title>Title goes here</title></head>
<body>Body goes here</body>
</html>
Now follow the instruction regarding saving and opening
HTML files. Check the result.

Notes
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Topics Covered
• Site definition and planning, checklist for site production,

site marketing, Site Tracking, evaluation, and maintenance.

Objectives
Upon completion of this lesson, you should be able to:
• Build your home page production checklist.
• How to market your site?
• Tracking and evaluating your web site.
• Web site maintenance
• More common HTML tags: heading, horizontal rules lines.

The Site Development Process
Every significant Web project poses unique challenges, but the
overall process of  developing a complex Web site generally
follows six major stages:
1. Site definition and planning
2. Information architecture
3. Site design
4. Site construction
5. Site marketing
6. Tracking, evaluation, and maintenance
Developing a large Web site is a process that may have far-
reaching budgetary, personnel, and public relations
consequences for an organization, both during the
development of the site and long after its successful
deployment. Too many Web sites begin life as ad hoc efforts,
created by small interest groups working in isolation from their
peers elsewhere in the organization and without fully
considering the site’s goals within the context of  the
organization’s overall mission. The result of  poorly planned,
hasty development efforts often is an “orphan site,” starved of
resources and attention.
As you consider the development process outlined below, note
that the construction of  the pages that make up the Web site is
one of the last things that takes place in a well-designed project.
Consider each step in the process, and its impact on your
developing site specification plan. Think before you act, and
make sure you have the organizational backing, budget, and
personnel resources you’ll need to make the project a success.

Site Definition and Planning
This initial stage is where you define your goals and objectives
for the Web site and begin to collect and analyze the
information you’ll need to justify the budget and resources
required. This is also the time to define the scope of the site
content, the interactive functionality and technology support
required, and the depth and breadth of information resources
that you will need to fill out the site and meet your reader’s
expectations. If you are contracting out the production of the

Web site, you will also need to interview and select a site design
firm. Ideally, your site designers should be involved as soon as
possible in the planning discussions.

Site Production Checklist
Not every site will require consideration of  every item below.
Developers within corporations or other large enterprises can
often count on substantial in-house technology support when
creating new Web sites. If  you are on your own as an individual
or small business, you may need to contract with various
technology and design vendors to assemble everything you’ll
need to create a substantial content site or small e-commerce
site.

Production
• Will your site production team be composed of in-house

people, outside contractors, or a mix of the two?
• Who will manage the process?
• Who are your primary content experts?
• Who will be the liaison to any outside contractors?
• Who will function long-term as the Webmaster or senior site

editor?

Technology
• What browsers and operating systems should your site

support?
• Windows, Macintosh, UNIX, Linux
• Netscape Navigator, Internet Explorer; minimum

version supported
• Network bandwidth of average site visitors

• Internal audience or largely external audience?
• Ethernet or high-speed connections typical of

corporate offices
• ISDN, or DSL medium-speed connections typical of

suburban homes
• Modem connections for rural, international, or poorer

audiences
• How will readers reach the support personnel?

• Email messages from readers
• Chat rooms, forums, help desks, or phone support

• Database support?
• User log-ins required to enter any site areas?
• Questionnaires required?
• Search and retrieval from databases needed?

• Audiovisual content
• Video or audio productions?

LESSON 6:
Site Development Process
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Budgeting
• Salaries and benefits for short-term development staff and

long-term editorial and support staff
• Hardware and software for in-house development

team members
• Staff training in Web use, database, Web marketing,

and Web design
• Outsourcing fees

• Site design and development
• Technical consulting
• Database development
• Site marketing

• Ongoing personnel support for site
• Site editor or Webmaster
• Ongoing server and technical support
• Database maintenance and support
• New content development and updating

Appoint a Site Editor
A site that is “everyone’s responsibility” can quickly become an
orphan. A maintenance plan should specify who is responsible
for the content of  each page in the site. To maintain consistent
editorial, graphic design, and management policies you’ll also
need one person to act as the editor of the overall Web site. The
site editor’s duties will vary according to how you choose to
maintain your site. Some editors do all the work of maintaining
site content, relieving their coworkers of the need to deal directly
with Web page editing. Other editors coordinate and edit the
work of many contributors who work directly on the site pages.
If multiple people contribute to site maintenance, the site
editor may choose to edit pages after they are created and posted
to avoid becoming a bottleneck in the communications process.
However, high-profile public pages or pages that contain very
important content should be vetted by the editor before public
posting.
In addition to ensuring editorial quality, a site editor must also
ensure that the content of the site reflects the policies of the
enterprise, is consistent with local appropriate use policies, and
does not contain material that violates copyright laws. Many
people who post pictures, cartoons, music files, or written
material copied from other sites on their own sites do not
understand copyrights and the legal risks in using copyrighted
materials inappropriately. A site editor is often an institution’s
first line of defense against an expensive lawsuit over the
misuse of protected material.

Site Mmarketing
Your Web site should be an integral part of  all marketing
campaigns and corporate communications programs, and the
URL for your site should appear on every piece of
correspondence and marketing collateral your organization
generates.
If  your Web site is aimed primarily at local audiences you must
look beyond getting listed in standard Web indexes, such as
Yahoo and Infoseek, URL and publicize your URL where local
residents or businesses will encounter it. Local libraries (and

schools, where the content is relevant) are often the key to
publicizing a new Web site within a localized geographic area.
You may also find opportunities to cross-promote your site
with affiliated businesses, professional organizations, broadcast
or print media, visitor or local information agencies, real estate
and relocation services, Internet access providers, and local city
or town directory sites. Your organization could also feature
local nonprofit charitable or school events on your Web site.
The cost in server space is usually trivial, and highly publicized
local events featuring a Web page hosted within your site will
boost local awareness of  your Web presence. Site sponsorship
might also interest local broadcast media as an interesting story
angle.
Your home page URL should appear in all:
• Print advertisements
• Radio and television advertisements
• Lobby kiosks in high-traffic areas of your enterprise or in

local libraries, schools, or other suitable venues
• Direct mail campaigns
• Business cards
• Stationery
• Bills and statements
• Product manuals and product packaging
• Response cards and warrantee cards
• Publications and promotional materials
• Press releases
• Posters and billboards
• Tracking, evaluation, and maintenance
An abundance of information about visitors to your site can be
recorded with your Web server software. Even the simplest site
logs track how many people (unique visitors) saw your site over
a given time, how many pages were requested for viewing, and
many other variables. By analyzing the server logs for your Web
site you can develop quantitative data on the success of your
site. The logs will tell you what pages were the most popular
and what brands and versions of  Web browser people used to
view your site. Server logs can also give you information on the
geographic location of your site readers. The usefulness of your
site logs will depend on what you ask of  the server and the
people who maintain the server. Detailed logs are the key to
quantifying the success of  a Web site. Your Webmaster should
archive all site logs for long-term analysis and should be
prepared to add or change the information categories being
logged as your needs and interests change.
A number of popular software packages are designed to
produce easily readable site traffic reports, complete with data
graphics and charts to aid in data analysis. As a service to
customers, site hosting companies often offer reports from
popular site analysis programs like WebTrends, often free of
charge. Before contracting with an Internet Service Provider
(ISP) for site hosting services, always ask about site analysis
services. If  your ISP or corporate Web site does not offer a
good site traffic analysis package, ask whether the Webmaster
can give you access to a monthly server log of  your account.
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Basic versions of traffic analysis programs like WebTrends cost
about three hundred dollars, and you can run them on a
personal computer if  you can gain access to the raw Web server
log from your ISP or corporate Webmaster.

Maintaining the Site
Don’t abandon your site once the production “goes live” and
the parties are over. The aesthetic and functional aspects of a
large Web site need constant attention and grooming,
particularly if a group of individuals shares responsibility for
updating content. Someone will need to be responsible for
coordinating and vetting the new content stream, maintaining
the graphic and editorial standards, and assuring that the
programming and linkages of all pages remain intact and
functional. Links on the Web are perishable, and you’ll need to
check periodically that links to pages outside your immediate
site are still working. Don’t let your site go stale by starving it of
resources just as you begin to develop an audience — if you
disappoint them by not following through it will be doubly
difficult to attract them back.

Backups and Asite Archives
The site editor should be sure that the Web site is regularly
backed up onto a secure and reliable storage medium to ensure
that a catastrophic hardware failure in your Web server does not
wipe out your Web site. Most Web servers maintained by
information technology professionals or commercial Web
service providers are backed up at least once a day. If  you don’t
know what your particular backup schedule is, ask your
ebmaster or Web services vendor. Human error is the most
common reason you may want quick access to a backup copy of
your Web site. Unfortunately, it’s easy to accidentally overwrite
an old file (or a whole directory of files) over a newer version on
the Web server, to delete something important in error, or to
inadvertently wipe out someone else’s work when updating a
Web site. A recent backup (ideally no more than twenty-four
hours old) can often be a lifesaver in correcting a mistake.
If your site is successful, it will quickly become an important
record of  your enterprise’s work, your accomplishments, and a
valuable record of the “state of things” as the site evolves over
time. Unfortunately, too little attention is paid to this aspect of
Web sites, and we are collectively losing huge pieces of  our
history because no one thinks about preserving permanent
records of  a Web site. Unless your Web site is prohibitively
large, your Web site editor could arrange to collect and store the
files of  the site periodically or contract with your Web service
provider to set aside a backup version at regular intervals so that
it can be stored for long-term use. We take for granted the
“paper trail” of history left by conventional business and work
practices. Without a plan for preserving our digital works, our
collective history may vanish without a trace.

Computer Lab

Evaluation of Last Exercise

Your  first web page using <HTML>,<HEAD>,<TITLE> &
<BODY> tags.
Now we move on to other HTML tags.
More Common HTML tags

Headings...
Headings are some of the most important tags within the
BODY of  your HTML document. You will usually use a
heading to tell what the following section of your page is
about. The opening tag for a heading is <hy> and the closing
tag is </hy> with y being the size of  the heading... from 1 to 6.
(1 being largest, and 6 being smallest)
Example of heading tags...
Bob fell over the chicken. [H1]
<h1>Bob fell over the chicken. [H1]</h1>
Bob fell over the chicken. [H2]
<h2>Bob fell over the chicken. [H2]</h2>
Bob fell over the chicken. [H3]
<h3>Bob fell over the chicken. [H3]</h3>
Bob fell over the chicken. [H4]
<h4>Bob fell over the chicken. [H4]</h4>
Bob fell over the chicken. [H5]
<h5>Bob fell over the chicken. [H5]</h5>
Bob fell over the chicken. [H6]
<h6>Bob fell over the chicken. [H6]</h6>
Horizontal Ruled Lines...
Horizontal Ruled Lines are used to separate different areas of a
web page. The tag for a horizontal ruled line is <hr>. The
horizontal ruled line DOES NOT have a closing tag. You may
also add certain attributes to the <hr> tag, such as WIDTH=n
(for fixed pixel width) or WIDTH=n% for a certain percentage
of the screen wide, SIZE=n to make the line a certain pixel
amount thick, and NOSHADE to turn the line’s shading off. A
plain <hr> with no attributes will make the line the full width
of the screen.
Example of horizontal ruled lines...
<hr width=50>
<hr width=50%>
<hr size=7>
<hr noshade>
You may also use several attributes within one tag...
<hr width=50% size=10 noshade>
Try it Yourself! – 2
Try typing this:
<html>
<head><title>Title goes here</title></head>
<body>
<h1>Body goes here</h1>
<hr>
<h3>Headings are kewl!</h3>
</body>
</html>
Check the result
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Assignment
1. Trace the history of  Internet and World Wide Web?
2. Define the goals of your personal home page?
3. What’s the objective of  your personal home page?
4. Plan for your personal home page?
5. Specify your site/page design, try to visualize them
6. Develop your website specification list?
7. What is HTML? Why learn it?
8. What are basic HTML tags?
9. Develop your first web page?
10.Build a site production checklist for your website?
11.Write a web page using heading tag?
12.Write a WebPages using horizontal ruler tag?

Notes
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Topics Covered
• Web page design versus conventional document design,

Guidelines for Web document design & Style, More readings,
More common tags in HTML and Text formatting tags.

Objectives
Upon completion of this lesson, you should be able to:
• Differentiate between conventional document design & Web

page design
• Check the guidelines for Web Document design
• Write more  common HMTL tags like paragraph
• Format your webpage with text formatting tags.
Users of web documents don’t just look at information, they
interact with it in novel ways that have no precedents in paper
document design. The graphic user interface (gui) of a
computer system comprises the interaction metaphors, images,
and concepts used to convey function and meaning on the
computer screen. It also includes the detailed visual
characteristics of every component of the graphic interface and
the functional sequence of interactions over time that produce
the characteristic look and feel of web pages and hypertext
linked relations. Graphic design and visual “signature” graphics
are not used simply to enliven web pages - graphics are integral
to the user’s experience with your site. In interactive documents
graphic design cannot be separated from issues of interface
design.

Web page design versus conventional document

Design
Concepts about structuring information today stem largely
from the organization of printed books and periodicals and the
library indexing and catalog systems that developed around
printed information. The “interface standards” of books in the
English-speaking world are well established and widely agreed-
upon, and detailed instructions for creating books may be
found in such guides as The Chicago Manual of Style. Every
feature of the book, from the contents page to the index, has
evolved over the centuries, and readers of early books faced
some of the same organizational problems that users of
hypermedia documents confront today. Gutenberg’s Bible of
1456 is often cited as the first modern book, yet even after the
explosive growth of  publishing that followed Gutenberg’s
invention of printing with movable type, more than a century
passed before page numbering, indexes, tables of contents, and
even title pages became expected and necessary features of
books. Web documents are undergoing a similar evolution and
standardization.

Design Precedents in Print
Although networked interactive hypermedia documents pose
novel challenges to information designers, most of the
guidance needed to design, create, assemble, edit, and organize
multiple forms of media does not differ radically from current
practice in print media. Most Web documents can be made to
conform to The Chicago Manual of Style conventions for
editorial style and text organization. Much of what an
organization needs to know about creating clear,
comprehensive, and consistent internal publishing standards is
already available in such publishing guides as the Xerox
Publishing Standards: A Manual of Style and Design. Don’t get
so lost in the novelty of  Web pages that basic standards of
editorial and graphic design are tossed aside.

Guidelines for Web Document Style & Design
The following items are offered for consideration when
designing Web documents. These are only general guidelines -
you should decide whether they are appropriate for a given
situation.

Contextual Information

• Clearly identify the host institution and author
• Clearly identify dates (e.g., origin, expiration, last update)
• Provide details of the copyright status of materials
• Provide background information about the server/host

organization
• Place local resources in the context of other relevant data
• Clearly identify:
Which information is local;
h. Which is mirrored (replicated) from another site; and
i. which is a link to another site

Accessibility

• Make it accessible from several entry points
• Have URLs approximating natural language
• Have reasonably short URLs
• Make sure it displays well in different browsers
• Serve it from a fast computer on a fast network link (ideally)
• Have it available 24 hours/day, 7 days/week, all year
• Keep it in one location (try not to move it to another server

or directory)

Structure & Organization
• Structure your information to take advantage of the

hypertext environment; that is, don’t put everything on one
page, break it into pieces that can logically stand on their own
and link to them.

• Don’t have “dead” links

LESSON 7:
Interface Design Issues
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• Don’t use “click here” for links
• Don’t have links to documents lacking information (under

construction)
• Don’t contain superseded or out-of-date information
• Label links well (make them descriptive and accurate)
• Strive for high “scan ability” - the ability to scan a page and

quickly see what is available from it

Format & Editing

• Be thankful for anything you can cut
• Create a document that is legible and well-formatted on

many of the most widely used clients
• Design esthetically and professionally
• Make appropriate use of upper and lower case characters
• Make minimal use of all upper case characters, underlines,

and “blink”
• Spell accurately and use good grammar
• Create and maintain a consistent look and feel

HTML Markup

• Tag according to HTML standard specifications and draft
standards as much as possible; if proprietary tags are used,
use only ones that have no harmful consequences for other
Web browsers.

• Tag legibly (i.e., tags all in uppercase contrast well with
mixed-case document text)

• Use blank lines to segregate logical document components
for HTML readability

Images
• Use images that directly relate to the topic of the page
• Use image processing techniques for minimizing image file

size.
• Use small images (thumbnails) linked to larger versions

when appropriate so the user can decide whether to wait for
the larger image to download.

• Use the ALT attribute of  the IMG tag for those who choose
not to load images and for non-graphical browsers.

• Use the WIDTH and HEIGHT attributes of the IMG tag
so that the browsers that support these attributes can display
the text right away before the images are completely
downloaded.

More Reading

Communication, Document Design and the World Wide

Web

Carole Meyers
Delivered at the Annual Meeting of the College English
Association, New Orleans, LA, April 1996.

Abstract
This paper describes an assignment used in a Technical Writing
course. Instead of presenting a traditional technical report,
students create World Wide Web pages using information
gathered from the Internet. By asking them to master both

their report topic and Hyper Text Markup Language, the
assignment helps to accustom students to their social role as
professional experts. Furthermore, the experience they gain in
working with Web documents enhances their sensitivity toward
the contextual nature of communication, allowing them to
become more skilled communicators in other media.

Overview: From Text to Web
This paper describes an assignment involving the World Wide
Web used in a Technical Writing class at the Georgia Institute of
Technology. The course is intended to introduce students to
professional communication, and it ideally serves to ease the
transition from college to workplace writing. Traditionally, the
course culminates in a technical report written by a group of
four or so students. They identify and research a local problem
or need and write a ten-page report proposing a solution. The
assignment’s goal is to provide students with both practice in
designing a document that presents information persuasively
and experience in speaking as an expert, a role that most Tech
students will have quickly to assume once in the workplace. I
use the same basic assignment but ask students to create World
Wide Web pages.
The translation from paper to an electronic medium has a
number of advantages. First and foremost, students are
engaged by designing Web documents in a way they are not by a
traditional print report. Keith Kilpatrick, a student last summer,
noted that “Writing hypertext was more fun than writing a
normal paper because we had more ‘freedom’ to express
ourselves and convey our information.” Second, the demands
of  designing for the Web are high. As I will discuss
momentarily, designing good documents for the Web forces
students not only to address significant technical issues but also
to hone their skills in communication in order to entice the
fickle Web user. Finally, the fact that the projects are accessible to
friends and family in distant places, as well as to prospective
employers, definitely encourages more thoughtful and polished
work than that found in text reports. Just by virtue of being
“published,” even if they are never looked at by anyone outside
of class, these documents become more significant in the eyes
of their authors.

Web Weaving...
One of the challenges of using the WWW is that it takes
significant time to understand both the nature of this network
of distributed information and its implications. I try to
accustom students to the Web by posting assignments on it
and by including references to Internet and Web resources in
our discussions of document design, graphics, correspondence,
and job searches. In past quarters I have also required students
to conduct a scavenger hunt for specific material on the Web,
but as more and more students know the Web coming into my
class, this more general introduction seems less necessary. It is a
demonstration of  the Web’s phenomenal growth-measured at
364,000% per year-that in the year that I’ve used this
assignment, we’ve moved from the Web being unfamiliar to
most of the class to most students having a good working
knowledge prior to the course.
Still, their knowledge is limited to how to work Netscape—
most are unfamiliar with the Internet’s origins in the military,
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the relationship of  the Web to older Internet devices like ftp,
gopher, and WAIS, and the fiber-optic technology supporting
the global network. Because this information is necessary to be
an informed Web author, I have students read and summarize
articles on the Internet, the WWW, and Hypertext Markup
Language, or HTML. Right before we enter the computer
classrooms, I spend a class or two lecturing on basic concepts
like the client-server model and the ways that files are referenced
on the WWW. This extensive introduction takes significant
time—students work outside of class for about two weeks and
I lecture in class for a day or two—but it greatly smooths the
transition into the computer lab by equipping students with a
knowledge base that they can use when authoring their own
Web pages. When I didn’t provide this extensive an
introduction, I spent the first two weeks in the computer
classroom running around answering very basic questions that
revealed fundamental misconceptions about the Internet, the
WWW, and HTML.
Once in the classroom, the first goal is to get them using
HTML to create a Web page. To script HTML, you can use any
text editor — a word processor will do nicely — but to ease our
introduction, we use an HTML editor for the Macintosh called
Web Weaver, which is shareware and freely available off the Net.
Web Weaver provides an easy entrance into HTML because it
operates like a word processor and has user friendly buttons
that insert HTML commands in much the same way that
Microsoft Word buttons format text. During the first two or
three classes, I demonstrate some basic commands and then
leave them to create their documents. To focus students’ efforts,
the first HTML assignment is due about ten days after we enter
the lab, and for that I ask that they write a home page describing
them and their interests. In preparation, I provide a list of
interesting home pages to look at as well as printouts of my
page and the code used to create it. Looking at other people’s
HTML code is one of  the best ways to learn it, and it’s easy to
do because in Netscape the “View Source” command lets you
see the source code of any page. I frequently start class with a
“Site of the Day” that contains some interesting technique or
trick so that students are exposed to a wide variety of
approaches and so that they increase their technical knowledge
gradually.
After about a week, students have completed the basic layout of
their home page which they store on a floppy disk. To make
that page accessible on the WWW, we put it up on a server
using a file transfer program called Fetch. Surprisingly enough,
this process, or rather the idea of this process, causes great
difficulty. Fetch is an extremely user friendly program, down to
the running dog that is its icon, and students pick it up quickly,
but the concept of  the server is a difficult one. Frequently I get
questions like “How can my group members get access to my
file?” When I respond, “Put it on the server and you’ll all have
access,” that idea takes awhile to sink in. I can only surmise that
the other means of storage commonly used are either
proprietary — you store a file on your disk or your computer —
or tangible — you store a file on the hard drive of Library Mac
#33. Of  course, the server is just a computer, like Library Mac
#33, but it is intangible, never seen and contacted only over a
network. Those even technical students have difficulty

conceptualizing what a server is and where their files are
indicates how deeply we think of information in terms of its
physical representation, and in terms of the ownership of that
representation. It is for some disturbing that files stored on a
server accessible via the Web are never “my” files or “your” files
because they can be easily replicated by any client who requests
them. This type of  disorientation illustrates one of  the biggest
challenges for teachers using the Internet and the WWW: while
the technical skills may be relatively easy to pick up, conceptual
adjustments occur only over time.

Designing for the WWW
Once students have a sense of the options available in HTML, I
start to use more class time for group discussion on criteria for
designing Web pages. There are both functional and aesthetic
concerns to address. In terms of function, we first consider the
multiple browsers currently present and what that means for
the web designer. While for many people the WWW and
Netscape are synonymous, there are in fact a wide variety of web
browsers out there. Some, like Lynx, display only text and all
have a different capability, which in turn necessitates varied
design strategies. For example, the large images that make
Netscape pages look so appealing will mean nothing to
someone running the text-only Lynx. In addition, even the
graphical Web browsers, such as Mosaic, Netscape, and
Explorer, support different HTML commands. Netscape’s
version 1.1, for instance, introduced its own HTML extensions
that vastly increased the ability to direct the appearance of pages
but which are only supported by Netscape. Thus, a page with
beautiful presentation in Netscape can be distinctly unappealing
in Mosaic. Currently, most pages are designed for Netscape,
which holds between 60 and 80% of the Web market. That
market, however, is rapidly expanding and changing with the
introduction of  browsers by the big online service providers,
America Online, CompuServe, Prodigy, and Internet Explorer,
Microsoft Network’s browser. A final complication is the fact
that evens the same program functions slightly differently
depending on what platform you are using — Macintosh,
Windows, or Unix. For example, a page designed using
Netscape for Windows doesn’t look the same in Netscape for
the Macintosh. (This is partly due to differences in the software
images and partly due to differences in the way platforms and
individual machines handle images.) Ideally, an instructor
would have access to all three platforms in one room to
illustrate the differences.
In addition to addressing these challenges, designers must
remember that people connect to the Web in different ways, the
lucky with fast direct network connections and the home user
usually with a modem that transmits at 14.4 bits/second. It
takes a 14.4 modem approximately nine minutes to download a
1 megabyte image file, a delay that for the Web designer means
minimizing the use and size of images. But it is big, bright,
clickable images that attract people to the Web in the first place.
So, the designer has to compromise, taking advantage of  the
possibilities offered by the most advanced software and
network connections, but constructing alternatives for users
with more limited access. Studies of computer users reveal that
for routine computing tasks, delays need to be less than 20
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seconds or the user becomes distracted and frustrated, so we
evaluate the loading times of pages against this benchmark and
propose alternative designs for slow-loading pages.
The WWW itself  is the best teacher of  what’s possible and
desirable or undesirable in Web design. After a lecture on
functional and aesthetic issues, we spend a class period or two
examining various good and bad pages and discussing what we
like or don’t like about them. This exercise is essential for
solidifying functional issues like clear navigation and uniform
document appearance as well as aesthetic concerns like managing
backgrounds with taste. At this point, it is also helpful to
explore alternatives to big image maps and to discuss ways to
construct aesthetically pleasing pages that are nonetheless
manageable in terms of size.
Because Web design is such a complex business, it is ideal for
introducing students to the multiple constraints that
characterize professional communication. To encourage
consideration of those constraints, the final project requires
documents that are both aesthetically pleasing and functional
when viewed by different browsers, in this case Netscape and
Lynx. Throughout the course, we emphasize the need to design
for various browsers by looking at the same page via Mosaic
and Lynx as well as Netscape, and I encourage those with access
to other browsers to check their pages there as well. If all acts of
communication are situated, then the technical aspects of the
WWW make every act even more deeply contextualized,
dependent on platform, program, network, and more. If
students can translate the sensitivity toward context they gain by
working with the Web, then they can become more aware and
skilled communicators in other media as well.
Another positive aspect about using this assignment as
opposed to a print one is that the technical constraints of the
Web force students to take the task more seriously than they
might a text report. This is particularly so at Georgia Tech,
where Technical Writing is a required course that students have
little interest in taking and that they expect to be easy. Not only
does introducing them to the Web make them more excited
about the class, but also the technical aspects of  the Web
encourage them to devote more attention and energy than they
would to a text document. Students perceive that the skills they
gain here are marketable and therefore worthwhile, unlike most
English classes, of course. Adena Fullard, a graduating senior,
wrote “Other friends of mine have to write long proposals
(blah!). This [assignment] was fun, interesting and will be
helpful in the real world of  computer technology.” Of  course,
the real world requires skills in communication as well as
computers and in fact, Adena has done more than learn a few
HTML tags this quarter. In mastering the technical limitations
of the medium, students are forced to pay attention to basic
concepts like audience and purpose, as well as visual design
elements like color theory. In short, they have to take
communication seriously and in so doing them significantly
advance their abilities as communicators.

Designing a Graphical User Interface

by Leslie Cortes, MD
Clinical Information Engines
Austin, Texas
Whether you aspire to develop the next big software hit or
simply create computer applications for your personal and office
use, your applications will need effective user interfaces to fulfill
their potential. Designing such an interface is part discipline
(following platform conventions and good design principles),
part science (usability testing) and part art (creating screen
layouts that are informative, intuitive and visually pleasing).
 Tax preparation software illustrates the principles behind
effective user interfaces better than almost any other type of
application. Tax preparation is a one-time task, practically all the
users are new to the program, and none of them will want or
have time to read a manual. Despite this, millions of taxpayers,
including many barely computer literate ones, manage to
prepare their own tax returns on home computers. How is this
possible?
 The answer: functionality and interface. If functionality is what
a program actually does, then interface is how the user interacts
with the program, perceives how the program does its work.
Concealing the details of a complex technology behind a good
task-oriented interface is not a new concept. One does not have
to understand the inner workings of an automobile to drive
one, or how an ICU monitor works to run a strip.
 Although pure text interfaces are still appropriate for some
applications, nowadays most Windows and Mac programmers
use the more popular and versatile graphical user interfaces
(GUI). The hallmark of GUI programming lies in its graphical
control features, such as toolbar buttons or icons. Unlike pure
text interfaces which accept only keystroke commands, GUIs
allow for a variety of input devices (such as a mouse or
penlight) for the user to manipulate text and images as visually
displayed. Web pages like this one employ a graphical interface,
for example, by using image maps to help users navigate the
site.

4. User-centered Design
In early days of computing, a good software program was one
that worked. A great program was one that worked and
expended the fewest computing resources. Creating a program
was an engineering process, delivering a working solution given
the programming constraints imposed by the last decade’s
computing environment. Computer programmers designed
programs for use by other computer professionals and not the
general public, so a generic interface permitting expeditious user
input was the order of the day. The point of  contact between
the general population and the computer was not the software
application but some output or printed report, such as a bank
statement or lab results.
But in today’s world, in which computer resources are abundant
and computer users are usually non-programmers and
computer neophytes, a good program is one that not only
works but is also easy to learn. And a great program is one that
works and is so user-friendly it does not even need to be
learned! With this shift to non-programmers who need
computers to perform many essential functions, the focus of
software development has extended beyond the traditional
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problem-centered task to center upon these users’ needs.
 
From a user’s perspective, the secret behind successful software
is that it makes sense. To create sensible software, user-centered
designers involve users throughout the development process.
Unlike problem-centered programming, which first and
foremost focuses on the task, user-centered designers begin by
observing how users confront present manual and automated
methods. Their goal is to understand users’ work tasks, their
mental models of those tasks, and the tools already familiar to
them. Programming can then incorporate selected task-solving
behaviors. An important component of this process is repeated
cycles of user testing and refinement prior to releasing the
software.  
Most clinician-developers do not have a staff of developers,
professional designers and usability testers. In fact, most
clinicians develop applications by and for themselves, or for a
small target audience such as their office staff. For individual
developers, is the distinction between a problem-centered
versus user-centered design rhetorical? The answer depends on
how much you enjoy training new staffers, undoing their
mistakes, and answering questions that result from their not
understanding how your programs work. If your goal is to
write applications that even a new staffer can use correctly
without much training or supervision, you might shift your
software development approach from problem-centered to
user-centered: critically evaluate and discuss how the tasks are
presently performed, decide what aspects should be mirrored by
the interface, program the tasks with that interface as part of the
blueprint, then allow the future users to finalize your work with
comments and suggestions.

Affordances, Metaphors, and Manipulations
Real world objects have physical features, and some of those
features lend themselves to human manipulation. The ways in
which a particular object can be used are its affordances (afford =
is for). A mouse button, for example, has one affordance: it can
be depressed to produce a mouse button click. Its affordance is
obvious; a button has no handle that can be pulled, so there
isn’t much chance a user would try to pull it.
The mouse itself, on the other hand, is an object with multiple
affordances. While clearly fitting the human grasp it is not
intuitively obvious that one must move it across a surface to
perform its function - a fact warmly portrayed by futuristic Star
Fleet engineer Mr. Scott as he first encounters a 20th century
mouse in Star Trek IV - The Voyage Home. The mouse is easy
to use, but only after all its affordances have been taught or
discovered.
Successful developers exploit a user’s knowledge of  the
affordances of real world objects to create visually meaningful
and intuitive environments by using metaphors and analogies.
The Macintosh trash can is a classic example. To discard real
documents we throw them in the trash. To recover something
tossed into the trash, we empty the trash can and pick through
its contents. Further, in the real world we deal with objects
using direct manipulation. We do not ask a trash can to empty
itself, but we pick it up and empty it. Direct manipulation
environments are achievable with GUIs using metaphors and

analogies. Such design improves the user’s interface dramatically,
because they are more intuitively learned and retained than
command environments, such as menus and buttons.
 
Study your users carefully. Look for metaphors that make sense
to them. Create analogies to the affordances of the real world
objects when it is helpful. Explore the direct manipulation
techniques such as drag-and-drop mouse gestures that your
platform supports. In this regard I find painting, drawing and
image processing programs more illustrative (sic) than tax
preparation software.

Ten Principles for Good GUI Design

1. The user must be able to anticipate a widget’s behavior from
its visual properties. Widgets in this context refer to visual
controls such as buttons, menus, check boxes, scroll bars,
and rulers. So let’s call this the Principle of  Consistency at the
Widget Level. This principle stresses that every widget in
your application should behave consistently. If  one button
responds to a single mouse click then every button should
respond to a single click. In software development
environments such as Delphi you can create your own
widgets. If your application requires a new widget that
behaves differently from a common or closely related widget,
anticipate the confusion and give your new widget a
distinctive appearance. Use metaphor affordances whenever
possible to make your widget’s appearance tell the user how
that widget behaves.

 2. The user must be able to anticipate the behavior of your
program using knowledge gained from other programs. This
is the Principle of Consistency at the Platform Level.
Consistancy is important not only to visual elements like
widgets but to abstractions such as mouse gestures,
accelerator keys, placement of menus, and icons and toolbar
glyphs. There are plenty of decisions regarding GUIs that are
arbitrary and platform-specific. Obtain a good GUI
application design guide for your target platform, and follow
it. If you feel compelled to improve upon conventions, you
will more than likely undo your “improvements” after users
complain about them. If you are doing cross-platform
development, maintain consistency with the host platform.
Maintaining consistency with the host platform trumps
achieving consistency of your application across platforms.
Your users will change applications on the same platform far
more frequently than they will run your application on
different platforms.

3. View every user warning and error dialog that your program
generates as an opportunity to improve your interface. Good
GUI interfaces rarely need or use warnings and error dialogs.
Exceptions include those that signal hardware problems
such as a disk failure or lost modem connection, or warnings
that ask the user’s permission to perform an irreversible and
potentially erroneous step. Otherwise, error dialogs in GUI
interfaces represent interface design flaws. Prevent, don’t
complain about, user errors. The most common flaws arise
from improperly formatted user input and inappropriate
task sequencing. Design your program interface to help your
users enter appropriate data. If your program requires
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formatted data (dates, currency, alphanumeric only, or a
particular numeric range) use bounded input widgets that
appropriately limit the user’s input choices. If  a certain
program step cannot be legitimately performed until your
user completes other steps, disable the dependent step until
all its dependencies are satisfied. Most GUI environments
dim disabled widgets to signal that the widget cannot be
selected. Use disabled widgets to limit user actions to those
that are valid.

4. Provide adequate user feedback. Like the Consistency
Principle, the Principle of User Feedback applies to widgets
and to program activity. Widgets often provide visual
feedback; click a button, and it briefly suggests it has been
depressed. Click a check box and its new appearance alerts the
user it has been selected or deselected. If you create your own
widgets, be sure to provide users with visual feedback for
each affordance. User feedback at the program level requires
that users know whether a step is in progress or completed.
Change the cursor (the Mac wristwatch or the Window
hourglass) to indicate brief delays, and use progress bars to
indicate progress of longer tasks. Design every screen in your
application so a novice user can easily tell what steps,
especially critical steps, have been performed.

5. Create a safe environment for exploration. Humans are born
explorers. Great interfaces invite and reward exploration, and
offer the novice both the thrill of discovery and the
satisfaction of unassisted accomplishment. Some interfaces
encourage users to explore unfamiliar features, others do
not. By allowing users to undo or redo, you encourage them
to explore your application without fear of corrupting the
database. Undo/Redo capabilities also eliminate the need for
dialogs requesting permission to perform a seemingly
erroneous function. A good interface makes a user feel
competent, while poor interfaces leaves the same user feeling
incompetent.

6. Strive to make your application self-evident. Good
applications have comprehensive manuals and online help
materials explaining program features and how to use them
to solve real world problems. Great applications are those
whose novice users rarely need to refer to the manuals or
online help. The difference between good and great is often
the degree to which the application and its interface are self-
evident. From your choice of labels and widget captions to
the arrangement of widgets on the screen, every interface
design decision you make needs to be tested by users. Your
goal is to create an interface that needs no explanation. A
pharmacy management system interface need not be self-
evident to a newspaper editor, but it should be to every
pharmacist.

 7. Use sound, color, animation and multimedia clips sparingly.
Sound, color, animation and multimedia presentations are
appropriate for education or entertainment, but effective use
in other applications is difficult. Most platforms have written
conventions that describe the appropriate use of sound,
color and animation. Follow them, and remember never to
use color or sound as the sole means of communicating
with the user (many users are colorblind or hearing-

impaired). Remember that these components must pass the
same usability tests as all other application features: include
them only if they improve your users’ ability to accomplish
tasks. Returning to our example, tax programs may use
multimedia clips to extend the utility of the software as part
of  their online educational strategy, for interested users
seeking added tax information. They are a software asset
because these clips are under user control and independent to
the task of completing the tax forms.

8. Help users customize and preserve their preferred work
environment. If your application will be installed and
operated by a single user, preserving the work environment
may be as simple as creating a few registry entries such as the
window’s latest size and position. However, applications
designed for multiple users or installed on different
computers must address additional issues. Most common
among these are video issues — both hardware-specific
involving the display (screen size, video resolution and color
depth) and user-specific such as poor visual accommodation
and acuity or colorblindness. Keep in mind that regardless
of  programming, the characteristics of  the user’s display will
affect your application’s appearance; your full-screen interface
may look fine on a 14-inch VGA display, but will those 8-
point Times-Roman labels and captions be legible on a 17-
inch display at a resolution of 1152x864? One popular
solution to any hardware irregularities or user preferences is
to permit the user to tailor the basic interface. Common
user-tailored details include fonts, toolbar location and
appearance, menu entries, and (especially important for users
with impairments) color and sound. It is helpful to give
users a way to choose among several predefined schemes,
and always include a way to return to the default color or
sound scheme. If multiple users take turns using your
application at a single workstation, consider recording
preferences as user-specific profiles rather than as a single
description of  the application’s appearance the last time it
was run.

9. Avoid modal behaviors. Programs using modal behavior
force the user to perform tasks in a specific order or
otherwise modify the user’s expected responses. Modal
behaviors generally feel uncomfortable to the user because
they restrict more intuitive or natural responses, but if
consciously and thoughtfully applied they can be used to
advantage. For example, “Wizard” type tools simplify
complex tasks by modal behavior. Warnings and error
messages are also typically modal, forcing users to first
address a critical issue before returning to the task. Modality
in this latter context is necessary but interrupts the user’s
concentration and goal-oriented behavior, and so is another
reason to avoid unnecessary warning and error messages (see
Principles 3 and 5 above). The best modal behaviors are
subtle but not hidden, and come forth naturally as a
consequence of the metaphor.
 In a typical painting program, for example, selecting a widget
generally alters the subsequent function of the program and
therefore results in modal behavior. Pick the brush widget,
and you are ready to paint. Pick the letter stencil widget, and
you type some text. Pick a shape widget, and you then draw
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that shape. This rarely causes confusion because the modal
behavior is based on a real world analogy; we already know
that by selecting a drawing instrument we are limiting the
color, texture and line thickness that will appear on our
paper. Good interfaces reveal the palette selection at a glance,
and change the cursor to provide additional visual feedback
once a selection is made.So if your application absolutely
requires modal behavior, bind that behavior to a strong
metaphor and give your user visual feedback so the mode is
natural and obvious.

10.Design your interface so that your users can accomplish their
tasks while being minimally aware of  the interface itself. We
could call this the Principle of  Transparency. Interface
transparency occurs when the user’s attention is drawn away
from the interface and naturally directed at the task itself. It is
the product of several factors, including a screen layout that
puts both tools and information where the user expected
them to be; icons and labels that are meaningful to the user;
and metaphors (including gestures) that are easy for users to
recognize, learn, remember, and perform. Choosing good
metaphors and adhering to the above principles are an
important start, but the most direct way to insure a
transparent interface is to perform user testing throughout
the program’s creation.
Following these 10 principles should help you create more
effective, user-friendly interfaces while avoiding many design
errors. Unfortunately, following sound design principles
cannot alone guarantee success. It is entirely possible to create
completely unworkable interfaces while strictly adhering to
the rules. I know, because I have written a few of  these, too.

Computer Lab

Other Common Tags And Text Formatting In Html

Paragraphs...
You will often use paragraphs in HTML, just as you do when
you write stories. The opening tag for a paragraph is <p>, and
the closing tag is </p>. The closing tag for a paragraph is not
always needed, but I recommend using it anyway.

Example of a paragraph...

Bob starts to chase the chicken around. Bob trips over a string
and goes flying into the pig’s mud pit! eww! What a pity!
<p>Bob starts to chase the chicken around. Bob trips over a
string and goes flying into the pig’s mud pit! eww! What a
pity!</p>

Text Formatting Properties...
If you had an entire web page without formatted text, it would
look rather dull and boring. This is why we use text formatting
tags. Some common text formatting tags are <b> and </b>
for bold, <i> and </i> for italics, <u> and </u> for
underlined, and <tt> and </tt> for typewriter. The <font
size=n> and </font> tags also come in handy.
Example of font tags...
Bob is a Cool Guy isn’t he?
<font size=+1>Bob</font> <font size=+2>is</font>
<font size=+3>a</font> <font size=+2>Cool</font>

<font size=+1>Guy</font> isn’t <font size=-1>he?</
font>

The Line Break...
When your HTML document is viewed, normally the text will
do a word-wrap at the end of a line. If you want to have the
text BREAK (go to another line) you will use the <br> tag.
This tag has no closing tag.
Example WITHOUT line Break...
Sentence One. Sentence Two. Sentence Three.
Sentence One.
Sentence Two.
Sentence Three.
Example WITH line Break...
Sentence One.
Sentence Two.
Sentence Three.
Sentence One.<br>
Sentence Two.<br>
Sentence Three.<br>

Font Size Commands
Maybe you’d like a little more control over your text size. Well,
here it is. The <FONT SIZE> commands. Heading
commands are great for right at the top of the page, but these
font commands are going to end up as the workhorses of your
pages.
There are twelve (12) font size commands available to you:

+6 through +1 and -1 through -6.

As you’ve probably guessed, +6 is the largest (it’s
huge); -6 is the smallest (it’s a little too small). Here
are a few of them in action. There’s no need to show
all of them. You’ll get the idea of their relative sizes.
Follow this pattern to place one on your page.

<FONT SIZE=”+3">This is +3</FONT>
<FONT SIZE=”+1">This is +1</FONT>
<FONT SIZE=”-1">This is -1</FONT>
<FONT SIZE=”-6">This is -6</FONT>
Notice that this first command, <FONT SIZE=”—”> is
actually doing two things:
1. It’s asking for a new font size...
2. then offering a number to denote the font size.
This is what I like to call a command inside of a command. The
technical HTML term is an “attribute”. When you have that,
you denote the attribute with an equal sign and enclose it within
quotation marks. Look above. See the equal sign and the plus
or minus number in quotes? That’s what I’m talking about.
Also notice that the end command for a <FONT SIZE=”—”>
tag only requires </FONT>. I should tell you now that there
are two other attributes you can use inside the FONT tag:
COLOR and FACE (these both have tutorials unto themselves.
Take a look). But even if  you use all three inside a FONT tag,
you still only need one </FONT>.
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Remember that an attribute is inside of  a tag. When you use an
end command, you are closing the tag, not the attribute. So you
only need the one end tag, like above.

Centering Text
Since you’ve already done some writing you’ve no doubt
noticed that the text that appeared in the browser window was
justified to the left of  the screen. That’s what’s known as the
default. It just happens without your specifying any particular
justification.
Notice that this text is centered on the page. It’s done by
surrounding the text you want centered with simple
<CENTER> and </CENTER> commands.
Here’s what it looks like:
<CENTER>
All text in here will be centered
</CENTER>
Text To The Right
Can you get text to the right? Sure. It’s done by setting the text
aside as a paragraph unto itself. I’m going to use the <P>
command, but now I’m going to alter it. I’m going to add an
attribute to it.
Here’s the format:
<P ALIGN=”right”>Text in here is pushed to the right</P>
See how I added the ALIGN=”right” attribute to the <P>
command? Okay, but you also have to remember that if  you
add an attribute to a single tag like the <P> tag, or the <BR>
tag (yes, there are attributes for BR), then you’ll need to use an
end tag. See the </P> up there?
If  you’re just using <P> to create a new paragraph, then it can
sit all by its lonesome. But the moment you add an attribute=,
you need to use the end tag.

Try it Yourself!-3
<html>
<head><title>Title goes here</title></head>
<body>
<h1 align=right>Body goes here</h1>
<hr>
<h3 align=center>Headings are kewl!</h3>
<p><b>Bold text is fun!</b><br>
<u>Underline is kewl too!</u></p>
</body>
</html>
Add all the other tags you learnt in this lesson, and check the
result

Notes
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Topics Covered
• Making your web pages freestanding, what every web page

needs, Accessibility and Fallback, Accessibility guidelines,
Managing links and images in HTML

Objectives
Upon completion of this lesson, you should be able to:
• Make your WebPages freestanding
• Check accessibility for a website.
• Follow the Accessibility guidelines
• Making hyperlinks in your Web page using HTML codes
• Managing images in a web page using HTML codes

Make your web pages freestanding
World Wide Web pages differ from books and other
documents in one crucial respect: hypertext links allow users to
access a single Web page with no preamble. For this reason Web
pages need to be more independent than pages in a book. For
example, the headers and footers of  Web pages should be more
informative and elaborate than those on printed pages. It
would be absurd to repeat the copyright information, author,
and date of a book at the bottom of every printed page, but
individual Web pages often need to provide such information
because a single Web page may be the only part of  a site that
some users will see. This problem of making documents
freestanding is not unique to Web pages. Journals, magazines,
and most newspapers repeat the date, volume number, and
issue number at the top or bottom of each printed page
because they know that readers often rip out articles or
photocopy pages and will need that information to be able to
trace the source of the material.
Given the difficulties inherent in creating Web sites that are both
easy to use and full of complex content, the best design strategy
is to apply a few fundamental document design principles
consistently in every Web page you create. The basic elements of
a document aren’t complicated and have almost nothing to do
with Internet technology. It’s like a high school journalism class:
who, what, when, and where.

Who
Who is speaking? This question is so basic, and the
information is so often taken for granted, that authors
frequently overlook the most fundamental piece of information
a reader needs to assess the provenance of  a Web document.
Whether the page originates from an individual author or an
institution, always tell the reader who created it. The flood of
Web sites propagating incorrect or intentionally misleading
material on the Florida vote problems of the 2000 American
presidential election offers a vivid example of how
“information” of no known origin and of dubious
authenticity can quickly cloud legitimate inquiry and discussion.

What
All documents need clear titles to capture the reader’s attention,
but for several reasons peculiar to the Web this basic editorial
element is especially crucial. The document title is often the first
thing browsers of  World Wide Web documents see as the page
comes up. In pages with lots of graphics the title may be the
only thing the user sees for several seconds as the graphics
download onto the page. In addition, the page title will become
the text of a browser “bookmark” if the user chooses to add
your page to his or her list of URLs (“Universal Resource
Locator,” the formal term for Web addresses). A misleading or
ambiguous title or one that contains technical gibberish will not
help users remember why they bookmarked your page.

When
Timeliness is an important element in evaluating the worth of a
document. We take information about the age of most paper
documents for granted: newspapers, magazines, and virtually all
office correspondence is dated. Date every Web page, and change
the date whenever the document is updated. This is especially
important in long or complex online documents that are
updated regularly but may not look different enough to signal a
change in content to occasional readers. Corporate information,
personnel manuals, product information, and other technical
documents delivered as Web pages should always carry version
numbers or revision dates. Remember that many readers prefer
to print long documents from the Web. If  you don’t include
revision dates your audience may not be able to assess whether
the version they have in hand is current.

Where
The Web is an odd “place” that has huge informational
dimensions but few explicit cues to the place of origin of a
document. Click on a Web link, and you could be connected to a
Web server in Sydney, Chicago, or Rome — anywhere, in fact,
with an Internet connection. Unless you are well versed in
parsing URLs it can be hard to tell where a page originates. This
is the World Wide Web, after all, and the question of where a
document comes from is sometimes inseparable from whom
the document comes from. Always tell the reader where you are
from, with (if relevant) your corporate or institutional
affiliations.
Incorporating the “home” URL on at least the main pages of
your site is an easy way to maintain the connection to where a
page originated. Once the reader has saved the page as a text file
or printed the page onto paper, this connection may be lost.
Although newer versions of the most common Web browsers
allow users to include the URL automatically in anything they
print, many people never take advantage of this optional
feature. Too many of  us have stacks of  printed Web pages with
no easy way of  locating the Web sites where they originated.

LESSON 8:
INTERFACE DESIGN ISSUES-2
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Every Web page needs:
• An informative title (which also becomes the text of any

bookmark to the page)
• The creator’s identity (author or institution)
• A creation or revision date
• At least one link to a local home page or menu page
The “home page” URL on the major menu pages in your site
Include these basic elements and you will have traveled 90
percent of the way toward providing your readers with an
understandable Web user interface.

Accessibility
One of  the defining principles of  the Web is that it should
provide all people, regardless of
physical or technological
readiness, with access to
information. Since the Web took
off as a visual medium, the goals
of design have been at odds with
the goals of  accessibility. When
designers began to use large
images, proprietary media
formats, and complex page
layouts to produce well-designed
documents, the Web became a
better-looking place, but those
users who require clean HTML
for access were shut out from
many pages. Today, the course of
Web design is shifting back to its
original purpose. HTML has
matured to offer more visual
controls, so designers have more
tools at hand to create structured and navigable Web sites
without resorting to hacks and workarounds. Around the
world, initiatives are under way to mandate that disabled users
have equal access to Internet resources, including the guidelines
issued by the Web Accessibility Initiative (WAI) of  the World
Wide Web Consortium (W3C) and, in the United States, the
amendments to Section 508 of the Rehabilitation Act of 1973.
The result is that Web interface design is intricately tied to
accessibility design. It is the responsibility of  Web designers to
understand and support the needs of disabled users.

Alternates and Fallbacks
The underlying principle of  Web accessibility guidelines is
simple: if you provide information in any medium besides
plain text, you should always provide an alternate, or fallback,
version. The notion of fallbacks is at the core of the language
of  the Web, allowing rich and varied content to transform
gracefully under different conditions. It also lies behind the
injunction that no content should become outdated and
inaccessible because of  the progress of  technology. To meet
these goals, HTML includes methods for providing fallbacks
for some types of nontext content.
As an example, one of  the beauties of  the Web and HTML is
the ability to build in “alternate” text descriptions so that users

without graphics capabilities can understand the function of
graphics on your pages. Blind users using specially designed
software will hear (via synthesized speech) the alternate
messages you supply along with your graphics (“ALT”
attributes in HTML) and so will not completely miss the
content of your pictures and graphic navigation buttons. Users
with text-only browsers or those who have turned off image
display will see the alternate text in place of the visual content.
If you use graphic menu systems for navigation, these text-
based alternate menus are an especially important aid to users
who cannot see your graphics (see Graphics, Accessibility). If
you use graphics like single-pixel GIFs as spacers in your page
layout, always be sure to include a blank ALT statement in the
spacer image source tag (ALT=””). The blank ALT statement

hides the graphic from text-only browsers and from browsers
that read text aloud for visually impaired users:
<IMG SRC=”pixel.gif ” HEIGHT=”1" WIDTH =”1"
ALT=”” HSPACE=”5">
You should also include alternates as part of  your page design
for users who cannot access your primary content. For example,
provide an equivalent text-only navigation menu for visually
impaired users who cannot use your graphical menus. Or if you
have video of a lecture or presentation on your site, include a
text transcript or subtitles so that deaf users can have access to
the materials.
www.organicgardening.com

Style Sheets
Your content can be made more accessible if  you use Cascading
Style Sheets (CSS) to style your pages. With CSS-styled pages,
users can easily apply personalized formatting to Web
documents. A page designed using red text against a green
background, for example, presents a problem for users with
red-green color blindness: the contrast between text and
background may not be great enough for the text to be
distinguishable. If the colors are set via a style sheet, users can
set their browser preferences to override your settings and can
apply their own style sheet to the page instead. With CSS-styled
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pages, the user can transform Web content into a format that
addresses their requirements for accessibility.

Accessibility Gguidelines
All professionally designed Web sites or intranet sites should
meet at least the minimum standards for accessibility as defined
by the World Wide Web Consortium guidelines. The W3C Web
site contains extensive information on the details of how to
make your site reasonably accessible to blind, deaf, or other
disabled users. Until recently Web designers faced difficulties in
implementing many of  the W3C accessibility suggestions
because the most popular versions of  the major Web browsers
either did not implement newer technology standards like
Cascading Style Sheets or implemented them inconsistently.
Now that both Netscape Navigator 6 and Internet Explorer 5
are almost completely compatible with W3C standards,
however, the reasons for not using CSS and other tools to
increase the accessibility of Web information to disabled readers
are disappearing.

Graceful Degradation
We all hope that every reader will arrive using the latest version
of  a major Web browser and that their computers will be state-
of-the-art models using fast connections to the Internet. The
reality is almost always less than ideal. You don’t need to design
your Web site exclusively for the lowest common denominator
of  current computing and network technology, but you do
need to consider what your site will look like to those readers
who do not have the best equipment, current software, or good
Internet connections. The problems here are aggravated by the
fact that Web site developers generally have much better
equipment than the average Web site reader. Don’t design for
your machine, design for your average reader.
Always check your page designs on typically sized display screens
(800 x 600 pixels) to be sure that all major navigation and
content areas fit well within the horizontal area of the screen.
Usually that will limit your page layouts to no more than 760

pixels in width. Many users with slow modem connections
routinely turn off  the image display in their browser. Try
turning off  graphics in your Web browser and look at your
pages - are they still intelligible and navigable? Do you use ALT
statements for every graphic? Do you use blank ALT statements
(ALT=””) to hide irrelevant graphics or spacer graphics from
text-only browsers?
Do not produce Web sites that depend on one browser
technology or browser plug-in (“This site is optimized for
Internet Explorer 5.5 and Macromedia Flash 5”). Such notes on
the home page of  a corporate or enterprise Web site look
sophomoric and will drive away most adult users. Design for
everyone using major browsers released in the two previous
years. If you must depend on proprietary browser plug-ins, try
to position the material that is dependent on the plug-in deeper
within the site, where presumably the reader will already have
made a commitment to your content and may not mind the
bother of having to download a plug-in to see special features.
Once readers have a clearer sense of what they might gain by
bothering to download a browser plug-in, they can make an
informed decision.
More Reading

Accessibility Online
Why It’s an Issue Nonprofits Should Make a Priority
Author: Jayne Cravens
Source: Knowbility.Org
Why Is Accessibility on the Internet Important?
• Would you construct a building for your organization that

was not accessible for someone using a wheelchair?
• Would your agency have a promotional event at a club that

excluded certain people from attending?
• Would you produce a brochure with a color scheme that

rendered it unreadable to those with color vision
impairments?

• Would you want to build a Web site that some potential
clients, customers, staff, press representatives or others
would not be able to access?

• Most everyone would reply to the questions above with a
resounding “no.” And, yet, people with disabilities are often
locked out of  Web sites because their needs are not
considered when web sites are designed.

• More than 49 million Americans have some type of
disability. U.S. Census data indicates that one in every five
Americans has a disability. As our society grows
proportionally older, the need for disability access will
increase along with these numbers. You might want to
consider YOURSELF “temporarily enabled.”

Internet User Scenarios to Consider
• A sight-impaired person may use a Web browser that reads

content on a Web page aloud, and this software is often
“confused” by image maps, frames, java scripts and other
Web design elements that have not been properly configured
for them.
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• A deaf person requires a text version of audio information

that is available on a web site to be able to use the site as
designed.

• Some people cannot perceive certain colors correctly, and may
not be able to see light-colored type on colored backgrounds.

• Someone with limited hand movement may not be able to
hold down more than one key on their keyboard at once.
Well designed Web menus provide alternative navigation
methods.

Just as buildings are designed to facilitate wheelchair navigation
through halls and doorways, there are ways to accommodate
access for many more users to your company’s online
communications. If  you construct a building, it’s easier and
cheaper to put in access for people with disabilities during the
initial construction than to add it on later. The same is true of
Web sites!
Many environmental barriers to people with disabilities can be
removed by making minor modifications or adjustments. The
same is true of  Web sites!
Designing a web site to be accessible to people using assistive
technologies and others with disabilities is very simple and costs
nothing if  it is done as you build your Web site. Making
accommodations on your Web site for the greatest number of
users increases the availability and usefulness of those materials.
If systems are flexible enough to meet the needs and
preferences of the broadest range of users of computers and
telecommunications equipment, regardless of  age or disability,
your potential audience is immediately increased by millions of
users.

Tools Created For One Group Can Serve Everyone

• Wheelchair ramps were created for people in wheel chairs and
walkers or for those who cannot otherwise use steps easily
because of an impairment. However, they are also used by
people pushing strollers, people with young children, mail
carriers pushing bins of mail, and many others.

• Closed captioning on TV was created for people with hearing
impairments. However, it’s also used by people learning
English or learning to read, and by bars and restaurants with
television displays, allowing customers to follow the
broadcast despite the noise of a crowd or a band.

• Large bathroom stalls were created for people in wheelchairs.
However, they are also used by parents with children, or
people who need to be assisted by another person.

• The lesson here is clear: the computer tools you develop with
accessibility in mind will probably serve a much broader
audience. For instance, many of  the suggestions we make
here will give HTML authors more control over pages and
will often shorten page download times for all users. They
will also allow users browsing the web via their cell phones
to access your site.

It’s About Alternatives, Not What You “Can’t” Do
Some designers initially think that making a Web site accessible
is going to mean curbing creativity and fun in designs. Not so!
Curricula on accessible web site design does not discourage
particular design elements. Rather, they provide alternative ways

to achieve effects and allows even more people to have access to
your work. Making an accessible site does not limit your
creativity; in fact, many web sites that have won awards for their
designs are also fully accessible.

Computer Lab

HTML

Managing Links And Images

Anchored Links

Without Links, the World Wide Web wouldn’t be a web at all!
To add a link... you will use the <a href=”location”> opening
tag and </a> closing tag. Whatever appears between these two
tags will become underlined and colored, and if you click on the
underlined text it will send the browser to the location within
the quotes.
Example of a link...
Visit Dave’s Site!
Visit <a href=”http://www.davesite.com/”>Dave’s Site</a>!
If you are just linking to a page in the same directory as your
current page, you don’t need the domain, just the page name.
If you have a page called contactme.html, you can use the code
<a href=”contactme.html”>Contact Me</a>.
Note: Although Links are usually used to send people to other
web pages, you may also use it to send email to a specific
address by using a location of mailto:user@host.

Example of a Mailto: Link...

Send email to the Author [Dave]!
Send email to <a href=”mailto:webmaster@davesite.com”>the
Author [Dave]</a>!
If  you want a link to open in a new window, add
target=”_blank” the end of  the anchor tag, e.g. <a
href=”http://www.neonlollipops.com/”
target=”_blank”>NeonLollipops.com</a>.
Example of  a link opening in a new window...
Visit NeonLollipops.com.

In-line Images...
You may also add images (pictures) to your web page, as long
as the image is in the .gif  or .jpg (or .jpeg) file formats. You will
not be able to use .bmp format files! The basic tag for in-line
images in <img src=”location”>. It is also recommended to add
HEIGHT and WIDTH attributes to the IMG tag, which will
allow the image to take proper proportions on a browser that is
not currently viewing images. It is also recommended to use the
ALT=”what picture is” to tell a person what a picture is in case
it is still loading or they are not viewing images. (The IMG tag
has no closing tag!)

Example of a basic in-line image...

<img src=”http://www.davesite.com/graphx/davesmll.gif ”
WIDTH=200 HEIGHT=50 ALT=”Dave’s Site”>
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If your image is in the same directory as your HTML file, just
use the image name. If your file is welcome.jpg, you can use
<img src=”welcome.jpg”> Then add the appropriate height,
width, and alt attributes as mentioned above.
Combining Links and Images...
Many times you may want to have an image that is linked, so
that if someone clicks the image, the person will be taken to
another page. This is rather simple- you just need to place the
IMG tag within the A HREF tags. (<a
href=”location_of_link”><img src=”location_of_image”></a>)
You may also use the ALIGN tags with images!

Example of a linked image...

<a href=”http://www.davesite.com/”><img src=”http://
www.davesite.com/graphx/davesmll.gif ” align=right></a>
Try it Yourself! – 4
<html>
<head><title>Title goes here</title></head>
<body>
<h1 align=right>Body goes here</h1>
<hr>
<h3 align=center>Headings are kewl!</h3>
<p><b>I can use text links... Visit <a href=”http://
www.davesite.com/”>Dave’s Site</a>!</b><hr width=50>
and Image Links... <a href=”http://www.davesite.com/
”><img src=”http://www.davesite.com/graphx/
davesmll.gif ”></a></p>
</body>
</html>
MANIPULATING IMAGES

Placement On The Page
First let’s worry about placing the image somewhere on the
page. The default is justified to the left. If you write an image
tag on a page, the image will pop up hard left.
If you want to have an image placed in the center of the page,
you might be able to guess at this point that you’d use the
<CENTER> and </CENTER> commands.
But how do we get the image to the right of  the page? Well,
how did we get text to the right? By adding the attribute
ALIGN=”—” to the <P> command, right? Could it be we do
the same thing here? Why yes, it could.
Here’s the format:
<IMG ALIGN=”right” SRC=”image.gif”>
Here’s what you get using “sally.gif ” in place of “image.gif ”:

Aligning Text With Images
Images don’t always stand alone. You will often want text
alongside them. Here you will ALIGN text along the top, the
middle, or the bottom. Again, you’ll use the ALIGN=”—”
attribute with one of these three: “top”, “middle”, or
“bottom”.
Images don’t always stand alone. You will often want text
alongside them. Here you will ALIGN text along the top, the
middle, or the bottom. Again, you’ll use the ALIGN=”—”
attribute with one of these three: “top”, “middle”, or
“bottom”.

Here are the formats:
<IMG ALIGN=”top” SRC=”sally.gif ”> text text text
<IMG ALIGN=”middle” SRC=”sally.gif ”> text text text
<IMG ALIGN=”bottom” SRC=”sally.gif ”> text text text
And here’s what it all looks like:
This is text ALIGN=”top”
This is text ALIGN=”middle”
This is text ALIGN=”bottom”
You may notice that using the top, middle, and bottom
attributes only allows for one line of text and then the rest
jumps down below the image.
Here’s the trick to solving that. Don’t use the top, middle, or
bottom attribute unless you only want one line of text. If you
want text to wrap around the image, use ALIGN=”left” and
ALIGN=”right”.
Even if the image is already to the left, use the ALIGN=”left”
attribute anyway. It allows the text to wrap around the image
fully. Try it, it’s quite a clever little deal.

Two At Once?
But what if you want only one line of text to come out of the
middle of the image, and you want the image aligned to the
right? Can you use two ALIGN=”—” attributes in the same
image? No.
You set the text coming out of the middle using the
ALIGN=”middle” attribute in the IMG tag. Then you set the
image and its text to the right by surrounding the two items
with the <P ALIGN=”right”> and </P> commands.
Are you starting to see how a tag does only one thing? If you
want two effects placed on one item, you’re going to have to use
two different sets of tags.

Changing Image Size
To begin this discussion, let me state that images on a
computer are not like photographs. Computer images are made
up of  a lot of  little colored dots. They’re known as picture
elements or “pixels” for short. So, just remember that during
this part of the Primer, numbers refer to pixels rather than
inches, or centimeters, or whatever. When I say pixels, I’m
talking little colored dots.
Every image is made up of pixels. The more pixels per inch the
image has the better, and more detailed, the image will appear.
Of course, that also means the image will take up a whole lot
more bytes on your hard drive. You’re going to find that most
images on the Web are 72 and 100 pixels per inch. Yes, there are
other settings, but 72-100 is a good trade-off between loss of
detail and bytes required.
Okay, so every image is made of  pixels. This means that you can
also denote an image by number of pixels. For example, the
“sally.gif ” image is 97 pixels high by 64 pixels wide. How do I
know that? I have an expensive graphics program that tells me
so. How would you know? Without a specific program, you
wouldn’t. You’ll have to play around with the numbers in these
commands a little bit, but it’s easy to do.
You might also want to open the image by itself  in the
Netscape Navigator browser window. Do that by choosing
OPEN FILE under the FILE menu. When the picture pops up,
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look at the title bar along the very top. The height and width
should be there.
Of  course, you can also go out onto the Web and surf  around
for a shareware graphics program. My personal favorite is
PaintShop Pro. You get it for free for 30 days and then it’s like
$80 or so to get it for good.
Here’s what you do. Denote to the image command how many
pixels high by how many pixels wide you want. The “sally.gif ”
image is 64X97 pixels. If I want the image to appear smaller, I
will ask for the pixels to be smaller, say 30X55. If I want it
bigger, I would set the pixels larger, say 100X250. Just
remember form. If you make the image smaller or larger, you
must keep the same general square, rectangle, or whatever, form.
Of  course, if  I want to, I can totally distort the picture.
Here’s the coding:
<IMG HEIGHT=”##” WIDTH=”##”
SRC=”image.gif”>
Notice the HEIGHT and WIDTH attributes nestled right
where the ALIGN command went before. You will replace the
“##” with a number of pixels for height and width. Here are
the three examples:
This is normal size:

This is 30X55:

This is 100X250:

This is 100X23:

Notes
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Topics Covered
• User centered design, clear navigation aids, Non dead-end

pages, Design Integrity and stability, Simplicity and
consistency, Feedback and Dialog, Navigation – Button Bars,
Writing Clean codes in HTML, List in HTML

Objectives
Upon completion of this lesson, you should be able to:
• Build a user centered design.
• Understand and use clear navigation aids.
• Maintain Integrity and stability in the Web page
• Build websites with proper Navigation
• Write clean codes in HTML
• Using list in HTML

User-centered Ddesign
Graphic user interfaces were designed to give people control
over their personal computers. Users now expect a level of
design sophistication from all graphic interfaces, including Web
pages. The goal is to provide for the needs of all your potential
users, adapting Web technology to their expectations and never
requiring readers to conform to an interface that places
unnecessary obstacles in their paths.
This is where your research on the needs and demographics of
the target audience is crucial. It’s impossible to design for an
unknown person whose needs you don’t understand. Create
sample scenarios with different types of users seeking
information from your site. Would an experienced user seeking
a specific piece of information be helped or hindered by your
home page design? Would a casual reader be intimidated by a
complex menu scheme? Testing your designs and getting
feedback from a variety of users is the best way to see whether
your design ideas are giving them what they want from your
site.

Clear Navigation Aids

Most user interactions with Web pages involve navigating
hypertext links between documents. The main interface
problem in Web sites is the lack of  a sense of where you are
within the local organization of information:

Clear, consistent icons, graphic identity schemes, and graphic or
text-based overview and summary screens can give the user

confidence that they can find what they are looking for without
wasting time.
Users should always be able to return easily to your home page
and to other major navigation points in the site. These basic
links should be present and in consistent locations on every
page. Graphic buttons will provide basic navigation links and
create a graphic identity that tells users they are within the site
domain. In this site, for example, the graphic header appears on
every page:

www.fastcompany.com
The button bar is efficient (offering multiple choices in a small
space) and predictable (it is always there, at the top of every
page), and it provides a consistent graphic identity throughout
the site.

No Ddead-end Pages
Web pages often appear with no preamble: readers can make or
follow links directly to subsection pages buried deep in the
hierarchy of  Web sites. They may never see your home page or
other introductory site information. If your subsection pages
do not contain links to the home page or to local menu pages,
the reader will be locked out from the rest of  the Web site:

LESSON 9:
USER CENTERED INTERFACE

DESIGN
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Make sure all pages in your site have at minimum a link back to
the main “home” page or, better yet, a home page link along
with links to the other sections of the site.

Direct Aaccess
Users want to get information in the fewest possible steps. This
means that you must design an efficient hierarchy of
information to minimize steps through menu pages. Studies
have shown that users prefer menus that present at least five to
seven links and that they prefer a few very dense screens of
choices to many layers of simplified menus. The following table
demonstrates that you do not need many levels of menus to
incorporate lots of choices:

Number of nested menus 5 7 8 10 

1 5 7 8 10 

2 25 49 64 100 

3 125 343 512 1000 

 
Design your site hierarchy so that real content is only a click or
two away from the main menu pages of your site.

Bandwidth and Interaction
Users will not tolerate long delays. Research has shown that for
most computing tasks the threshold of frustration is about ten
seconds. Web page designs that are not well “tuned” to the
network access speed of typical users will only frustrate them. If
your users are primarily general public browsers “surfing” the
Web via dial-up modem connections, it is foolish to put huge
bitmap graphics on your pages — the average modem user will
not be patient enough to wait while your graphics download
over the phone line. If, however, you are building a university
or corporate intranet site where most users will access the Web
server at Ethernet speeds or better, you can be much more
ambitious in the use of graphics and multimedia. Many home
computer users can now use high-speed DSL (digital subscriber
line) or cable modems to access the Web. However, industry
observers expect that it will be at least another five years before
Web designers can count on most home users having access to

high-speed Web connections. In general, be conservative with
Web graphics. Even users with high-speed connections
appreciate a fast-loading page.
Simplicity and consistency
Users are not impressed with complexity that seems gratuitous,
especially those users who may be depending on the site for
timely and accurate work-related information. Your interface
metaphors should be simple, familiar, and logical — if you
need a metaphor for information design, choose a genre
familiar to readers of  documents, such as a book or a library.
Highly unusual, “creative” navigation and home page
metaphors always fail because they impose an unfamiliar,
unpredictable interface burden on the user.

www.amazon.com
The user interface for your Web site should follow the general
navigation and layout conventions of major Web sites because
your users will already be used to those conventions. Users
spend most of their time on sites other than yours, so avoid
highly unusual interfaces if you wish to attract and keep a large
audience.
The best information designs are never noticed. An excellent
model of  interface design is the Adobe Corporation Web site.
Graphic headers act as navigation aids and are consistently
applied across every page in the site. Once you know where the
standard links are on the page header graphics, the interface
becomes almost invisible and navigation is easy:
For maximum functionality and legibility, your page and site
design should be built on a consistent pattern of modular
units that all share the same basic layout grids, graphic themes,
editorial conventions, and hierarchies of organization. The goal
is to be consistent and predictable; your users should feel
comfortable exploring your site and confident that they can find
what they need. The graphic identity of a series of pages in a
Web site provides visual cues to the continuity of  information.
The header menu graphics present on every page of the Adobe
site create a consistent user interface and corporate identity:

www.adobe.com/type
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Even if your site design does not employ navigation graphics, a
consistent approach to the layout of titles, subtitles, page
footers, and navigation links to your home page or related
pages will reinforce the reader’s sense of context within the site.
To preserve the effect of  a “seamless” system of  pages you may
wish to bring important information into your site and adapt it
to your page layout scheme rather than using links to send the
reader away from your site (be sure there are no copyright
restrictions on copying the information into your site).
Design integrity and stability
To convince your users that what you have to offer is accurate
and reliable, you will need to design your Web site as carefully as
you would any other type of corporate communication, using
the same high editorial and design standards. A site that looks
sloppily built, with poor visual design and low editorial
standards, will not inspire confidence.
Functional stability in any Web design means keeping the
interactive elements of  the site working reliably. Functional
stability has two components: getting things right the first time
as you design the site, and then keeping things functioning
smoothly over time. Good Web sites are inherently interactive,
with lots of links to local pages within the site as well as links to
other sites on the Web. As you create your design you will need
to check frequently that all of  your links work properly.
Information changes quickly on the Web, both in your site and
in everyone else’s. After the site is established you will need to
check that your links are still working properly and that the
content they supply remains relevant.

Feedback and dialog
Your Web design should offer constant visual and functional
confirmation of  the user’s whereabouts and options, via
graphic design, navigation buttons, or uniformly placed
hypertext links. Feedback also means being prepared to respond
to your users’ inquiries and comments. Well-designed Web sites
provide direct links to the Web site editor or Webmaster
responsible for running the site. Planning for this ongoing
relationship with users of your site is vital to the long-term
success of the enterprise.
NAVIGATION
A rich set of graphic navigation and interactivity links within
your Web pages will pull users’ attention down the page,
weaning them from the general-purpose browser links and
drawing them further into your content. By providing your
own consistent and predictable set of navigation buttons you
also give the user a sense of  your site’s organization and make
the logic and order of your site visually explicit. In this example
the rich graphics and many links offered by the Salon technology
and business page immediately draw the reader into the site:

www.salon.com
Provide context or lose the reader
Readers need a sense of context, of their place within an
organization of information. In paper documents this sense of
“where you are” is a mixture of graphic and editorial
organizational cues supplied by the graphic design of the book,
the organization of the text, and the physical sensation of the
book as an object. Electronic documents provide none of the
physical cues we take for granted in assessing information.
When we see a Web hypertext link on the page we have few cues
to where we will be led, how much information is at the other
end of the link, and exactly how the linked information relates
to the current page. Even the view of  individual Web pages is
restricted for many users. Most Web pages don’t fit completely
on a standard office display monitor (800 x 600 pixels), and so
there is almost always a part of the page that the user cannot
see:
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Web pages need to give the user explicit cues to the context and
organization of information because only a small portion of
any site (less than a page) is visible at one time:
As the Web page designer it is up to you to provide these
functional and context cues.

“Going back” and going to the previous page
All hypertext systems share a common feature that has no direct
precedent in print media: going “back” through a series of links
you have previously visited is not the same as paging “back”
through the preceding pages of an ordered sequence of pages.
When users click on a hypertext link in a Web document they
often are transported from one Web site to another, perhaps
even from one country to another. Once made, the hypertext
link is bidirectional; you can “go back” to the Web site you just
left by clicking on the “Back” button of the viewer. Having hit
the “Back” button, you can move to the new Web site again by
hitting the “Forward” button:

Button Bars
For the information designer hypertext links are a mixed
blessing. The radical shifts in context that links create can easily
confuse Web users, who need organized cues and interface
elements if they are to follow and understand hypertext links
from one Web page to another. This is particularly true when
users need to be able to follow (or at least recognize) an ordered
sequence of documents. Notice in the diagram above that
although the user has entered the second Web site at page 6, the
site is an ordered sequence of pages.
If  the standard Web browser “Back” and “Forward” buttons
are augmented with “Next Page” and “Previous Page” buttons
built into the page, the user will have interface tools to navigate
through the information in your site in the sequence you
intended. Button bars can also display location information
much as running chapter headers do in printed books:

www.demusart.com
Unlike the “Back” and “Forward” buttons, whose functions are
relative only to the pages you have seen most recently, “Next
Page” and “Previous Page” buttons in a document are fixed
links you provide to associated documents. By providing
paging buttons and links to local home pages and contents
pages you give users the tools to understand how you have
organized your Web site information, even if  they have not
entered your Web of  pages through a home page or contents
page. The buttons don’t prevent people from reading the
information in whatever order they choose, but they do allow
readers to follow the sequence of pages you have laid out:
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Button bars are also the most logical place for links back to your
home page or to other menu pages related to the current page.
A button bar can be built with text-based links or a series of
individual button graphics at the top or bottom of the page:

Computer Lab
Clean Code...
Clean code means that your HTML coding follows all
specifications, I personally don’t use true clean code, but very
close to it. Here are a few ways to keep your code clean:
· Don’t type special characters into your code, instead type
their escape code... many characters should NEVER be typed
directly into HTML code... for example the “<“, “>”, the “©”,
“&”, and the “ itself. Instead, type &escape_code;
(Ampersand, Escape Code for Character, then a semicolon). For
these 5 characters, here are the escape codes...
• For the < type &lt;
• For the > type &gt;
• For the © type &copy;
• For the & type &amp;
• For the “ type &quot;
Use quotes around values in attributes... For example, if you
want a horizontal rule that is half of the screen width, type <hr
width=”50%”> rather than <hr width=50%>, or if you want
one that is size 5 type <hr size=”5"> rather than <hr size=5>.
Isn’t it ironic that I don’t? <g>
Don’t overlap tags... Overlapping occurs when Tag A starts,
Tag B starts, Tag A closes, then Tag B closes. This will cause
errors in sensitive browsers. For Example, it will not render
correctly in Navigator 4.0 Beta1, Netscape purposefully built
into the browser so developers could catch errors. Examples:
Wrong Way (Overlaps):
<font size=+1><b>This is Bold and One Font Size Bigger</
font></b>
Right Way (Doesn’t Overlap):
<font size=+1><b>This is Bold and One Font Size Bigger</
b></font>
Wrong Way (Overlaps):
<a href=”here.html”><i>This link is italicized</a></i>
Right Way (Doesn’t Overlap):
<a href=”here.html”><i>This link is italicized</i></a>
The Comment Tag...
If you are writing an HTML document, sometimes you may
want to put little reminders to yourself with your code so that
you will be able to interpret your coding better. A comment will

not appear in a web browser when the page is displayed... it is
only visible when the source code is viewed. You start
commented text with <!— and end it with —>.

Try it Yourself! – 6
<html>
<head><title>TITLE HERE</title></head>
<body>
<!— No One Will see this really long comment I have typed
right here unless they decide to view the source. —>
This page Copyright &copy; 1998 Little Joe’s Pages &amp;
davesite.com.
</body>
</html>
Check the result

LIST
The UNORDERED LIST...
The Unnumbered List is the first of the three types of lists.
This is probably the most common list you will use.
Example of an Unordered List...
• pencils
• pens
• erasers
• paper
• glue
Notice the Bullet Before each List Item. Now here is the HTML
Code for the Unordered List Above...
<ul>
 <li>pencils
 <li>pens
 <li>erasers
 <li>paper
 <li>glue
</ul>
The <ul> tag is the opening Unordered List Tag. Between
these two tags you place LIST ITEMS, each one having an
individual <li> opening tag. (If  you want, you can use an
optional </li> closing tag, but it is not needed.) There is no
limit to the number of List Items you may have in a single list.

The Ordered List...
The Ordered List, also known as the Numbered List, is very
similar in structure to the unordered list, except each list item
has a number in front of  it, instead of  a bullet. Also, the
opening tag for the list is <ol> instead of <ul>, and the
closing tag is </ol> instead of </ul>. List Items within the
list still use the same tags.
Example of an Ordered List...
1. pencils
2. pens
3. erasers
4. paper
5. glue
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Notice the Number Before each List Item. Now here is the
HTML Code for the Ordered List Above...
<ol>
 <li>pencils
 <li>pens
 <li>erasers
 <li>paper
 <li>glue
</ol>

The Definition List...
I have never used this type of List, but it may be helpful to you.
This type of list is a little more complicated, but still very easy to
use. This list starts with the <dl> opening tag, and ends with
the </dl> closing tag. This has another tag known as <dt> for
Definition Term, and <dd> for Definition Definition. These
two tags do not need closing tags.
Example of a Definition List...

alliance
A union, relationship, or connection by kinship, marriage, or
common interest.

alligator
Large amphibious reptile with very sharp teeth, powerful jaws.
alliterate
To arrange or form words beginning with the same sound.
Now here is the HTML code for this Definition List...
<dl>
 <dt>alliance
 <dd>A union, relationship, or connection by kinship,
marriage,
 or common interest.
 <dt>alligator
 <dd>Large amphibious reptile with very sharp teeth, powerful
jaws.
 <dt>alliterate
 <dd>To arrange or form words beginning with the same
sound.
</dl>

Try it Yourself!-7
<html>
<head><title>Title goes here</title></head>
<body bgcolor=”#AABBCC”>
<h1 align=right>Body goes here</h1>
<hr>
<center><h3>Headings are kewl!</h3></center>
<hr size=10>
<ul>
<li>pencils
<li>pens
<li>erasers
<li>paper
<li>glue
</ul>

</body>
</html>

Check the result

Assignment
1. Differentiate between a conventional document design &

Web page design?
2. What are the things you should check, when you convert text

for Web?
3. How can the paragraph tag be used?
4. What are text formatting tags in HTML?
5. Format the text in your personal Home page?
6. What are freestanding web pages?
7. What are the checklists for Accessibility for a website?
8. Add links in your personal homepage to your classmate’s

homepage?
9. Insert your and your friend’s photos in your home page?
10.What are the various user centered designs?
11.Build the Navigation strategy for your personal home page?
12.Add list to your personal Home page?

Reference
www.webstyleguide.com
http://www.medicalcomputingtoday.com/0agui.html
http://www.enablingbiz.com/gui_design.ht
http://www.dreamink.com/beginners/b3.shtml
http://www.ils.unc.edu/crenshaw/web_database.htmL
www.webstyleguide.com
http://www.htmlgoodies.com/
http://www.dreamink.com/beginners/
http://prometheus.cc.emory.edu/cfm/academic/CEA.html
http://sunsite.berkeley.edu/Web/guidelines.html
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Topics Covered
• Organizing Framework Information, Hierarchy of

Importance, Extended Fonts and Navigation using HTML
code.

Objectives
Upon completion of this lesson, you should be able to:
• Organize Information for your website
• Build a Hierarchy of Information.
• Use Extended Fonts using HTML code in the Web page
• Build Navigation within a document using HTML code.
In architecture as in all other operative arts, the end must direct
the operation. The end is to build well. Well building hath three
conditions. Commodity, firmness, and delight.
— Sir Henry Wotton, The Elements of Architecture
THE DESIGN OF THE SITE will determine its
organizational framework. At this stage you will make the
tactical design decisions about what your audience wants from
you, what you wish to say, and how to arrange the content to
best meet your audience’s needs. Although people will notice
the graphic design of  your Web pages right away, the overall
organization of the site will have the greatest impact on their
experience.
The fundamental organizing principle in Web site design is
meeting users’ needs. Ask yourself what your audience wants,
and center your site design on their needs. Many organizations
and businesses make the mistake of using their Web sites
primarily to describe their administrative organization, and only
secondarily do they offer the services, products, and
information the average user is seeking. Most readers won’t care
how your company or department is organized and will be put
off if such inside information is all your site appears to offer.
Talk to the people who make up your target audience, put
yourself  in their shoes, and make the items and services they
want the most prominent items on the home page.
Notice, in the illustration below, how the major categories in the
Yale–New Haven Hospital home page center on the needs and
interests of various audiences, not on how the hospital is
organized:

www.ynhh.com

Organizing Information
Our day-to-day professional and social lives rarely demand that
we create detailed architectures of what we know and how those
structures of  information are linked. Yet without a solid and
logical organizational foundation, your Web site will not
function well even if your basic content is accurate, attractive,
and well written. Cognitive psychologists have known for
decades that most people can hold only about four to seven
discrete chunks of  information in short-term memory. The way
people seek and use reference information also suggests that
smaller, discrete units of information are more functional and
easier to handle than long, undifferentiated tracts.
There are five basic steps in organizing your information:
1. Divide your content into logical units
2. Establish a hierarchy of importance among the units
3. Use the hierarchy to structure relations among units
4. Build a site that closely follows your information structure
5. Analyze the functional and aesthetic success of your system

Organizing Framework Information
Most information on the World Wide Web is gathered in short
reference documents that are intended to be read no
sequentially. This is particularly true of sites whose contents are
mostly technical or administrative documents. Long before the
Web was invented, technical writers discovered that readers
appreciate short “chunks” of information that can be located
and scanned quickly. This method for presenting information
translates well to the Web for several reasons:
• Few Web users spend time reading long passages of text on-

screen. Most users either save long documents to disk or
print them for more comfortable reading.

LESSON 10:
SITE DESIGN-1



53

E
-M

E
D

IA
• Discrete chunks of  information lend themselves to Web

links. The user of  a Web link usually expects to find a specific
unit of  relevant information, not a book’s worth of general
content. But don’t overly subdivide your information or you
will frustrate your readers. One to two pages (as printed) of
information is about the maximum size for a discrete chunk
of  information on the Web.

• Chunking can help organize and present information in a
uniform format. This allows users not only to apply past
experience with a site to future searches and explorations but
also to predict how an unfamiliar section of  a Web site will
be organized.

• Concise chunks of information are better suited to the
computer screen, which provides a limited view of long
documents. Long Web pages tend to disorient readers; they
require users to scroll long distances and to remember what
is off-screen.

The concept of a chunk of information must be flexible and
consistent with common sense, logical organization, and
convenience. Let the nature of  the content suggest how it
should be subdivided and organized. At times it makes sense
to provide long documents as a subdivided and linked set of
Web pages. Although short Web documents are usually
preferable, it often makes little sense to divide a long document
arbitrarily, particularly if  you want users to be able to print easily
or save the entire document in one step.

Hierarchy of Iimportance
Hierarchical organization is virtually a necessity on the Web.
Most sites depend on hierarchies, moving from the most
general overview of  the site (the home page), down through
increasingly specific submenus and content pages. Chunks of
information should be ranked in importance and organized by
the interrelations among units. Once you have determined a
logical set of priorities, you can build a hierarchy from the most
important or general concepts down to the most specific or
detailed topics.

Relations
When confronted with a new and complex information system,
users build mental models. They use these models to assess
relations among topics and to guess where to find things they
haven’t seen before. The success of the organization of your
Web site will be determined largely by how well your system
matches your users’ expectations. A logical site organization
allows users to make successful predictions about where to find
things. Consistent methods of displaying information permit
users to extend their knowledge from familiar pages to
unfamiliar ones. If you mislead users with a structure that is
neither logical nor predictable, they will be frustrated by the
difficulties of  getting around. You don’t want your users’
mental model of  your Web site to look like this:

Function
Once you have created your site, analyze its functionality.
Efficient Web site design is largely a matter of  balancing the
relation of menu, or home, pages with individual content
pages. The goal is to build a hierarchy of menus and pages that
feels natural to users and doesn’t mislead them or interfere with
their use of the site.
Web sites with too shallow a hierarchy depend on massive
menu pages that can degenerate into a confusing “laundry list”
of unrelated information:

Menu schemes can also be too deep, burying information
beneath too many layers of menus. Having to navigate through
layers of nested menus before reaching real content is
frustrating:

If  your Web site is actively growing, the proper balance of
menus and content pages is a moving target. Feedback from
users (and analyzing your own use of the site) can help you
decide if your menu scheme has outlived its usefulness or has
weak areas. Complex document structures require deeper menu
hierarchies, but users should never be forced into page after
page of menus if direct access is possible. With a well-balanced,
functional hierarchy you can offer users menus that provide
quick access to information and reflect the organization of your
site.
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The most important step in planning your site is to organize
your information. Thinking carefully about what you want to
say and how you want to say it requires that you become
intimately acquainted with your site content. Create outlines,
chunk your information into sections and subsections, think
about how the sections relate to one another, and create a table
of contents. This exercise will help immensely when it comes
time to build the individual pages of your site and may
determine the eventual success of  your Web site.
A well-organized table of contents can be a major navigation
tool in your Web site. The table is more than a list of  links — it
gives the user an overview of  the organization, extent, and
narrative flow of your presentation:

Computer Lab

Extended Fonts...
The newest version of many browsers supports extended
fonts, in which you can choose to have the document fonts be
other than the normal one. This is accomplished by adding the
FACE=”font_name” attribute to the <FONT> tag. The most
commonly supported fonts are Verdana, Arial, Helvetica,
Impact, Comic Sans MS, and a few others. It is not
recommended to make your page font dependent, because the
older versions of many browsers don’t yet support this feature.
Example of Extended Fonts...
<font size=+2 face=”Verdana”>Verdana</font>
Verdana
<font size=+2 face=”Arial”>Arial</font>
Arial
<font size=+2 face=”Helvetica”>Helvetica</font>
Helvetica
<font size=+2 face=”Impact”>Impact</font>
Impact
<font size=+2 face=”Comic Sans MS”>Comic Sans MS</
font>
Comic Sans MS
Note: If you don’t see one or more of the above fonts, then
your browser probably doesn’t support the extended fonts.

Text Color...

You can change the color of  the text by setting the
COLOR=”font_color” attribute in the <FONT> tag. The
Color is usually set by using the hexadecimal system (#000000
black to #FFFFFF white) but can also be set in newer browsers
by using the simple word of the color. (Red for Red, Blue for
Blue, etc.)
Example of  Text Color...
<font color=”Blue”>Hey I’m Blue!</font>
Hey I’m blue!
<font size=+2 face=”Impact” color=”Green”>Hey I’m green
and in Impact Font!</font>
Hey I’m green and in Impact Font!
<font color=”Red”>Hey I’m red!</font>
Hey I’m red!
Try it Yourself ! – 8
Try typing this:
<html>
<head><title>Fonts and Colors Are Cool</title>
</head>
<body>
<font color=”Yellow” face=”Arial”>Hey I’m Yellow Text...
Change my color!</font><br>
<font size=+2 color=”purple”>Hey I’m Purple Change My
Color!</font><br>
This page Copyright &copy; 1997 Little Joe’s Pages &amp;
davesite.com.
</body>
</html>

Check the Rresult

Navigation Within a Document...
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Wouldn’t it be nice to be able to click a link and move to
another area within the same page? Well you can. You will use
the normal anchor tag (<A HREF>) except instead of placing
another page in the quotes, we will use a named portion of the
document, which begins with a #. To name the part of  the
document, go to the area you want to name, and place <a
name=”name_of_area”>text</a>, then to call a link to that
place from somewhere else in the document, use <a
href=”#name_of_area”>text</a> Example:
<a href=”#section2">Go To Section 2</a><br>
blah<br>
blah<br>
blah<br>
blah<br>
blah<br>
blah<br>
<a name=”section2">Welcome To Section 2!</a>
Go To Section 2
blah
blah
blah
blah
blah
blah
Welcome To Section 2!
Once you have the section named, you can even call it from
other documents... for example, if you named a section in
index.html called section2, you could call it from
bookmarks.html using <a href=”index.html#section2">.
Try it Yourself ! – 9
In the Box below, type the following HTML code, then click
“Check it Out!” The HTML document you made will be
displayed in your browser. You may wish to change the words
within the tags just to try it out.
Try typing this:
<html>
<head><title>Navigation is Cool</title>
</head>
<body>
<a name=”section1">This Is Section One</a><hr>
<a href=”#section2">Click Here to Go to Section 2!</
a><br><br><br><br><br><br><br><br><br>
<a name=”section2">This Is Section Two</a><hr>
<a href=”#section3">Click Here to Go to Section 3!</
a><br><br><br><br><br><br><br><br><br>
<a name=”section3">This Is Section Three</a><hr>
<a href=”#section1">Click Here to Go to Section 1!</
a><br><br><br><br><br><br><br><br><br>
This page Copyright &copy; 1997 Little Joe’s Pages &amp;
davesite.com.
<a href=”http://www.davesite.com/webstation/html/
chap09.shtml”>Back to The Tutorial!</a>
</body>
</html>

Notes
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Topics Covered
• Who is your target audience, Categorization, Identifying

Content, Adding Visitor Value, Content is the King,
Graphics constraints for Web, Picking up the right Graphic
film format, Putting Borders for Images in HTML
document, Using Background Color in HTML

Objectives
Upon completion of this lesson, you should be able to:
• Identify your target audience
• Understand the important of Identifying Content
• Use the right content for right kind of Audience
• Pick the right graphic file format for Web
• Add Border to your images using HTML
• Use Background color

Who Is Your Target Audience?
Any form of communication requires at least two people.
While the internet is a great medium for communicating, it
differs from other traditional forms of media like print, radio
or television because of one main reason - people are coming to
visit your website ON PURPOSE.
Think about that for a moment. When you see advertising in
the newspaper, hear it on radio or see it on television, it’s
interrupting something else, like reading, or listening to music
or watching a movie. Most people “tune out” ads. But, when
they visit a website, it’s a different story altogether.
The people who come to your site are there for a reason.
They’ve either sought you out or found a link to your site
interesting enough that they clicked on it. Now they’ve landed
on your virtual doorstep and it’s up to you to invite them in.
People who visit your website on purpose have a purpose. They
are your target audience - the ones who have the disposable
income to keep you in business. They are the most important
people on the internet. How much do you know about them?
The better you know your target audience, the better you can
use the internet to benefit your business.

If you know your audience, you can...
• choose the right colours and layout for your website
• develop site content that meets your audience’s needs
• use language on your site that appeals to your audience’s

emotions
• create services that your audience wants
• get better search engine positioning under keywords and

phrases that your audience would search for products or
services like yours with

• exceed your visitors’ expectations and crush your
competition

Maybe the last point is a little exaggerated, but you get the
point. Many companies put sites online that seem to have no
purpose and are trying to appeal to everyone. You’ll do better if
you maintain focus and appeal to the people who need and
want your services. From your domain name to the colours and
language you use online, the knowledge of your target audience
is essential to your online success.
Breaking down this target audience into several groups helps
you to work out whether your planned content matches up
against the needs of the audience.

Categorisation
Try to divide the people who will use your site into different
categories. Begin with any obvious groupings, then divide those
further. The trick is to divide your audience into types that will
need slightly different things from your site.
Depending on the topic of the site, different ways of dividing
your audience might be useful. Some general examples are:
• Experience with the site’s topic
• Experience with the Web in general
• Disability (blind, deaf, can’t type, can’t use mouse, etc.)
• Nationality or location (Europe, North America, Asia, etc.)
• Language
• Disposable income
• Political beliefs
• Sex
• Age

What to Consider
Not all the categories I suggested above are useful for every site.
In general, you should probably pick three or four important
ways to divide users and work with those.
There are two main reasons for considering a certain division
irrelevant:
• because it doesn’t make any difference
• because your site isn’t intended for that type of user
Consider a site which provides a technical reference to a
computer programming language.
Based on the first point above, you would not generally need to
differentiate based on the sex, age, political beliefs, or disposable
income of your users. They will all want the same content
regardless of these factors, so those categories can safely be
ignored.
As an example of the second point, your site might be
designed for experienced programmers and you are not going
to include content for novices, so that division might also seem
irrelevant.

LESSON 11:
SITE DESIGN-2
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However, when you exclude users like this, you should be sure
to keep it in mind during the design process. Your final site
should inform users of these categories that they are not catered
for here, and preferably give some suggestions as to where they
might go instead; if you like, you could consider this as one
small piece of content for those users. (In the example site, this
might result as a link in the front page such as ‘This is an
advanced resource. Beginning programmers should check out
The X Tutorial instead.’)

Example types of users
We’ll take another example: a site including cake recipes.
The basic site audience is:
• People who want to bake cakes
• This can usefully be divided into the following (overlapping)

types:
• Experienced cooks
• Inexperienced cooks
• People from the same local region as you (i.e. those who live

in Britain)
• People from elsewhere in the world
Some other common ways to divide users are not helpful in
this case; for example, it doesn’t make much difference whether
users of that site are male or female, or whether they are rich or
poor.

Identifying Content
Although creating a website can be easy, there’s more to it than
first meets the eye. Your first task, before investing any time or
money, should be to determine the primary reason you want to
be on the Internet and to identify the audience you want to
reach. The content, as well as the scope and quality of design
should be driven by the answers to these questions. Do your
homework!
Your purpose may be as general as to let the world know you
exist by posting the online equivalent of a brochure, display ad
or newsletter. Or it may be as specific as increasing sales by
selling your products online. Obviously, the latter increases the
scope of work. Be sure that your development objectives are
consistent with the resources you have available to create and
maintain a site. If not, reassess your short-term and long-term
objectives, and adjust them accordingly.
The next step is to create a profile of your target audience and
design a site that’s responsive to their needs and interests. Select
content by thinking from the perspective of your visitors. How
can you add value to their online experience? How can you make
your website different than an electronic version of a printed
page? In other words, how can you add useful interactivity?

Adding Visitor Value
Let’s say you’re the owner of  a bookstore. The Web offers a
natural extension of your business, not only to generate sales
but to provide service to loyal customers. These are people who
frequent the author events you host and who ask your staff for
reading recommendations. You know that many of  them have
computers because they buy computer books. Based on the

knowledge of your customers, what should you include on
your website?
The Web is a powerful medium that offers many ways to
enhance your business or organization, especially if you add
interactivity to your content mix. Consider creating forums
where customers can post exchange with one another and chat
rooms where they discuss literature, sort of  a virtual book club.
The site of  ad agency TBWA is an excellent example. It not only
showcases the firm’s portfolio, it conducts online focus groups
and opinion surveys. Adding information-based value is really
the key. The more you can add, the more successful your
cyberventure will be

Content is King
Once you’ve decided what you and your audience want, it’s time
to prepare the content. This involves more than adding HTML
code to documents you may already have. Here are some general
guidelines that we will discuss in more detail in later articles.
• The home page should draw your audience in, not

overwhelm them with information. Keep the layout simple
and the text brief. Add graphics to communicate your image.

• Reproducing existing brochures or other documents on the
Web usually doesn’t work well. People have short attention
spans and don’t particularly like to read copious mounts of
text on a computer screen. Use only the most compelling
information. Add headings and bold text, where
appropriate, to make reading easier. Try to limit the length of
a web page to three screens.

• If you must include lengthy documents, break them up into
sections with headings. Create an index or table of contents
at the top of the page, with links to each section. If you
want to provide access to a lot of documents, add a search
feature or provide them as PDF files that can be easily
downloaded for reading off-line.

• Use graphics to enhance the site, but minimize graphics file
sizes whenever possible. Include only those images that add
value. Not every photo needs to be in color; not every catalog
item needs a picture; not every picture needs to be full screen.

• A layout that looks good when viewed in your favorite web
browser may look different to people accessing the site from
an online service such as AOL. Check your web page by
viewing it in a number of browsers, including Internet
Explorer, Netscape Navigator and AOL’s.

• Consider adding links to related websites to expand
information. Be sure to send courtesy notices to webmasters
at the sites you link to.

• If you have the time to respond, encourage feedback via e-
mail. You will get invaluable information from your
audience.

• Measure traffic to your site. Track viewers’ paths through
your web pages, so you can adjust your content accordingly.

More Reading
Back to the User: Creating User-Focused Websites
By Tammy Sachs
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We’ve all come a long way. That being said, when we observe
target users trying out Web sites in our consumer lab, some
common problems persist. This article summarizes five key
lessons learned from listening to and observing all kinds of
users (from teens to seniors to doctors) try out all kinds of
Web sites at various stages of  development. Our goal: to
provide some overarching guidelines about bringing a customer
voice to site design.

Lesson 1: If you want to know what people want,

ask them.
Many marketers-even of well-established brands-forget the
basics of marketing and usability research and treat the World
Wide Web like the Wild Wild West, not exploring up front:
• Who will be using the site-customers, prospects, investors,

etc.
• How these users speak and think
• What content and features drive their interest
• The relationship between the on- and off-line experience
Over the years, we have conducted post-launch research for
many organizations that launched their sites without
conducting any marketing or usability research-a treacherous
process known as “Launch and Learn.” The outcome: costly
revisions implemented after alienating and frustrating untold
numbers of customers and prospects.
We have also worked with many organizations that first expose
target users to their Web sites in usability testing-after
considerable time, money, and emotional investment has been
made in a particular site architecture, feature set, and look and
feel. This often occurs right before launch when there is little
chance for user feedback to be integrated-and at great cost.
Sound familiar?
To fast track the development process and infuse initial design
ideas with a user mindset, we suggest conducting a few carefully
constructed focus groups at the very outset. These are some of
the questions we’ve found that focus group research can help
answer:
• How to create a “front door” that will successfully “invite in”

each of your various audiences (customers and prospects;
doctors and patients, etc.)

• How to “bucket” the main content areas and label them
intuitively

• What the site can do to reinforce a brand’s strengths and
overcome its shortcomings (e.g. beef  up customer service,
offer products there is no room for in your stores)

• What features and content are worth building or acquiring
If done well, focus groups should generate insights that help
designers build a robust prototype of the site that comes pretty
close to nailing what users want. It is at this point that a site is
ready for usability testing.
Lesson 2: If you want to know if they can use your site, watch
them do it.
Many marketers launch sites without knowing if anyone other
than their developers can use the site to:

• Buy a car
• Build a stock portfolio
• Send a gift
• Find out about a drug or disease
• Get the right cell phone plan
Despite all the progress we’ve made on the Web, how many of
us still today experience:
• Error messages that don’t help us
• Registration processes we can’t complete
• Products we can’t find

Purchase paths that don’t lead to a sale
Either these sites have not done usability testing or the testing
they’ve done has not accomplished its goal-to make sure the
people who use the site can easily and successfully do what they
came to do.
The following are tips for how to conduct usability testing that
ensures that your users can-and want to-use your site.
• Interview people who would actually use your site. If  you

want to know if  a gift finder service works, there is no
substitute for observing the folks that would choose to use
it.

• Start early-before you’ve built out the entire site.
• Even if  you use a slide show, show test participants screens

on a computer, not paper. We believe strongly that all of  us
react differently to a computer screen than we do to a printed
page. Test in the medium you ultimately will use.

• Give people tasks to do that let you see them travel the key
pathways you want to make sure are successful.

• Word the tasks so they don’t use the language of  the site.
• Don’t just observe people as they are trying out a path: ask

them what they are thinking. If  queried at the very moment
they click on a particular button, test participants can tell you
exactly what was going through their mind—and offer
invaluable help about how to fix navigation, labels, etc.

• Iterate. After the fourth person tells you they don’t know
what a key label means, change it. Modify the prototype
based on their collective feedback and try a new label with the
next four people. Iterative design and testing makes the best
use of research dollars and accelerates development.

• Document your findings on video. Reviewing tapes of  the
user experience is very helpful to developers. Integrating
video clips of real users into your presentations to
management provides powerful support for your
recommendations.

Lesson 3: Your homepage is a 30 second window of
opportunity. Don’t be shy.
Many homepages are so cluttered that it is difficult for site
visitors to figure out basic information such as what the site is
all about and who it serves. One of the things people tell us
about Google is that the sheer simplicity of the homepage gives
users the impression that their search will be successful.



59

E
-M

E
D

IA
While your homepage may need to contain a great deal more
information than Google’s, there is a lesson to be learned from
their approach.
We’ve found that if  you’re lucky, users will stick around and try
to figure out your homepage for about 30 seconds. Therefore,
their first impressions are critical. Users should immediately be
able to:
• Understand what you offer and feel like they’ve come to the

right place
• Select the path that is right for them-HMO plan member,

HR Director, online banking customer, loan applicant
• Identify the range of  activities they can do-get recipes, shop,

download forms, chat, etc.
• Intuit what is most important from where you’ve placed

content.
• We find that users consistently correlate where you place

“stuff ” on the homepage with its importance:
• Left, center, and above the fold = important.
• Below the fold = unimportant.
• Anything with a logo or ad-like visual, next to a banner or

on the far right of the page = advertising which = “ignore”
me.

Just like with a newspaper, we as Web site users have been
trained to select “in” some information and select “out” others-
and we’ve created strategies for navigating lots of information.
It is critical in laying out your homepage not only to eliminate
what is extraneous (or can be introduced later) but to put the
most important content and functionality in the high rent
district!
Lesson 4: People don’t read, don’t make them.
We figure about 10% of  the population at most are true
“readers.” You occasionally encounter them in usability testing.
They read every instruction, caption, copy point, etc. They make
informed decisions about what button to click on and what
path to take. It is important to note that they are a very small
segment of  Web users. The rest of us:
Click first, read or think later
• Go directly to a bolded word, icon, or button that looks

about right
• Skip over directions, help pages, or text that gets in the way

of where we think we want to go
• Take a lot of  inadvertent pathways and need an easy way to

get back on track
• In order for your site to succeed, it is important to design for

the “non-reader”:
• Any words, instructions or data crucial to a user’s success

should be embedded in a visual icon so it can’t be missed.
• People will tend to fill in the first field they see even if it isn’t

for them. So, if  you have two alternate paths, try presenting
them side-by-side vs. one after the other. This will protect
non-readers from filling out a field that is not intended for
them.

• If a task requires several steps, number them so users can
easily track where they are and what to do next.

• Don’t tell them anything until they need to know it.
• Many users are very literal so make sure your words cannot

be misinterpreted (e.g. “Click anywhere to begin”; “Buy now.”)
• Provide enough information up front (e.g. article summary,

product overview) so users can quickly assess if they want to
take a path—but not so much detail that they have to wade
through lots of copy before getting to other options

• Use hyperlinks effectively so users control their pathway—
and the level of  detail they seek. The beauty of  the Web is its
“non-linearity.”

Most importantly, when designing your interface, consider that
non-readers will not always take the path you intended for
them. So, save them from the garden path. Your overall site
architecture should be consistent with a clear breadcrumb trail
that lets them easily and intuitively get back on track.
Lesson 5: Search and You Shall Find... Hopefully!
In many a usability lab, you give a user a task to find or buy
something and the first thing they do is to search for the Search
box. That is, if they can’t immediately find what they want on
your homepage and, for some, even before they’ve given it a
shot, they start typing what they want in your search box.
As such, Search is probably one of the most critical things to get
right on your site. Here are some guidelines we’ve developed
based on what users have told and shown us about what
makes or breaks the Search function.
• If a search fails, offer tips on how to get better results-or

point users to a path that keeps the dialogue going (e.g. a
way to email you and tell you what they are looking for.)
Witness the search term function Google added for
misspellings: “Did you mean...?”. Even if none of the
choices they provide help you, this feature builds good will
and encourages the user to try again.

• Make sure that the Browse and Search functions are clearly
separated and mutually exclusive-or users will think they can
browse and then refine their choices by searching within the
category they’ve chosen

• Lose the Boolean logic-only statisticians want to define their
search with strings. Offer a way to get a pop-up window that
shows users how to enter words in the search box to
optimize results-e.g. Chicago-style pizza in Los Angeles-and
doesn’t require them to leave the page they are on.

• There are many ways to define a label or word-rug vs. carpet,
PDA vs. handheld, sofa vs. couch. Any way you say it should
get results.

• Offer Advanced Search only after Basic Search has failed.
Limit the options you offer so it isn’t too advanced for the
user.

• Make sure people can search on the dimensions that are
most important. Focus groups are a good place to learn what
criteria are most important to search on (e.g. for sweaters,
which criteria are key: color, fiber, price, size, style or all of the
above?)
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• This isn’t English class. All of us spellers, the good, the bad
and the terrible, should still be able to get the results we seek.

• Make it clear what universe they are searching-your site or the
entire Web.

As much as people love the Web for the access it offers to a
huge database in cyberspace, most people will tell you that their
Search experience is, on the whole, a very frustrating one. And,
what is worse, when Search fails the user, they often equate the
fact that they can’t find something with the perception that you
don’t offer it.
The silver lining here is that you can truly differentiate your site
and build a relationship with users by offering a Search function
that provides them with the results they seek.
What we’ve seen consistently over time is that companies-small
and large-who bring target users into the development process
at key junctures get tremendous payback for their investment.
The result:
• Sites that build lasting customer relationships
• Sites that “beat” the competition by being first in market to

identify and address unmet needs with new features and
content

• An accelerated development process
Most importantly, having users provide information about
their needs, expectations, language and logic enables developers
to think like users-vs. copywriters, graphic designers or
programmers-and, in so doing, create powerful user-driven site
experiences.

Computer Lab

Why Graphics?
Images can make your HTML document more compelling than
text alone If you only put text in this document, the document
would seem quite dull. On the other hand, a few well-placed
graphics can break up the text, making it seem more readable,
and make the document more visually appealing.
Images can often convey your message better than text alone.
Remember the saying, “a picture is worth a thousand words?”
inline images—that lets you convey your message better and
create a more visually attractive Web page.

Image Constraints
The following points have to be considered while adding
images to your document:
Graphics files are slow to download. The average user with a
14.4KBps modem can wait several seconds or even several
minutes while a graphics file downloads.
Search engines don’t know what to do with images. Search
engines such as AltaVista and Excite can’t index your images.
Thus, if  you depend heavily on images, your Web page isn’t as
likely to be hit upon by these search engines’ users.
Many users don’t have graphical browsers. Thousands of
people are still using Lynx, for example, which is a UNIX-
based, text-only browser. In addition, Internet Explorer and
Netscape users might disable inline images in order to open
Web pages faster.

Images aren’t always internationalized. Because HTML
documents published on the Web have a worldwide audience,
internationalized images might be important.
Color images aren’t always portable. A color image that looks
good on your computer might not look quite as good on
another user’s computer. Thus, you need to pay particular
attention to how you use colors in an image.

Picking The Right Graphics File Format
There are many file formats which you can use to store images
like; GIF, JPEG, PCX, PNG, WMF, and so on. When creating
images for use in an HTML document, always use those file
formats that most browsers understand for ex: GIF or JPEG.
Each file format has different properties. While one file format
downloads faster, for example, the other format maintains
more image detail. Some of them are:

Colors

GIF supports 256 colors. JPEG supports 16.7 million colors.
Thus, if  color depth is not important or you’re using a limited
number of colors in an image, you can be comfortable using
GIF. On the other hand, if  you want to maintain a
photographic-quality color depth, then you might consider
using JPEG.

Loss
Lossy compression schemes cause an image to lose detail when
the graphics program saves it. That is how these schemes
compress the file so much. Lossless compression schemes, on
the other hand, don’t cause an image to lose any detail at all.
Table describes each file format’s compression scheme.

Compression Scheme

Format Scheme Description  

GIF  Lossless  GIF compresses without losing any 
detail. Thus, if you're concerned more 
with maintaining detail than download 
speed, use GIF.  

PNG  Lossless  PNG also compresses without losing 
any detail. PNG is a good alternative to 
GIF, except that it's not directly 
supported by most Web browsers.  

JPEG  Lossy  JPEG causes an image to lose detail 
when saved. If you're concerned more 
with file size than with detail, however, 
use JPEG.  

Browser Support
While including images you should always try to stick with
those file formats that are directly supported by the most
popular browsers. These formats include GIF and JPEG. PNG
is not yet supported by a majority of  the Web browsers.
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Controlling The Border
You control the border around an image with the BORDER=
attribute. In most browsers by default, the border is visible only
on images that are used as links. To turn the border off  for all
images, add the BORDER=” 0 “ attribute to the <IMG> tag,
resulting in a complete image tag:
<IMG SRC=” butterfl.gif  “ ALT=”butterfly image”
HEIGHT=”92" WIDTH=”104" BORDER=”3">

Likewise, you can increase the border width around an image by
increasing the value in the BORDER= attribute:

Creating Thumbnails
A thumbnail is a smaller version of an image, but it is also a
link to the larger version. Thumbnails can also link to
multimedia applets or to other content that is time-consuming
to download or not universally accessible.
To add a thumbnail image, start by having both images-the
thumbnail and the larger version-available. Make a thumbnail
by starting with the full-size version. Then, use your image-
editing software to resize or resample the image to a much
smaller size-as small as possible while still retaining the gist of
the image. Save this second image under a different name. Then
follow these steps:
1. Include the thumbnail image in your document as you’d

include any other image. For example, the code might look
like this:
<IMG SRC=”photo-thumbnail.jpg” HEIGHT=”78"
WIDTH=”193" ALIGN=”RIGHT” BORDER=1
ALT=”Thumbnail of Original Photo”>

2. Add a link from the thumbnail to the larger image.
<A HREF=”photo.jpg”><IMG SRC=”photo-
thumbnail.jpg” HEIGHT=”78" WIDTH=”193"
ALIGN=”RIGHT” BORDER=”1" ALT=”Thumbnail of
Original Photo”></A>

If you set the border to 0, be sure that the supporting text or
other cues in the HTML document make it clear that the image
is, in fact, a link to a larger photograph. Alternatively, do as we
did and simply set BORDER=1 to make clear that an image is a
link
Although you can achieve the same visual effect in your
document by using the original image and setting a smaller
display size with the HEIGHT= and WIDTH= attributes, this
technique defeats the purpose of thumbnails. Even if you reset
the display size with HEIGHT= and WIDTH=, the entire
(full-size) image will have to be downloaded to your computer.
The trick to effective thumbnails is to reduce both the
dimensions and the actual file size to the smallest possible value
so the page will load quickly.
<HTML>
<HEAD>
<TITLE>THUMBNAIL EXAMPLE</TITLE>
</HEAD>
<BODY>
<A HREF=”FLOWER-BIGGER.jpg”><IMG
SRC=”flower.jpg”
ALIGN=”TOP” BORDER=”0" ALT=”Thumbnail of
Original Photo”></A>
</BODY>
</HTML>
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Using Background Images
Most browsers support background images, the patterns or
images behind the text in HTML documents. As a rule,
background images are tiled throughout the available space,
meaning that they are multiple copies of one image placed side
by side to fill the screen.
Tiling offers two main advantages.
First, you can produce a seamless background, meaning that the
casual viewer cannot see where individual images start and stop.
Second, you can develop more visually interesting backgrounds
by ensuring that background images tile either horizontally or
vertically. For example, an image that Is only 10 pixels high and
1280 pixels wide is as wide or wider than any browser window
is likely to be. Therefore, the image will repeat vertically, but not
horizontally. This can produce a vertical band.
The magic number 1280 ensures that no browser can be wider
than the image. If you use a narrower image, you might have an
attractive image when viewed at 800 x 600 resolution, but with
two vertical bands (on the left and near the right) at 1024 x 768
resolution, for example.
Similarly, you can use a tall image to produce a tiled horizontal
band. Pay careful attention to making the image taller than your
page could possibly be; otherwise, the background will repeat. A
good technique is also to make the image fade into the
background color of the document.
If you use background images in your document and the color
of the image does not adequately contrast with the text color,
reset your document colors. You might also want to set the
colors to complement your background image.
To add a background image, use the attributes in Table in the
opening <BODY> tag.

Tag  Use  

BACKGROUND="..."  Uses URL to identify an 
image for the background of 
an HTML document.  

BGPROPERTIES=FIXED Sets the background image 
as nontiled, nonscrolling for 
use with lnternet Explorer.  

 To specify a background image, add the background= attribute
to your opening <body> tag.
<Body background=”imageback.jpg”>
You can use style sheets to include background images behind
individual page elements, rather than placing a background
image behind the entire page.
If you have a background image that you want to use as a
watermark of sorts for your pages-and if your visitors will use
internet explorer-add the bgproperties-fixed attribute. This
attribute prevents the image from tiling throughout the
background. The full code for the <body> tag is:
<Body background=”imageback.jpg” bgproperties-fixed>
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Topics Covered
• Site structure, Basic Information structures, Creating Site

Diagrams,Site File & Directory structures, Advanced HTML
cod, Adding Tables in web document.

Objectives
Upon completion of this lesson, you should be able to:
• Define Site Structures
• Identify Structural Theme you want to use for your website
• Choose between sequences, Hierarchies and webs
• Use Advanced HTML code : create tables in web document.

Site Structure
If  you are interested in the World Wide Web you can hardly
escape references to hypertext and hypermedia. The computer
press is full of  fuzzy thinking about how Web-based
information can somehow “link everything to everything.” The
implication is that with the Web you can dispense with one of
the most challenging aspects of presenting information —
putting it into a logical order and creating an interesting and
understandable resource for readers. But if your idea of how
one section of  your site relates to other areas is hazy, if  you have
no comprehensive narrative or clear sense of organization, your
readers will know it soon enough, and most will leave in
pursuit of material that is better organized.

Basic Information Structures
Web sites are built around basic structural themes. These
fundamental architectures govern the navigational interface of
the Web site and mold the user’s mental models of  how the
information is organized. Three essential structures can be used
to build a Web site: sequences, hierarchies, and webs.

Sequences
The simplest way to organize information is to place it in a
sequence. Sequential ordering may be chronological, a logical
series of topics progressing from the general to the specific, or
alphabetical, as in indexes, encyclopedias, and glossaries. Straight
sequences are the most appropriate organization for training
sites, for example, in which the reader is expected to go through
a fixed set of material and the only links are those that support
the linear navigation path:

More complex Web sites may still be organized as a logical
sequence, but each page in the main sequence may have links to
one or more pages of digressions, parenthetical information, or
information on other Web sites:

Hierarchies
Information hierarchies are the best way to organize most
complex bodies of  information. Because Web sites are usually
organized around a single home page, hierarchical schemes are
particularly suited to Web site organization. Hierarchical
diagrams are very familiar in corporate and institutional life, so
most users find this structure easy to understand. A hierarchical
organization also imposes a useful discipline on your own
analytical approach to your content, because hierarchies are
practical only with well-organized material.

Webs

LESSON 12:
SITE DESIGN-2
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Weblike organizational structures pose few restrictions on the
pattern of information use. In this structure the goal is often to
mimic associative thought and the free flow of ideas, allowing
users to follow their interests in a unique, heuristic, idiosyncratic
pattern. This organizational pattern develops with dense links
both to information elsewhere in the site and to information at
other sites. Although the goal of this organization is to exploit
the Web’s power of  linkage and association to the fullest,
weblike structures can just as easily propagate confusion.
Ironically, associative organizational schemes are often the most
impractical structure for Web sites because they are so hard for
the user to understand and predict. Webs work best for small
sites dominated by lists of links and for sites aimed at highly
educated or experienced users looking for further education or
enrichment and not for a basic understanding of a topic.

Creating site diagrams
Site planning with a team is often easier if you base your major
structural planning and decisions on a shared master site
diagram that all members of the group can work with. The site
diagram should evolve as the plan evolves and can act as the
core planning document as changes are proposed and made in
the diagram. Site diagrams are excellent for planning both the
broad scope of the site and the details of where each piece of
content, navigation, or interactive functionality will appear. In
well-equipped Web projects the team meetings often center on a
computer and data projector showing Web pages or
PowerPoint graphics. Although there is no substitute for
looking at actual Web pages, ironically, this reliance on data
projection is a severe limitation in explaining complex Web site
structures to a team. No matter how good your data projector
is, you can show only one Web page at a time in a Web browser,
and no current data projector can match the resolution, size, or
flexibility (you can write on it) of a large paper diagram. For
major planning meetings we often print at least one very large
color diagram of the site organization, so that everyone can see

the “big picture” as it develops from meeting to meeting. The
site diagram dominates the middle of the conference table,
becoming a tactile, malleable representation of the plan as it
evolves. Everyone is free to make notes on it or suggest
improvements in the site structure, and the revised diagram
becomes the official result of the meeting.

Site file and directory structures
Site diagrams are also useful when your project moves from
planning to actual Web page production. As the new site is built
up in a directory on the Web server, the site diagram is often the
first place programmers look to gain an understanding of how
the site files should be subdivided into directories (“folders”)
on the server.
The pattern of directories and subdirectories of the site files
should mirror the major content divisions and structures as
shown on the site diagram:

As the site directories and subdirectories are organized on the
server, information on the exact names used for major
directories and files should be added to the site diagram, so that
everyone on the team has a ready current reference to the
naming conventions and file locations in the site.

Summary
Most complex Web sites share aspects of  all three types of
information structures. Except in sites that rigorously enforce a
sequence of pages, users are likely to use your site in a free-form
weblike manner, just as they would a reference book. But the
nonlinear usage patterns typical of  Web surfers do not absolve
you of the need to organize your thinking and present it within
a clear, consistent structure that complements your design goals.
The chart below summarizes the three basic organization
patterns against the “linearity” of the narrative and the
complexity of the content:
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Computer Lab

Enhance A Web Page Using Advanced Html

Code
HTML tables which are grids made up of rows & columns
Tables are used when you want information to be portrayed
more effectively than described in paragraphs. Tables serve two
functions. Firstly, they help present complex data in a
presentable form. Secondly, you can use the tables to
incorporate more sophisticated design elements into webpages.

Why use Tables in HTML?
HTML Tables mark up data that should be organized in a table
structure, instead of in paragraphs or other block-level
structures. With tables, you can present data organized in rows
& columns. Lets say, we have the following data of  the marks
obtained by a student of class X in different subjects.

Subject Maximum Marks Marks Obtained 

Mathematics  100 80 

Physics  200 150 

Chemistry 100 70 

It’s a good illustration of  the concept of  a Table and we can use
it to define the following terms related to Tables:
• A Table’s rows are the horizontal lines of  data. The above

table has 4 rows.
• The columns are the vertical lines of data. There are 3

columns in this table.
• Each piece of data is at the intersection of a row & a column

and these intersections are called cells. Since there are 4 rows
& 3 columns, this table has 4x3=12 cells.

• The first three cells in the first row show labels for the type
of information in each column. These special cells are called
headings.

Tables are sometimes used for general page layout, for example,
to organize paragraphs into columns.
Creation of Basic Tables
To create a Table in HTML, you’ll use the table element. The
table element starts with the <TABLE> tag and ends with the
</TABLE> tag. You’ll need to understand the rules of what
elements should appear between these two tags.

Basic Table Tags
Here is the list of  Table tag with its description

Tag Usage 

<TABLE> Marks the Table within HTML 
document 

<TR> Marks a row within a table. The 
closing tag is optional 

<TD> Marks a cell (table data) within a 
row. The closing tag is optional 

<TH> Marks a heading cell within a row. 
The closing tag is optional 

 

Steps to be folloWed For Adding Information To Table

Rows & Columns

Follow The Steps As Outlined Here To Build A Table & Add
Information Into It.
1. Start With A Functional Html Document Containing The

Appropriate Structure Tags.
2. Add The <Table> Tags Where You Want The Table

Boundaries To Appear.
<Table>
</Table>
3. Add <Tr> Tags Between The Boundaries Noted Above For

Each Row. Lets Say, We Add Four <Tr> Tags, One For Each
Row.

<TABLE>
<TR>
</TR>
<TR>
</TR>
<TR>
</TR
<TR>
</TR>
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</Table>
4. Add <th> tags in the first row where you want to include

table headings. Lets say we add three <th> tags. You can
include some spaces or tabs to set off the table heading (and
data) tags so that you can easily see which text is associated
with each row and cell.

<TABLE>
<TR>

<TH> </TH>
<TH> </TH>
<TH> </TH>

</TR>
<TR>
</TR>
<TR>
</TR
<TR>
</TR>

</TABLE>
5. Add <td> tags to create individual cells in which to include

information. Lets say, the sample table here contains 9 data
cells.

<TABLE>
<TR>

<TH> </TH>
<TH> </TH>
<TH> </TH>

</TR>
<TR>

<TD> </TD>
<TD> </TD>
<TD> </TD>

</TR>
<TR>

<TD> </TD>
<TD> </TD>
<TD> </TD>

</TR
<TR>

<TD> </TD>
<TD> </TD>
<TD> </TD>

</TR>
</TABLE>

6. Add the content for each cell. Place the table heading
information between the <th> tags and enter data between

<TD> TAGS.
<TABLE>

<TR>
<TH> SUBJECT </TH>

<TH> MAXIMUM MARKS </TH>
<TH> MARKS OBTAINED </TH>

</TR>
<TR>

<TD> MATHEMATICS </TD>
<TD>100 </TD>
<TD> 80 </TD>

</TR>
<TR>

<TD> PHYSICS </TD>
<TD> 200 </TD>
<TD> 150 </TD>

</TR
<TR>

<TD> CHEMISTRY </TD>
<TD>100</TD>
<TD>70</TD>

</TR>
</TABLE>

The complete html code is the following
<HTML>

<HEAD> <TITLE> TABLES IN HTML </TITLE> </
HEAD>

<BODY>
<H2> TABLES IN HTML </H2>

<TABLE>
<TR>

<TH> SUBJECT </TH>
<TH> MAXIMUM MARKS </TH>
<TH> MARKS OBTAINED </TH>

</TR>
<TR>

<TD> MATHEMATICS </TD>
<TD>100 </TD>
<TD> 80 </TD>

</TR>
<TR>

<TD> PHYSICS </TD>
<TD> 200 </TD>
<TD> 150 </TD>

</TR
<TR>

<TD> CHEMISTRY </TD>
<TD>100</TD>
<TD>70</TD>
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</TR>

</TABLE>
</BODY>
</HTML>

The above code when seen in the browser window looks like

Assignment
1. Build a Hierarchy of relations and functions for your

website?
2. Try using extended fonts and Text color in your personal

homepage?
3. Add Navigation within your  personal Home page?

4. Identify the audience for your personal home page?
5. What should be the content for your home page?
6. Differentiate usage of graphics for Desktop Publishing and

Web?
7. Add Background color to your personal home page?
8. What are site structures?
9. Identify which site structure to use for your personal home

page?
10.Add tables in your home page?

Reference

www.webstyleguide.com
http://www.w3.org/MarkUp/Guide/Advanced.html
http://www.learnthenet.com/english/html/43idcont.htm
http://www.digital-web.com/articles/
creating_user_focused_websites/
http://www.leafdigital.com/class/lessons/content/2.htm
http://www.davesite.com/webstation/html/chap08.shtml
http://www.davesite.com/webstation/html/chap09.shtm

Notes
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Topics Covered
Site design themes, Site Genres like Training, Web based
Training application, and Teaching, Continuing education,
Adding Rows and columns using HTML code, Deleting
Rows and Columns.

Objectives
Upon completion of this lesson, you should be able to:
• Define  Site design themes
• Identify different Site genres.
• Teaching and Education Sites
• Continuing Education
• Add rows and columns in a web document using HTML

code
• Delete rows and columns

Site Ddesign Themes
All presentations of information are governed by parameters
determined by the objectives, the practical logistics of the
chosen medium, and the audience. The figure below plots
major themes for information delivery against two fundamental
variables - the linearity of the structure of your presentation and
the length of the typical user’s contact time:

Some general modes of  Web use are more structured and
depend on audiences who arrive knowing what they wish to
accomplish without the need for site-supplied motivation.
Corporate intranets, training sites, educational sites, reference
sites, and many well-known news and information sites benefit
from audiences that know what to expect at a particular site and
arrive there with a specific goal in mind. E-commerce and
entertainment sites have a complex dual mission to balance: to
motivate casual browsers to spend time in the site and become

customers as well as to provide fast access to products and
information to experienced users.

Naive designers and clients eager to do almost anything to
attract attention to a Web site consistently make the mistake of
maximizing immediate graphic impact over all other possible
attributes of a site design. They have the misguided notion that
if you constantly hit the reader between the eyes with a huge,
noisy graphic or Flash animation, you will sustain their
attention. Sometimes this does work — for about ten to fifteen
seconds. “Eye candy” is a quick blast of visual sweets, but you
can’t build a Web site on a moment’s attention. Most readers
quickly tire of blaring animated graphics and the long
downloads, plug-in compatibility irritations, and distracting
stimuli that complicate such sites. A successful site requires real,
sustained engagement, and you get that only by offering both
sophisticated visual stimuli and a site that is structured to meet
the needs of  its audience quickly and effectively.

Training
Web-based training applications tend to be linear in design and
typically present few opportunities to digress from the central
flow of the presentation. Don’t confuse readers or confound
your own expectations by offering many links away from the
central message. Restricting links to the “Next” and “Previous”
paging functions guarantees that everyone will see the same core
presentation and allows you to predict users’ contact time more
accurately. Most training presentations assume a contact time of
less than one hour or are broken up into sessions of an hour or
less. Tell your readers how long the session will last, and warn
them not to digress from the required material if they are to
receive credit for the training. Training applications typically
require a user log-in and often present forms-based quiz
questions in true-false or multiple-choice formats. User
registration data and scores are typically stored in a database
linked to the Web site.

LESSON 13:
ADVANCED HMTL
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info.med.yale.edu/hhmi

Teaching
Good teaching applications are also built around a strong
central narrative, but they typically offer more opportunities to
pursue interesting digressions from the main themes of the
Web site. The information presented is usually more
sophisticated and in-depth than in training applications. Links
are the most powerful aspect of  the Web, but they can also be a
distraction that may prevent visitors from getting through the
presentation. If  you wish to provide links to other Web-based
resources beyond your local site, you might consider grouping
the links on a separate page away from the main body of the
material. Often readers will want to print material from a
teaching site and read it later from paper. Make this easy for
them by providing a “printing” version that consolidates many
separate pages into one long page.

www.dartmouth.edu/~chelab

Continuing Education
The audiences for heuristic, self-directed learning will chafe at
design strategies that are too restrictive or linear. The typical
corporate or academic user of such sites is usually fairly
knowledgeable in the subject area. The Web is an ideal medium
for “just in time” training, where users pick just the specific
topic where they need education. Flexible, interactive, nonlinear
design structures are ideal for these readers because it is difficult
to predict exactly which topics will most interest them. The
design must permit fast access to a wide range of topics and is
typically dense with links to related material within the local site
and beyond on the World Wide Web. Text-based lists of  links
work well here for tables of contents and indexes because they
load fast and are full of information, but well-designed graphics
and illustrations are also needed so that this easily bored
audience will stay involved with the material. Contact times are
unpredictable but are often shorter than for training or teaching
sites because the readers are usually under time pressure. Easy
printing options are another must for this audience.

info.med.yale.edu/intmed/cardio/imaging

Computer Lab

Adding & Removing Rows & Columns
Once you create a table, you can easily add or delete rows &
columns to it.

Adding Rows
Lets say we want to add a row to the above created table. To add
a row to your table, insert additional <TR> and <TD> tags
where you want new row to appear. For example, we add a new
row at the bottom of this table like this:
<TABLE>
<TR>
<TH> Subject </TH>
<TH> Maximum Marks </TH>
<TH> Marks Obtained </TH>
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</TR>
<TR>
<TD> Mathematics </TD>
<TD>100 </TD>
<TD> 80 </TD>
</TR>
<TR>
<TD> Physics </TD>
<TD> 200 </TD>
<TD> 150 </TD>
</TR
<TR>
<TD> Chemistry </TD>
<TD>100</TD>
<TD>70</TD>
</TR>
<TR>
<TD> Sanskrit </TD>
<TD> 150 </TD>
<TD> 90 </TD>
</TR>
</TABLE>
The resulting table looks like this:

Adding columns
In order to add one column to the table, you must add one cell
to each row. The general process is
• Add those many number of  cells to each row, as you want

the number of columns to be inserted.
• You must insert the <TD> tags where you want the new

column to appear, either to the left or right or somewhere in
between.

For example, lets say we add one new column to the extreme
right of the table by adding <TH> tags to the topmost row
and <TD> tags to each of the rest of the rows.
<TABLE>
<TR>
<TH> Subject </TH>
<TH> Maximum Marks </TH>

<TH> Marks Obtained </TH>
<TH> Remarks <TH>
</TR>
<TR>
<TD> Mathematics </TD>
<TD>100 </TD>
<TD> 80 </TD>
<TD> Pass </TD>
 </TR>
<TR>
<TD> Physics </TD>
<TD> 200 </TD>
<TD> 150 </TD>
<TD> Pass </TD>
</TR
<TR>
<TD> Chemistry </TD>
<TD>100</TD>
<TD>70</TD>
<TD> Pass </TD>
</TR>
<TR>
<TD> Sanskrit </TD>
<TD> 150 </TD>
<TD> 90 </TD>
<TD> Pass </TD>
</TR>
</TABLE>
The resulting table looks like:

Deleting Rows & Columns
For deleting a row or column, you must delete all the tags
associated with that row or column.
• When deleting a row, make sure to delete the <TD> tags

and <TR> tags that enclose it.
• When deleting a column, make sure to delete the <TH> tags

as well as the <TD> tags from each row.
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Here is an illustration of the deletion of the last row we had
added in the previous table.
<TABLE>
<TR>
<TH> Subject </TH>
<TH> Maximum Marks </TH>
<TH> Marks Obtained </TH>
</TR>
<TR>
<TD> Mathematics </TD>
<TD>100 </TD>
<TD> 80 </TD>
</TR>
<TR>
<TD> Physics </TD>
<TD> 200 </TD>
<TD> 150 </TD>
</TR
<TR>
<TD> Chemistry </TD>
<TD>100</TD>
<TD>70</TD>
</TR>
<TR>
<TD> Sanskrit </TD>
<TD> 150 </TD>
<TD> 90 </TD>
</TR>
</TABLE>
So here, we have deleted the <TR> and <TD> contents which
helps in deleting the complete row within the <TR> & </TR>
tags.
 Similarly to delete the column we had inserted last from the
table, we delete each <TD> element from each row.
<TABLE>
<TR>
<TH> Subject </TH>
<TH> Maximum Marks </TH>
<TH> Marks Obtained </TH>
<TH> Remarks <TH>
</TR>
<TR>
<TD> Mathematics </TD>
<TD>100 </TD>
<TD> 80 </TD>
<TD> Pass </TD>
</TR>
<TR>
<TD> Physics </TD>

<TD> 200 </TD>
<TD> 150 </TD>
<TD> Pass </TD>
</TR
<TR>
<TD> Chemistry </TD>
<TD>100</TD>
<TD>70</TD>
<TD> Pass </TD>
</TR>
<TR>
<TD> Sanskrit </TD>
<TD> 150 </TD>
<TD> 90 </TD>
<TD> Pass </TD>
</TR>
</TABLE>

Notes
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Topics Covered
• Entertainment and magazine sites, News sites & E-

commerce site, Formatting Tables – Creating Table
Border and Border color, Background color in
Tables.

Objectives
Upon completion of this lesson, you should be able
to:
• Identify Entertainment and Magazine sites.
• Know about News sites & E-commerce sites.
• Format Tables - Create Table Border and set border

color.
• Apply Background color in Tables.

Entertainment and Magazine Sites
Unlike the sites covered thus far, entertainment sites
usually cater to an audience whose interests and
motivations are usually much less focused. This
audience needs to be grabbed immediately by
compelling graphic and text presentations, or they’ll

simply hop somewhere else in search of stimulation. As in any
other design genre, what is “compelling” depends entirely on
the audience’s expectations. Slate’s sophisticated mix of  political
commentary and social criticism depends heavily on clever, well-
written headlines and teasers.

The well-designed home page presentation is derived entirely
from presentation styles used in political and current affairs

magazines, because that’s exactly the
audience Slate is seeking.
News sites
News sites have largely adapted the
existing design genres of print
newspapers and magazines to the
smaller format of  the Web. Virtually all
of the design conventions used on the
New York Times Web site derive from
well-established print precedents,
although ironically, the New York Times’s
louder, more colorful Web presence
owes more to the exaggerated visual
hierarchies of USA Today than to the
Times’s conservative print conventions.

E-commerce
In e-commerce sites the crucial design
parameters are efficient navigation and
search, along with speed to the final
“place order” button. During the “dot-
com” market bubble many new
e-commerce sites spent fortunes of their

investors’ money on elaborate Macromedia Flash or digital
video presentations and quickly failed - some went bankrupt
before the site was launched. Meanwhile, the Web’s most
successful commerce sites kept things technically simple and
basic. Amazon, eBay, Yahoo!, and other successful Web

LESSON 14:
SITE GENRES-1
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commerce sites use remarkably spare page design schemes and
simple text- or tab-based navigation systems. Another area
where e-commerce sites often fail is in providing search engines
that are smart enough to “degrade gracefully” when there is no
exact match to a request. If  a shopper types in “PDA” and the
inventory fails to turn up any products by that exact name, the

search engine should default to a list of
“personal digital assistants” made by various
manufacturers.
Amazon has experimented with various tab
systems as the site has grown, but the choice of
tabs as a navigation system was wise - tabs are
one of the few real-world graphic navigation
metaphors to have translated to the screen. Tabs
work with only about eight or fewer choices,
however. As tabs multiply, their sheer number
creates confusion.
Amazon’s order processing screens are also a
model of  navigation design for Web commerce.
Most well-designed order screens are short and
deal with topics one at a time (review items in
“shopping cart,” provide shipping address, add
credit card information, and so on) on screens
that don’t require scrolling. But this forces the order process to

take place over multiple screens, which could become tedious if
not for the “you are here” progress icons at the top of the
screen. The lesson here is clear: all e-commerce processes involve
some tedium for the buyer. Yet if  you provide information on
the user’s current position, the slow series of  screens becomes
less of a problem because the user knows what to expect.

Computer Lab

Formatting Tables
Tables can be formatted to improve
the overall appearance. Like you can
1. Add borders
2. Include background colors
3. Adjust cell spacing and cell padding
4. Adjust cell alignment
5. Specify cell size
6. Specify table alignment

Creating Table Borders
Table Borders are the lines that enclose
tables and clearly separate rows,
columns and cells. To specify Table
borders, you use an attribute and a
number, measured in pixels, that tell
the browsers the width of the border.
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Attributes 

Use  

BORDER = n Specifies a table border width, 
which is measured in pixels. The 
larger the number, the wider the 
border. BORDER= 0 removes 
borders, the default setting.  

BORDERCOLOR 
= "#rrggbb" 

Specifies a color for the table 
border as #rrggbb number or 
name.  

Follow the steps as given below to create a table border and
specify its color:
1. Add the BORDER= attribute to the opening table tag:

<TABLE BORDER=5>
2. Specify the Border color by using the BORDERCOLOR=

attribute and either an RGB value or the color name.
<TABLE BORDER=5 BORDERCOLOR= “#FF0000”>
See the resulting Table, how it looks:

Including a Table Background Color
You can specify the background color for the table cells. This
Background color appears only at the background of the cells
and not on the border of  the Table. The Table Background
color attribute is BGCOLOR= “#rrggbb” and is used in the
opening <TABLE> tag, like this:
<TABLE BGCOLOR= #CCFFFF”>
The resulting Table will look like this:

While adding a background color to the table cells, you must
take care of the following:
1. The background color should be light if the text color is dark

& vice versa.
2. The chosen color should be aesthetically pleasing.
3. The resulting HTML document should be viewed in a few

different browsers.

Notes
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Topics Covered
• Computer Lab: Adjusting Cell alignment, specifying a cell

size, Cell spacing and padding, Specifying Table Alignment &
Width, and Adding Frames – an introduction.

Objectives
Upon completion of this lesson, you should be able to:
• Adjust Cell alignment
• Specify you own cell size and spacing.
• Align Tables according to the Web page.
• Add Frames to your web page – An Introduction.

Adjusting Cell Alignment
Cell alignment refers to the horizontal and vertical alignment of
the cell contents. For most of the browser, the default setting
of the cell alignment is:
• Table Headings are horizontally and vertically centred in the

cell.
• Table Contents are left aligned horizontally and centred

vertically in the cell.
Here is the Description of Cell Alignment Attributes

Attribute Use 

ALIGN = 
n 

Specifies the horizontal alignment 
of cell contents as LEFT, 
CENTER or RIGHT 

VALIGN 
= n 

Specifies the vertical alignment of 
cell contents as TOP, MIDDLE, 
BOTTOM or BASELINE. 

To set the alignment attributes, you must use them in any
<TR> , <TD>, or <TH> tags.
<TR ALIGN= RIGHT>
or
<TD VALIGN= TOP>
or
<TH ALIGN= CENTER VALIGN= MIDDLE>
Specifying Cell Size
The Cell Size can be specified in two ways:
1. As a percentage of  the browser window.
2. As a fixed size in the number of pixels.
For example, a cell size which has been set to 50% of the
browser window will be wider or narrower depending upon the
screen resolution and on the size of  the browser window. In

such a case the size of the Cell will be relative to the size of the
browser window.
While if the cell size has been set to a fixed number of pixels,
lets say, 200 pixels, then it will be exactly that wide in the
browsers regardless of the resolution and size of the browser
window.
Here is a description of  the TABLE Width and Text Wrap
attributes

Table Width 
Attribute 

Usage 

WIDTH= 
"n" 

Specifies the width of a cell 
in either pixels or as a 
percentage of table width. 

NOWRAP Prohibits text wrapping 
within the cell, thus 
requiring all text to appear 
on one line. 

Again use these attributes with the <TH> or <TD> tags to
control the TABLE WIDTH and text wrap.
Cell Spacing and Cell Padding
Cell spacing is the spacing between the cells & Cell padding is
the spacing between cell contents and cell borders.
Here is the description of the Cell Spacing & Cell Padding
attributes:

Attribute Usage 

CELLSPACING= 
n 

Specifies, in pixels, the space 
between cells. 

CELLPADDING= 
n 

Specifies, in pixels, the space 
between cell contents and cell 
borders. 

Adding more space within and between cells with these
attributes will help improve the readability and appearance of
the Table.
These attributes are again included within the <TABLE> tag
like this:

LESSON 15:
ADVANCED HTML-2
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<TABLE CELLSPACING= 5 CELLPADDING = 4
BORDER= 3>

The complete source code for the above table which includes the
CELLSPACING & CELLPADDING attributes of  the TABLE
tag is here:
<HTML>
<HEAD> <TITLE> Tables in HTML </TITLE> </
HEAD>
<BODY>
<h2> Tables in HTML </h2>
<TABLE CELLSPACING= 5 CELLPADDING = 4
BORDER= 3 BGCOLOR= “#CCFFFF” >
<TR>
<TH> Subject </TH>
<TH> Maximum Marks </TH>
<TH> Marks Obtained </TH>
<TH> Remarks <TH>
</TR>
<TR>
<TD> Mathematics </TD>
<TD>100 </TD>
<TD> 80 </TD>
<TD>Pass </TD>
</TR>
<TR>
<TD> Physics </TD>
<TD> 200 </TD>
<TD> 150 </TD>
<TD>Pass</TD>
</TR
<TR>
<TD> Chemistry </TD>
<TD>100</TD>
<TD>70</TD>
<TD>Pass</TD>
</TR>

<TR>
<TD> Sanskrit </TD>
<TD> 150 </TD>
<TD> 90 </TD>
<TD>Pass </TD>
</TR>
</TABLE></BODY>
</HTML>

Specifying Table Alignment & Width
Table width, alignment and text wrap settings specify how the
table fits into the HTML document.
These attributes along with their description is provided here:

Attribute Usage 

WIDTH= n Specifies table width in 
pixels or as a percentage of 
the window width. 

ALIGN= "…" Specifies table alignment as 
LEFT, CENTER, RIGHT. 

Again these attributes should be used as shown below:
<TABLE WIDTH=70% ALIGN= “RIGHT”>
Lets say we use the following source code with WIDTH and
ALIGN attributes to TABLE as given below:
<HTML>
<HEAD> <TITLE> Tables in HTML </TITLE> </
HEAD>
<BODY>
<h2> Tables in HTML </h2>
<TABLE WIDTH=70% ALIGN= “RIGHT”
CELLSPACING= 5 CELLPADDING = 4 BORDER= 3
BGCOLOR= “#CCFFFF” >
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<TR>
<TH> Subject </TH>
<TH> Maximum Marks </TH>
<TH> Marks Obtained </TH>
<TH> Remarks <TH>
</TR>
<TR>
<TD> Mathematics </TD>
<TD>100 </TD>
<TD> 80 </TD>
<TD>Pass </TD>
</TR>
<TR>
<TD> Physics </TD>
<TD> 200 </TD>
<TD> 150 </TD>
<TD>Pass</TD>
</TR
<TR>
<TD> Chemistry </TD>
<TD>100</TD>
<TD>70</TD>
<TD>Pass</TD>
</TR>
<TR>
<TD> Sanskrit </TD>
<TD> 150 </TD>
<TD> 90 </TD>
<TD>Pass </TD>
</TR>
</TABLE>
 
</BODY>
</HTML>
The resulting Table will appear like this:

 

Adding Frames
Frame is a feature in HTML which allows a single browser
window to be divided into multiple sections, each with an
independent HTML page loaded inside it, and these HTML
pages can interact with each other. Each page loaded within each
section of the frames window is a separate HTML document.
Subdividing browser window can dramatically improve both
the appearance and the usability of the site. For example,
because frames group information, visitors can more easily find
what they want.

 6.1 Advantages of using Frames
Frames widely supported by a number of browsers, offer a
number of advantages, both to users and developers.
1. Frames are widely used on the Internet and are perceived as a

hallmark of a technically sophisticated site.
2. Frames can be implemented to accommodate older browsers

that can’t actually display frames, so you can also serve all
visitors to your site.

3. Frames reduce downloading time. Visitors can download
only the content pages- and not static elements such as logos
and navigation menus.

4. Frames improve site usability. Navigation remains visible as
content changes in a separate frame.

5. As the frames separate content from navigation elements
and structural elements, you can easily and quickly update
pages and provide new content More about Frames in
HTML in the Next Chapter
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Assignment
1. What are site genres?
2. Add new rows and columns to your already developed web

document
3. Add Borders to the tables of your webpage?
4. Keeping care of the overall look of the page, apply table

border color and background color?
5. Adjust new cell alignment for your webpage?
6. What is cell padding, explain with example?
7. What are frames in HTML? What are the advantages?

Notes
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Topics Covered
• Site elements, Different  kinds of  Home pages, Graphics or

Text, Master  Page layout Grids, Evaluation of HTML,
Evaluation Test –Theoretical and Lab Exercise

Objectives
Upon completion of this lesson, you should be able to:
• Identify different layouts for Home pages
• Define Splash Screens
• Choose between Graphics or Text for your home page
• Design Master page layout Grid
• Final roundup of  HTML

Site Elements
Web sites vary enormously in their style, content, organization,
and purpose, but all Web sites that are designed primarily to act
as information resources share certain characteristics.

Home pages
All Web sites are organized around a home page that acts as a
logical point of  entry into the system of  Web pages in a site. In
hierarchical organizations, the home page sits at the top of the
chart, and all pages in the Web site should contain a direct link
back to the home page. The World Wide Web URL for a home
page is the Web “address” that points users to the Web site. In
many cases, home page addresses are used more than home and
business street addresses.
The thirty square inches at the top of a home page comprise the
most visible area of  the Web site. Most readers will be looking
at your site on a seventeen- to nineteen-inch monitor, and the
top four or five vertical inches are all that is sure to be visible on
their screens. The best visual metaphor here is to a newspaper
page - position matters. It’s nice to be on the front page, but
stories “above the fold” are much more visible than those
below. In sites designed for efficient navigation the density of
links at the top of the home page should be maximal — you’ll
never get a better chance to offer your readers exactly what they
want in the first page they see:
Home pages perform a variety of functions. Some designs
primarily take advantage of the high visibility of the home
page; it’s the most visited page of  your site and is therefore ideal
for posting news and information. The high visibility of the
home page also makes it the ideal place to put a menu of links
or table of contents for the site. Navigation schemes in sites
that use the home page for news and menu listings are often
centered on the home page, using it as the “home base” for
most navigation through the site. Other home page designs use
the home page as the first opportunity to steer audiences into
subtopic or special interest areas of the site. The following are
the most common home page design strategies:

Menu home pages

Menu-like lists of links dominated the design of most home
pages in the first few years of the Web, and this remains the
most common type of home page. Menu-style pages need not
be dominated by plain lists of text-based HTML links —
graphic imagemaps are often more space efficient, packing the
maximal number of links into every square inch of the page.
Sophisticated designs combine graphic imagemaps and blocks
of  text-based links. Text links offer less visual impact but are
much easier to change on short notice.

LESSON 16:
ROUNDING UP HTML
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News oriented home pages
The home pages of such organizations as the New York Times
and CNN (Cable News Network) are obvious examples here,
but many organizations take advantage of the high visibility of
their home pages to make announcements to both employees
and the larger Web audience. Live information makes a home
page more attractive and more likely to generate repeat visits.
Many home page designs reserve one or more areas for late-
breaking news, calendar events, or alert messages. If you choose
this approach, standardize the location and nature of the news
areas within a general page framework that remains stable over
time. Readers will be disoriented if your home page changes
too much from week to week.

Path-based home pages
Large Web sites offer so much information to so many
audiences that it can be impossible to represent the depth and
breadth of the site content in a single home page. In addition,
readers often come to a Web site with specific interests or goals
in mind. In such cases it is often advantageous to use the home
page to split the audience immediately into interest groups and
to offer them specific, more relevant information in menu pages
deeper within the site.

Splash screens
Splash screens, or site covers, are the most controversial of all
site elements. For many readers, site covers are simply an
additional and annoying mouse click between them and the
content they are seeking. Such readers would like to be presented
with a site index at the start rather than a splash screen with
pretty graphics or spiffy animations. The key is to assess your
audience and then choose the entry that seems most
appropriate.
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Consider the function of your site. Is your typical visitor there
for a single visit or will they visit often? An online tool such as a
calendar or search engine should not have a purely aesthetic site
cover, because visitors may visit the site several times a day. An
elegant but nonfunctional cover on such a site will soon become
tedious. Of course, visitors who do not wish to enter through
the front door can simply bookmark an internal page of your
site, such as the table of contents. But if you find yourself
repeatedly making this argument for using a splash screen, you
may wish to adapt or even remove your cover to better
accommodate your audience.

The success of splash screens depends enormously on the
expectations of the site visitor. If you were to visit a site about
a poet you would enter with different expectations than you
would when visiting a site about carpal tunnel syndrome.
Visitors to a site about poetry may not simply be out Web
foraging but may instead be looking for an experience, for art,
for entertainment. A mysterious, enigmatic, aesthetically
pleasing facade might just entice such visitors in.
One of these four basic schemes may dominate the home page
design, but increasingly home pages are a complex amalgam of
all strategies. The library of congress’s thomas home page mixes
images, menu lists, and special interest sections:

Graphics or text?
The primary layout decision you will make about your home
page is how heavily you will use graphics on the page. Most
corporate, institutional, and education home pages display at
least a small graphic banner across the top of the home page,
and in commercial sites the trend is rapidly moving toward
complex mixtures of links embedded in graphic imagemaps
and links in text that emulate the look and functions of CD-
ROM multimedia title pages or print magazines. Although
strong graphics can be effective at grabbing a browser’s
attention, large graphic menus impose long loading times for
pages, especially for users linking to the Internet via modems or
slow network connections. Even if the user is accessing your
Web site at Ethernet speeds, graphic menus may still load many
times slower than text-based lists of links.
This dichotomy between slow-loading but attractive graphics-
based home pages and fast-loading but prosaic text-based
home pages also reflects the need to address multiple audiences
with different expectations. The goals for most Web sites are to
transmit internal information (to students, employees, and
clients) and to communicate with potential clients and the
general Web-browsing public. The Guggenheim Museum has
opted for a graphic home page design, but the layout is carefully
designed to stay within the dimensions of the average office
monitor. Because the graphic area is moderately sized, the page
loads reasonably quickly for a graphic menu:
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The relatively plain, mostly text-based home page for the World
Wide Web Consortium offers an efficient ratio of  links per
kilobyte of page size, but at some cost in pure visual appeal.
The page is fast-loading and well designed for its audience of
Web specialists but would not attract the average browser
through presentation alone:

The best way to meet the needs of both casual browsers and
highly targeted frequent users is to present alternative views of
your Web site. One approach is to make a visually attractive
main home page aimed at the general audience of  Web
browsers but also to offer a more text-oriented alternate home
page that emphasizes rapid access to information via detailed
text menus. Another approach is to use a graphic banner at the
top of the home page, followed by a set of text-based links.
The home page for The Atlantic Online reflects this dual
approach, with a moderate-sized graphic image topping a well-
organized set of text links:

Many Web users who access the Internet via modems choose
not to load graphics and thus will not see menu links
embedded in image map graphics. If you choose to depend on
links embedded in image maps, it is crucial to provide
alternative text-based links that will remain visible even if
readers have chosen to turn off the display of graphics. Many
sites provide these text-based links in small sizes below the
page footer, where they are accessible but do not disrupt the
overall design of the page:

The master page layout grid
The home page usually gets the most attention in the
beginning of  a Web site design project. Your home page is
important, but remember- it is inherently singular. Don’t let the
design of the home page dominate your site design strategies.
When designing a large Web site it’s much more important to
concentrate on the standard layout grid that all the internal
pages of the site will share. After all, you’ll have only one home
page, but you could easily have thousands of internal pages as
the site grows. If you make a mistake on the home page you
only have one page to fix. If you make a mistake in creating the
basic internal page grid you could soon have thousands of
pages to fix. The overall success of  the Web site will depend
more on a strong, logical page grid than on the appeal of the
site’s home page. The details of  page layout grids are discussed
in the following chapters, but we raise the issue of page grids
here because it is a crucial design decision when creating a Web
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site. Think about it: if you tire of your home page, you have
only one page to change. Make a big mistake with your page
grid and you could end up with thousands of poorly designed
pages.
Constructing a layout grid usually begins by analyzing the
content structure you have worked out and deciding what
(besides the all-important home page link) you will need for the
most general navigation purposes. Here you are trying to
establish what links will be present and generally useful on every
page of  your Web site. If  you work in a corporation or any
sizeable government or nonprofit enterprise you must also
consider how your particular site fits into the larger context of
the other Web sites in your enterprise. Does your enterprise
already have an established and successful Web design format
that you can adopt? If not, carefully consider what links, logos,
and other graphic and functional elements reflecting your place
in the larger enterprise should be present on all of your pages.
The goal is to establish a logical and consistent approach to
where basic graphic identity elements, navigation links, and
other essential information appear on every page within your
site. Terminology is also crucial here: choose your words
carefully for links and titles, and solicit comments and feedback
from fellow team members and site users. A misleading or
confusing label or phrase can ruin the functionality of a link.
A page grid establishes the number, location, and terminology
of all major page links and page graphic elements:

Note that so far we have not discussed specific graphic elements
in relation to the page grid. A page grid can be used to enforce a
very rigid, visually consistent identity scheme by incorporating
information on the exact graphics, logos, fonts, colors, and
wording of page elements:
Illustration: Complex Yale-New Haven Hospital intranet
interface layout grid (large graphic, opens in new window)

However, a page grid is also a great way to allow a variety of
visual approaches to site design within an enterprise while
maintaining a reasonably consistent navigational interface for
the user. All three of these pages, though they use a variety of
colors and graphic schemes, share the same underlying page grid
that specifies the position and wording of major navigation
links and other page elements:

info.med.yale.edu, its.med.yale.edu/wdd, and
its.med.yale.edu

After establishing the internal page grid you can build the site
home page on the same underlying grid, so that readers who
come to your site are immediately introduced to the page grid,
identity graphics, and navigation scheme that is used
throughout the site. The home page grid does not have to be
identical to the internal page grid; home pages must provide a
much wider range of content and navigation elements than the
average internal page. For this reason home pages are often
much wider to fill the screen and more graphic than the average
internal page:
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Computer Lab

Rounding Up HTML
All this four weeks, we have covered all aspects of HTML which
includes Fundamentals to the Advanced HTML; we will cover
the Frames and Style Sheets using Dreamweaver. This is the
best time to evaluate ourselves. So, today we will round up
HTML and its elements.
The evaluation test will consists of a Class test and Lab exercise.
I would rather like you to practice and go through the following
aspects of HTML:
• ELEMents Of  A Web Page
• Overview Of Html
• Creating A New Html Document
• Saving An Html Document
• Viewing An Html Document
• Tags And Attributes
• Basic Html Document Components
• Body Text

Lab Exercise
Give final touches to your personal home pages and add the
following elements to it:
• A Brief Biography
• Your Hobbies listed in an ordered list
• Your best friends listed  in an  unordered list
• Photographs of  yourselves and Family with aligned Text

• Use Horizontal Rulers to divide sections of your home page
• Add links to your favorite websites

Summary
This lesson is aimed at differentiating the different layout plans
of home pages designed for a particular audience. There is also
Evaluation Test -1, where we evaluate ourselves both
theoretically and hands on in the lab. We follow up with the
final touches of our personal home pages.

Notes
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Topics Covered
• Menus and sub sites, Site guides – Table of contents or site

Index, site maps, Searching features in websites, Rounding
Up HTML – 2

Objectives
Upon completion of this lesson, you should be able to:
• Define Menus and sub  sites
• Create site guides using either Table of  contents or site

index.
• Create Site maps.
• Searching features
• Evaluation Test - 2

Menus and Sub sites
Unless your site is small you will probably need a number of
submenu pages that users enter from a general category listing
on your home page. In complex sites with multiple topic areas
it is not practical to burden the home page with dozens of links
- the page grows too long to load in a timely manner, and its
sheer complexity may be off-putting to many users. Providing a
submenu page for each topic will create a mini-home page for
each section of the site. For specialized, detailed submenus you
could even encourage frequent users to link there directly. In this
way the submenus will become alternate home pages in
“subsites” oriented to a specific audience. Be sure to include a
basic set of links to other sections of the site on each subsite
home page, and always include a link back to your main
organization home page.

Site Gguides
Unlike print media, where the physical heft and dimensions of
a book or magazine give instant cues to the amount of
information to expect, Web sites often give few explicit
indications of the depth and extent of the content available.
This is especially true when the home page does not provide an
extensive listing of internal site links. Although search facilities
offer users quick access to your content, they are no substitute
for a clear, well-organized exposition of  your site’s contents.
Even the best search engines are relatively stupid and have only
the most primitive means of  assessing the priority, relevance,
and interrelations of the information resources you offer in
your Web site.

Tables of contents or site indexes
Tables of contents and keyword indexes of  the information in
your Web site are an easy way to give readers a clear sense of  the
extent, organization, and context of  your site content. Tables of
contents and indexes are familiar print conventions; readers
understand them and will appreciate the overviews,
perspectives, and efficient navigation they afford. The main
difference between Web-based indexes and their print
counterparts is that a Web site index need not be as extensive or
detailed as a book index because you can always use a search
engine to find every obscure reference to a keyword. A Web site
index should point to the most relevant and useful occurrences
of a keyword and ignore minor references (those will turn up in
a keyword search anyway).

Site maps
Site maps give the reader an overview of  the site contents. Site
maps come in two varieties: graphic diagrams that literally use

LESSON 17:
ROUNDING UP HTML-2



86

E
-M

E
D

IA

the “map” metaphor and organized list links to major pages
within the site.
The form of graphic site maps varies from hierarchical
branching diagrams to geographic metaphors, but they all share
the same limitations:
• Graphic maps of  large or complex Web sites are at best

simple metaphors that convey only the approximate outlines
of the site content. Computer screens offer limited space, so
site map graphics tend to oversimplify and exaggerate
hierarchies of information. The results are seldom worth the
time and expense involved in making the graphic, unless you
mean to convey only the broadest outlines of the site
structure. Unless your Web site deals with information that
is inherently spatial (a set of maps, for instance), text-based
tables of contents or indexes will always be more efficient
and informative.

• Graphic site maps are often complex graphic files, which are
harder to change as your site evolves.

• Graphic site maps are inherently large graphics and are slow
to download.

Site maps based on carefully organized text links of major
menus and submenu pages and major page titles are much
more informative than graphic maps and can easily be updated
as your site matures. Most effective text site maps are really just
expanded tables of contents. As such they are instantly familiar
and understood by the vast majority of the readers in your
audience. Bitstream’s site map is a particularly well designed
example of this type:

“What’s new?” pages
Many Web sites need to be updated frequently so that the
information they present doesn’t become stale. But the presence
of new information may not be obvious to readers unless you
make a systematic effort to inform them. If items that appear
on your home page menu are updated, you could place a “new”
graphic next to each updated item. If, however, your site is
complex, with many levels of information spread over dozens
(or hundreds) of  pages, you might consider making a “What’s

New” page designed specifically to inform users of updated
information throughout the site.
Every Web page in a corporate or institutional site should carry a
revision date that is changed each time the page is updated so
that users can be sure they have the latest version. Many readers
print pages from the Web. Without a revision date, your readers
have no way of telling whether the page they printed is current
or outdated.

Search Features
Search facilities are a necessity for large sites and are convenient
even for smaller sites that contain long documents. Sites that are
updated frequently also require a good search engine, because
your menus and site index will probably not keep pace with
every change you make in the content pages of the site. But
search engines are no substitute for a carefully organized
browsing structure of menus and submenus. The two systems,
browsing by menu and searching by keyword, complement each
other -neither system alone is adequate. Keyword searches give
the reader specific links to follow but with no overview of  the
nature and extent of your content and no feel for how you have
organized the information. Menus and tables of contents are
great for broad overviews, but if  your readers are looking for a
specific piece of information not mentioned in the contents,
they may miss what you have to offer.
The search software you use will often dictate the user interface
for searching. If  you update your content frequently, be sure
that your search engine’s indexing is done at least daily. Also be
sure that your readers understand exactly what content is being
searched: the entire Web site or just a subsection? If  your site is
complex you may wish to offer readers a pop-up menu that
lists the areas of your site and allows them to limit their search
to a specific area. And make sure that the results page also
matches the graphic design of the site.

Computer Lab

Rounding Up Html
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All this four weeks, we have covered all aspects of HTML which
includes Fundamentals to the Advanced HTML; we will cover
the Frames and Style Sheets using Dreamweaver. This is the
best time to evaluate ourselves. So, today we will round up
HTML and its elements.
The evaluation test – 2 will consist of a Class test and Lab
exercise. I would rather like you to practice and go through the
following aspects of HTML:
• Elemens of a good website desing
• Why graphics?
• Image constraints
• Ways of  anchoring links
• Inserting email links  from your page
• Activating an image
• Tables in html
• Frames – an introduction

Lab Exercise
Give final touches to your personal home pages and add the
following elements to it:
• Add anchoring links within your web site
• Insert email link to your friends in your personal home page
• Use Inline Image as links
• Add table formatting your personal detail
• Use appropriate background color to your tables
• Use Cell padding and Table alignment

Summary
This lesson gave you the idea about Menus  and  sub sites, Site
guides like Table of  contents and site index. It also taught you
about site maps, searching  features in a  websites. Finally we
round  up HTML completely with the Evaluation Test – 2.

Notes
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Topics Covered
• FAQ pages, Bibliographies and appendixes, custom server

error pages, contact information and user feedback,
Introduction to Dreamweaver work area, The Toolbox.

Objectives
Upon completion of this lesson, you should be able to:
• Identify FAQ pages  and what thy area all about.
• Create Bibliographies and appendixes
• Understand user feedback forms
• Identify the functionalities of Dreamweaver work

environment
• Identify The Dream weaver’s toolbox

FAQ Pages
The Web and other Internet-based media have evolved a unique
institution, the FAQ or “frequently asked questions” page,
where the most commonly asked questions from users are
listed along with answers. FAQ pages are ideal for Web sites
designed to provide support and information to a working
group within an institution or to a professional or trade group
that maintains a central office staff. Most questions from new
users have been asked and answered many times before. A well-
designed FAQ page can improve users’ understanding of  the
information and services offered and reduce demands on your
support staff.

Bibliographies And Appendixes
The concept of “documents” in electronic environments like
the Web is flexible, and the economics and logistics of  digital
publishing make it possible to provide information without
the costs associated with printing paper documents. Making a
report available to colleagues on paper usually means printing a
copy for each person, so costs and practicality dictate that paper
reports be concise and with limited supporting material.
Bibliographies, glossaries, or appendixes that might be too
bulky to load into a task force report or committee
recommendations document can instead be placed in a Web
site, making the information available to colleagues as needed.

Custom Server Error Pages
Most Web users are familiar with the “404 error, file not found”
screens that pop up on the screen when a Web server is unable
to locate a page. The file may be missing because the author has
moved or deleted it, or the reader may simply have typed or
copied the URL of the page incorrectly. One mark of  a really
polished Web site is custom-designed and useful error and
server message pages. Most standard error screens are generic,
ugly, and uninformative. A well-designed error screen should be
consistent with the graphic look and feel of  the rest of  the Web
site. The page should offer some likely explanations for the
error, suggest alternatives, and provide links to the local home
page, site index, or search page:

Contact information and user feedback
The Web is a bidirectional medium - people expect to be able to
send you comments, questions, and suggestions. Always
provide at least one link to an email address in a prominent
location in your site. You can request user information and
feedback using Web page forms and then use a database to
store and analyze their input.
The logistical and support staff implications of creating a
popular Web site are often overlooked until a crisis develops.
Rolling out a new, heavily trafficked Web site is like suddenly
adding a second front door to your enterprise. Who will greet
the people who come flooding in? Who will answer their
questions about your organization and its products and
services? Who will collect and analyze the information you
receive from your readers? Before you add this functionality to
your Web pages, be sure you have an infrastructure in place to
handle the fruits of your success.

Street Addresses, Phone Numbers, Fax Numbers
It is amazing how often site developers forget that not all
communication with the organization goes through the Web
site. Even if  you have a great Web site, people will still want to
call you, send you mail and express packages, and fax you
documents. Your home page should include the same contact
information you provide on your stationery, marketing
materials, and business cards. If your home page design
doesn’t allow adequate space for this information, at least
provide a link to another page with contact information.

Maps, Travel Directions, Parking Information
Your Web site is an ideal place to make travel information
available to clients, visitors, vendors - anyone who needs to find
your organization. Graphic maps, text-based directions, local
hotel information, and even internal floor plans can ensure that
your visitors will be able to reach you easily and efficiently.

LESSON 18:
SITE ELEMENTS
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Computer Lab

Dreamweaver
Dreamweaver is considered a WYSIWYG (what-you-see-is-
what-you-get) program because of its visual interface. What sets
Dreamweaver apart from many other design tools is its tag
editing features. For this reason Dreamweaver is usually the
preferred tool for developers who are proficient in HTML.
In addition to always having an HTML code window just a click
away, Dreamweaver also has a built in tag editor, an option to
use an external HTML editor, and when elements are copied to
the clipboard, they are copied in HTML format.
Take a guided tour of Dreamweaver
Before you get started, watch the Guided Tour movies to
familiarize yourself  with the Web development process and
with Dreamweaver features.
1. In Dreamweaver, choose Help > Guided Tour.
2. Click a movie title.
3. Close the movie when you finish.

The Dreamweaver work area
Let’s start with a brief  overview of  the Dreamweaver work area.
• If you haven’t already launched Dreamweaver, double-click

the Dreamweaver icon to launch it.
The Dreamweaver work area accommodates different styles of
working and levels of expertise. When you launch
Dreamweaver, the following work area items open:

Toolbars
Dreamweaver has 3 primary toolbars: Objects, Properties and
Launcher. The Objects Toolbar allows you to insert objects with
the click of  a mouse. The Properties Toolbar is the most
important of them all. It is used to specify attributes on the
selected object. The Launcher Toolbar opens different palettes.

The Properties Toolbar

This is the toolbar you will use most often. This is where you
specify attributes for the object you are working with. An object
is anything HTML element. Text is an object, as is a graphic, a
list, a table and a form. Options on the toolbar change
according to the active object. The figure above is the default if
no object is selected. As you can see, most of the default
options have to do with the presentation of text.
When the ‘More’ arrow on the lower right corner is selected, the
Toolbar doubles in size, with some advanced options.

With no objects selected, there are no advanced options.

Here we show the toolbar with an image selected. As you can
tell, the options have all changed. There are fields for width and

height dimensions, links, vertical space, horizontal space,
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alignment, maps ... These are all Advanced Options that will be

explained later in ttutorial.

The Objects Toolbar
The Objects toolbar is where you can easily insert many HTML
objects. With this toolbar you can insert images, tables,
horizontal rules, layers, applets, active x, plugins, Flash,
Shockwave and rollovers.
You can also toggle the items in this toolbar by clicking on the
arrow near the top. This brings up a sub-menu where you can
change to Forms, Head, and Invisibles. With Forms you can
add standard form objects. With the Head Objects, you can
define your meta tags and other information that appears in the
<HEAD> container. With the Invisible Objects you can add
anchors, comments, scripts and more.
Unless you author with a large monitor, I recommend you keep
this toolbar closed to avoid clutter in your work area. I’ve found
the more workspace I have, the easier it is to work and the
better the results.

The Launcher

This is an easy way to launch certain palettes and windows
within Dreamweaver. You should note that this toolbar also
resides in the lower right corner of the Dreamweaver window
without the text descriptions. I recommend that you learn what
the icons mean, then remove this toolbar from your workspace.

Site - This is where you can manage your site.
Library - Here you can keep a collection of  objects just by
dragging them into the window. You can also maintain
templates here.
Styles - Here you can specify and apply Style Sheets
Behaviors - Here you can define and apply Javascript Behaviors
Timeline - Here you can control Dynamic HTML animations
HTML - Here you can view and edit the source code of the
document

Assignment
1. What are FAQ pages?
2. What should be  there in the contact information?
3. Why is User feedback important?
4. What is Dreamweaver?

Notes
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Topics Covered
• Clarity and Vitality, How can you trust in your website, Page

Design Tips, Menu commands in Dreamweaver, Preferences
setting in Dreamweaver.

Objectives
Upon completion of this lesson, you should be able to:
• Create the look and feel of  Websites
• Create Trust in your website
• Get some page tips
• Identify Menu commands in Dreamweaver
• Set Preferences in Dreamweaver

Clarity-vitality...  The Look And Feel Of

Websites
As we surf  the web, we are somewhat awed by the myriad
expressions of design which are evident (we shall not discuss
the sites which are, quite simply, not designed). We come across
clean, crisp, and beautiful sites which convey a lot of
information in an easy to navigate manner. Then there are the
sites, which are cluttered, discordant and somewhat confusing.
Still others which are zany and dynamic, ‘happening’ sites where
colours, concepts, visuals, text, coalesce and flow in harmony.
Sites designed by people from all around the world. From
designers who experiment with a new medium and absorb it as
part of  their portfolio of services, to the new genre of  web
masters and designers who live and breathe the WWW.
(We shall not go into the merits of  frames, navigation bars on
the left, right, centre, top, bottom et al or whether a page scrolls
endlessly or not).
It is quite evident today, that some designers advocate clarity
and order in design, while others lay emphasis on visual vitality.
At Iris, we believe that good design achieves a comfortable
blend of the two-a fresh appealing look, with a clear emphatic
message.
There is no universal rule for designing and creating effective
websites. The medium is evolving and so is its design. The key
is appropriateness. Are the graphics and design appropriate for
the tone and content of the message, the intention of the
sender, the requirements of the medium, the needs, desires,
and orientation of the receiver? Some messages need to lay
emphasis on clarity, others on vitality and still others, on a
blend of  the two.
Subjectivity and aesthetics come easily to many artists and
designers. But, analyzing a message and its purpose requires
objectivity-the ability to evaluate whether the design is exciting
and strong, clear or beautiful, and, at the same time, whether it
is really the most effective way of saying what needs to be said
to those we need to reach.

So often, the messages we send out are enveloped in a clutter of
noise. Noise, in communication theory, is anything that reduces
and interferes with the comprehension of the message by the
recipients. It can be wavy lines on the TV screen, static on the
radio, broken links or a slow page on the Internet. In graphics it
can be a confusion of elements with inadequate organization,
or illegible type, or a picture that conveys the wrong impression,
or a presentation that is too plain or too much like others that it
fails to get noticed and read. One must remember that the role
of design is to be noticed and communicate information to the
receiver.
Browsing through the web reveals a wide range of designs that
work very well. In the best sites, the graphics enhance rather that
obscure the clarity of the message content of the site. Beauty
and utility are both vital facets of communication design. It is
appearance that makes a message noticed, read, enjoyed,
believed and remembered. Where as the graphic look establishes
that crucial first impression.

How to create trust in your website

‘As the internet develops and matures, its success will largely
depend on gaining and maintaining the trust of visitors’
(Cheskin Research, January 1999)
There’s an active debate over what constitutes trust online,
mostly prompted by the fact that startup e-commerce
companies realize they’re losing sales because no one trusts
them – only 10 per cent of respondents to the Cheskin e-
commerce trust survey felt that there was little or no risk when
purchasing on the web.
Part of a reason why trust is such an issue with consumers is
because of the unfamiliar and insecure online environment.
The good news is that charities have always operated on trust
and so have a head start on many online traders. One story
quoted by Michael Johnston in The Fundraiser’s Guide to the
Internet, for example, tells of a Greenpeace donor to who had
not made an online transaction before, but did trust the
Greenpeace name enough to assume it would be alright this
time.
The bad news is that for established charities, this head start is
very easy to lose online, and for smaller or newer charities, it’s
difficult to gain. While some methods of building trust are
obvious, for example offering guarantees of privacy and
security, others are less so. The basics of  these are outlined
below.

Trustworthiness is about experience over time
‘Trust is understood by most consumers to be a dynamic
process – it deepens or retreats based on experience’, reports a
Cheskin Research study on eCommerce. ‘The trusting process
begins when an individual perceives indications that a firm may
be worthy of trust’.

LESSON 19:
PAGE DESIGN-1
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These indications might come through its manners,
professionalism and sensitivity. Over time, the Cheskin study
reports, these become ‘character traits’ such as dependability,
reliability and honesty.
It follows that once a charity has a creditable site, the times it can
persuade visitors to return, the higher the levels of trust that
will be generated.

Trustworthiness is about good site design
The clarity and integrity of navigation, as well as being features
of a ‘good experience’ online (see separate section >>), also
help create an atmosphere of security and trust in the site.
Cheskin Research separate the attributes of navigation
‘trustworthiness’ into:
• Navigation clarity - the terminologies for navigation and

content are apparent for the user to differentiate
• Navigation access - navigation placement is consistent,

persistent and easy to find
• Navigation reinforcement - prompts, guides, tutorials and

instructions aid and inform the user to perform a transaction
or search.

Cheskin also highlight the importance of good, solid page
design. A site should resemble other trusted sites, should look
‘crafted’ rather than thrown together, and visuals and layout
should clearly convey a site’s idea and purpose.

Trustworthiness is about your confidence and

honesty

The web is an open medium, and users expect your site to be
open. Have confidence in your site. Don’t be afraid to link it to
others you feel might be of use to your visitors – you’ll be
doing users a service by filtering through a lot of the rubbish,
and they might well return to your site as a ‘gateway’ site. It also
gives a sense of  a shared cause and community. Besides this, as
Nielsen points out, it’s naive to expect that people won’t look at
other sources for their information anyway.
It’s also about transparency. If  there are failings with your site or
service, don’t gloss over them, let your users know onsite that
you’re aware of  the problems and are trying to fix them.

Trustworthiness Is About Fulfillment
Cheskin advise that if you quickly and efficiently deliver users
what you promise – whether this is merchandise or a particular
on-line service – this will increase their confidence in your
services. If  you don’t deliver, then you risk creating a fatal rift.
Part of this fulfilment is related to the information you
provide. If  it’s inaccurate, out of  date or too shallow, you’re not
fulfilling your expected role as a provider of information.

Trustworthiness Is About Persistent Branding
Make sure your logo appears on every page, advises Cheskin.
This not only helps navigation and establishes the identity of
your site, it also creates an online identity for your charity, and
gives your name an emotional resonance.

Page Design Tips
Regardless of how advanced you are at using HTML code,
images, and animations, in order to take advantage of these
useful tools you must pay careful attention to how you layout

your web pages. That being said, it is equally important that you
realize that there is much more to effective page layout than
simply creating a nice looking page. The following tips will help
you make the most out of your images, and allow you to create
logically organized, user-friendly web pages.
Keep Important Sections Above the Fold
One of the keys to successful web page design is keeping all
important text and images above the fold. All significant
information should be accessible to users without scrolling
down the page, and should be organized in a logical, easy to
follow manner. For example, at Host Search, our most
important function is our search function, which is available to
users on the first page, above the fold. Information that needs
to be kept above the fold includes the name of the site, the site
logo, and any sections of content or pages that you wish to
promote to users. Remember, this is the part of your site that
your users will see first, so plan carefully because in the Internet
world, first impressions really do last a lifetime.

Make Sure Text is Readable
In many web sites today, the combination of  text and images is
extremely common, and a good way to get the most out of
each space on your web page. That being said, it is extremely
important to make certain that all text which is combined with
images is readable by users. Perhaps the best way to achieve this
goal is to use contrasting text and image colors, and to blur the
background image. By blurring the background image, you are
in effect drawing attention to the clear part of the image, which
is the text, thus getting the most out of both the image and the
text. In addition, this tactic also helps to reduce the size of these
combined images, allowing your page to load faster.

Create Grid Layers
When designing your page, it is a good idea to create your page
all at once, and save it as a single file. Although the file will end
up being rather large, it will give you a good idea of the look
and feel of the page. After you have your page laid out, create a
new upper-most layer using a graphics program, and set it to
low opacity. Next, draw blocks on that layer using a color to
mark the edges of the images on the page. Using these blocks
as a guide, you can then make changes to the images below. The
layer of sblocks will help you keep your page consistent, and are
extremely useful for dynamic pages.

Avoid Wide Text Columns
When designing your web pages, it is a good idea to avoid
wide, margin-to-margin text blocks, which take up a lot of
space and can put off readers. Instead, lay out longer text stories
in narrow vertical columns. Also try to avoid putting long
vertical columns side by side, as it will make the reader scroll up
and down the page.

Use Sub-categories
In order to avoid large text blocks, break up text into smaller
sub-categories. This will assure that your pages are more
aesthetically pleasing, and more reader-friendly. Sub-categories
also allow readers to select certain portions of content that they
are interested in, rather than making them sift through large text
blocks.
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Dreamweaver

Menu Commands
Dreamweaver has many of the standard menus as other
programs: File, Edit, View, Insert, Modify, Text, Commands,
Window and Help. Just about everything in the program can be
accessed via a menu command.

The File Menu
Under the file menu you can manage your documents, by
saving, opening, creating new documents, etc. There are also
many unique commands specific to Dreamweaver.
Import/Export - You can import XML into a template, export
editable regions (of a template) as XML, and export CSS styles.
More import/export features can be added by using plugins.
Convert - You can convert your document to 3.0 browser
compatible or you can convert tables to layers.
Preview in Browser - You can check your document in your
browser of  choice. You can also define browsers here. When
you get comfortable working in Dreamweaver, you’ll find
yourself checking your work in the browser often. The shortcut
keys are F12 for the primary browser and Command (CTRL for
PC) F12 for the secondary browser.
Check Links - Here you can make sure all the links within the
current document are intact. You can also check links sitewide.
The shortcut keys are Command (CTRL) F7 for the open
document or Command F8 for the entire site.
Check Target Browsers - You can use this feature to check the
compatibility of your document with a browser of your choice.
Dreamweaver will check the HTML in your document for
compliance with the browser you choose, and will generate an
HTML report showing errors.
Recent Documents - There is always a list of the last few
documents you worked on with Dreamweaver. You can easily
re-open the document by selecting its name from the File
Menu.

The Edit Menu

Undo/Redo - Here you can undo or redo a previous action.
Shortcut keys are Command (CTRL) Z for undo and
Command (CTRL) Y for redo.
Cut/Copy - Places the selected item on the clipboard. If Cut is
selected, the item is removed from the document. Any object
can be copied to the clipboard, including HTML elements
(forms, tables). Shortcut keys are Command (CTRL) X for Cut,
or Command (CTRL) C for copy.
Paste - Pastes an item from the clipboard. The shortcut key is
Command (CTRL) V.
Paste as Text - This is useful when the clipboard contains
HTML or other code Dreamweaver would recognize. If you
want to display the code in the document, select this option. By
default, Dreamweaver will paste the code into the source of the
document and it will be applied immediately.
Launch External Editor - This is where you can launch the
HTML editor of your choice, whether it be BBEdit, Simpletext,

Homesite or Notepad. The default editor is specified in
Preferences.
Preferences - Here is where you specify application preferences,
such as editors, HTML, and more. We will be discussing the
Preferences dialog in detail in the next section.
Find/Find Next/Replace - This is where Dreamweaver will
look for a specific string of text (you define). This is a powerful
feature when working with large sites. We will be discussing this
feature in more detail later.
The View Menu
Here you can change aspects of how your workspace is
displayed.
Head Contents - With this selected, a toolbar appears at the
top of your document just below the menus. Here you can
quickly add or modify elements that belong in the <HEAD>
of  the HTML document, such as Meta Tags, Javascripts and
Styles.
You can learn more about the <HEAD> of  an document here.
Invisible Elements - These are elements that cannot be seen
on the page, such as Styles, Comments, Hidden Fields, etc.
Dreamweaver will use a symbol to show that an object is
present (see below). If View | Invisible Objects are selected,
they will be displayed in your workspace like the icon below.
Rulers/Grids - You can turn rulers and grids on and off. You
can also specify which unit to measure by. Pixels is
recommended.
Layer/Table/Frame Borders - By default, Dreamweaver has
an outline border for all these elements. You may turn them
off here.
The Insert Menu
This is where you insert objects to your page. You can insert
images, tables, horizontal rules, layers, active x, plugins, Flash,
Shockwave, rollovers, forms, form objects, anchors, columns,
scripts, line breaks, non breaking space, server side includes and
<HEAD> elements.
We will be discussing many of  these in more detail later in the
tutorial.
Modify
This is where you modify certain elements of the page, such as
Tables, Frames and more. We will be discussing these in more
detail as we start creating documents.
Text
This is where text can be formatted. Many of these same
commands are mirrored on the Properties Palette while working
with text. We’ll also be discussing this in more detail as we work
more with documents.
Commands
This is where you’ll find some Dreamweaver specific
commands.
Clean up HTML - Here you can remove redundant and empty
tags, non-Dreamweaver tags or specific tags. This feature comes
in handy when working with a document either created by
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someone else or by another WYSIWYG code generating
program that inserts proprietary tags.
Apply Source Formatting - Here you can apply HTML
formatting settings to the document.
Set Color Scheme - Here you can choose from pre-set color
schemes within Dreamweaver.
Sort Table - Here you can sort elements within a table.
Format Table - Here you will find more advanced table
formatting options.

Window
Here is where you can open toolbars and palettes, such as
Properties and Site Files. You can also hide the palettes or
arrange them. There is also a list of documents currently open
within the program. This makes it easier to work with more
than one document at a time.

Help
We hope you won’t need this ;)
Preferences

This is where you set your application preferences. We
recommend you change these settings before doing any serious
work in Dreamweaver. It’ll make your work easier in the long
run. We’re not going to cover every single option within this
dialog box. Most of  the options are self  explanatory. We’ll take
a deeper look at just a few of the most important options.
General - We recommend you have ‘Show Site Window Only
On Startup.’ The site window is where it all begins within
Dreamweaver. This is where you should manage all your files.
It’s also easy for first-timers to close the application
inadvertently when closing a document. When the Site Window
is open, the application remains open.
We also recommend that you make sure the ‘Add Extension
When Saving’ box checked. You can use either .htm or .html.
Some browsers will not recognize an HTML document without
the extension. It’s quite easy for Mac users to leave the extension
off, since they don’t require it to open the file.
External Editors - Here is where you specify which HTML
editor to use when modifying the code. Dreamweaver bundles

with BBEdit for the Mac and Homesite for the PC. These are
the two strongest tag editors out there, so we recommend these
for managing the code. If you want something lighter weight,
you can use Simpletext or Notepad, depending on your
platform.
To specify which program, just click on the browse button and
navigate to the application file. Once you’ve found it, double
click and that’s it.
You can also specify an image editor. You can use Photoshop,
or an image optimizer such as Image Ready or Fireworks. We
recommend the latter. This makes it easier to optimize your
images on the fly. Simply bring them into Dreamweaver, select
them, and click on Edit. They can then be optimized in your
program of choice, with little interruption.
HTML Format - For those who want their code just so, this is
where you specify how Dreamweaver will handle it. We all have
our preferences, a tab here, a space there. If you communicate
your preferences correctly to Dreamweaver, it will feel like it was
handcoded when you bring it into your favorite editor.
HTML Rewriting - Dreamweaver can fix mistakes, but it can
also be wrong on occasion. If you feel you know more than
Dreamweaver, tell it so right here. It can prompt you when it
finds a mistake, or it can ignore the mistake entirely. I’ve found
Dreamweaver to be fairly accurate when reporting mistakes, so I
have it prompt me when it finds one.
Invisible Elements - As mentioned above, Dreamweaver can
show you invisible elements with that pretty yellow icon. Here
is where you specify which ones it shows you. It might not be
necessary for it to show you each line break. Personally I like to
know everything that’s there. But it’s up to you to decide.
Preview in Browser - As already mentioned, this can be
defined from the File Menu. Here is another place where you
can specify which browsers are primary and secondary.
Site FTP - Yes, you can even upload your site using
Dreamweaver. This is where you set your communication
preferences for the FTP client, such as a Firewall, if you have
one. You can also define how long to wait for timeouts, etc.
Status Bar - I’ve found this is to be a useful feature. What I
check most is the download time of different modems.
Dreamweaver will display the size of the page and the
download time for the page and all it’s elements in the status
bar. You just have to specify the modem speed, which depends
on your audience.
You should browse through the rest of the Preferences.
Everyone’s different, so some might be more important to you
than the average user. Now that you’re finished, let’s start
working.
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Topics Covered
• Designing Effectively, Design Tips, Site Management in

Dreamweaver, Site Maps, Working with Site Maps

Objectives
Upon completion of this lesson, you should be able to:
• Balance Artistic design with practical functionality.
• Build a consistent website design
• Manage Website HTML codes through Site Manager in

Dreamweaver
• Understand the utility of Site Maps

Designing Effectively
Now that you know what web design and related terms mean,
lets get down to the real thing: Designing Effectively How to
balance artistic design with practicality and functionality.

Use of Graphics and Content
Unless your website is all about graphics, how to make them,
edit them or just a bunch of links to graphics websites, I
suggest you use graphics sparingly, especially the flashing,
twirling kind. They not only detract readers from the content,
but they also take ages to load. You do not want your readers to
leave your website because your graphically attractive page does
not seem to load fast enough. Then again, too much text is
boring. So mix and match the graphics and text on your page,
having enough white space so that the page is not plain
annoying.

Layout and Design
While designing, keep in mind that poor layout and design will
make your pages unreadable and difficult to keep your visitors
on your website for long. Some of  the things that make a poor
design and layout:
3. Text that is too small to read
4. Color combinations of text and background that make the

text hard to read
5. Large graphic files that take forever to load
6. Multiple things that blink
7. Unclear navigation; over complex navigation
8. Paragraphs of type in all caps, bold, and italic all at once
9. Graphics that don’t fit on the screen (assuming a screen of

640x460 pixels)
10.Animations that never stop
11.Complicated frames, too many frames, unnecessary scroll

bars in frames
12.Cluttered, not enough alignment of elements
Some of the things that make a webpage stand out from the
crowd:
13.Stay away from bad design features listed above.
14.Background does not interrupt the text

15.Navigation buttons and bars are easy to understand and use
16.Good use of graphic elements (photos, subheads, pull

quotes) to break up large areas of text
17.A large site has an index or site map
18.Link colors coordinate with page color
19.Every graphic link has a matching text link
20.Animated graphics turn off by themselves
21.Pages download quickly
22.All pages have the immediate visual impact within 640 x 460

pixels

Planning
Most of the time, all it takes to design your website effectively is
a little planning. When designing a website, it needs to be clean,
uncluttered, attractive and easy for users to read and find what
they need. Begin with a webdesign plan:
24.what colors do you want to use?
25.Are these colors complimentary?
26.What items - text, images, data - do you want to put in your

pages?
27.What layout do you want? Look at other websites and then

decide.

Site Design Tips
When developing the look and feel of your web site, perhaps
the most important thing to keep in mind is consistency. A
consistent web site not only lets users know where they are, but
can also help to establish brand awareness, and allows for
continuity regardless of who is working on your site at any
given time. The following easy-to-follow tips have been
designed to make sure your site gets started down the road to
web success!

Consistency: The Key to Web Success
The most important aspect of web site design is without a
doubt establishing consistency. In order to successfully establish
consistency within your web site, try using database templates
to create a common look and feel for your site. Although
database templates are not the answer for all web sites, and may
not be practical for smaller sites, it is extremely important for all
pages in your site to share common elements, and exhibit a
high degree of  page-to-page consistency. The advantage of
database templates is that they are extremely easy to create, and
make your site consistent regardless of changes in personnel.
Database templates also allow you to make changes to your site
much more easily, and allow you to change certain elements
without recreating the entire page from scratch.
If you are creating a smaller site, you will have a bit more leeway
to work with, however you should still aim to maximize
consistency. Consistency can help give your site a more
professional look and feel, and also makes for easy navigation.
Logos

LESSON 20:
PAGE DESIGN-2
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Another important aspect of site design is the placement of
company logos or other symbols of your site that will be used
to create brand awareness. By placing logos in a common
position on all your web pages, users will be able to easily
determine that they are at your site. Many sites still do not
recognize the importance of this, however if you follow this
simple rule of  thumb, your site will have a much greater chance
of establishing itself among users.

Use Common Images
In the Internet business, speed is king, and you can help to
decrease the loading time of your web site by using common
images on your pages. If you use common images, your site
will load faster because the images which have already appeared
on a previous page will be loaded from browser caches, rather
than from the server itself. This decreases the number of  files
to be loaded from the server, and thus decreases loading time.
If you must change images from page to page, try to use
common elements from other pages in order to decrease
loading time. This tactic is especially useful for title bars, which
can be broken up into individual images. When a new page is
loaded, the elements from the old page are loaded from the
cache, leaving only the new elements to be loaded.

Prioritize Site Content
Another useful tip which can help make your site design more
effective is to prioritize all content and images. By doing so, you
will be able to attract the user’s attention to the important
aspects of your site, and thus ensure that the things you want
to be seen are seen first. Once you have prioritized your site,
make sure to place the most important sections near the top of
your page, and make them larger in size
By following these four simple tips, you will not only help
make your site more professional in appearance, but will also
help to decrease loading time, and establish brand awareness
among your users. Site design is an enormous task, and requires
a great deal of though and planning, however, these simple tips
will help put you on the right track to establishing a successful
Internet presence.

Computer Lab

Dreamweaver

Site Management
Site management is an essential part of  a Webmaster’s job
description. Far from static designs, the Web site is not like a
magazine advertisement that you’re finished with as soon as
you send the file to the printer. Publishing your Web site pages
on the Internet is really just the first step in an ongoing-often
day-to-day-management task. Dreamweaver includes an
integrated but separate window known as the Site window to
handle all your Web management needs. With the Site window,
you can do the following:
• Transfer files to your remote site from your local

development site and back again
• Issue system commands to enable CGI programs on the

server
• Monitor your Web site for broken links and orphaned files
• Check a file in or out during team Web development

Site Management with Dreamweaver

At the simplest level, site management means transferring your
files from the local drive to a publishing server. To help the
Dreamweaver developer cope with these issues and avoid the
type of frustration they can produce, a useful site management
tool is included within Dreamweaver: the Site window. Its key
features include the following:
• A quick, visual view of the elements of your site on your

local and remote directories
• Fast drag-and-drop functionality for transferring files with

dependent file support
• Site management check-in and check-out tools for groups

working on files within the same    web site
• A Link Checker that helps you identify broken or unused

objects being posted to your site
• A Site Map that enables you to both visualize your Web site

structure and alter it
To begin managing your site, simply select ‘Site Files’ from the
Window Menu (or hit F5).

This is where you add and modify files and directories on your
site. You can also upload your files via FTP, generate a site map,
and change links sitewide.
Before you begin, you must first define the site. You do this in
the Pop-up window in the toolbar (in the screen shot it says
‘tutorial’). Select define sites, which will bring up the following
dialog box:
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You may define as many sites as you like and they can be
accessed via the popup menu. Since you most likely don’t have
any sites already, press the ‘New’ button. Now you’ll see the
following dialog box:

Here you give the site a name, define the local path, the remote
path and choose whether you want to use Cache to speed link
updates (recommended).
You can also specify your FTP server, Web Server, configure
your site map, and specify whether you would like to Check
Files In and Out. The latter is usually only relevant when other
people (a team) are working within the same site.
So now that you have defined your site, you will notice that all
the of the files and folders within the directory you chose are in
the site window.
We recommend you add and modify files through this window.
You’ll understand why shortly.
A great way to create your site is by using Context menus.
Context menus are activated either by right-clicking (PC) or
CTRL-click (Mac). With Context Menus, one can add, rename or
delete files and folders as well as check browsers and links. All
of the context menu commands are also offered through the
File Menu.
To add a file using the context menus, simply select ‘New File’.
Dreamweaver will not only create the file, but will also add the
necessary HTML tags in order to be a valid HTML file.
When beginning a project, we recommend adding the necessary
files and folders first. This can be done quickly using the context
menus. First create the home page file (‘index.html’) in the root

directory. Then create folders for subsequent pages and sections,
and a folder for images and support files.
A typical business site might be organized like this (folders are
in [ ] brackets):
[about]
[contact]
[images]
[links]
[services]
index.html
Once the appropriate folders have been created, create a file
inside each one of  them, including graphics. To do this, simply
highlight the folder, access the Context menu and select ‘New
File.’ This will place the file inside the folder selected. For now,
there’s no need to modify the files. You can leave them as is.
Make sure each folder has an ‘index.html’ file.
So what’s the benefit of  creating/moving files within the Site
Files window? There are several benefits. First of all,
Dreamweaver will immediately add the file/folder to it’s site
cache, which will make it easier to change and update links.
If a file is moved outside of Dreamweaver, links will not be
updated. Sometimes Dreamweaver will detect links as being
absolute local rather than relative. When this happens,
everything will work fine locally, but when placed online, the
links will all be pointing to file:///(something).
Also, when a new file is created, Dreamweaver adds necessary
tags for it to be a valid HTML document. Dreamweaver adds
the following:
<html>
<head>
<title>Untitled Document</title>
<meta http-equiv=”Content-Type” content=”text/html;
charset=iso-8859-1">
</head>
<body bgcolor=”#FFFFFF”>
</body>
</html>
If files are created in the Finder or Explorer, all the tags except
for <html> must be added.
Files can be moved throughout the site in two different ways.
1. Drag and Drop - Click on the file and drag it over a folder.

When that folder is highlighted, release the mouse button.
2. Cut and Paste - Select a File, hit CTRL (Command) X, or go

to the Edit Menu and select ‘Cut’. Find the folder you would
like to move the file, select it and either hit CTRL
(Command) V or go to the Edit Menu and select ‘paste.’

Files can also be copied by using the Copy and Paste feature.
Select a file, hit CTRL (Command) C or go to the Edit Menu
and select ‘Copy’. Find the folder you would like to move the
file and then hit CTRL (Command) V.
Files can also be copied within the same folder by Copying and
Pasting. Dreamweaver will add ‘Copy of ’ to the beginning of
the file name. This can be useful when you wish to use the
same look and feel as another file. Simply copy the file, rename
it, then modify it.
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Only one file can be pasted from the clipboard at a time. If you
wish to copy and paste the same file multiple times, you must
re-copy it for every paste.
When a file is moved, Dreamweaver will check its site cache for
links to that file. If there are links to that file, you will be shown
a list of  pages linking to it. You can easily change the links by
pressing the Update button. This is the largest advantage of
moving files within Dreamweaver.
We also recommend that if files be deleted, you delete them
within Dreamweaver. To delete a file or folder, simply select it
and either use the Context Menu and select ‘Delete’ or hit the
delete key on your keyboard. Dreamweaver will then check the
site cache to see if there are any other files within the site
pointing to the file you are planning to delete. If there are, you
will be informed that links will be broken by continuing. You
will be given the option to continue with the delete or cancel. If
you do not get a warning dialog box, you may safely delete the
file.
Dreamweaver can also generate a complete map of your site.
This is done by either going to the Window menu and selecting
‘Site Map’ or by clicking on the sitemap icon in the toolbar.

Working with the Site Map
A Web site consists primarily of  pages linked to other pages,
which in turn can be linked to more pages. The more complex
the site, the more difficult it becomes to comprehend-or
remember-the entire structure when looking at just a directory
listing.
With Dreamweaver, you can easily view your entire Web site and
its links as a hierarchical tree using the Site Map feature. Not
only do problems such as broken links jump out at you-after
all, they’re depicted in red-but also the Site Map can give you a
much needed overview of  the entire site. Poor site design can
lead to visitors getting “lost” or frustrated with the number of
links it takes to get to an important page. Dreamweaver’s Site
Map gives you a visual reference and enables you to create the
structure for entire sites in a point-and-click environment.

The site map is useful in many ways.
It’s a different perspective of  your site. By viewing your site
map, you can see how a visitor would navigate throughout your
site.
It’s another way to manage files and links. Since the map is
structured by the way files are linked, you can easily change the
link from one file to another. Select the linked file, access the
context menu, and select ‘Change Link.’ You will then be
prompted for a new file to link to. You can also remove or hide
links in this manner.
You can generate a graphic to either put online or for your own
reference. To generate a graphic, simply go to the File Menu and
select ‘Save Site Map As’. You will then be prompted for a
filename. Site maps can be saved as either a Bitmap (BMP) or a
PNG file.
The Site Map is a graphical representation of your site, with all
its Web pages symbolized by icons, as shown in Figure 7-10.
The Site Map resembles both an organizational chart and a flow
chart. The Web site’s home page is shown at the top of  the
chart. A link from one page to another is represented by a
connecting line with an arrowhead. Any document, other than
the home page, that is linked to additional pages indicates these

pages with a plus or minus symbol in Windows systems and a
right or down arrow in Macintosh systems. By default,
Dreamweaver displays your Site Map only two levels deep.
Selecting the plus/minus (arrow) symbols shows and hides the
view of the linked pages on deeper levels.

Notes
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Topics Covered
• Site Design (Quality), Style Guide - Giving a Voice, Page

Layout and Design, Dreamweaver : Understanding how
HTML work, Setting Page properties

Objectives
Upon completion of this lesson, you should be able to:
• Add Quality in site designing
• Check for General guidelines in style Guide
• Page layout and Design
• Understand how HTML works in Dreamweaver
• Set Page Properties according to your requirement.

Site Design: Designing in Quality
Quality isn’t something you apply to a finished web site like
wood sealer on a new deck: a good site has quality designed in
and built in.
Any particular site will have its own unique scale and meaning
for “quality”, because quality is a measurement of a complex
relationship of goals, purposes, audience needs, execution of
design, and other issues specific to that site. I can’t define web
site quality in such a way that it maps to all web sites or reflects
the views of all customers, but I can say that certain attitudes
and decisions on the parts of web building teams will have a
noticeable positive effect on the perceived quality of any web
site.
While the following points are not the express responsibility of
quality assurance, QA does speak for the user, and should stand
in for the user during decisions that will have a strong effect on
the user experience. Quality assurance should work to get the
site going in a good direction from the get-go.

Form an Empowered Team
A site requires resources to create and maintain, and your team
should be your most valuable resources. Use job descriptions
that make sense, and use job descriptions that are appropriate
to the task.
Here are a couple of good articles on finding and keeping good
web teams:
• http://www.hotwired.com/webmonkey/98/22/

index0a.html
• http://www.hotwired.com/webmonkey/98/01/

index0a.html

Decide on - and agree to - a plan
Any company doing business on the web should have a
mission statement, or statement of direction. It is very
difficult to map out future work and strategies without a clear
message from on high about where the company intends to go.
One of these statements will provide some stability from which
the web site can springboard forward.

Every serious web site must have some explicit goals describing
just what the site is about - what’s the purpose of  the site? who
is the site’s audience? How will success be measured?
The best intentions and a cool design aren’t going to sustain
your development and production processes if you are missing
a concrete statement of your goals for the site and what it
should do. Without a clear direction and goals, a web site
cannot deliver a consistent, steady message to customers; hardly
a platform for quality.

Identify and understand your customers
Unless you’re building a vanity home page, even more
important than having a product to sell or a story to tell is
having somebody to sell or tell it to. You must define who your
audience is; if possible, gather feedback and involve your
audience in your design process.

Architect your information space for the user
Information architecture describes the organization of your
information - whether it happens to be the products you sell or
the articles you make available - and the way your site is
structured to facilitate access to this information. Will your
information be accessed through a search function, or through a
table of contents? Will users routinely need to click through
several levels of information to get to what they want to see?
Study your audience’s interaction with your site’s information
space, and design the presentation of the information to
accommodate the users’ modes of interaction. Make it easy to
find stuff.

Define the Requirements and Specifications
Requirements detail the objectives for a web site project;
requirements describe what the web site is supposed to do, what
functions should be created, what tasks the user should be able
to accomplish. Specifications explain how the requirements are
supposed be implemented and completed. These two kinds of
instructions are essential to the successful completion of any
web site project

Document your standards and styles
Standards are essential to the quality of any site: standards tell
coders and writers what the acceptable ranges of performance
are. Standards allow you to set a definition of “quality” for your
site, give you a landmark to measure performance against, and
give you a measure you can refine as you better learn what your
users need and what your team can provide.
Style is the way your site presents its unique way of looking at
things; style is the “voice” your site uses to address its audience.
If your site needs a specific voice and tone in order to fulfill its
relationship with the user correctly, then codify and document
the elements of style that comprise this voice

Some General Comments on Style Guides
Anything that goes into making your web site distinctive
should be analyzed, understood and documented, because one

LESSON 21:
SITE DESIGN QUALITY
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of the keys to maintaining a successful site is the ability to
reproduce that which makes it successful in the first place. If
your audience loves your site because of its “sassy” attitude,
find out what goes into making it sassy. If  your audience trusts
your site because it speaks with authority, look at what creates its
aura of  authority.
Every successful site has some fundamental product, message,
service or function that appeals to its audience; successful sites
package their information in a style that reflects their own special
voice, sense of  community, relationship to their audience,
design imperatives - in short, a site’s style is its personality.
Successful web sites have identities created through the style and
voice of their content, and these identities will benefit from a
consistency of presentation. The best way to achieve this
consistency is with a style guide. And of course, formal style
guides provide benchmarks for the site’s quality team to test
against.
The hidden danger in designing style guides is the potential for
conflating content with interface. For many sites, content is the
product or message of the site, so content should be presented
in such a way as to maximize the impact. But sites also have an
infrastructure with navigation schemes and purely functional
elements - don’t monkey with navigation unless you know your
audience can handle the deviations from familiar standards.

Creating a “Voice”
A great site finds a voice that speaks to its specific audience in
exactly the right tone; a great site creates a style guide to help its
writers and content providers maintain this consistency of
presentation.
A style guide doesn’t have to be complicated; the authors
simply decide on certain goals for content, and agree to some
consistent rules for grammar and word choice. For example, if
your voice is best served by using the word “website” instead
of the words “web site”, make it official. If the content team
decides that end punctuation rightfully belongs outside closing
quotes, so be it. If your content is purposefully irreverent,
specify the limits, if  any, to the degree of  irreverence allowed.
The point is to decide on a shared approach to style, and to
implement this approach in a consistent manner.
A good example of a style guide for a particular voice is the
book Wired Style: Principles of English Usage in the Digital
Age. While this book describes well the making of Wired
Magazine’s distinctive voice and attitude, it is much less useful
as a primer for web style precisely because it documents Wired’s
style: A web site’s style guide must come from the teams and
corporate culture that created it, so adopting an external style
will hurt the site’s purpose for being. I appreciate Wired’s
iconoclastic approach to voice, but I think they do a disservice
by not explicitly differentiating between content and site
infrastructure:
...we encourage you to do the following: Welcome inconsistency,
especially in the interest of  voice and cadence. Treat the
institutions and players in your world with a dose of
irreverence. Play with grammar and syntax. Appreciate
unruliness.
(page 96)
In your style guide, keep content voice distinct from any voice
you have for navigation and other infrastructure elements; your

content is too valuable to create barriers blocking your audience
from accessing it.

Page Layout and Design
Just as voice plays a role in defining a site’s identity, so too does
the “look and feel” of the pages and divisions of your site.
Most pages combine content with functional, branding and
navigation elements. The most common page layout on the
web is probably the “navigation on the left, content on the
right” theme made famous by C|NET.
Usability analysis teaches that “typical” users are easily
confounded by certain common design pitfalls; to be fair, some
of these pitfalls are due to the limits of HTML as a layout
language, or to the unclear boundaries between the page being
viewed and the browser application that displays it. Every
designer must make some key decisions on the layout of pages,
the inclusion and placement of navigation and branding
elements, the appearance of text on the pages, and the order in
which pages should be viewed; the designer’s challenge is to
make decisions that result in an appropriate experience for the
target audience.
Designers must develop a style guide for the look and feel that
they want: if a set of font faces is used for a specific category of
element, document it. If the navigation scheme requires a
specific color combination, document exactly which colors
belong in which circumstances. A formal style guide that
specifies how the pages are to look provides a benchmark for
quality control to test against; even more importantly, though, a
formal style guide provides a baseline that quality assurance can
work with to suggest improvements.

More Online Examples
Here are some examples of style guides that discuss design
considerations and the reasons behind making certain decisions;
please note that these are exit links, pointing at external web
sites.
Web Style Manual from Yale University School of Medicine’s
Center for Advanced Instructional Media (C/AIM)
According to the authors Patrick Lynch and Sarah Horton, this
very strong site was created “to approach Web page and site
design as a challenge that combines traditional editorial
approaches to documents with graphic design, user interface
design, information design, and the technical authoring skills
required to optimize the HTML code, graphics, and text within
Web pages.”
(http://wwwwseast2.usec.sun.com/styleguide/)Sun
Microsystem’s Guide to Web Style
From the authors: “This is a cookbook for helping people
create better web pages. The guidelines presented here represent
the opinions and preferences of a small group of people within
Sun who have created some web pages, and have looked at
many more. We’ve drawn from our own observations,
opinions and judgements about what makes web pages better
or worse, as well as extrapolating from the existing body of
usability and user interface design literature.” (The above URL is
no longer valid, and I haven’t found a replacement.)
Webmonkey’s “The Foundations of  Web Design”
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Author Jeffrey Veen: “...we’ve learned a tremendous amount
about how to do what we do. It seemed only natural to collect
and rigorously evaluate our principles for Web design.”

Computer Lab

Dreamweaver

Understanding How Html Works
In a perfect world, you could lay out the most complex Website
with a visual authoring tool and never have to see the HTML,
much less code in it. Dreamweaver takes you a long way toward
this goal-in fact, you can create many types of  Web pages using
only Dreamweaver’s Document window. As your pages become
more complex, however, you will probably need to tweak your
HTML just a tad.
The HTML page is divided into two primary sections: the
<head> and the <body>. Information relating to the entire
document goes in the <head> section: the title, description,
keywords, and any language subroutines that may be called
from within the <body>. The content of  the Web page is
found in the <body> section. All the text, graphics, embedded
animations, Java applets, and other elements of the page are
found between the opening <body> and the closing </body>
tags. When you start a new document in Dreamweaver, the
basic format is already laid out for you. Here below we show
you the code from a Dreamweaver blank Web page.
The HTML for a New Dreamweaver Page
<html>
<head>
<title>Untitled Document</title>
<meta http-equiv=”Content-Type” content=”text/html;
charset=iso-8859-1”>
</head>
<body bgcolor=”#FFFFFF” text=”#000000”>
</body>
</html>
Notice how the <head>...</head> pair is separate from the
<body>...</body> pair, and that both are contained within
the <html>...</html> tags. Also notice that the <body> tag
has two additional elements:
bgcolor=”#FFFFFF”
and
text=”#000000”
These types of elements are known as attributes. Attributes
modify the basic tag and either can be equal to a value or can
stand alone; in this example, the first attribute, bgcolor, is set to
a hexadecimal number that represents the color white and the
second, text, is set to the hexadecimal value for black. Thus, this
attribute sets the background color of the body—the page—to
white and the default text color to black. Not every tag has
attributes, but when they do, the attributes are specific. One last
note about an HTML page: You are free to use carriage returns,
spaces, and tabs as needed to make your code more readable.
The interpreting browser ignores all but the included tags and
text to create your page. Some minor, browser-specific
differences in interpretation of these elements are pointed out

throughout the book, but by and large, you can indent or space
your code as you desire.
When you first start Dreamweaver, your default Web page is
untitled, with no background image but a plain white
background. You can change all these properties and more
through Dreamweaver’s Page Properties dialog box.

Page Properties
Now it’s time to begin working on your first page. Before you
begin with the page it’s best to define properties of  the page,
such as Colors and the Title. This can be done with the Page
Properties dialog.
The Page Properties can be found in the Modify menu, or with
the keyboard shortcut Command-J or CTRL-J.

The key areas of the Page Properties dialog box are as follows:
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Page Property   Description 
Title 
 

The title of your Web page. The name you enter here 
appears in the browser’s title bar when your page is 
viewed. Search engine spiders also read the title as one 
of the important indexing clues. 
 

Background Image 
 

The file name of the graphic you want in the page 
background. Either type in the path directly or pick a file 
by clicking the Browse (Choose) button. You can embed 
the graphic of your choice in the background of your 
page; if the image is smaller than your content requires, 
the browser tiles the image to fill out the page. Specifying 
a background image overrides any selection in the 
Background color field. 
 

Background 
 

Click this color swatch to change the background color of 
The Web page. Select one of the browser-safe colors from 
the pop-up menu, or enter its name or hexadecimal 
representation (for example, “#FFFFFF”) directly into the 
text box. 
 

Text 
 

Click this color swatch to control the color of default text. 
 

Links 
 

Click this color swatch to modify the color of any text 
designated as a link, or the border around an image link. 
 

Visited Links 
 

Click this color swatch to select the color that linked text 
changes to after a visitor to your Web page has selected 
that link and then returned to your page. 
 

Active Links 
 

Click this color swatch to choose the color to which 
linked text changes briefly when a user selects the link. 
 

Left Margin, Top Margin, 
Margin Width, Margin Height 
 

Enter values here to change the default margin settings 
used by browsers. The Left and Top Margin settings are 
used by Microsoft, whereas Margin Width and Margin 
Height are used by Netscape. 
 

Document Encoding 
 

The character set in which you want your Web page to be 
displayed. Choose one from the drop-down list. The 
default is Western (Latin 1). 
 

Tracing Image 
 

Selects an image to use as a layout guide. 
 

Image Transparency 
 

Sets the degree of transparency for the tracing image. 
 

 

The title is what appears on the top of the browser bar
In the ‘Background Image’ field you can specify a tiling image to
use for your background.
One can specify a Background color in the ‘Background’ field.
This number must be a hexadecimal value or one of the
standard colors. If you are unsure about the hexadecimal value,
you can pick from Dreamweaver’s Web Safe Color Palette.

You can also specify colors for Text, Links, Visited Links and
Active Links in the corresponding fields.
The Left Margin, Top Margin, Margin Width and Margin
Height fields are all used to determine how far the body of the
page is from the edge of the browser. This must be a number
in pixels.
As you can tell if you use 0 for all your margins, there no
spacing between the edges of the browser window and your
content.

The Document Encoding field is where you select the Character
Set for your page. If your page is in English you should leave
this at the default - Western (Latin1).
Dreamweaver handles Hexadecimal values and HTML standard
color names:
• Black
• Maroon
• Green
• Olive
• Navy
• Purple
• Teal
• Gray
• Silver
• Red
• Lime
• Yellow
• Blue
• Fuchsia
• Aqua
• White
Dreamweaver also offers many of its own built-in tools to
allow color selection to be much easier. These can be accessed
from many places within the program by clicking on this
button: 

This brings up the standard palette as well as a color picker. The
color picker can be used to pick a color from elsewhere on the
screen, including other open windows. All one must do is click
on a color and that will become the active color for the element
selected.
There are other tools available, such as the Color Dialog. This
can be accessed from the Text Menu by choosing Color. It can
also be accessed from the Color Palette:

Click on the circled icon to access the Color Dialog Box.
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From this dialog one can choose from all the colors in the bar
(most of them are web safe). RGB values can also be entered.
This is useful when working with graphics programs such as
Photoshop or Fireworks.
These colors can also be added to the ‘Custom Colors’ so that
they may be used again. To do this simply select an empty
(white) box under Custom colors, choose your color and click
on the ‘Add to Custom Colors’ button. This color can now be
used from the Color Dialog anytime.

Assignment
1. Write the means to create trust in your website?
2. Check the Menu commands  of  Dreamweaver?
3. Select the Preference options and check the current

requirement in your system?
4. Why is consistency important in Site Designing?
5. What are the key features of Site management by

Dreamweaver?
6. Create you home page file index.html using Dreamweaver?
7. What are site map? Explain why they are useful?
8. Start re conceptualizing your personal home page? Re

structure its design planning?
9. Write the guidelines for Style guide?
10.Explain the elements of a basic HTML page by

Dreamweaver?
11.What are the key areas of page properties?

Notes
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Topics Covered
• Bandwidth: History to Future, What is Broadband Internet
• Dreamweaver: Adding text to webpage, Heading, Paragraph,

the <br> tag.

Objectives
Upon completion of this lesson, you should be able to:
• Define Bandwidth
• The history to the future scope  of Bandwidth
• Define Broadband
• Clear out misconceptions on Broadband connection
• Add Text to your webpage
• Add Heading and Edit Paragraphs in the webpage
• Use the <br> tag

Bandwidth
Bandwidth: “The amount of data that can be transmitted in a
fixed amount of time. For digital devices, the bandwidth is
usually expressed in bits per second(BPS) or bytes per second.”
(http://www.webopedia.com/)
Bandwidth has been in the news lately. You may have seen
stories about “broadband Internet” services having difficulty
catching on throughout the U.S. (http://
www.washingtonpost.com/wp-dyn/articles/A45676-
2002Jan14.html). The word “broadband” is used to describe
Internet services which are faster than the normal dialup
connection. So what exactly is “bandwidth” and why should
you care? If you use the Internet, you may already know why
you should care, but maybe a further explanation here is in
order.

Bandwidth in History
In ancient times (around 1980), I first started using a modem
(or acoustic coupler, as they were called in those days) to connect
a terminal via a telephone line to a computer that was located in
another building. The fact that you could do such a thing at all
was remarkable. I’d dial the phone number, place the phone
handset in the acoustic coupler (in ancient times, all phones had
the same basic shape), and I’d be communicating with the
remote computer at 300 bits per second. 300 bits per second
allows about 30 characters to be transmitted every second.
That’s about 6 words per second or about 360 words per
minute. While this rate was slower than my reading speed, it
was still fast enough to work on computer programs, especially,
since programming languages tend to use either short or
abbreviated commands. You can imagine, my delight, however,
when that 300 BPS modem was replaced with a 1200 BPS
model.
Today, the Internet connection to my office operates at a transfer
speed of  100 Megabits per second. That’s 100 million bits per
second - I’ll do the math - that’s 333,333 times faster than that

300 BPS modem. This means that I can now receive text faster
than I can read it ( and often do). But more significantly, I can
pull up a web page and see a full-color photograph without
having to wait all afternoon for that photograph to be
transmitted. This gets us closer to why bandwidth is important.

Bandwidth to a “T”
Let’s explore for an example, the letter “T”. To transmit the
computer representation of the letter T requires one byte which
is eight bits (as in “bits per second”). But let’s suppose that we
want to send a black and white picture of the letter “T” that
takes up a 100 by 100 pixel space on a computer screen (if your
screen resolution is 800X600 imagine a square which is one-
eight the width of your screen). That picture would require
10,000 bits to represent. Let’s say we wanted to use a extremely
varied color pallet to decorate our T. We would need 32 bit
planes to represent all possible colors. That increases the size of
our T representation to 320,000 bits.
Suppose we wanted to animate our T for 5 seconds at 30
frames (or individual pictures) per second. We are now up to 48
million bits of  information for our one little T. To get this T
movie across campus from one computer to another would
theoretically take only one half  of  a second (that’s theoretical
because there are other factors which effect the actual speed that
data can be transmitted on a computer network). What if we
wanted to retrieve that “T” movie over that 300 BPS modem
from 20 years ago? It would only take 44 hours (almost 2 days).
The example above makes it clear that the Internet as we know
it today would not exist at a bandwidth of 300 bits per second.
Even though our black and white picture of the T could be
transferred in 33 seconds, a page full of black and white graphics
would take much longer. The color picture of the T would
transfer in about 17 minutes. But notice that the greatest leap
comes between that color picture and the animated version we
imagined above. In actuality, digital video technology employs
clever compression and other methodology for minimizing the
amount of bandwidth needed, however, to move beyond static
pictures and text still requires a great leap in available
bandwidth.

Bandwidth and Today’s Internet
On campus, we have quite a bit of bandwidth at our disposal
and yet it still seems that the Internet is sometimes kind of
slow. Although our campus network operates at 100 Megabits
per second, which is quite handy for moving information
around campus, our connection to the Internet operates at only
45 megabits per second. We have two such connections, but the
aggregate bandwidth is 90 megabits per second, still slower
than the on-campus network. But all over the Internet, many
web sites may be connected at an even slower speed. The time
that it takes your browser to contact a remote server and retrieve
a web page is dependent upon the lowest bandwidth
connection between you and that server and how much

LESSON 22:
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information is being transmitted across that connection (and
remember that there are millions of users on the Internet
transmitting millions of bits of information).
Most home Internet users still do so via a dialup modem. The
fastest dialup modems are rated at 56 kilobits per second. For
various reasons, it is unlikely that dialup modems will ever be
much faster than 56 KBPS. This is 1700 times slower than our
campus network. Still, at a theoretical 56 KBPS, it take only 14
minutes to transfer our imaginary “T” movie. This is a great
improvement over 20 years ago, but still not very practical. But
suppose you could have 384 KBPS available to you at home.
That brings our movie down to under three minutes to transfer
(assuming comparable bandwidth all the way to the source).
In actuality, the technical issues surrounding bandwidth and the
operation of the Internet are much more complex, but our
illustration above helps get a handle on why bandwidth matters
where the Internet’s development is concerned. To take the next
leap, which is the integration of  high-quality moving pictures
and sound with Internet content, will require an across the
board increase in available bandwidth, both within the core
Internet network and to individual homes. To do so requires,
requires a change in technology in home communications.

So how do I get my Bandwidth?
That change is coming, but it is coming slowly. It is coming so
far as only two alternatives. Digital Subscriber Line (DSL) service
from your local phone company can provide that 384 KBPS
bandwidth or even greater, while replacing your old analog voice
service. It allows you to talk on the phone and communicate
with the Internet at the same time. Unfortunately, because of
equipment limitations DSL is not available in all homes.
Furthermore, it costs an average of $50 per month which is
about twice what you’d pay for a typical analog phone line. The
only hope of that cost coming down is competition, however,
local phone companies are not known for inviting competition
into their service areas (quite the opposite).
That leaves your local cable company as the only possible
alternative for broadband service. My broadband cable service
increased in price from about $50 per month to about $75 per
month with no prior notification. My local cable company is
notorious for bad customer service and they lived up to that
reputation while I was trying to get my service disconnected.
Luckily, I was eligible for DSL service and am marveling at the
fact that I now consider Southwestern Bell to be one of the
easiest companies to deal with. Still, if they decide to arbitrarily
raise the price of  the service, I have no third alternative to select.

The future of Bandwidth
Without that next quantum leap in bandwidth availability, the
Internet remains a useful, but limited, information source. Just
imagine digital video conferencing as easy to do as sending e-
mail. Imagine posting movies of your kids on your personal
web site instead of just still pictures. But don’t stop there.
Imagine a room in your house which can create a virtual
environment and then create images of your family and friends
within that environment so that you can have a virtual get-
together with people conversing and coming and going as if the
room were real. We’re going to need a lot more bandwidth.

What On Earth Is? Broadband
Broadband: that’s fast internet access, right? Wrong. Well, wrong
as far as the true definition goes, which is why ISPs can call their
paltry 128Kbps services ‘broadband’ in their ads and get away
with it.
Strictly speaking, broadband has nothing to do with the
internet and it’s simply a term that refers to any high-bandwidth
connection. Well, we say ‘simply’ but unless you have a degree
in computer science, you’re probably still none the wiser.
Bandwidth is a measure of how much data that can be
transferred between two points at any one time. Writing has
more bandwidth than speech, for example, since you can usually
read a page in far less time than it takes to listen to someone
read it aloud.
Similarly, a publisher looking to distribute the latest batch of
Harry Potter books would opt for a high-bandwidth lorry (lots
of copies in the back) over a low-bandwidth motorcycle courier
(one copy in his satchel).
When it comes to computers, the introduction of kilobytes
(KB) and megabytes (MB) starts to complicate things but the
principles are the same.
A hard disk, for example, has much more bandwidth than a
floppy disk drive, since it can transfer around 41,000 pages of
Notepad text in one second (about 40MB, for those that are
interested). A floppy disk drive, on the other hand, can only
transfer around 500 pages (about 50KB) in the same amount
of time.
Internet connections are much the same. An ordinary telephone
line is slow at transferring data and, being low bandwidth, a
dial-up modem connection is often called ‘narrowband’. An
ADSL-converted telephone line or cable TV fibre optic line,
however, has lots of bandwidth, hence ‘broadband’.
Here comes the ‘but’: An internet connection may have lots of
bandwidth but that doesn’t mean its users have access to it.
Cable TV companies, for example, use most of their
bandwidth for delivering TV programmes and the rest is then
shared on a street-by-street basis for internet access.
That internet access might be fast (2Mbps with some ISPs) or it
might be slow (128Kbps for others) but since both are
delivered over a high-bandwidth connection, they’re both
technically broadband.

The science
We fibbed a bit when we explained how bandwidth applies to
internet connections in order to keep things simple. When it
comes to networking (an umbrella term under which all internet
connections fall), broadband really refers to how many signals
can be sent over a connection at the same time and that depends
on the range of available frequencies.
A fibre optic cable TV connection typically has 750MHz of
bandwidth, with each TV channel it carries requiring 6MHz a
piece. In other words, a cable TV service is limited to around a
100 TV channels.
For internet access, cable TV companies usually devote one
channel’s worth of  bandwidth for downloading and that gives
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a speed of up to 36Mbps, to be shared between everyone
connected to that particular bit of the network.
Less bandwidth is usually given over to uploads, since most
people download more data than they upload. Typically, a
broadband service downloads at 512Kbps and uploads at
128Kbps and most broadband services are therefore
‘asymmetrical’ networks.

The basics
Bandwidth isn’t an easy concept, so here’s a simple analogy.
Outside your house, under the road, is a large pipe that carries
hundreds of gallons of fresh water a second.
You, however, only have access to a fraction of that amount,
since the pipes that connect your taps to it are narrow, but that’s
still ample for most households.
Similarly, broadband ISPs maintain a ‘fat pipe’ (no, really) that
transfers dozens of megabytes of data each second - lots and
lots of bandwidth, in other words. That bandwidth is then
shared between the ISP’s customers, who are usually allocated
512Kbps each.
Unfortunately, just as a main water supply couldn’t maintain its
pressure if  every household it served turned all of  their taps on
at once, an ISP’s fat pipe lacks the bandwidth to provide every
customer’s full allocation at the same time.
Fortunately, most internet tasks - web browsing, email and so
on - are low bandwidth, which means there’s always some spare
capacity.
The system isn’t foolproof  though and if  you spend all day,
every day downloading enormous files, you’re hogging
bandwidth. Just imagine how you’d feel if  your shower slowed
to a drip while your neighbour turned on all of their taps to fill
their swimming pool.

Computer Lab

Dreamweaver

Adding Text To Your Web Page
If  content is king on the Web, then certainly style is queen-
together they rule hand in hand. Entering, editing, and
formatting text on a Web page is a major part of  a Webmaster’s
job. Dreamweaver gives you the tools to make the task as clear-
cut as possible. From headlines to comments, this chapter
covers the essentials of working with basic text.

Starting with Headings
Text in Hypertext Markup Language ( HTML) is primarily
composed of headings and paragraphs. Headings separate and
introduce major sections of the document, just as a newspaper
uses headlines to announce a story and subheads to provide
essential details. HTML has six levels of headings; the syntax
for the heading tags is <hn>, where n is a number from 1 to 6.
The largest heading is <h1> and the smallest is <h6>.
The sample headlines are shown below, it depict the basic
headings as rendered through Dreamweaver and as compared
to the default paragraph font size. As you can see, some
headings are rendered in type smaller than that used for the
default paragraph. Headings are usually displayed with a
boldface attribute.

Two methods set text as a particular heading size in
Dreamweaver. In both cases, you first need to select the text you
want to affect. If you are styling a single line or paragraph as a
heading, just position the cursor anywhere in the paragraph to
select it. If you want to convert more than one paragraph, click
and drag out your selection.
Once the text for the heading is selected, you can choose your
heading level by selecting Text->Paragraph Format and then
one of the Headings 1 through 6 from the submenu.
Alternatively, you can make your selection from the Text
Property Inspector. ( If  it’s not already open, display the
Property Inspector by selecting Window->Properties.) In the
Text Property Inspector, open the Format drop-down List as
shown below and choose one of the six headings.

You can convert any paragraph or line into a heading by using
the Format options in the Text Property Inspector.

Working with Paragraphs
Usually the bulk of  text on any Web page is composed of
paragraphs. Paragraphs in HTML are denoted by the <p> and
</p> pair of  tags. When your Web page is processed, the
browser formats everything between those two tags as one
paragraph and renders it to fit the user’s screen, word wrapping
as needed at the margins. Any additional line breaks and
unnecessary white space (beyond one space between words and
between sentences) in the HTML code are ignored.
Dreamweaver starts a new paragraph every time you press Enter
(Return) when composing text in the Document window. If
you have the Code view or the Code Inspector open when you
work, you can see that Dreamweaver inserts the following code
with each new paragraph:
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<p>&nbsp;</p>
The code between the tags creates a non breaking space that
enables the new line to be visible. You won’t see the new line if
you have just the paragraph tags with  nothing (neither a
character nor a character entity, such as &nbsp;) in between:
<p></p>
When you continue typing, Dreamweaver replaces the non
breaking space with your input, unless you press Enter (Return)
again.
The figure below illustrates two paragraphs with text and a
third paragraph with the non breaking space still in place.

Dreamweaver automatically wraps any text inserted into the
Document window. If  you press Enter (Return) without
entering text, Dreamweaver enters paragraph tags surrounding a
non breaking space.
You can easily change text from most other formats, such as a
heading, to paragraph format. First, select the text you want to
alter. Then, in the Property Inspector, open the Format options
drop-down list and choose Paragraph. You can also choose
Text->Paragraph Format->Paragraph from the menu or use the
keyboard shortcut Ctrl+Shift+P (Command+Shift+P).
All paragraphs are initially rendered on the page in the default
font at the default size. The user can designate these defaults
through the browser preferences, although most people don’t
bother to alter them. If you want to change the font name or
the font size for selected paragraphs explicitly, use the techniques
described in the upcoming section, “Styling Your Text.”

Editing Paragraphs
By and large, the editing features of Dreamweaver are similar to
other modern word processing programs—with one or two
Web-oriented twists. Dreamweaver has Cut, Copy, and Paste

options, as well as Undo and Redo commands. You can search
for and replace any text on your Web page under construction
and even check its spelling.
The “twists” come from the relationship between the Design
and Code views of the Document window, which give
Dreamweaver special functionality for copying and pasting text
and code. Let’s see how that works.

Inserting Text
You’ve already seen how you can position the cursor on the
page and directly enter text. In this sense, Dreamweaver acts like

a word processing program, rather
than a page layout program. On a
blank page, the cursor starts at the
top-left corner of  the page. Words
automatically wrap to the next line
when the text exceeds the right
margin. Press Enter (Return) to
end the current paragraph and start
the next one.

Indenting text
In Dreamweaver, you cannot
indent text as you can with a word
processor. Tabs normally have no
effect in HTML. To indent a
paragraph’s first line, one method
uses non breaking spaces, which
can be inserted with the keyboard
shortcut Ctrl+Shift+spacebar
(Command+Shift+spacebar). Non
breaking spaces are an essential part
of  any Web designer’s palette
because they provide single-
character spacing- often necessary to
nudge an image or other object
into alignment. You’ve already
seen the code for a non breaking

space-&nbsp;-that Dreamweaver inserts between the <p>...</
p> tag pair to make the line visible.
The <br> tag
As with headings, the paragraph tag falls among the class of
HTML objects called block elements. As such, any text marked
with the <p>...</p> tag pair is always rendered with an extra
line above and below the text, often called whitespace. To have a
series of blank lines appear one after the other, use the break tag
<br>. Multiple break tags may also be used to provide
whitespace between elements. Break tags are used within block
elements, such as headings and paragraphs, to provide a line
break where the <br> is inserted. Dreamweaver provides two
ways to insert a <br> tag: You can choose the Enter Line Break
button from the Characters panel of the Objects panel or you
can use the keyboard shortcut Shift+Enter (Shift+Return).
Figure below  demonstrates the effect of  the <br> tag. The
menu items in Column A on the left are the result of using the
<br> tag within a paragraph. In Column B on the right,
paragraph tags alone are used. The <h1> heading is also split at
the top (modified through style sheet selections) with a break
tag to avoid the insertion of an unwanted line. By default,
Dreamweaver marks <br> tags with a symbol: A gold shield
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with the letters BR and the standard Enter/Return symbol.
You can turn off  this display feature by choosing Preferences-
>Invisible Elements and deselecting the Line Breaks
checkbox.

Use break tags to wrap your lines without the additional line
spacing brought about by <p> tags.

Notes
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Topics Covered
• E-video – Internet video and technology convergence,

Steaming Media basics – Streaming, Buffering, Future
possibilities, Styling up your text with preformatted text in
Dreamweaver.

Objectives
Upon completion of this lesson, you should be able to:
• Define e-video
• Trace the technological convergence from VCR to the present

e-video
• Define Streaming Media
• Understand different elements of Streaming media process.
• Styling up the text using preformatted text in Dreamweaver
E-video: Producing internet video as broadband
technologies converge

Background
When Thomas Alva Edison invented the phonograph in 1877,
he gave us the freedom to select and play music in our own
home at our own convenience. It took another century until the
VCR became widely available and we gained the ability to
similarly select and play videos. But Edison’s contribution
wasn’t just the invention of  the phonograph, or the light-bulb,
or even the 1,093 inventions for which he received a patent. He
helped found an industry, the industry of  electric power and
analog appliances that transformed the twentieth century in
both the home and the factory.
Now another industrial transformation is underway, the digital
revolution. It can be traced to Tim Berners-Lee’s creation of  the
graphical interface, which allowed the Internet to become a
popular communication tool. As a result, within only six years
the Internet had reached 80 million users. This is astonishing
compared to past communication media successes.
The Internet had existed for decades mostly for scientific
workers and the military. When in 1989, while working at the
European Particle Physics Laboratory (CERN) in Geneva,
Berners-Lee proposed a global hypertext system he called the
World Wide Web. It could link more than just text—it could
link graphics, sound, and video to create an entire hypermedia
system. Instead of  a single database, the basis for his World
Wide Web would be the Internet, the vast network of  networks
around the world.
Over the next couple of years, Berners-Lee and his collaborators
laid the groundwork for the Web, inventing and refining the
HyperText Transfer Protocol (HTTP) for linking Web
documents, the Hypertext Markup Language (HTML) for
formatting Web documents, and the Universal Resource
Locator (URL) system for addressing Web documents. These
days, most of us reach the Web through commercial browsers,

such as Netscape Navigator or Internet Explorer. The first
contact most Internet users had with streaming data started
with Progressive Network’s RealAudio releasing its RealAudio
Server and client programs. RealAudio started playing as soon
as the user chose a selection. It was a cross-platform program
that could be played from Windows, Unix, and Mac systems.
The first true streaming videos ran during 1994 over the
experimental Mbone (Multicast Backbone) network. This
protocol is a form of Internet Protocol (IP) multicasting, which
replicates streaming videos to thousands of  servers. Access to
these events was initially confined to users with high-end Sun
workstations. The primary media server distributed its signal to
other repeater servers on the network.
Streaming media started with the Internet’s first streaming
player, RealAudio. In April 1995, it allowed listeners to hear
audio as it was being downloaded. The first Internet streaming
video player was Xing Technologies’ StreamWorks, released in
August 1995. It was based upon Motion Picture Expert Group
(MPEG) compression and provided jerky “talking heads”
images the size of  a postage stamp. This was followed shortly
by VDOLive from VDOnet Corp. In early 1997 Progressive
Networks, renamed RealNetworks, released RealVideo along
with an all-in-one audio-video player called RealPlayer.
As the use of streaming media has increased, competition for
customers in the streaming media market has intensified. While
RealNetworks has emerged as the clear leader as of 1999, rapid
changes in compression-decompression (codec) standards offers
many new challengers. Increasingly, however, the question is
asked, How do Microsoft’s Windows Media and other formats
stack up against the RealNetworks?
Microsoft entered into the streaming video market in 1997 with
its buyout of  WebTV Networks and Vxtreme. Microsoft
introduced its Active Streaming Format (ASF) in conjunction
with the developing MPEG-4 standard. This protocol provides
a standard method of  synchronizing audio, video, and
multimedia. Competition between ASF and RealNetworks’ G2
emerged in 1999, as the World Wide Web Consortium (W3C)
endorsed Synchronized Multimedia Integration Language
(SMIL). SMIL provides a text-based tag markup format for
streaming multimedia, freeing developers from proprietary
formats and enabling multiple vendors to supply software
tools. Other groups developed open standards with Java-based
applets that didn’t require preinstalled players in order to stream
video.
Macromedia’s Shockwave and Flash protocols first produced
streaming animation. Authoring platforms for real-time
delivery of animation during streaming videos have become
available. They allow multimedia-style animation and interactive
controls to be linked with broadcast-style audio and video.

LESSON 23:
STREAMING MEDIA
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Regardless of which vendor you choose, the equipment and
software used in multimedia production is often on the cutting
edge and not as fully developed as products in the more
established computer desktop applications. As a result, there are
often compatibility issues that must be resolved in making a set
of software and hardware choices to complement your
production system.
The actual making of the multimedia content involves the
following five basic steps:
1. Preparing the content source material
2. Capturing the audio/video using a computer with a video

capture card
3. Editing the video and saving the large uncompressed file
4. Compressing the video
5. Delivering the movie content over the Web
Each of these steps can be optimized toward improving the
final client video. For example, optimizing computer capture
hardware requires a balanced understanding of data-flow versus
choke points within the PC capture process. A high speed
Pentium III, with 256MB RAM, an 8.4GB (8 millisecond) hard
drive, and wide-SCSI-3 bus can demonstrate up to 40Mbps
throughput while capturing video. Unfortunately, many low-to-
medium-priced capture cards provide a throughput of only 2 to
5Mbps (even after optimal configuration), producing a limiting
choke point in your systems.
But even after heroic efforts on your part in optimizing the
source video, the hardware and software, and the editing and
compression process, there remains a significant barrier to
delivering your video over the Web. This is the “last mile”
connection to the client.

The Bandwidth Problem
The bandwidth of Internet communications has been steadily
increasing due to the overall pressures to improve performance
from users. The important point is that the infrastructure
provided by the Internet has become widespread and has
developed enough performance to allow rapid transmission of
large volumes of  data. Now it is becoming ready for video.
The problem with video, however, has been trying to push it
over digital networks where it clogs and chokes the critical
connections. The arrival of data compression has reduced the
problem of transmitting video data to more manageable levels.
The technology has only recently reached the point where video
can be digitized and compressed to levels that allow reasonable
quality of appearance following distribution over digital
networks

The Bandwidth Solution
Yogi Berra once said, “Predictions can be tricky, especially when
you’re talking about the future.” And looking forward is
certainly more perilous than using hindsight to review history.
However, the future of rapidly converging technology is not so
complex and uncertain that a few reasonable predictions about
certain aspects of streaming video as well as the future of the
Internet can’t be discerned.
Electronic Video, or “e-Video,” includes all audio/video clips
that are distributed and played over the Internet, either by direct

download or streaming video. And it is streaming video that is
the nexus of technology convergence because it is the
improvement in bandwidth to deliver video that will prove
decisive in reconciling competing technology standards. As this
last stumbling block of bandwidth limitation is finally
overcome, the television, cable, data, and telecommunication
technologies will converge toward a compatible and coherent
industry standard based on a one-to-one customized Internet
commerce model.
Up to this point, video has involved moving very large files (3-
40Mbps), and delivering such large data rates on the Internet
seemed prohibitive. Consider that to expand the Internet
bandwidth a factor of 10 times its current backbone would cost
additional billions of dollars for construction of fiber, copper,
or satellite equipment. Now consider the relatively small cost of
an equivalent expansion of bandwidth improvement produced
by software changes in data compression or by equipment
upgrades, such as, optical multiplexing.
The ideal vision for broadband may be an end-to-end optical
fiber network with fiber direct to the home. But this expensive
and long-term option may be preempted by a combination of a
near term breakthrough in compression technology and/or less
expensive optical wave division multiplexing. Obviously, the
data compression of streaming video compression-
decompression (codec) standards will play a critical role in the
form of required bandwidth reduction. This in turn will
contribute to technology convergence.

Streaming Media Basics
Streaming Media is media (audio, video, or graphics) that is
delivered as a stream of data, and played as it is received. It
allows you to view large data files without long delays and
minimal data loss as well as to view live events in real time.

Streaming
The process of streaming starts when a media file is broken
into smaller pieces so it can be transferred and played as each of
the pieces is received, rather than waiting for the whole file to be
transferred before playback starts. (This is similar to receiving
and reading a serialized novel, one chapter at a time, instead of
waiting for the whole book to arrive before starting to read it.)
How quickly you can receive files is mostly a matter of your
internet bandwidth (more information on bandwidth below).
One of the features of RealPlayer is that it can select a data
stream that best matches your available bandwidth (some
media is streamed at more than one bandwidth) so the media
stream provided matches the transfer/download speed available
to you.
RealPlayer can also display media created in SMIL (Synchronized
Multimedia Integration Language) protocol, which is used to
better optimize the bandwidth of a presentation. SMIL
presentations send different streams for each of the
components of a presentation (for example: a video stream,
audio stream, and text stream). Each stream has a different
optimum bit-rate associated with it. The result is that a complex
presentation can be streamed with a much lower bandwidth
than if the whole presentation was limited to the format and
bandwidth of the largest media type.
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Bandwidth
The property that most affects your experience playing any type
of Streaming Media over the Internet is bandwidth. Usually
this means the maximum speed (Kbps) of your Internet
connection, but it can also refer to capacity of the media server
(how many data streams the server can provide), as well as other
network constraints. If RealPlayer had to download data faster
than your connection can handle, such as viewing a 256Kbps
stream over a 56Kbps connection (you can see the bandwidth
of any stream on your Status Display), the presentation would
have to regularly pause to let the system catch up. To avoid this,
a media provider can stream RealAudio and Real Video in
multiple bandwidths at the same time, such as at 56Kbps and
at 256Kbps. RealPlayer will choose the data stream with a
bandwidth that best matches your Preferences. Of course a
narrower, or lower bandwidth, data stream will be of lower
quality, but it is less likely to be interrupted than a wider data
stream.

Buffering
When media is being streamed, the bandwidth does not always
remain constant. Often it will fall below what is required to
stream the presentation smoothly. To avoid pauses due to
delays or slow transmissions, RealPlayer will cache, or buffer, a
portion of the media stream before beginning to play it. (This
is indicated by “Loading xx%” appearing in the Status Display
when you start playing a clip.) When the bandwidth through
your connection is low, or data drops, RealPlayer takes data from
the buffer. When bandwidth returns to normal, RealPlayer puts
data into the buffer until the cache is refilled. When you attempt
to view a high-bandwidth clip over a low-bandwidth
connection, RealPlayer will attempt to create as large a buffer as
possible before beginning playback.

Streaming Media vs. Recorded Media
Generally speaking, Streaming Media refers to media that is
being presented on the Internet. The data stream originates on
the Internet, is transferred by modem/data-line to your
computer, is decoded by a Player, and is then viewed by a
consumer. Recorded Media refers to data files that are directly
accessible from your computer (on a hard drive or network
drive) such as audio CD tracks on a CD, or .RM or .MP3 files.
Note: From a purely technical standpoint, media that is being
played from a local drive (recorded media) is still being streamed
to the Player software, but this process is much faster than
media that is arriving from the Internet. For the purpose of
this discussion, Streaming Media refers only to media that is
arriving from the Internet.

On Demand vs. Live Steaming Media
On Demand Media: A media file that is available on the
Internet and is streamed to your computer. Typically it is an
audio or video clip that you can select and listen to from start to
finish.
Live Streaming Media: An audio or video stream that is being
data-cast live, and is available continuously. Typically these are
Internet Radio or TV stations.

Computer  Lab

Dramweaver

Styling Your Text
When the Internet was founded, its intended focus was to
make scientific data widely accessible. Soon it became apparent
that even raw data could benefit from  being styled contextually,
without detracting from the Internet’s openness and
universality. Over the short history of  HTML, text styles have
become increasingly important, and the World Wide Web
Consortium (W3C) has sought to keep a balance between
substance and style. Dreamweaver enables the Web designer to
apply the most popular HTML styles directly through the
program’s menus and Property Inspector. Less prevalent styles
can be inserted through the integrated text editors or by hand.

Working with preformatted text
Browsers ignore formatting niceties considered irrelevant to
page content: tabs, extra line feeds, indents, and added white
space. However, you can force browsers to read all the text,
including white space, exactly as you have entered it. By applying
the preformatted tag, <pre>, you tell the browser that it should
keep any additional white space encountered within the text. By
default, the <pre> tag also renders its content with a mono
space font such as Courier. For these reasons, the <pre> tag
was used to lay out text in columns in the early days of HTML,
before tables were widely available.
You can apply the preformatted tag either through the Property
Inspector or the menus. Before you use either technique,
however, be sure to select the text or position the cursor where
you want the preformatted text to begin. To use the Property
Inspector, open the Format list box and choose Preformatted.
To use the menus, choose Text->Paragraph Format-
>Preformatted.
The <pre> tag is a block element format, like the paragraph or
the headings tags, rather than a style. This designation as a block
element format has two important implications. First, you can’t
apply the <pre> tag to part of a line; when you use this tag, the
entire paragraph is altered. Second, you can apply styles to
preformatted text—this enables you to increase the size or alter
the font, but at the same time maintain the white space feature
made possible with the <pre> tag. All text in figure below uses
the <pre> tag; the column on the left is the standard output
with mono spaced font; the column on the right uses a
different font in a larger size.
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Preformatted text gives you full control over the line breaks,
tabs, and other white space in your Web page.
HTML’s logical styles are used to mark text relatively or within a
particular context, rather than with a specific look. The eventual
displayed appearance of logical styles is completely up to the
viewer’s browser. This is useful when you are working with
documents from different sources—reports from different
research laboratories around the country, for instance—and you
want certain conformity of style. Logical styles are utilitarian;
physical styles such as boldface and italic are decorative. Both
types of  styles have their uses in material published on today’s
Web.
All of Dreamweaver’s styles are accessed by choosing Text-
>Style and selecting from the 13 available style name options. A
checkmark appears next to the selected tags. Style tags can be
nested (put inside one another), and you can mix logical and
physical tags within a word, line, or document. You can have a
bold, strikethrough, variable style; or you can have an
underlined, cited style. (Both variable and cite are particular
logical styles covered later in this section.) If, however, you are
trying to achieve a particular look using logical styles, you should
probably use the Cascading Style Sheets feature.
Take a look at Figure below for a comparison of  how the styles
are rendered in Dreamweaver, Internet Explorer 5.0, and
Netscape Communicator 4.7. While the various renderings are
mostly the same, notice the browser differences in the
Definition styles and the difference in how the Keyboard style is
rendered in Dreamweaver and either browser.

In this comparison chart, the various renderings of
Dreamweaver style tags are from Dreamweaver, Netscape
Communicator 4.7, and Internet Explorer 5.0 (from left to
right).
Two of  the three physical style tags—bold and italic—are both
available from the Text Property Inspector and through
keyboard shortcuts (Ctrl+B or Command+B, and Ctrl+I or
Command+I, respectively). The Underline tag, <u>, is available
only through the Text->Style menu. Underlining text on a Web
page is generally discouraged in order to avoid confusion with
links, which are typically displayed underlined.
Both physical and logical style tags are described below in the
table

Style  
 

Tag 
 

Description 
 

Bold 
 

<i> 
 

Text is rendered with an italic style. 
 

Underline 
 

<u> 
 

Text is rendered underlined. 
 

Strikethrough 
 

<s> 
 

Used primarily in edited documents to depict edited 
text. Usually rendered with a line through the text. 
 

Teletype 
 

<tt> 
 

Used to represent an old-style typewriter. Rendered in a 
monospace font such as Courier. 
 

Emphasis 
 

<em> 
 

Used to accentuate certain words relative to the 
surrounding text. Most often rendered in italic. 
 

Strong Emphasis 
 

<strong> 
 

Used to strongly accentuate certain words relative to 
the surrounding text. Most often rendered in boldface. 
 

Code 
 

<code> 
 

Used to depict programming code, usually in a 
monospaced font. 
 

Sample 
 

<samp> 
 

Used to display characters in a literal sequence, usually 
in a monospaced font. 
 

Variables 
 

<var> 
 

Used to mark variables in programming code. Most 
often displayed in italics. 
 

Keyboard 
 

<kbd> 
 

Used to indicate what should be user input. Often 
shown in a monospaced font, sometimes in boldface. 
 

Citation 
 

<cite> 
 

Used to mark citations, references, and titles. Most often 
displayed in italic. 
 

Definition 
 

<dfn> 
 

Used to denote the first, defining instance of a term. 
Usually displayed in italic. 
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Topics Covered
• Dreamweaver - using HTML styles, Applying HTML styles,

Defining HTML styles

Objectives
Upon completion of this lesson, you should be able to:
• Start using HTML styles
• Apply HTML styles
• Define HTML styles

Computer Lab

Dreamweaver

Using Html Styles
In the world of  Web design, consistency is a good thing. A site
where headings, subheads, and body text are consistent from
page to page is far easier for the visitor to quickly grasp than one
where each page has its own style. Although the best approach
for a consistently designed site may be the use of Cascading
Style Sheets, that approach requires 4.0 and later browsers, and
many clients are not willing to write off  those potential Web
visitors using older software.
To bridge the gap between old and new-and to make it easier to
apply the same set of tags over and over again-Dreamweaver
includes HTML Styles. HTML Styles are similar to CSS in that
you define a custom style for text and give it any attributes you
want: font name, size, color, format, and so on. Then you apply
that  style to either a selection or an entire block of text. The
primary difference is that, with HTML Styles, Dreamweaver
adds the necessary standard HTML tags, instead of CSS style
declarations, to recreate your style. In other words, if you always
set your legal disclaimers in Verdana at a –1 size in a deep red
color, you can define your “legal” style once and apply it over
and over again with one step, anywhere on the site.
HTML Styles, however, are not a replacement for CSS styles,
and you should keep in mind some important differences:
• Modifying a HTML Style definition affects only subsequent

applications of the style. When a CSS style is altered, the
change is immediately seen wherever the style has been
applied on the current page as well as in all future
applications.

• HTML Styles use standard text tags and cannot, therefore,
create some of the special effects possible in CSS. For
example, you could not create a HTML style that eliminates
the underline from a link or changes the leading of a
paragraph.

• Although defined HTML Styles are accessible from anywhere
within a site, they are applied on a document-to-document
basis, whereas with CSS, an external style sheet could be
defined and linked to pages anywhere on your site.

Even with these differences, however, HTML Styles are an
enhancement to a designer’s workflow and extremely easy to
use.

Applying HTML Styles
The HTML Styles panel, shown in Figure 9-12, displays all
currently available styles as well as options for removing style
formatting, editing existing styles, adding new styles, or
removing styles from the panel.

Manage your standard formatting through the HTML Styles
panel.
HTML Styles are divided into two distinct types: paragraph and
selection styles. A paragraph style affects an entire block element,
whether it is a single heading, a paragraph, or another block
element such as a block quote. Paragraph styles are designated
with a ¶ symbol in the HTML Styles panel. A paragraph style is
applied to the entire current block element, whether the cursor
has selected the text or is just within the block. A selection style,
on the other hand, applies formatting only to selected text.
Selection styles are marked in the HTML Styles panel with an
underlined lowercased a, like this (a).
It’s possible for both paragraph and selection styles to either
clear the existing style before adding the new formatting or add
the new formatting to the existing style. The default behavior is
for existing formatting to be removed; if the style is to be
added, a small plus sign (+) is shown in front of the style
name.
To apply an HTML Style, follow these steps:
1. Open the HTML Styles panel in one of the following ways:

•  Select Window->HTML Styles.
•  Choose the HTML Styles button from either

Launcher.
•  Press the keyboard shortcut, Ctrl+F11
(Command+F11).

2. To apply a style to the currently selected text, choose any
designated (a) HTML Style.

LESSON 24:
HTML STYLES
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3. To apply a style to the current block element, choose any so-
designated (¶) HTML Style.

It’s easiest to always have the Auto Apply option selected, so
that your choices immediately are applied; if this option is not
selected, click the Apply button.

Defining HTML Styles
Naturally, the standard list of  styles is just a jumping-off  place
for the HTML Styles panel. To get the most out the feature, you
should design your own custom styles. Dreamweaver gives you
a number of methods to define a style:
Style by Example-Create a new style from formatted text
onscreen.
• Modify an Existing Style—Edit a standard or custom style

to your liking. You can even duplicate the style first, so both
old and new versions are available.

• Build a New Style—Select all the desired attributes for your
selection or paragraph style and try it out right away on
selected text.

You can remove all styling from a bit of  text and keep the
surrounding styling with the Clear Selection Style command.
All style definitions are managed in the Define HTML Style
dialog box, shown in the figure below, how the dialog box is
opened depends on which method you’re using to create or
modify your style.
• To create a style from example, select tags you want to

include in the style from the Document window or the Tag
Selector and then choose the New Style button from the
HTML Styles panel.

• To modify an existing style, double-click its name in the
HTML Styles panel list.

• To create a new style built on an existing one, select the style
and then, from the context-sensitive menu of the HTML
Styles panel, select Duplicate.

• To create a style from the ground up, choose the New Style
button on the HTML Styles panel.

To define an HTML Style, follow these steps:
1. Open the Define HTML Style dialog box using one of the

previously described methods. Clear Paragraph style Clear
Selection style

2. Enter a unique name for your style, if creating a new one.
3. Choose whether your style is to apply to a selection or a

paragraph.
4. Select whether your style will add to the existing style or clear

existing style.
5. Choose the desired font attributes:
•  Font
•  Size
•  Color
•  Style: Bold, Italic, or Bold-Italic
 Other . . . (Additional Optional Styles): Underline,
Strikethrough, Teletype,    Emphasis, Strong, Code, Variable,
Sample, Keyboard, Citation, Definition

Build or modify styles in the Define HTML Style dialog box.
6. If defining a paragraph style, select from the following

attribute options:
• Format: None, Heading 1 through Heading 6, or

Preformatted
• Alignment: Right, Center, Left.

7. Click OK when you’re done.

Assignments
1. Define Bandwidth?
2. How can you get an Internet connection? Explain all

possibilities?
3. What is Broadband connection? How effective is it over

other connections?
4. What additional feature does Dream weaver gives in

formatting paragraph?
5. How indenting text in paragraph works in Dream weaver?
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6. What is <br> tag? Explain with examples What is Streaming

media?
7. What is buffering in Streaming Media?
8. What is preformatted text?
9. What is text property inspector?
10.Why underlining text should be avoided in a web page?
11.What are the two distinct types of HTML styles?
12.How do your create your own HTML styles?

Notes
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Topics Covered
• Consistency, Page Dimension, Page Length
• Dreamweaver - Modifying Text format, Font color, Editing

Font list, Text Alignment.

Objectives
Upon completion of this lesson, you should be able to:
• Relate Consistency to page design
• Know about Page Dimension and its elements
• Page length in relation to content
• Modifying Text in Dreamweaver
• Selecting font color
• Editing Font list in Dreamweaver
• Text alignment in paragraph

Consistency
Establish a layout grid and a style for handling your text and
graphics, then apply it consistently to build rhythm and unity
across the pages of your site. Repetition is not boring; it gives
your site a consistent graphic identity that creates and then
reinforces a distinct sense of “place” and makes your site
memorable. A consistent approach to layout and navigation
allows readers to adapt quickly to your design and to confidently
predict the location of information and navigation controls
across the pages of your site.

If  you choose a graphic theme, use it throughout your Web
site. The Bridgeman Art Library home page banner, below, sets
the graphic theme for the site and introduces distinctive
typography and a set of navigation buttons:

www.bridgeman.co.uk
Below is a banner at the top of an interior page in the
Bridgeman Art Library site. Note how the typography and the
navigation theme are carried over to the interior banners. There
is no confusion about whose site you are navigating through:

www.bridgeman.co.uk

Page Ddimensions
Although Web pages and conventional print documents share
many graphic, functional, and editorial similarities, the
computer screen, not the printed page, is the primary delivery
site for Web-based information, and the computer screen is very
different from the printed page. Computer screens are typically
smaller than most opened books or magazines. A common
mistake in Web design is spreading the width of  page graphics
beyond the area most viewers can see on their seventeen- or
nineteen-inch display screens:

LESSON 25:
VISUAL HARMONY-1
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Graphic safe areas
The “safe area” for Web page graphics is determined by two
factors: the minimum screen size in common use and the width
of  paper used to print Web pages.
Most display screens used in academia and business are
seventeen to nineteen inches (forty-three to forty-eight
centimeters) in size, and most are set to display an 800 x 600-
pixel screen. Web page graphics that exceed the width
dimension of the most common display screens look
amateurish and will inconvenience many readers by forcing
them to scroll both horizontally and vertically to see the full
page layout. It’s bad enough to have to scroll in one (vertical)
direction; having to scroll in two directions is intolerable.

www.microsoft.com and  www.mapquest.com
Even on small computer screens it is possible to display
graphics that are too wide to print well on common letter-size,
legal-size, or A4 paper widths. Current browser versions
attempt to resolve printing problems by providing the option
to scale the page contents to fit the standard paper width.
However, many users are unaware of the “fit to page” option.
Another problem is that wide pages that are scaled to fit are
often illegible because the type has been scaled excessively. In
many Web pages, however, printing is a secondary concern. Just
be aware that your readers will either lose the right margin of
your layout or produce a scaled document if they print wide
pages in standard vertical print layout. Pages with lots of text
should always be designed to print properly because most
readers will print those pages to read them more comfortably.
If the page layout is too wide readers will lose several words
from each line of text down the right margin or have to
contend with small type.
The graphic safe area dimensions for printing layouts and for
page layouts designed to use the maximum width of 800 x 600
screens are shown below:
Graphic “safe area” dimensions for layouts designed to print
well:
Maximum width = 560 pixels
Maximum height = 410 pixels (visible without scrolling)
Graphic “safe area” dimensions for layouts designed for 800 x
600 screens:
Maximum width = 760 pixels
Maximum height = 410 pixels (visible without scrolling)
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Page Length
Determining the proper length for any Web page requires
balancing four factors:
1. The relation between page and screen size
2. The content of your documents
3. Whether the reader is expected to browse the content online

or to print or download the documents for later reading
4. The bandwidth available to your audience
Researchers have noted the disorientation that results from
scrolling on computer screens. The reader’s loss of  context is
particularly troublesome when such basic navigational elements
as document titles, site identifiers, and links to other site pages
disappear off-screen while scrolling. This disorientation effect
argues for the creation of  navigational Web pages (especially
home pages and menus) that contain no more than one or two
screens’ worth of information and that feature local
navigational links at the beginning and end of the page layout.
Long Web pages require the user to remember too much
information that scrolls off the screen; users easily lose their
sense of context when the navigational buttons or major links
are not visible:

Scrolling
In long Web pages the user must depend on the vertical scroll
bar slider (the sliding box within the scroll bar) to navigate. In
some graphic interfaces the scroll bar slider is fixed in size and
provides little indication of the document length relative to
what’s visible on the screen, so the reader gets no visual cue to
page length. In very long Web pages small movements of  the
scroll bar can completely change the visual contents of the
screen, leaving the reader no familiar landmarks to orient by.
This gives the user no choice but to crawl downward with the
scroll bar arrows or risk missing sections of the page.
Long Web pages do have their advantages, however. They are
often easier for creators to organize and for users to download.
Web site managers don’t have to maintain as many links and
pages with longer documents, and users don’t need to
download multiple files to collect information on a topic. Long
pages are particularly useful for providing information that you
don’t expect users to read online (realistically, that means any
document longer than two printed pages). You can make long
pages friendlier by positioning “jump to top buttons” at
regular intervals down the page. That way the user will never
have to scroll far to find a navigation button that quickly brings
him or her back to the top of the page.
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All Web pages longer than two vertical screens should have a
jump button at the foot of the page:

If  a Web page is too long, however, or contains too many large
graphics, the page can take too long for users with slow
connections to download. Very large Web pages with many
graphics may also overwhelm the RAM (random access
memory) limitations of  the user’s Web browser, causing the
browser to crash or causing the page to display and print
improperly.

Content and Page Length
It makes sense to keep closely related information within the
confines of  a single Web page, particularly when you expect the
user to print or save the text. Keeping the content in one place
makes printing or saving easier. But more than four screens’
worth of information forces the user to scroll so much that the
utility of the online version of the page begins to deteriorate.
Long pages often fail to take advantage of the linkages available
in the Web medium.

If you wish to provide both a good online interface for a long
document and easy printing or saving of its content:
• Divide the document into chunks of no more than one to

two printed pages’ worth of information, including inlined
graphics or figures. Use the power of hypertext links to take
advantage of  the Web medium.

• Provide a link to a separate file that contains the full-length
text combined as one page designed so the reader can print
or save all the related information in one step. Don’t forget
to include the URL of the online version within the text of
that page so users can find updates and correctly cite the
source.

In general, you should favor shorter Web pages for:
• Home pages and menu or navigation pages elsewhere in

your site
• Documents to be browsed and read online
• Pages with very large graphics
In general, longer documents are:
• Easier to maintain (content is in one piece, not in linked

chunks)
• More like the structure of their paper counterparts (not

chopped up)
• Easier for users to download and print

Computer Lab

Dreamweaver

Modifying Text Format

As a Web designer, you easily spend at least as much time
adjusting your text as you do getting it into your Web pages.
Luckily, Dreamweaver puts most of  the tools you need for this
task right at your fingertips. All the text-formatting options are
available through the Text Property Inspector. Instead of  hand-
coding <font>, <blockquote>, and alignment tags, just select
your text and click a button.

Adjusting font size
The six HTML heading types ( H1 to H6) enable you to assign
relative sizes to a line or to an entire paragraph. In addition,
HTML gives you a finer degree of control through the size
attribute of  the font tag. In contrast to publishing
environments, both traditional and desktop, font size is not
specified in HTML with points. Rather, the <font> tag enables
you to choose one of seven different explicit sizes that the
browser can render (absolute sizing), or you can select one
relative to the page’s basic font. Figure below  shows the default
absolute and relative sizes, compared to a more page designer–
friendly point chart (accomplished with Dreamweaver’s
Cascading Style Sheets features).

Which way should you go-absolute or relative?
Come designers think that relative sizing gives them more
options. As you can see by the chart in Figure below, browsers
are limited to displaying seven different sizes no matter what-
unless you’re using Cascading Style Sheets. Relative sizing does
give you additional flexibility, though, because you can resize all
the fonts in an entire Web page with one command. Absolute
sizes, however, are more straightforward to use and can be



120

E
-M

E
D

IA

coded in Dreamweaver without any additional HTML
programming. Once again, it’s the designer’s choice.

Absolute size
You can assign an absolute font size through either the
Property Inspector or the menus. In both cases, you choose a
value, 1 (smallest) through 7 ( largest), to which you want to
resize your text; you might note that this order is the reverse of
the heading sizes, which range from H1 to H6, largest to
smallest.

In this chart, you can see the relationships between the various
font sizes in an HTML browser and as compared to “real-
world” point sizes.
To use the Property Inspector to pick an absolute font size,
follow these steps:
1) Select your text.
2) In the Property Inspector, open the Font Size drop-down

list of options.
3) Choose a value from 1 to 7.
To pick an absolute font size from the menu, follow these
steps:
1) Select your text.
2) Choose Text->Size and pick a value from 1 to 7, or Default

(which is 3).

Relative size
To what exactly are relative font sizes relative? The default font
size, of course. The advantage of relative font sizes is that you
can alter a Web page’s default font size with one command, the
<basefont> tag. The tag takes the following form:
<basefont size=value>
where value is a number from 1 to 7. The <basefont> tag is
usually placed immediately following the opening <body> tag.
Dreamweaver does not support previewing the results of
altering the <basefont> tag and the tag has to be entered by
hand or through the external editor.

You can distinguish a relative font size from an absolute font
size by the plus or minus sign that precedes the value. The
relative sizes are plus or minus the current <basefont> size.
Thus, a <font size=+1> is normally rendered with a size 4 font
because the default <basefont> is 3. If you include the
following line in your Web  page:
<basefont size=5>
text marked with a <font size=+1> is displayed with a size 6
font. Because browsers display only seven different size fonts
with a <basefont size=5> setting—unless you’re using
Cascading Style Sheets—any relative size over <font size=+2>
won’t display differently when previewed in a browser.
Relative font sizes can also be selected from either the Property
Inspector or the menus. To use the Property Inspector to pick a
relative font size, follow these steps:
1) Select your text or position the cursor where you want the

new text size to begin.
2) In the Property Inspector, open the Font Size drop-down

list of options.
3) To increase the size of  your text, choose a value from +1

through +7.
4) To decrease the size of  your text, choose a value from –1 to

–7.
To pick a relative font size from the menus, follow these steps:
1) Select your text or position the cursor where you want the

new text size to begin.
1) increase the size of  your text, choose Text->Size Increase and

pick a value from +1 to +7.
1) To reduce the size of  your text, choose Text->Size Decrease

and pick a value from –1 to –7.

Adding font color
Unless you assign a color to text on your Web page, the browser
uses its own default, typically black. You can change the font
color for the entire page by choosing Modify->Page Properties
and selecting a new color from the Text Color swatch. You can
also color any specific headings, words, or paragraphs that you
have selected in Dreamweaver.
The <font> tag goes to work again when you add color to
selected elements of the page—this time, with the color
attribute set to a particular value. HTML color is expressed in
either a hexadecimal color number or a color name. The
hexadecimal color number is based on the color’s red-green-blue
value and is written as follows:
#FFFFFF
The preceding represents the color white. You can also use
standard color names instead of the hexadecimal color
numbers. A sample color code line follows:
I’m <font color=”green”>GREEN</font> with envy.
Dreamweaver understands both color names and hexadecimal
color numbers, but its HTML code output is in hexadecimal
color numbers only. Again, you have two ways to add color to
your text in Dreamweaver. The Property Inspector displays a
drop-down list of the browser-safe colors and also gives you an
option to choose from a full-spectrum Color dialog box. If you
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approach your coloring task via the menus, the Text->Color
command takes you immediately to the Color dialog box.
To use the Property Inspector to color a range of  text in
Dreamweaver, follow these steps:
i. Select the text you want to color or position the cursor where

you want the new text color to begin.
ii. From the Property Inspector, you can
a. Type a hexadecimal color number directly into the Font

Color text box.
b. Type a color name directly into the Font Color text box.
c. Select the Font Color swatch to open the browser-safe color

picker.
iii. If you chose to type a color name or number directly into the

Font Color text box, press Tab or click the Document
window to see the color applied.

iv. If you clicked the Font Color swatch, select your color from
the browser-safe colors available. As you move your pointer
over the color swatches, Dreamweaver displays the color in
the corner and the color’s hexadecimal number below.

v. For a wider color selection from the Color dialog box, select
the Palette icon in the lower-right corner of the color swatch.

To access the full-spectrum color picker in Windows, follow
these steps:
1. Select your text or position your cursor where you want the

new text color to begin.
2. Choose Text->Color to open the Color dialog box, as

shown in the figure below:
3. Select one of the 48 preset standard colors from the color

swatches on the left of the Color dialog box, or use either of
the following methods:
• Select a color by moving the Hue/Saturation pointer

and the Luminance pointer.
• Enter decimal values directly into either the Red, Green,

and Blue boxes or the Hue, Saturation, and Luminance
boxes.

4. If you create a custom color, you can add it to your palette by
selecting Add to Custom Colors. You can add up to 16
custom colors.

5. Click OK when you are finished.

Use the Color dialog box in Windows to choose a color for
your font outside of the browser-safe palette.

Assigning a specific font
Along with size and color, you can also specify the typeface in
which you want particular text to be rendered. Dreamweaver
uses a special method for choosing font names for a range of
selected text, due to HTML’s unique way of  handling fonts.
Before you learn how to change a typeface in Dreamweaver, let’s
further examine how fonts in HTML work.

About HTML fonts
Page layout designers can incorporate as many different fonts as
available to their own systems. Web layout designers, on the
other hand, can use only those fonts on their viewers’ systems.
If you designate a paragraph to be in Bodoni Bold Condensed,
for instance, and put it on the Web, the paragraph is displayed
with that font only if that exact font name is on the user’s
system. Otherwise, the browser uses the default system font,
which is often Times or Times New Roman. Fonts are specified
with the <font> tag, aided by the name attribute. Because a
designer can never be certain of which fonts are on visitors’
computers, HTML enables you to offer a number of options
to the browser, as follows:
<font name=”Arial, Helvetica, sans-serif ”>Swiss Maid
Foundry</font>
The browser encountering the preceding tag first looks for the
Arial font to render the enclosed text. If Arial isn’t there, the
browser looks for the next font in the list, which in this case is
Helvetica. Failing to find any of the specified fonts listed, the
browser uses whichever font has been assigned to the category
for the font- sans-serif in this case.

Selecting a font
The process for assigning a font name to a range of text is
similar to that of assigning a font size or color. Instead of
selecting one font name, however, you’re usually selecting one
font series. That series could contain three or more fonts, as
previously explained. Font series are chosen from the Property
Inspector or through a menu item. Dreamweaver enables you
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to assign any font on your system—or even any font you can
name-to a font series,
To assign a specific font series to your text, follow these steps:
1. Select the text or position your cursor where you want the

new text font to begin.
2. From the Property Inspector, open the drop-down list of

font names. You can also choose Text->Font from the
menu bar. Your font list is displayed.

3. Select a font from the Font List. To return to the system
font, choose Default Font from the list.

It’s also possible to enter the font name or font series directly in
the Property Inspector’s Font drop-down list.

Editing the Font List
With the Edit Font List dialog box, Dreamweaver gives you a
point-and-click interface for building your font lists. Once the
Edit Font List dialog box is open, you can delete an existing
font series, add a new one, or change the order of the list so
your favorite ones are on top. Take a look at Figure below to see
the sections of the Edit Font List dialog box: the current Font
List, the Available Fonts on your system, and the Chosen
Fonts. The Chosen Fonts are the individual fonts that you’ve
selected to be incorporated into a font series.
Let’s step through the process of  constructing a new font series
and adding it to the Font List:
1. To open the Edit Font List dialog box, either choose Edit

Font List through the Font Name option arrow in the
Property Inspector, or select Text->Font->Edit Font List.

2. If  the Chosen Fonts box is not empty, clear the Chosen
Fonts box by selecting the plus (+) button at the top of the
dialog box. You can also scroll down to the bottom of  the
current Font List and select “(Add fonts in list below).”

3. Select a font from the Available Fonts list.

4. Click the << button to transfer the selected font to the
Chosen Fonts list.

5. To remove a font you no longer want or have chosen in
error, highlight it in the Chosen Fonts list and select the >>
button.

6. Repeat Steps 3 through 5 until the Chosen Fonts list
contains the alternative fonts desired.

7. If you want to add another, separate font series, repeat Steps
2 through 5.

8. Click OK when you are finished adding fonts.
To change the order in which font series are listed in the Font
List, follow these steps:
1. In the Font List dialog box, select the font series that you

want to move.
2. If you want to move the series higher up the list, select the

up-arrow button at the top-right of the Font List. If you
want to move the series lower down the list, select the
down-arrow button.

To remove a font series from the current Font List, highlight it
and select the minus(–) button at the top-left of the list.
Remember, you need to have the fonts on your system to make
them a part of  your Font List. To add a font that’s unavailable
on your computer, type the name of the font into the text box
below the Available Fonts list and press Enter ( Return).

Aligning text
You can easily align text in Dreamweaver, just like in a
traditional word processing program. HTML supports the
alignment of text to the left or right margin, or in the center of
the browser window. Like a word processing program,
Dreamweaver aligns text one paragraph at a time. You can’t left-
align one word, center the next, and then right-align the third
word in the same paragraph.
To align text, you can use one of  three methods: a menu
command, the Property Inspector, or a keyboard shortcut. To
use the menus, choose Text->Alignment and then pick the
alignment you prefer (Left, Right, or Center). Table below
explains the Text Property Inspector’s Alignment buttons and
the associated keyboard shortcuts.

Indenting entire paragraphs
HTML offers a tag that enables you to indent whole
paragraphs, such as inset quotations or name-and-address
blocks. Not too surprisingly, the tag used is called the
<blockquote> tag. Dreamweaver gives you instant access to the
<blockquote> tag through the Indent and Outdent buttons
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located on the Text Property Inspector, as shown in Figure
below:

To indent one or more paragraphs, select them and click the
Indent button in the Property Inspector. Paragraphs can be
indented multiple times; each time you click the Indent button,
another <blockquote>...</blockquote> tag pair is added.
You can’t control how much space a single <blockquote>
indents a paragraph- that characteristic is determined by the
browser.
If you find that you have over-indented, you can use the
Outdent button, which is also located on the Property
Inspector. The Outdent button has no effect if your text is
already at the left edge. You also have the option of  indenting
your paragraphs through the menus; choose Text->Indent or
Text->Outdent.

Notes
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Topics Covered
• Design Grids for Web pages, Page layout, Frames
•  Dreamweaver - Inserting Images, Web Graphic Format,

Inline images, Modifying and Editing Images, Working with
alignment options.

Objectives
Upon completion of this lesson, you should be able to:
• Learn how grids brings order to a page
• Design for screen of Information.
• Use Frames aesthetically
• Insert images  in Dreamweaver
• Know  all the web graphic formats and where to use them
• Modify and edit images
• Align images according to design plans of web page.

Design Grids For Web Pages
Consistency and predictability are essential attributes of any
well-designed information system. The design grids that
underlie most well-designed paper publications are equally
necessary in designing electronic documents and online
publications, where the spatial relations among on-screen
elements are constantly shifting in response to the user’s input
and system activity.

Grids bring order to the page
Current implementations of HyperText Markup Language do
not allow the easy flexibility or control that graphic designers
routinely expect from page layout software or multimedia
authoring tools. Yet HTML can be used to create complex and
highly functional information systems if  it is used thoughtfully.
When used inappropriately or inconsistently, the typographic
controls and inlined graphics of  Web pages can create a
confusing visual jumble, without apparent hierarchy of
importance. Haphazardly mixed graphics and text decrease
usability and legibility, just as they do in paper pages. A balanced
and consistently implemented design scheme will increase
readers’ confidence in your site.

No one design grid system is appropriate for all Web pages.
Your first step is to establish a basic layout grid. With this
graphic “backbone” you can determine how the major blocks of
type and illustrations will regularly occur in your pages and set
the placement and style guidelines for major screen titles,
subtitles, and navigation links or buttons. To start, gather
representative examples of your text, along with some graphics,
scans, or other illustrative material, and experiment with various
arrangements of the elements on the page. In larger projects it
isn’t possible to exactly predict how every combination of text
and graphics will interact on the screen, but examine your Web
layout “sketches” against both your most complex and your
least complex pages.
Your goal is to establish a consistent, logical screen layout, one
that allows you to “plug in” text and graphics without having
to stop and rethink your basic design approach on each new
page. Without a firm underlying design grid, your project’s page
layout will be driven by the problems of the moment, and the
overall design of  your Web site will seem patchy and confusing.

Vertical stratification in Web pages
A Web page can be almost any length, but you’ve only got
about forty-five square inches “above the fold” - at the top of
your page - to capture the average reader, because that is all he or
she will see as the page loads. One crucial difference between
Web page design and print page design is that when readers
turn a book or magazine page they see not only the whole next
page but the whole two-page spread, all at the same time. In
print design, therefore, the two-page spread is the fundamental
graphic design unit.
Print design can achieve a design unity and density of
information that Web page design cannot emulate. Regardless
of how large the display screen is, the reader still sees one page
at a time, and even a twenty-one-inch screen will display only as
much information as is found in a small magazine spread:

LESSON 26:
IMAGES IN DREAMWEAVER
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Design for screens of information
Most Web page designs can be divided vertically into zones with
different functions and varying levels of graphics and text
complexity. As vertical scrolling progressively reveals the page,
new content appears and the upper content disappears. A new
graphic context is established each time the reader scrolls down
the page. Web page layouts should thus be judged not by
viewing the whole page as a unit but by dividing the page into
visual and functional zones and judging the suitability of each
screen of information. Notice the vertical structure of the home
page reproduced below. The top screen of  information is much
denser with links because it is the only area that is sure to be
visible to all users:

Page Layout
Laying out Web pages involves a bit of wizardry. HTML was
designed by engineers and scientists who never envisioned it as
a page layout tool. Their aim was to provide a way to describe
structural information about a document, not a tool to
determine a document’s appearance. Once the real world started
to work on the Web, graphic designers began adapting the
primitive tools of HTML to produce documents that looked
more like their print counterparts. The point was not to
produce “jazzier” or “prettier” pages. The layout conventions
of print documents have evolved over hundreds of years for
concrete and practical reasons, and they offer many functional
advantages over the simplistic, single-column page layout
envisioned by the original designers of  the World Wide Web.
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Flexible design
The Web is a flexible medium designed to accommodate
different types of users and a variety of display devices. Unlike a
printed document, which is “fixed” in its medium, the look of
a Web page depends on such elements as the display size,
resolution, and color settings, the height and width of the
browser window, software preferences such as link and
background color settings, and available fonts. Indeed, there is
no way to have complete control over the design of  a Web page.
The best approach, then, is to embrace the medium and design
flexible pages that are legible and accessible to all users.

Layout with style sheets
One of the visual properties that Cascading Style Sheets are
meant to describe is how elements are positioned on the page.
Style sheet positioning allows designers to set margins, to
position text and images on the page relative to one another, to
hide and show elements, and to stack elements so they overlay
one another. In theory, style sheet positioning should provide
all the design control needed to lay out visually appealing and
legible Web pages. In practice, however, browser inconsistencies
have rendered style sheet positioning useless, at least for the
time being. Though the W3C specifications for style sheet
positioning contain most of the tools needed for good design,
Microsoft and Netscape have done a particularly poor job of
implementing them, so that properties such as borders and
margins display quite differently from browser to browser. If
you are creating a site for a diverse audience you should steer
clear of style sheet positioning for now and design your pages
using layout tables as described below. If standards compliance
is a priority, use style sheet positioning for page layout, but keep
your layouts simple and be ready to accept variability across
browsers and platforms.

FRAMES
Frames are meta-documents that call and display multiple
HTML documents in a single browser window. A frame
document contains no BODY HTML tags, just the parameters
for the frames and the URLs of the HTML documents
designated to fill them. Frames-based pages do not function as
an integrated unit, which is both good and bad. Frames are
useful for certain content and greatly facilitate site maintenance.
They provide a good way to maintain narrative and design
consistency in your site; you can split the browser screen
between site navigation and the material you wish to bring up
with a link.
But frames also impose interface and design limitations. Frames
can easily confuse readers who wish to print material on a page
or bookmark a page for later reference or navigate using the
browser’s “Forward” and “Back” buttons. And screen space
becomes an issue with frames; if you use frames to divide the
browser screen, you will force many readers to scroll both
horizontally and vertically to see the full contents of each frame.
The current consensus among Web design and usability experts
is that frames should be used only in the rare instances when
their limited advantages clearly outweigh the many problems
they can cause.

Flexibility
Frames are useful in a site whose contents are expected to
change frequently. Because a frames-based site can be designed
to have a single file for navigation, if you add or remove pages
from the site you will have to modify only that one file. Our
online Web Style Guide, for example, requires that a number of
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files be changed if we add or delete a page because each page in
the site has its own navigation. If we had used frames in our
design, we would have had a single file for the section menu,
and when we needed to add a page, only that file would have
had to be changed to reflect the addition. As it is, when we add
a page to a section we must edit each file in that section to add
the new link.

Functionality
Frames can give a targeted area of your site a functional
coherence. Say your site contains a collection of poems by Emily
Dickinson. You could create a virtual “reading room” for her
poetry using frames, with the leftmost frame providing the
navigation links and the main frame at the right displaying the
poems. Because most visitors linger in this area and would use
the links you provide for navigation, the quirky navigation of
the “Back” button would not be too intrusive.
You can also use frames to provide additional interactivity to
your page. Frames allow you to put a page up on the user’s
screen and change its contents without rewriting the screen. The
frames can interact; clicking a link in one frame can change the
contents of the other. For example, a text with annotations in
one frame can be linked to a footer frame, so that clicking on the
text reference fills the footer frame with the corresponding note:

Aesthetics
Many page designers have avoided frames because of their
prescribed borders and limited flexibility. Current versions of
browser software, however, allow many more frame parameters
to be defined. In fact, frame borders can now be set to zero.
This allows you to design using the functionality of frames
without requiring them to be visual and perhaps inharmonious
elements on your page.

Frame Titles

The visual relationship between the content in frames is usually
obvious for users who can see: for example, navigation links in
the left frame, content in the right. Without the benefit of
visual cues, however, blind users will have difficulty orienting
themselves in a frames-based layout. As discussed above, there
are many reasons to avoid a frames-based layout, but if you
must use frames, be sure to include titles for FRAMESET tags
and a NOFRAMES alternative to navigating your site.
<FRAMESET COLS=”20%, 80%” TITLE=”Web Style
Guide”>
<FRAME SRC=”nav.html” TITLE=”Navigation”>
<FRAME SRC=”chapter1.html” TITLE=”Chapter 1:
Process”>
<NOFRAMES><A HREF=”content.html” TITLE=”Table
of  Contents”>Web Style Guide Table of Contents</A>
</NOFRAMES>
</FRAMESET>

Computer Lab

Dreamweaver

Inserting Images
The Internet started as a text-based medium primarily used for
sharing data among research scientists and among U.S. military
commanders. Today, the Web is as visually appealing as any
mass medium. Dreamweaver’s power becomes even more
apparent as you use its visual layout tools to incorporate
background and foreground images into your Web page
designs. Completely baffled by all the various image formats
out there? This chapter opens with an overview of  the key
Web-oriented graphics formats, including PNG. Also, this
chapter covers techniques for incorporating both background
and foreground images-and modifying them using new
methods available in Dreamweaver 4.

Web Graphic Formats
If you’ve worked in the computer graphics field, you know that
virtually every platform-as well as every paint and graphics
program-has its own proprietary file format for images. One of
the critical factors in the Web’s rapid, expansive growth is the
use of cross-platform graphics. Regardless of the system you
use to create your images, these versatile files ensure that the
graphics can be viewed by all platforms.
You need to understand the uses and limitations of  each of  the
formats so you can apply them successfully in Dreamweaver.
Let’s look at the fundamentals.

GIF
GIF, the Graphics Interchange Format, was developed by
CompuServe in the late 1980s to address the problem of  cross-
platform compatibility. With GIF viewers available for every
system from PC and Macintosh to Amiga and NeXT, the
format became a natural choice for an inline (adjacent to text)
image graphic. GIFs are bitmapped images, which means that
each pixel is given or mapped to a specific color. You can have
up to 256 colors for a GIF graphic. These images are generally
used for illustrations, logos, or cartoons-anything that doesn’t
require thousands of colors for a smooth color blend, such as a
photograph. With a proper graphics tool, you can reduce the
number of colors in a GIF image to a minimum, thereby
compressing the file and reducing download time.
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The GIF87a and GIF89a varieties
The GIF format has two varieties: “regular” (technically,
GIF87a) and an enhanced version known as GIF89a. This
improved GIF file brings three important attributes to the
format. First, GIF89a supports transparency, in which one or
more of the colors can become invisible. This property is
necessary for creating non rectangular appearing images.
Whenever you see a round or irregularly shaped logo or
illustration on the Web, a rectangular frame is displayed as the
image is loading- this is the actual size and shape of the graphic.
The colors surrounding the irregularly shaped central image are
set to transparent in a graphics-editing program (such as
Fireworks or Adobe Photoshop) before the image is saved in
GIF89a format.
Although the outer area of a graphic seems to disappear with
GIF89a, you won’t be able to overlap your Web images using
this format without using layers. Figure below demonstrates
this situation. In this figure, the same image is presented twice-
one lacks transparency and one has transparency applied. The
image on the left is saved as a standard GIF without
transparency, and you can plainly see the shape of  the full image.
The image on the right was saved with the white background
color made transparent, so the central figure seems to float on
the background.

Interlacing capabilities of GIF89a
The second valuable attribute contributed by GIF89a format is
interlacing. One of the most common complaints about
graphics on the Web is lengthy download times. Interlacing
won’t speed up your GIF downloads, but it gives your Web
page visitors something to view other than a blank screen. A
graphic saved with the interlace feature turned on gives the
appearance of “developing,” like an instant picture, as the file is
downloading. Use of  this design option is up to you and your
clients. Some folks swear by it; others can’t abide it.

The same image, saved without GIF transparency (left) and
with GIF transparency (right)

Animation capabilities of GIF89a

Animation is the final advantage offered by the GIF89a format.
Certain software programs enable you to group your GIF files
together into one large page-flipping file. With this capability,
you can bring simple animation to your page without
additional plug-ins or helper applications. Unfortunately, the
trade-off is that the files get very big, very fast.

JPEG
The JPEG format was developed by the Joint Photographic
Experts Group specifically to handle photographic images.
JPEGs offer millions of colors at 24 bits of color information
available per pixel, as opposed to the GIF format’s 8-bit and
256 colors. To make JPEGs usable, the large amount of  color
information must be compressed, which is accomplished by
removing what the algorithm considers redundant information.
This is often referred to as lossy compression-in which pixels are
lost-as opposed to lossless compression, a characteristic of GIF
images.
The more compressed your JPEG file, the more degraded the
image. When you first save a JPEG image, your graphics
program asks you for the desired level of compression. As an
example, take a look at the three pictures in figure below. Here
you can compare the effects of JPEG compression ratios and
resulting file sizes to the original image itself. As you can
probably tell, JPEG does an excellent job of compression, with
even the highest degree of compression having only a little
visible impact. Keep in mind that each picture has its own
reaction to compression.

JPEG compression can save your Web visitors substantial
download time, with little loss of  image quality.
With JPEGs, what is compressed for storage must be
uncompressed for viewing. When a JPEG picture on your Web
page is accessed by a visitor’s browser, the image must first be
downloaded to the browser and then uncompressed before it
can be viewed. This dual process adds additional time to the
Web-browsing process, but it is time well spent for
photographic images. JPEGs, unlike GIFs, have neither
transparency nor animation features.
A newer strand of JPEG called Progressive JPEG gives you the
interlace option of the GIF format, however. Although not all
browsers support the interlace feature of  Progressive JPEG,
they render the image regardless.

PNG
The latest entry into the Web graphics arena is the Portable
Network Graphics format, or PNG. Combining the best of
both worlds, PNG has lossless compression, like GIF, and is



129

E
-M

E
D

IA
capable of millions of  colors, like JPEG. Moreover, PNG offers
an interlace scheme that appears much more quickly than either
GIF or JPEG, as well as transparency support that is far
superior to both the other formats.
One valuable aspect of the PNG format enables the display of
PNG pictures to appear more uniform across various computer
platforms. Generally, graphics made on a PC look brighter on a
Macintosh, and Mac-made images seem darker on a PC. PNG
includes gamma correction capabilities that alter the image
depending on the computer used by the viewer.

Using Inline Images
An inline image can appear directly next to text—literally in the
same line. The capability to render inline images is one of the
major innovations of  the World Wide Web’s transition from
the Internet. This section covers all the basics of inserting inline
images into Dreamweaver and modifying their attributes.

Inserting inline images
Dreamweaver can open and preview any graphic in a GIF,
JPEG, or PNG format. With Dreamweaver, you have six
methods for placing a graphic on your Web page:
• From the Objects panel, select the Insert Image button.
• From the menu bar, choose Insert->age.
• From the keyboard, press Ctrl+Alt+I

(Command+Option+I ).
• Point to an image file in the Site window using

Dreamweaver’s Point to File feature.
• Drag either the Insert Image button or an icon from your file

manager (Explorer or Finder) to your page.
• Drag a thumbnail (a small version of an image) or filename

from the Images category of the Assets panel onto your
page. This capability is new in Dreamweaver 4 and is covered
in detail in a following section.

The first four methods require that you first position the cursor
at the point where you want the image to appear on the page;
the drag-and-drop method enables you to place the image inline
with any existing element.
For all but the method using the Assets panel, Dreamweaver
opens the Select Image Source dialog box and asks you for the
path or address to your image file. Remember that in HTML, all
graphics are stored in separate files linked from your Web page.
The image’s address can be just a filename, a directory path and
filename on your system, a directory path and filename on your
remote system, or a full URL to a graphic on a completely
separate Web server. You don’t have to have the file
immediately available to insert the code into your HTML.

In this Select Image Source dialog box, you can keep track of
your image’s location relative to your current Web page.
From the Select Image Source dialog box, you can browse to
your image folder, and preview images before you load them.
To enable this feature, make sure the Preview Images option is
selected. Dreamweaver can preview GIF, JPEG, or PNG files.
In the lower portion of the dialog box, the URL text box
displays the format of the address Dreamweaver inserts into
your code. Below the URL text box is the Relative To list box.
Here you can choose to declare an image to be relative to the
document you’re working on (the default) or relative to the site
root. (After you’ve saved your document, you see its name
displayed beside the Relative To box.)

Modifying images
When you insert an image in Dreamweaver, the image tag,
<img>, is inserted into your HTML code. The <img> tag takes
several attributes, all of which can be entered through the
Property Inspector. Code for a basic image looks like the
following:
<img src=”images/Collection01.gif ” width=”172”
height=”180”>
Dreamweaver centralizes all of its image functions in the
Property Inspector. The Image Property Inspector, shown in
Figure below, displays a small thumbnail of the image as well as
its file size. Dreamweaver automatically inserts the image
filename in the Src text box (as the src attribute). To replace a
currently selected image with another, click the folder icon next
to the Src text box, or double-click the image itself. This
sequence opens the Select Image Source dialog box. When
you’ve selected the desired file, Dreamweaver automatically
refreshes the page and corrects the code.
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The Image Property Inspector gives you total control over the
HTML code for every image.
With the Property Inspector open when you insert your image,
you can begin to modify it immediately.

Editing the Image
Dreamweaver is a terrific Web authoring tool, but it’s not a
graphics editor. Quite often, after you’ve inserted an image into
your Web page, you find that the picture needs to be altered in
some way. Perhaps you need to crop part of  the image or make
the background transparent. Dreamweaver enables you to
specify your primary graphics editor for each type of graphic in
the File Types/Editors category of the Preferences.
Once you’ve picked an image editor, clicking the Edit button in
the Property Inspector opens the application with the current
image. After you’ve made the modifications, just save the file in
your image editor and switch back to Dreamweaver. The new,
modified graphic has already been included in the Web page.

Adjusting height and width
The width and height attributes are important: Browsers build
Web pages faster when they know the size and shape of  the
included images. Dreamweaver reads these attributes when the
image is first loaded. The width and height values are initially
expressed in pixels and are automatically inserted as attributes in
the HTML code.
Browsers can dynamically resize an image if its height and width
on the page are different from the original image’s dimensions.
For example, you can load your primary logo on the home page
and then use a smaller version of it on subsequent pages by
inserting the same image with reduced height and width values.
Because you’re only loading the image once and the browser is
resizing it, download time for your Web page can be
significantly reduced.

You don’t have to use pixels to enter your resizing
measurements into Dreamweaver’s Property Inspector. You can

also use inches (in), picas ( pc), points ( pt), millimeters (mm),
or centimeters (cm). The values must be entered without spaces
between the number and the measurement abbreviation, as
follows:

72pt
You can also combine measurement systems. Suppose, for
example, you want to resize a picture’s height to 2 inches and 5
centimeters. In the Property Inspector, you enter the following
value in the H text box:

2in+5cm
Dreamweaver translates both inches and centimeters to their
equivalent in pixels and then adds them together. The
measurements are system-dependent; on the Macintosh, an
inch equals 72 pixels and on Windows, an inch is 96 pixels.
When you use values with a combined measurement system,
you can only add values- you can’t subtract them. When you
press the Tab key or click outside of the height and width
boxes, Dreamweaver converts your value to pixels.

Working with alignment options
Just like text, images can be aligned to the left, right, or center.
In fact, images have much more flexibility than text in terms of
alignment. In addition to the same horizontal alignment
options, you can align your images vertically in nine different
ways. You can even turn a picture into a floating image type,
enabling text to wrap around it.

Horizontal alignment
When you change the horizontal alignment of a line-from left
to center or from center to right-the entire paragraph moves.
Any inline images that are part of that paragraph also move.
Likewise, selecting one of a series of inline images in a row and
realigning it horizontally causes all the images in the row to
shift. In Dreamweaver, the horizontal alignment of an inline
image is changed in exactly the same way you realign text, with
alignment buttons found on the Property Inspector. As with
text, buttons exist for Left, Center, and Right. Although these
are very conveniently placed on the lower portion of the
Graphics Property Inspector, the alignment attribute is actually
written to the <p> or other block element enclosing the image.

Vertical alignment
Because you can place text next to an image-and images vary so
greatly in size-HTML includes a variety of options for specifying
just how image and text line up. As you can see from the chart
in Figure below ,a wide range of  possibilities is available. To
change the vertical alignment of any graphic in Dreamweaver,
open the Align drop-down list in the Image Property Inspector
and choose one of the options.
Dreamweaver writes your choice into the align attribute of the
<img> tag. The various vertical alignment options are listed in
the following table, and you can see examples of each type of
alignment in figure given below.
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You can align text and images in one of  nine different ways
using the Align option box on the Image Property Inspector.

The final two alignment options, Left and Right, are special
cases; details about how to use their features are covered in the
following section.

Wrapping text
Long a popular design option in conventional publishing,
wrapping text around an image on a Web page is also
supported by most, but not all, browsers. As noted in  the
preceding section, the Left and Right alignment options turn a
picture into a floating image type, so called because the image
can move depending on the amount of text and the size of the
browser window.

Your text wraps around the image depending on where the
floating image is placed (or anchored). If you have the feature
enabled in the Invisibles pane of Preferences, Dreamweaver
inserts a Floating Image Anchor symbol to mark the floating
image’s place. The Figure below shows two examples of text
wrapping. In the top case, the Floating Image Anchor symbol is
placed in the midst of the first paragraph, which causes the
three paragraphs to flow around the right-aligned image. In the
bottom case, the image is left-aligned.
The Floating Image Anchor is not just a static symbol. You can
click and drag the anchor to a new location and cause the
paragraph to wrap in a different fashion. Be careful though—if
you delete the anchor, you also delete the image it represents.
You can also wrap a portion of the text around your left- or
right-aligned picture and then force the remaining text to appear
below the floating image. However, the HTML necessary to do
this task cannot currently be inserted by Dreamweaver and must
be coded by hand. You have to force an opening to appear by
inserting a break tag, with a special clear attribute, where you
want the text to break. This special <br> tag has three forms:

Aligning an image left or right enables text to wrap around
your images.
<br clear=left> Causes the line to break,

and the following text
moves down vertically until no
floating images are on
the left.

<br clear=right> Causes the line to break, and the
following text
moves down vertically until no
floating images are on
the right.

<br clear=all> Moves the text following the image
down until no floating images are
on either the left or the right.
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Topics Covered
• Page Header and footers , Fixed verses flexible tables,

General  design considerations
• Dreamweaver - Putting pictures in background, Applying

simple web animation, Including banner  ads, Inserting
rollover images

Objectives
Upon completion of this lesson, you should be able to:
• Understand why are page headers a site identity
• proper usage of fixed tables
• areas where flexible tables are used
• How to divide the webpage  with horizontal rules
• apply a simple web animation
• include banner ads
• Insert rollover images

Page Headers And Footers
Many Web authors surrender to the giddy thrills of  large home
page graphics, forgetting that a Web page is not just a visual
experience- it has to function efficiently to retain its appeal to the
user. Remember that the page builds its graphic impact only
gradually as it is downloaded to the user. The best measure of
the efficiency of a page design is the number of options
available for readers within the top four inches of the page. A
big, bold graphic may tease casual Web surfers, but if  it takes
the average reader thirty seconds to download the top of your
page, and there are few links to be seen until he or she scrolls
down the page (causing even longer delays), then you may lose a
big part of your audience before you offer them links to the rest
of your site.

Page headers: Site identity
Careful graphic design will give your Web site a unique visual
identity. A “signature” graphic and page layout allows the reader
to grasp immediately the purpose of the document and its
relation to other pages. Graphics used within headers can also
signal the relatedness of  a series of  Web pages. Unlike designers
of  print documents, designers of  Web systems can never be
sure what other pages the reader has seen before linking to the
current page. Sun Microsystems’s many Web pages and subsites
all include a signature header graphic that includes basic
navigation links:

Even if you choose not to use graphics on your pages, the
header area of  every Web page should contain a prominent title
at or near its top. Graphics placed above the title line should not
be so large that they force the title and introductory text off the
page on standard office-size display screens. In a related series
of documents there may also be subtitles, section titles, or
other text elements that convey the relation of the displayed

document to others in the series. To be effective, these title
elements must be standardized across all the pages in your site.

Page footers: Provenance
Every Web page should contain basic data about the origin and
age of the page, but this repetitive and prosaic information
does not need to be placed at the top of the page. Remember,
too, that by the time readers have scrolled to the bottom of
your Web page the navigation links you might have provided at
the top may no longer be visible. Well-designed page footers
offer the user a set of links to other pages in addition to
essential data about the site.
The pages in the IBM Web site all carry a distinctive footer
graphic with a consistent visual and functional identity:

Fixed Versus Flexible
The behavior of an HTML table depends largely on how its
cells are defined. One “feature” of tables is that they try to be
accommodating; they expand and collapse to accommodate
their contents and to fit the dimensions of the viewer’s browser
window. In their most basic form, tables are not much more
precise than plain text.

Example: Variable-width layout table (opens in new window)
Example: Fixed-width layout table (opens in new window)
It is possible to create flexible layout tables that resize gracefully
without sacrificing the integrity of your design, but if you are
turning to layout tables for precision you will need to use fixed-
width layout tables.

LESSON 27:
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Use fixed-width tables for precise layouts
Putting content into a fixed-width table means that your page
layout will be stable whatever the size of the user’s screen or
browser window. Designing in a stable environment means
that you can fix the position of elements on the page and
control typographic features such as line length and spacing. A
downside of a controlled layout is that on large display screens a
major portion of  screen real estate goes unused. You can avoid
the “wasteland” effect of a fixed layout by centering the table in
the browser window or by designing a background graphic to
fill the empty areas of the screen.

In a fixed-width table you must define cell widths with absolute
values. This will keep the tables from expanding to fill the
window. Then, to keep tables from collapsing when the
browser window is too small to accommodate their
dimensions, include an invisible image equal to the width of
the cell in each table cell. These two techniques will force table

cells to maintain their dimensions regardless of the size of the
browser window.

Use flexible tables for layouts that adapt
A popular viewpoint is that designers should embrace the
nature of  Web documents and create flexible layouts that adapt
to different viewing conditions. To do this, you need to be
willing to abandon control of aspects of your page design,
notably line length. Flexible design is in many ways more
challenging than fixed design because it requires a deep
understanding of HTML and its implementation across
platforms and browsers. It also requires that you think “outside
the box” of your own configuration and come up with graphics
and layouts that will still “work” under varying viewing
conditions.

Tables are inherently flexible, so one approach to flexible design
is to let table cells size themselves according to their contents
and the size of  the browser window. Another approach is to
specify cell widths using percentage values; for example, set the
left scan column width to 40 percent and the main text column
width to 60 percent. That way the columns will resize when the
window size is changed, but they will always maintain their
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relative proportions regardless of the size of the browser
window. You can also use a combination of  fixed and
unspecified table cell widths to create a flexible layout. Using this
technique you specify in pixels the width of the columns that
require absolute positioning - for example, a navigation column
or gutter - and leave the remaining column, such as the text
column, unspecified so that it adapts to fill the screen.

General Design Considerations

Understand The Medium
Readers experience Web pages in two ways: as a direct medium
where pages are read online and as a delivery medium to access
information that is downloaded into text files or printed onto
paper. Your expectations about how readers will typically use
your site should govern your page design decisions. Documents
to be read online should be concise, with the amount of
graphics carefully “tuned” to the bandwidth available to your
mainstream audience. Documents that will most likely be
printed and read offline should appear on one page, and the
page width should be narrow enough to print easily on
standard paper sizes.

Include fixed page elements
Each page should contain a title, an author, an institutional
affiliation, a revision date, copyright information, and a link to
the “home page” of  your site. Web pages are often printed or
saved to disk, and without this information there is no easy way
to determine where the document originated. Think of each
page in your site as a newspaper clipping, and make sure that
the information required to determine its provenance is
included.

Don’t impose style

Don’t set out to develop a “style” for your site, and be careful
about simply importing the graphic elements of  another Web
site or print publication to “decorate” your pages. The graphic
and editorial style of  your Web site should evolve as a natural
consequence of consistent and appropriate handling of your
content and page layout.

Maximize prime real estate
In page layout the top of the page is always the most dominant
location, but on Web pages the upper page is especially
important, because the top four inches of the page are all that is
visible on the typical display screen. Use this space efficiently and
effectively.

Use subtle colors
Subtle pastel shades of colors typically found in nature make
the best choices for background or minor elements. Avoid bold,
highly saturated primary colors except in regions of maximum
emphasis, and even there use them cautiously.

Beware of Graphic Embellishments
Horizontal rules, graphic bullets, icons, and other visual
markers have their occasional uses, but apply each sparingly (if
at all) to avoid a patchy and confusing layout. The same
consideration applies to the larger sizes of  type on Web pages.
One reason professional graphic designers are so impatient with
plain HTML is that the H1 and H2 header tags display in
grotesquely large type on most Web browsers. The tools of
graphic emphasis are powerful and should be used only in
small doses for maximum effect. Overuse of graphic emphasis
leads to a “clown’s pants” effect in which everything is garish
and nothing is emphasized.

Computer Lab

Dreamweaver

Putting Pictures In The Background
You can also have an image in the background of  an HTML
page. This section covers some of the basic techniques for
incorporating a background image in your Dreamweaver page.
Note:Remember, you add an image to your background in
Dreamweaver by modifying the Page Properties. Either choose
Modify->Page Properties or select Page Properties from the
contextual menu that pops up when you right-click
(Command+click) any open area on the Web page. In the Page
Properties dialog box, select a graphic by choosing the Browse
(Choose) button next to the Background Image text box. You
can use any file format supported by Dreamweaver-GIF, JPEG,
or PNG.
Two key differences exist between background images and the
foreground inline images discussed in the preceding sections of
this chapter. First and most obvious, all other text and graphics
on the Web page are superimposed over your chosen
background image. This capability can bring extra depth and
texture to your work; unfortunately, you have to make sure the
foreground text and images work well with the background.
Basically, you want to ascertain that enough contrast exists
between foreground and background. You can set the default
text and the various link colors through the Page Properties
dialog box. When trying out a new background pattern, you
should set up some dummy text and links. Then use the Apply
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button on the Page Properties dialog box to test different color
combinations. See Figure 10-9 for an example of this test at
work.
The second distinguishing feature of background images is that
the viewing browser completely fills either the browser window
or the area behind the content of  your Web page, whichever is
larger. So, if  you’ve created a splash page with only a 200×200
foreground logo, and you’ve incorporated an amazing
1,024×768 background that took you weeks to compose, no
one can see the fruits of your labor in the background—unless
they resize their browser window to 1,024×768. On the other
hand, if your background image is smaller than either the
browser window or what the Web page content needs to
display, the browser and Dreamweaver repeat (or tile) your
image to make up the difference.

If  you’re using a background image, be sure to check the default
colors for text and links to make sure enough contrast exists
between background and foreground.

Dividing the Web Page with Horizontal Rules
HTML includes a standard horizontal line that can divide your
Web page into specific sections. The horizontal rule tag, <hr>,
is a good tool for adding a little diversion to your page without
adding download time. You can control the width (either
absolutely or relative to the browser window), the height, the
alignment, and the shading property of the rule. These
horizontal rules appear on a line by themselves; you cannot
place text or images on the same line as a horizontal rule.
To insert a horizontal rule in your Web page in Dreamweaver,
follow these steps:
1. Place your cursor where you want the horizontal rule to

appear.
2. From the Common pane of the Objects panel, select the

Insert Horizontal Rule button or choose the Insert-
>Horizontal Rule command.

Dreamweaver inserts the horizontal rule and opens the
Horizontal Rule Property Inspector, as shown in the figure
below:

1) To change the width of  the line, enter a value in the width
(W) text box. You can insert either an absolute width in
pixels or a relative value as a percentage  of the screen.
• To set a horizontal rule to an exact width, enter the

measurement in pixels in the width (W) text box and
press the Tab key. Then select pixels in  the drop-down
list.

• To set a horizontal rule to a width relative to the
browser window, enter the percentage amount in the
width (W) text box and press Tab. Then select the
percent sign (%) in the drop-down list.

The Horizontal Rule Property Inspector controls the width,
height, and alignment for these HTML lines.
2) To change the height of  the horizontal rule, type a pixel

measurement in the height (H) text box.
For both the width and height values, you can also enter a
value in inches (in), picas (pc), points (pt), millimeters (mm),
or centimeters (cm), just as with images. When you press
Tab to leave the text box, Dreamweaver converts your entry
to pixels.

3) To change the alignment from the default (centered), open
the Align dropdown list and choose another alignment.

4) To disable the default “embossed” look for the rule, deselect
the Shading checkbox.

5) If you intend to address (call) your horizontal rule in
JavaScript or another application, you can give it a unique
name. Type it into the unlabeled name text box located
directly to the left of the H text box.

To modify any inserted horizontal rule, simply click it. (If  the
Property Inspector is not already open, you have to double-click
the rule.) As a general practice, size your horizontal rules using
the percentage option if you are using them to separate items
on a full screen. If the horizontal rules are being used to divide
items in a specifically sized table column or cell, use the pixel
method.
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Applying Simple Web Animation
Why include a section on animation in a chapter on inline
images? On the Web, animations are, for the most part, inline
images that move. Outside of the possibilities offered by
Dynamic HTML. Web animations typically either are animated
GIF files or are created with a program such as Flash that
requires a plug-in. This section takes a brief look at the
capabilities and uses of GIF animations.
A GIF animation is a series of still GIF images flipped rapidly to
create the illusion of motion. Because animation-creation
programs compress all the frames of your animation into one
file, a GIF animation is placed on a Web page in the same
manner as a still graphic.
In Dreamweaver, click the Insert Image button in the Objects
panel or choose Insert->Image and then select the file.
Dreamweaver shows the first frame of your animation in the
Document window. To play the animation, preview your Web
page in any graphics-capable browser.
As you can imagine, GIF animations can quickly grow to be very
large. The key to controlling file size is to think small: Keep
your images as small as possible with a low bit-depth (number
of colors) and use as few frames as possible.
To create your animation, use any graphics program to produce
the separate frames. One excellent technique uses an image-
processing program such as Adobe Photoshop and
progressively applies a filter to the same image over a series of
frames. Figure below shows the individual frames created with
Photoshop’s Lighting Effects filter. When animated, a spotlight
appears to move across the word.
You need an animation program to compress the separate
frames and build your animated GIF file. Many commercial
programs, including Macromedia’s Fireworks, can handle GIF
animation. QuickTime Pro can turn individual files or any other
kind of movie into an animated GIF, too. Most animation
programs enable you to control the number of times an
animation loops, the delay between frames, and how
transparency is handled within each frame.

Five of twelve frames are compressed into one animated file.

Dreamweaver Technique: Including Banner Ads
Banner ads have become an essential aspect of  the World Wide
Web; for the Web to remain, for the most part, freely accessible,
advertising is needed to support the costs. Banner ads have
evolved into the de facto standard. Although numerous
variations exist, a banner ad is typically an animated GIF of a
particular width and height and under a specified file size.
File size for a banner ad is not as clearly determined, but it’s just
as important. The last thing a hosting site wants is for a large,
too heavy banner to slow down the loading of its page. Usually
a commercial site has an established maximum file size for a
particular banner ad size. Generally banner ads are around 10K
and no more than 12K. The lighter your banner ad, the faster it
loads and-as a direct result- the more likely Web page visitors
stick around to see it.
It’s not unusual for an advertisement to come from an outside
source, so a Web page designer often has to allow space for the
ad without incorporating the actual ad. Some Web designers use
special placeholder images. In Dreamweaver, placeholder ads can
easily be maintained as a Library item and placed as needed from
the Assets panel, as shown in Figure below, graphics such as
these, you could also just insert a plain <img> tag-with no src
parameter-using the Quick Tag Editor. When an <img> tag
without a src is in the code, Dreamweaver displays a broken
image icon that could then be resized to the  proper banner ad
dimensions in the Property Inspector.
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Use the Library to store standard banner ad images for use as
placeholders.

Inserting Rollover Images
Rollovers are among the most popular of  all Web page effects.
A rollover (also known as a mouseover) occurs when the user’s
pointer passes over an image and the image changes in some
way. It may appear to glow or change color and/or shape; when
the pointer moves away from the graphic, the image returns to
its original form. The rollover indicates interactivity and
attempts to engage the user with a little bit of flare.
Rollovers are usually accomplished with a combination of
HTML and JavaScript. Dreamweaver was among the first Web
authoring tools to automate the production of rollovers
through its Swap Image and Swap Image Restore behaviors.
Later versions of Dreamweaver make rollovers even easier with
the Rollover Image object. With the Rollover Image object, if
you can pick two images, you can make a rollover.
Technically speaking, a rollover is accomplished by manipulating
an <img> tag’s src attribute. You’ll recall that the src attribute is
responsible for providing the actual file name of the graphic to
be displayed; it is, quite literally, the source of the image. A
rollover changes the value of src from one image file to another.
Swapping the src value is analogous to having a picture within a
frame and changing the picture while keeping the frame.
Dreamweaver’s Rollover Image object automatically changes the
image back to its original source when the user moves the
pointer off  the image. Optionally, you can elect to preload the
images with the selection of  a checkbox. Preloading is a Web
page technique that reads the intended file or files into the
browser’s memory before they are displayed. With preloading,
the images appear on demand, without any download delay.
Rollovers are typically used for buttons that, when clicked, open
another Web page. In fact, JavaScript requires that an image
include a link before it can detect when a user’s pointer moves
over it. Dreamweaver automatically includes the minimum link
necessary: the #target link. Although JavaScript recognizes this
symbol as indicating a link, no action is taken if the image is
clicked by the user; the #, by itself, is an empty link. You can,

naturally, supply whatever link you want in the Rollover Image
object.
To include a Rollover Image object in your Web page, follow
these steps:
1) Place your cursor where you want the rollover image to

appear and choose Insert->Rollover Image or select Insert
Rollover Image from the Common panel of the Objects
panel. You can also drag the Insert Rollover Image button to
any existing location on the Web page.
Dreamweaver opens the Insert Rollover Image dialog box
shown in

2) If desired, you can enter a unique name for the image in the
Image Name textbox, or you can leave the name
automatically generated by Dreamweaver.

3) In the Original Image text box, enter the path and name of
the graphic you want displayed when the user’s mouse is not
over the graphic. You can also choose the Browse (Choose)
button to select the file. Press Tab when you’re done.

4) In the Rollover Image text box, enter the path and name of
the graphic you want displayed when the user’s pointer is
over the graphic. You can also choose the Browse (Choose)
button to select the file.

The Rollover Image object makes rollover graphics quick
and easy.
5) If desired, specify a link for the image by entering it in the

When Clicked, Go To URL text box. If  you are entering a
path and file by hand, be sure to delete the initial target link,
#. If you use the Browse (Choose) button to select your file,
the target link is deleted for you.

6) To enable images to load only when they are required,
deselect the Preload Images option. Generally, it is best to
leave this option selected (the default) so that no delay occurs
in the rollover appearing.

7) Click OK when you’re finished.

Assignment
1. What are Graphic “safe” areas?
2. What are the four factors for determining page length

according to content in Web page?
3. Explain with limitation of scrolling in a web document?
4. What is the difference between Absolute Font and Relative

font size?
5. How do you add font color by HTML coding?
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6. How can you edit the font list?
7. What is the usability of grids in a web page
8. What are frames and explain their functionality?
9. Difference between GIF87a and GIF89a?
10.What is the difference between Absolute Font and Relative

font size?
11.How do you add font color by HTML coding?
12.How can you edit the font list?
13.What is the difference in usability of page headers and

footers?
14.Identify the advantages of using flexible tables?
15.What is the background image and foreground inline

images?
16.How does GIF image have the animated behavior?
17.What are the considerations for using a banner in a website?
18.What is a roll over image?

Notes
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Topics Covered
• Distinguishing graphic text and HTML text, An

introduction to type, Letter  as pictures, Dreamweaver Lab
evaluation

Objectives
Upon completion of this lesson, you should be able to:
• Understand the basic of  Typography
• Distinguish graphic text and HTML text
• An introduction to type
• Dreamweaver Lab evaluation

Typography
Typography exists to honor content.
Robert Bringhurst, The Elements of  Typographic Style
TYPOGRAPHY is the balance and interplay of letterforms on
the page, a verbal and visual equation that helps the reader
understand the form and absorb the substance of the page
content. Typography plays a dual role as both verbal and visual
communication. As readers scan a page they are subconsciously
aware of  both functions: first they survey the overall graphic
patterns of the page, then they parse the language, or read.
Good typography establishes a visual hierarchy for rendering
prose on the page by providing visual punctuation and graphic
accents that help readers understand relations between prose
and pictures, headlines and subordinate blocks of text.

Website Typography
Typography on the web is tricky, you need to distinguish
between graphic text and HTML text.
Typography can be tricky on the web because you need to
distinguish between graphic text and HTML text. HTML text
can be controlled in terms of size, color, leading, and font (to
some extent). Unfortunately line breaks are just about
impossible to control in HTML text. This is for two reasons,
one is that most text areas will “stretch” with the browser as it
is widened or narrowed by the user. The second reason is that it
is possible to place text into a table that does not stretch, but
the different ways type is handled between Macintosh and
Windows (and even between operating systems) makes it
impossible to specifically control the line breaks in a block of
text.
Although you can specify any font in HTML text you should
normally choose between Arial, Verdana, Helvetica, or Times
because for the text to display in the chosen font it must be
installed on the user’s system. These four are all likely to be
installed.
If you do want to control font and line breaks you will need to
treat type graphically. This is often used for navigation graphics,
headlines or sub heads. Keep in mind though that any text that
is specified as a graphic will not be searchable by the search

engines and cannot be edited through WebTop (or other
content management systems).
Tech note: precise control of graphic text. By duplicating the
layers of type graphics and adjusting the layer opacity of the
duplicated layer you can control the intensity of the type color.
When creating small graphic type, adjust the point size by 0.1
increments until it looks best. (Sometimes reducing the size will
improve the clarity of the type due to the relative juxtaposition
of the pixels.) Keep all type layers unrendered so that they can
be used later to create additional graphics consistently.

More Reading
Web Typography Tutorial by Nadav Savio
An Introduction to Type
Why should we care so much about this arcane art? Design is
fundamentally about communication, and, for all the power of
images, words remain at the core of how we communicate.
Typography is the practice of  visually representing words. Type
conveys meaning, both in the obvious sense that words and
sentences communicate, and in the subtler sense that the
particular visual representation we use - the style, size, and so on
- affects the message. While a computer might care only which
ASCII codes are represented, we humans are affected by
associations and visual relationships: To us, Helvetica means
something different than Garamond.

Type also affects communication in the straightforward sense of
legibility. If  I can’t read your text, I certainly can’t understand it,
no matter how clever your writing may be. But legibility isn’t
just an algorithm to follow (“always use 66 characters per line”
or “serif typefaces are more readable than sans-serif ”). Legibility
is subtly affected by the shape, spacing, and size of individual
letters and words, and the arrangement of those words into
lines on the page or screen.
All of the effort we put into our text - both in terms of content
and presentation - has a direct effect on the meaning of the
message we convey. This is one of  the most basic precepts of
typography. So, before we get into the specifics of  displaying
type, let’s explore the relationship between type and meaning.

Associating Meaning with Type
When I say type affects meaning, what am I talking about? Why
can’t I just choose one of my favorite faces and be done with it?
Well, I think an illustration is in order:

LESSON 28:
TYPOGRAPHY-1
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This example may be extreme, but the point is that your choice
of typeface can either undercut your desired meaning or it can
support and extend it. When we see “HAL 9000” set in Data 70
- a typeface designed in 1970 to look like futuristic computer
output - the idea of HAL, the misguided computer from
Kubrick’s 2001: A Space Oddyssey, is communicated both in the
semantic meaning of the words and in the visual, associational

meaning of the letterforms. The visual and semantic meanings
coincide, making each stronger. When we see the same words in
the whimsical Art Nouveau face Hobo, our brains have to work
to ignore the visual meaning conveyed by the typeface in order
to comprehend the semantic meaning contained in the word.
Of course, as with any “rule,” there are times where you might
want to intentionally force this conflicted reaction for effect.
What, then, makes one typeface communicate one thing and
another typeface communicate some other thing? This is a
difficult question, but the simple answer is that it does so in
two ways: by association and through basic visual
communication.
Associations have to do with our past experience: Where have
we seen a given typeface before? What did it mean then?
Schoolbook conveys a feeling of childhood innocence in large
part because we’ve seen it before in grade-school primers and
children’s books:

We similarly associate stencil faces with blueprints, construction
sites, military lettering, and shipping crates. Associations also
work in reverse: One of the complaints typographers have
about Helvetica is that it’s been used so often, in so many

different circumstances, that it has ceased to have any
associational meaning. Of  course this sort of meaninglessness
can be a meaning all its own, perfect for creating a sort of
unstyled style.
The IBM logo is another interesting example of how type gains
meaning. Many of  us see this familiar logo and think the
horizontal lines are there to convey the idea that IBM makes
computers. But, as it turns out, the lines are there for very
different reasons: They lighten up what would otherwise be a
very heavy logo while suggesting the company’s authority and
reliability by evoking the anti-forgery lines of financial
documents. In fact, they signify “computer” to us only because
of their use in the logo of a huge, highly-visible computer
company. As Paul Rand, the logo’s designer, put it, “It’s since
been used to symbolize the computer industry, and that’s only
because it’s been used by IBM. There’s nothing inherent in
horizontal lines or vertical lines that says ‘computer’ except what
you read into it because of  association with a good company.”
(Paul Rand, by Steven Heller, p. 156.)
Letters as Pictures
Unlike associational meaning, which is dependent on culture
and history, visual communication comes into play on a basic
human level. Hard edges evoke different emotional responses
than soft edges. Ornamentation, such as elaborate serifs or
uneven edges, will give a different feel than sparse, unadorned
letterforms. Other differences abound, including shape,
thickness, color, variation, symmetry, and so on.

Obviously, the differences among type faces are myriad. To get a
grasp on all of these distinctions, it helps to name the different
aspects of letterforms and typographic design.

Computer Lab

Dreamweaver

Class Exercise

As now, we have covered enough of Dreamweaver already; you
must be working on your personal home page concurrently.
Today, we concentrate ourselves on applying the various
techniques we learnt in Dreamweaver till now. Enhance your
web site with all the elements we learnt till now, your evaluation
will be done, with respect to the maximum usability and clutter
free web design you create.
Your personal web site may be a portfolio website or contain
general information about yourself  and your family, friends etc.,
You are supposed to submit your webpage before the
computer lab is over, your work will be evaluated.
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Topics Covered
• Characteristics of type on the web, Content Structure and

Visual logic,
• Dreamweaver - Establishing web links, understanding URLs,

Hypertext, Pointing to  a file, Adding an Email link,
Navigating with anchors, moving within the same
document, Targeting your links,

Objectives
Upon completion of this lesson, you should be able to:
• Characteristic of type on the Web
• Understand Visual logic in Web designing
• Understand URLs
• Adding hyperlink to your website
• Use point to file icon
• Add email link
• Use anchors in your web document
• Anchors within a document
• Target  your links

Characteristics of type on the Web
Although the basic rules of typography are much the same for
both Web pages and conventional print documents, type on-
screen and type printed on paper are different in crucial ways.
The computer screen renders typefaces at a much lower
resolution than is found in books, magazines, and even pages
output from inexpensive printers. Most magazine and book
typography is rendered at 1200 dots per inch (dpi) or greater,
whereas computer screens rarely show more than about 85 dpi.
Also, the useable area of typical computer screens is smaller than
most magazine and book pages, limiting the information you
can deliver on a Web page without scrolling.
But perhaps the most distinctive characteristic of  Web
typography is its variability. Web pages are built on the fly each
time they are loaded into a Web browser. Each line of  text, each
headline, each unique font and type style is re-created by a
complex interaction of  the Web browser, the Web server, and
the operating system of  the reader’s computer. The process is
fraught with possibilities for the unexpected: a missing font, an
out-of-date browser, or a peculiar set of font preferences
designated by the reader. You should regard your Web page
layouts and typography as suggestions of  how your pages should
be rendered -you’ll never know exactly how they will look on
the reader’s screen.

Content structure and visual logic
The originators of HTML were scientists who wanted a
standard means to share particle physics documents. They had
little interest in the exact visual form of the document as seen
on the computer screen. In fact, HTML was designed to enforce
a clean separation of content structure and graphic design. The
intent was to create a World Wide Web of  pages that will
display in every system and browser available, including
browsers that “read” Web page text to visually impaired users
and can be accurately interpreted by automated search and
analysis engines.
In casting aside the graphic design and editorial management
traditions of  publishing, the original designers of  the Web
ignored human motivation. They were so concerned about
making Web documents machine-friendly that they produced
documents that only machines (or particle physicists) would
want to read. In focusing solely on the structural logic of
documents they ignored the need for the visual logic of
sophisticated graphic design and typography.
For example, most graphic designers avoid using the standard
heading tags in HTML (H1, H2, and so on) because they lack
subtlety: in most Web browsers these tags make headlines look
absurdly large (H1, H2) or ridiculously small (H4, H5, H6). But
the header tags in HTML were not created with graphic design
in mind. Their sole purpose is to designate a hierarchy of
headline importance, so that both human readers and
automated search engines can look at a document and easily
determine its information structure. Only incidentally did
browser designers create a visual hierarchy for HTML headers by
assigning different type sizes and levels of boldness to each
header element.

LESSON 29
WEB LINKS AND
DREAMWEAVER
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Computer Lab

Dreamweaver

Establishing Web Links

To me, links are the Web. Everything else about the medium
can be replicated in another form, but without links, there
would be no World Wide Web. As your Web design work
becomes more sophisticated, you’ll find more enhanced uses
for links: sending mail, connecting to an FTP site—even
downloading software. In this chapter, you learn how
Dreamweaver helps you manage the various types of links, set
anchors within documents to get smooth and accurate
navigation, and establish targets for your URLs. But first, let’s
begin with an overview on Internet addresses to give you the
full picture of the possibilities.

Understanding URLs
URL stands for Uniform Resource Locator. An awkward
phrase, it nonetheless describes itself  well—the URL’s function
is to provide a standard method for finding anything on the
Internet. From Web pages to newsgroups to the smallest
graphic on the most esoteric of pages, everything can be
referenced through the URL system.
The URL can use up to six different parts, although all parts are
not necessary for the URL to be read. Each part is separated by
some combination of a slash, colon, and hash mark delimiter.
When entered as an attribute’s value, the entire URL is generally
enclosed within quotes to ensure that the address is read as one
unit. A generic URL using all the parts looks like the following:
method://server:port/path/file#anchor
Here’s a real-world example that also uses every section:
http://www.idest.com:80/dreamweaver/index.htm# bible
In order of appearance in the body of an Internet address, left
to right, the parts denote the following
The method used to access the resource. The method to
address Web servers is the HyperText Transport Protocol
(HTTP). Other methods are discussed later in this section.
The name of  the server providing the resource. The server
can either be a domain name (with or without the “www”
prefix) or an Internet Protocol ( IP) address, such as
199.227.52.143.
The port number to be used on the server. Most URLs do
not include a port number, which is analogous to a telephone
extension number on the server, because most servers use the
defaults.
The directory path to the resource. Depending on where the
resource (for example, the Web page) is located on the server,
the following paths can be specified: no path (indicating that the
resource is in the public root of the server), a single folder
name, or a number of folders and subfolders.
The filename of the resource. If the filename is omitted, the
Web browser looks for a default page, often named index.html
or index.htm. The browser reacts differently depending on the
type of file. For example, GIFs and JPEGs are displayed by
themselves; executable files and archives (Zip, StuffIt, and so
on) are downloaded.

The named anchor in the HTML document. This part is
another optional section. The named anchor enables the Web
designer to send the viewer to a particular section of an HTML
page.
Because it is used to communicate with servers, the HTTP
access method is far and away the most prevalent method on
today’s World Wide Web. In addition to the HTTP access
method, other methods connect with other types of servers.

Part of  the richness of  today’s Web browsers stems from their
capability to connect with all the preceding (and additional)
services.

Surfing the Web with Hypertext
Most often, you assign a link to a word or phrase on your page,
an image such as a navigational button, or a section of graphic
for an image map (a large graphic in which various parts are
links). Once you have created the link, you have to preview it in
a browser; links are not active in Dreamweaver’s Document
window.
Designate links in HTML through the anchor tag pair: <a> and
</a>. The anchor tag generally takes one main attribute—the
hypertext reference, which is written as follows:
href=”link name”
When you create a link in Dreamweaver, the anchor pair
surrounds the text or object that is being linked. For example,
if you link the phrase “Back to Home Page,” it may look like
the following:
<a href=”index.html”>Back to Home Page</a>
When you attach a link to an image, logo.gif, your code looks as
follows:
<a href=”home.html”><img src=”images/logo.gif ”></a>
Creating a basic link in Dreamweaver is easy. Simply follow these
steps:
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1. Select the text, image, or object you want to establish as a

link.
2. In the Property Inspector, enter the URL in the Link text box

as shown in the figure below, You can use one of  the
following methods to do so:

• Type the URL directly into the Link text box.
• Select the folder icon to the right of the Link text box

to open the Select File dialog box, where you can
browse for the file.

• Select the Point to File icon and drag your mouse to an
existing page or link. This feature is explained later in
this section.

• Drag a link from the Assets panel onto a text or image
selection.

Only a few restrictions exist for specifying linked URLs.
Dreamweaver does not support any letters from the extended
character set (also known as High ASCII ), such  as ¡, à, or ñ.
Complete URLs must have fewer than a total of 255 characters.
You should be cautious about using spaces in path names and,
thus, URLs. Although most browsers can interpret the address,
spaces are changed to a %20 symbol for proper Unix usage,
which can make your URLs difficult to read.
Text links are most often rendered with a blue color and
underlined. You can specify the document link color by
choosing Modify->Page Properties and selecting the Link Color
swatch. In Page Properties, you can also alter the color to which
the links change after being selected (the Visited Link Color) and
the color flashed when the link is clicked (the Active Link Color).

Pointing to a file
Dreamweaver has an alternative method of identifying a link-
pointing to it. By using the Point to File icon on the Property
Inspector, you can quickly fill in the Link text box by dragging
your mouse to any existing named anchor or file visible in the
Dreamweaver environment. The Point to File feature saves you
from having to browse through folder after folder as you search
for a file you can clearly see onscreen.
You can point to a file in another open Dreamweaver window
or one in another frame in the same window. If  your desired
link is a named anchor located further down the page,
Dreamweaver automatically scrolls to find it. You can even
point to a named anchor in another page, and Dreamweaver
enters the full syntax correctly.
Perhaps one of the slickest applications of the Point to File icon
is when it is used in tandem with the Site window. The Site
window lists all the existing files in any given Web site, and
when both it and the Document window are onscreen, you can
quickly point to any file.

Perhaps one of the slickest applications of the Point to File icon
is when it is used in tandem with the Site window. The Site
window lists all the existing files in any given Web site, and
when both it and the Document window are onscreen, you can
quickly point to any file.
1. Select the text or the graphic that you’d want to make into a

link.
2. In the Property Inspector, click and hold the Point to File

icon located to the right of the Link text box.
3. Holding down the mouse button, drag the mouse until it is

over an existing link or named anchor in the Document
window or a file in the Site window.

As you drag the mouse, a line extends from the Point to File
icon, and the reminder “Point to a file to make a link” appears
in the Link text box.
1) When you locate the file you want to link to, release the

mouse button. The filename with the accompanying path
information is written into the Link text box as shown in
the figure below:

The Point to File capability enables you to quickly insert a link to
any onscreen page.

Adding an E-Mail Link
E-mail links are very common on the Web. Rather than opening
a new Web page like a regular link, when an e-mail link is clicked,
a window for sending a new e-mail message is displayed. The
message window is already preaddressed to the recipient,
making it convenient to use. All the user has to do is add a
subject, enter a message, and select Send.
E-mail links no longer need be added by hand. Dreamweaver
includes an object that streamlines the process. Just enter the
text of  the line, and the e-mail address and the link is ready. E-
mail links, like other links, do not work in Dreamweaver when
clicked and must be previewed in the browser.
To enter an e-mail link with the new object, follow these steps:
2) Position your cursor where you want the e-mail link to

appear.
3)  From the Common category of the Objects panel, select the

Insert E-Mail Link button.
The Insert E-Mail Link dialog box, shown in the figure below:
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The Insert E-Mail Link object creates links that make it simple
for your Web page visitors to send an e-mail.
4) In the Insert E-Mail Link dialog box, enter the visible text

for the link in the Text field.
5) Enter the e-mail address in the E-Mail field.

Click OK when you’re done.
If you already have the text for the e-mail link in the document,
you can also usethe Property Inspector to insert an e-mail link.
Just highlight the text and in the Link field of the Property
Inspector, enter the URL in this format:
mailto:name@company.com
Make sure that the URL is a valid e-mail address with the @
sign properly placed.

Navigating with Anchors
Whenever you normally link to an HTML page, through
absolute or relative addressing, the browser displays the page
from the top. Your Web visitors must scroll to any information
rendered below the current screen. One HTML technique,
however, links to a specific point anywhere on your page
regardless of the display window’s contents. This technique
uses named anchors.
Using named anchors is a two-step process. First you place a
named anchor somewhere on your Web page. This placement is
coded in HTML as an anchor tag using the name attribute, with
nothing in between the opening and closing tags. In HTML,
named anchors look like the following:
<a name=”bible”></a>
The second step includes a link to that named anchor from
somewhere else on your Web page. If  used, a named anchor is
referenced in the final possible portion of an Internet address,
designated by the hash mark (#), as follows:
<a href=”http://www.idest.com/dreamweaver/
index.htm#bible>
You can include any number of  named anchors on the current
page or another page. Named anchors are commonly used with
a table of contents or index.
To insert a named anchor in Dreamweaver, follow these steps:
1. Place the cursor where you want the named anchor to appear.
2. Choose Insert->Named Anchor. You can also select the

Insert Named Anchor button from the Invisibles category
of the Objects panel. Or use the key shortcut Ctrl+Alt+A
(Command+Option+A).

3. The Named Anchor dialog box opens. Type the anchor
name into the text box.

When you press Enter (Return), Dreamweaver places a named
anchor symbol in the current cursor location and opens the
Named Anchor Property Inspector

The Named Anchor tag enables you to link to specific
areas of  a Web page.
4) To change an anchor’s name, click the named anchor symbol

within the page and alter the text in the Property Inspector.

Moving within the same document
One of the major advantages of using named anchors is the
almost instantaneous response the viewer receives when they
click them. The browser only needs to scroll to the particular
place in the document because the entire page is loaded. For
long text documents, this capability is an invaluable time-saver.
Once you have placed a named anchor-or all of them at once-in
your document,  you can link to these anchors. Follow these
steps to create a link to a named anchor in the same document:
Select the text or image that you want to designate as a link.
In the Link text box of the Property Inspector, type a hash
mark, #, followed by the exact anchor name.
For example:
#top
Remember, anchor names are case-sensitive and must be unique
in each document.
In Dreamweaver, you can also use the Point to File icon to
choose a named anchor link. If your named anchor is in the
same document, just drag the Point to File icon to the named
anchor symbol. When you release the mouse, the proper named
anchor is inserted into the Link text box. If the named anchor
is on the same page but off screen, Dreamweaver automatically
scrolls the Document window as you approach the edge. In
Windows, the closer you move to the edge, the faster
Dreamweaver scrolls. Dreamweaver even returns the screen to
your original location, with the new link at the top of the
screen, after you release the mouse button. In long documents
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with a table of contents or index linking to a number of named
anchors, it’s common practice—and a good idea—to place a link
back to the top of the page after every screen or every topic. This
technique enables your users to return to the menu quickly and
pick another topic without having to manually scroll all the way
back.

Targeting Your Links
Thus far, all of  this chapter’s links have had a similar effect:
They open another Web page or section in your browser’s
window. What if  you want to force the browser to open
another window and load that new URL in the new window?
HTML enables you to specify the target for your links.
Targets are most often used in conjunction with frames-that is,
you can make a link in one frame open a file in another. Here,
though, let’s take a look at one of  the HTML predefined targets
useful in a situation where you want to load another URL into a
new window.
To specify a new browser window as the target for a link in
Dreamweaver, follow these steps:
1) Select the text or image you want to designate as your new

link. In the Property Inspector, enter the URL into the Link
text box. After you’ve entered a link, the target option
becomes active.

2) Choose the option button next to the Target list box and
select _blank from the drop-down list. You can also type it
in the list box.

Dreamweaver inserts a _blank option in the Target list box, as
shown in Figure Below. Now, when your link is activated, the
browser spawns a new window and loads the referenced link
into it. The user has both windows available.

You can force a user’s browser to open a separate window to
display a specific link with the Target command.
The _blank target is most often used when the originating Web
page is acting as a jump station and has numerous links
available. By keeping the original Web page open, the user can
check out one site without losing the origin point.
You can even use the _blank target technique on named anchors
in the same document, thereby emulating frames to some
degree.

Notes
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Topics Covered
• Cascading style sheets, Advantages of CSS, How style sheet

works
• Dreamweaver - creating list, bulleted list, Editing unordered

list, Mastering Numbered lists, Editing ordered lists, Making
definition list

Objectives
Upon completion of this lesson, you should be able to:
• Define Cascading Style sheets
• Note the advantages of using CSS
• Understand how CSS works
• Create list - ordered and unordered
• Use other numbering styles
• Make Definition lists

Cascading Style Sheets
This division between structural logic and
visual logic is on its way to being
reconciled through the use of Cascading
Style Sheets (CSS). Style sheets provide
control over the exact visual style of
headers, paragraphs, lists, and other page
elements. For example, if you prefer H3
headers to be set in 12-point Arial bold
type, you can specify those details in a
style sheet. In this way you can retain the
logical use of HTML’s structural tags
without sacrificing graphic design
flexibility.
At this writing, however, the major Web
browsers offer inconsistent and
incomplete CSS support. Although both
Microsoft Internet Explorer version 3.0
and higher and Netscape Navigator
version 4.0 and higher support CSS, their
exact implementations of it differ. A
most frustrating example of this is the
margin property. Standard HTML
headings float far above the paragraphs
they describe. With style sheets authors
can designate more suitable margins in a
heading style declaration. Yet the
Netscape browser adds the designated
amount to the standard margin, whereas
Explorer simply adds the margin defined in the style sheet. The
upshot is that until the browsers offer a more consistent
implementation of CSS, only a handful of properties can be
used reliably.
So what do you do when you know the advantages of
preserving the document structure but you want to design Web
pages that are attractive and functional enough to capture and

sustain an audience? You compromise. In the sites we create we
use a grab bag of tricks to present as polished and sophisticated
a page design as we can manage within the boundaries of
“official” HTML. We use no proprietary HTML tags, such as
those specific to Internet Explorer or Netscape Navigator. Our
approach to typography emphasizes visual design over
structural purity. Wherever possible, we use “plain vanilla”
HTML to describe document structure and CSS to define visual
layout. We do not strive for complete control and consistency
for our pages but instead accept a certain degree of variability
between platforms and browsers. Where CSS falls short,
however, we dip into our grab bag of tricks rather than sacrifice
visual integrity. We believe that this is the best compromise
until everyone can shift over to a mature implementation of
CSS and leave plain HTML behind.

Advantages of CSS
This book is not a manual on HTML, and covering the full
design implications of Cascading Style Sheets is well beyond the
scope of this chapter. If you are not using CSS to manage the
graphic design of  your Web site, however, you should at least
be planning a transition to CSS technology within the next year.
Cascading Style Sheets offer Web designers two key advantages
in managing complex Web sites:

LESSON 30:
CASCADING STYLE SHEETS
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• Separation of content and design. CSS gives site developers

the best of both worlds: content markup that reflects the
logical structure of the information and the freedom to
specify exactly how each HTML tag will look.

• Efficient control over large document sets. The most
powerful implementations of CSS will allow site designers
to control the graphic “look and feel” of thousands of pages
by modifying a single master style sheet document.

Style sheets provide greater typographic control with less code.
Using plain HTML, you need to define the physical properties
of an element such as the <H1> tag each time you use it.
<H1 ALIGN=”center”><FONT FACE=”Verdana, Helvetica,
Arial, sans-serif ” SIZE=”6" COLOR=”gray”>Section
heading</H1></FONT>
When you define these properties using CSS, that single
definition, or rule, applies to every instance of the <H1>
element in all documents that reference the style sheet.
H1 { text-align: center; font-size: 16pt; font-family: Verdana,
Helvetica, Arial, sans-serif; color: gray }
In addition, style sheets offer more formatting options than
plain HTML tags and extensions. For example, interline
spacing, or leading, can be controlled using style sheets, as can
such text properties as letterspacing and background color. And
fortunately the text formatting properties are implemented well
enough across browsers to be used with some consistency.
How style sheets work
Style sheets are not new. Every graphic Web browser (even back
to Mosaic 1.0) has incorporated style sheets. It just wasn’t
possible to modify the fixed styles that browsers used to
determine, for example, exactly how H1 headers look on the
screen. The fundamental idea behind CSS is to let site authors
and users determine the size, style, and layout details for each
standard HTML tag.
If you have ever used the “styles” features of a page layout or
word processing program, you will understand the basic idea
behind CSS. The styles feature of a word processor is used to
determine exactly how your titles, subheadings, and body copy
will look, and then the copy is formatted when you apply a style
to each element. Once all the copy has been styled, you can
change the look of each occurrence of every element simply by
changing the style information. CSS works in the same way,
except that with CSS you can set up one master style sheet that
will control the visual styling of every page in your site that is
linked to the master style sheet:

Computer Lab

Dreamweaver

Creating Lists
Lists serve several different functions in all publications,
including Web pages. A list can itemize a topic’s points or
catalog the properties of an object. A numbered list is helpful
for giving step-by-step instructions. From a page designer’s
point of  view, a list can break up the page and simultaneously
draw the viewer’s eye to key details.
Lists are an important alternative to the basic textual tools of
paragraphs and headings. In this chapter, you study
Dreamweaver’s tools for designing and working with each of
the three basic types of lists available under HTML:
• Unordered lists
• Ordered lists
• Definition lists
The various list types can also be combined to create outlines.
Dreamweaver supplies a straightforward method for building
these nested lists.

Creating Bulleted (Unordered) Lists
What word processing programs and layout artists refer to as
bulleted lists are known in HTML as unordered lists. An
unordered list is used when the sequence of the listed items is
unimportant, as in a recipe’s list of  ingredients. Each unordered
list item is set off by a leading character and the remainder of
the line is indented. By default, the leading character is the
bullet; in HTML, you also can specify two other symbols by
conventional means and a custom bullet through Cascading
Style Sheets (CSS).
You can either create the unordered list from scratch or convert
existing text into the bulleted format. To begin an unordered
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list from scratch, position the cursor where you want to start the
list. Next, click the Unordered List button supplied conveniently
on the Text Property Inspector or use the Text->List-
>Unordered List command.

An itemized list that doesn’t need to be in any specific order is
perfect for formatting as an unordered list.If you are changing
existing text into a list, select the paragraphs first and then
execute the Unordered List button or menu command.
Dreamweaver creates one list item for every paragraph. As you
can see from the figure above, list items are generally rendered
closer together than regular paragraphs. Unlike block elements
such as paragraphs or headings, HTML doesn’t insert
additional lines above and space below each line of a list.

Editing unordered Lists
Once a series of paragraphs is formatted as an unordered list,
you can easily add additional bulleted items. The basic editing
techniques are the same for all types of lists:
• To continue adding items at the end of  a list, simply press

Enter (Return) to create each new paragraph. Another bullet
is inserted.

• To insert an item within an unordered list, place your cursor
at the end of the item above the desired position for the
added item and press Enter (Return).

• List items can be copied or cut and pasted in a different place
on the list. Place your cursor in front of the list item below
where you want the repositioned item to appear and choose
Edit->Paste.

• To end a bulleted list, you can press Enter (Return) twice or
deselect the Unordered List button on the Text Property
Inspector.

Using Other Bullet Symbols
Although HTML doesn’t include a wide range of different
symbols to use in an unordered list, you have a few options.
Most browsers recognize three different bullet styles: bullet (the

default), circle, and square. You can apply the style to the entire
unordered list or to one list item at a time.

A list is indented if the text wraps around the screen or if you
insert a line break.

Changing the overall style

To change the bullet style of  the overall unordered list, follow
these steps:
1. Position your cursor anywhere in an existing list.
2. If  necessary, click the expander arrow on the Text Property

Inspector to display the additional options. Click the List
Item button.

3. In the List Properties dialog box that appears (see Figure 12-
3), open the Style options list.

4. Select one of the four options:
• [Default]: No style is listed, and the browser applies its

default, usually rendered as a bullet.
• Bullet: A solid circle.
• Circle: An open circle.
• Square: A solid square
Click OK.
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You can change the style of  the entire list or just one list item
through the List Properties dialog box.
When you try to change the style of just one list item,
Dreamweaver alters all the successive list items as well. By
default, list items don’t specify a bullet style. Therefore, when a
new style is inserted, all the following items adopt that style.

Mastering Numbered (Ordered) Lists
Ordered lists offer a slightly wider variety of built-in styles than
unordered lists, but you cannot customize the leading character
further. For instance, you cannot surround a character with
parentheses or offset it with a dash. Once again, the browser is
the final arbiter of how your list is viewed.
Many of the same techniques used with unordered lists work
with ordered lists. To start a new numbered list in
Dreamweaver, place your cursor where you want the new list to
begin. Then, in the Text Property Inspector, select the Ordered
List button or choose Text->List->Ordered List.
As with unordered lists, you can also convert existing
paragraphs into a numbered  list. First select your text and then
select either the Ordered List button or the Text->List-
>Ordered List command.

Editing ordered lists
The HTML code for an ordered list is <ol>. Both <ol> and
<ul> use the list item tag, <li>, to mark individual entries, and
Dreamweaver handles the formatting identically:
<ol>
<li>Stir in two sets of venetian blinds.</li>
<li>Add one slowly rotating ceiling fan.</li>
<li>Combine one flashing neon sign with one dangling light
bulb.</li>
<li>Toss in 150 cubic yards of  fog.</li>
<li></li>
</ol>

The empty list item pair, <li>...</li>, is displayed on the page
as the next number in sequence.

Ordered lists are used on this page to create a numbered
sequence.

Using other numbering styles
In all, you can apply five different numbering styles to your
numbered lists:
• Arabic numerals: 1, 2, 3, and so forth (this is the default

style)
• Roman Small: i, ii, iii, and so forth
• Roman Large: I, II, III, and so forth
• Alphabet Small: a, b, c, and so forth
• Alphabet Large: A, B, C, and so forth

Changing single list items
1. You can restyle your entire list all at once, or you can just

change a single list item. To change the style of  the entire
ordered list, follow these steps:

2. Position your cursor anywhere in an existing list.
3. If  necessary, click the expander arrow on the Text Property

Inspector to display the additional options. Select the List
Item button.
The List Properties dialog box opens, with Numbered List
showing as the List Type.

4. Open the drop-down list of Style options and choose any of
the five preceding numbering types.

5. Click OK.

Altering single and subsequent items
As with unordered lists, when you modify the style of one
ordered list item, all the subsequent items adopt that style. To
alter the style of a single and all subsequent items, follow these
steps:
1. Select the item you wish to change.
2. In the expanded portion of the Text Property Inspector,

select the List Item button.
3. In the List Properties dialog box from the List Item section,

open the New Style list of options.
4. Select one of the five numbering options.
Although you can’t automatically generate an outline with a
different numbering system for each level, you can simulate this
kind of outline with nested lists.

Making Definition Lists
A definition list is another list in HTML that doesn’t use
leading characters, such as bullets or numbers, in the list items.
Definition lists are commonly used in glossaries or other types
of documents in which you have a list of terms followed by
their description or explanation.
Browsers generally render a definition list with the definition
term flush left and the definition data indented, as shown in
Figure below. As you can see, no additional styling is added.
You can, however, format either the item or the definition with
the Text->Style options.
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Definition lists are ideal for glossaries or other situations in
which you have a list of terms followed by their definition.
To begin your definition list in Dreamweaver, follow these
steps:
1. Choose Text->List->Definition List.
2. Type in the definition term and press Enter (Return) when

you are finished. Dreamweaver indents the line.
3. Type in the definition data and press Enter ( Return) when

you are finished.
4. Repeat Steps 2 and 3 until you have finished your definition

list.
5. Press Enter (Return) twice to stop entering definition list

items.
When you insert a definition list, Dreamweaver denotes it in
code using the <dl>...</dl> tag pair. Definition terms are
marked with a <dt> tag, and definition data uses the <dd> tag.
A complete definition list looks like the following in HTML:
<dl>
<dt>Capital</dt>
<dd>Sum owed by a business to its owners. See Owner’s
Equity.</dd>
<dt>Cash</dt>
<dd>Total of  currency, coins, money orders, checks, bank
drafts, and letters
of credit the firm has on hand or in bank accounts from which
money can be
drawn immediately.</dd>
<dt>Cash Payments Journal</dt>
<dd>Journal for recording payments made in cash.</dd>
</dl>
When originally proposed by the World Wide Web
Consortium, the <dt> column was intended to take up only

one-third of  the browser window, but the latest, most
common browsers don’t follow this design specification.

Assignment
1. What is Typography?
2. What is URL? What is the background image and

foreground inline images?
3. Breakup the body of HTTP addresses and explain each part?
4. How do you add an Email links in your web document

using Dreamweaver?
5. What are Named Anchors, Explain with example?
6. What is a Cascading Style sheet?
7. Write the advantages of  using CSS?
8. What are the basic types of list available with HTML?
9. What is a Definition List? Explain with examples?

Notes
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Topics Covered
• Alignment, Justification of headlines, White space,

Indenting Paragraph
• Dreamweaver - Using Nested List, Using Graphical Bullets

Objectives
Upon completion of this lesson, you should be able to:
• Aligning text- Justified, Left Justified and others
• Use Correct line length
• White space
• Indent Paragraph
• Use nested list
• Use Graphical bullets in Dreamweaver

Alignment
Margins define the reading area of your page by separating the
main text from the surrounding environment. Margins provide
important visual relief in any document, but careful design of
margins and other “white space” is particularly important in
Web page design because Web content must coexist on the
computer screen with the interface elements of the browser
itself and with other windows, menus, and icons of the user
interface.

Margins and space can be used to delineate the main text from
the other page elements. And when used consistently, margins
provide unity throughout a site by creating a consistent
structure and look to the site pages. They also add visual
interest by contrasting the positive space of the screen (text,
graphics) from the negative (white) space.
Text blocks have different ways of sitting within margins. Left-
justified, centered, right-justified, and justified text are the
alignment options available on the Web.

Justified Text
Justified text is set flush with the left and right margins.
Justified blocks of text create solid rectangles, and block
headings are normally centered for a symmetrical, formal-
looking document. In print, justification is achieved by
adjusting the space between words and by using word
hyphenation. Page layout programs use a hyphenation
dictionary to check for and apply hyphenation at each line’s end
and then adjust word spacing throughout the line. But even
with sophisticated page layout software, justified text blocks
often suffer from poor spacing and excessive hyphenation and
require manual refinement. This level of control is not even a
remote possibility on Web pages. The most recent browser
versions (and CSS) support justified text, but it is achieved by
crude adjustments to word spacing. Fine adjustments are not
possible on low-resolution computer displays and are
impractical to implement in today’s Web browsers. Also, Web
browsers are unlikely to offer automatic hyphenation any time
soon, another “must” for properly justified text. For the
foreseeable future, the legibility of  your Web documents will
suffer if you set your text in justified format.

Centered and right-justified text blocks
Centered and right-justified text blocks are difficult to read. We
read from left to right, anchoring our tracking across the page at
the vertical line of  the left margin. The ragged left margins
produced by centering or right-justifying text make that
scanning much harder, because your eye needs to search for the
beginning of each new line.

Left-justified text
Left-justified text is the most legible option for Web pages
because the left margin is even and predictable and the right
margin is irregular. Unlike justified text, left justification requires
no adjustment to word spacing; the inequities in spacing fall at
the end of  the lines. The resulting “ragged” right margin adds
variety and interest to the page without interfering with
legibility.

LESSON 31:
CONTENT STRUCTURE AND LEGIBILITY
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Justification of headlines
Titles and headings over left-justified body text should also be
flush left. Centered headings pair well with justified text, but
justified text should not be used on Web pages. Centered
display type contrasts with the asymmetry of the ragged right
margin of left-justified body text and produces an unbalanced
page.

Until typographic options for Web pages become more
sophisticated, we recommend that you use left-justified text
blocks and headlines as the best solution for most layout
situations.

Line length
Text on the computer screen is hard to read not only because of
the low resolution of computer screens but also because the
layout of most Web pages violates a fundamental rule of  book
and magazine typography: the lines of  text on most Web pages
are far too long for easy reading. Magazine and book columns
are narrow for physiological reasons: at normal reading distances
the eye’s span of  acute focus is only about three inches wide, so
designers try to keep dense passages of text in columns not
much wider than that comfortable eye span. Wider lines of text
require readers to move their heads slightly or strain their eye
muscles to track over the long lines of text. Readability suffers
because on the long trip back to the left margin the reader may
lose track of the next line.
You can use invisible tables (BORDER=”0") to restrict the text
line length to about fifty to seventy characters per line (see Page

Design, Page layout). The exact character count is difficult to
predict because of the way different browser software and
operating systems display type sizes. In conventional print
layouts, columns of thirty to forty characters per line are
considered ideal.
In the end, the decision to restrict line length is a philosophical
one. From a design standpoint, a measure that is comfortable
for reading is good practice. One of the fundamental principles
of  the Web, however, is that users should be able to structure
their own view. Users with a large monitor may not want their
text blocks circumscribed if it means that a large portion of
their screen goes unused. A low-vision user with fonts set large
will not appreciate being forced to view long pages with short
lines of text. So although leaving text free to fill the browser
window may affect readability, following conventions may also
affect the accessibility and legibility of your documents.

When designing a fixed-width layout, we typically use page
layout tables with text cells no wider than about 365 pixels. If
12-point Times New Roman type is used, this cell width yields
a line about fifty characters long, averaging about nine to ten
words per line. We believe that this achieves the best balance
between space efficiency and legibility. If  you choose a flexible
layout approach, use CSS leading controls to increase line
spacing to 15 or 16 points (see White space). Additional line
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spacing allows a somewhat longer line length without sacrificing
legibility.

White Space
The vertical space in a text block is called leading, and it is the
distance from one baseline of text to the next. Leading strongly
affects the legibility of text blocks: too much leading makes it
hard for the eye to locate the start of the next line, whereas too
little leading confuses the lines of type, because the ascenders of
one line get jumbled with the descenders of the line above. In
plain HTML it is not possible to implement true leading, but
CSS offers leading control (referred to as “line spacing” in CSS
terminology). In print one general rule is to set the leading of
text blocks at about 2 points above the size of the type. For
example, 12-point type could be set with 14 points of  leading.
We suggest generous leading to compensate for longer line
lengths and the lower resolution of the computer screen, for
example, 12-point type with 14 to 16 points of  leading.

Indenting Paragraphs
There are two major schools of thought on denoting
paragraphs. The classic typographic method uses indents to
signal the beginning of a new paragraph (as we have in this
book). However, many technical, reference, and trade
publications now use a blank line of white space to separate
paragraphs. Indented paragraphs work especially well for longer
blocks of prose, where the indents signal new paragraphs with
minimal disruption to the flow of text. Blank line spacing
between paragraphs, in contrast, makes a page easy to scan and
provides extra white space for visual relief. Either approach is
valid as long as the paragraph style is implemented consistently
throughout the site.
To indent paragraphs without using CSS, you can insert several
non-breaking space characters (&nbsp;) at the start of each
paragraph. You can also use a transparent single-pixel GIF
graphic as a spacer and adjust its horizontal spacing. If  you are
using CSS you can set the exact spacing for the indentation
using the “text-indent” property of paragraphs.
&nbsp;&nbsp;&nbsp;&nbsp; To indent paragraphs without
using CSS, ...
<IMG SRC=”pixel.gif ” HEIGHT=”1" WIDTH =”1"
ALT=”” HSPACE=”8">To indent paragraphs without using
CSS, ...
<P STYLE=”text-indent: 8pt”>To indent paragraphs without
using CSS, ...
To separate paragraphs with blank lines you could put a
paragraph tag (<P>) at the end of each paragraph. The
paragraph tag adds a full blank line between paragraphs. To
adjust the amount to an amount less or more than a full blank
line you can use the CSS “margin” property, but beware of
spacing inconsistencies between browsers. You can also use the
line break tag (<BR>) followed by a transparent single-pixel
GIF graphic as a spacer to control the space between paragraphs.
As always when using a spacer graphic, be sure to include empty
ALT text to hide the image from assistive technologies and text-
only browsers:
<BR>
<IMG SRC=”pixel.gif ” HEIGHT=”1" WIDTH =”1"
ALT=”” VSPACE=”2">

Computer Lab

Dreamweaver

Using Nested Lists
You can combine, or nest, lists in almost any fashion. For
instance, you can mix an ordered and unordered list to create a
numbered list with bulleted points. You can have one
numbered list inside of  another numbered list. You can also
start with one numbering style such as Roman Large, switch to
another style such as Alphabet Small, and then return to
Roman Large to continue the sequence (as with an outline).
Dreamweaver offers an easy route for making nested lists. The
Indent button in the Text Property Inspector-when used within
a list-automatically creates a nested list. As an example, the
ordered list in the figure given below has a couple of bulleted
points (or unordered list items) inserted within it. Notice how
the new items are indented one level.

Dreamweaver automatically generates the code necessary to
build nested lists when you use the Indent button on the
Property Inspector.
Follow these steps to create a nested list in Dreamweaver:
• Select the text in an existing list that you want to reformat

with a different style
• In the Text Property Inspector, choose the Indent button.

You can also select the Text->Indent command.
Dreamweaver indents the selected text and creates a separate
list in the HTML code with the original list’s properties.

• Go to the List Properties dialog box and select another list
type or style, as described in preceding sections.

To examine the origins of  the term nested list, take a look at the
code created for this list type by Dreamweaver:
<ol>
<li>Stir in two sets of venetian blinds.</li>
<li>Add one slowly rotating ceiling fan.</li>
<li>Combine one flashing neon sign with one dangling light
bulb.</li>
<ul>
<li>Use a bare bulb, preferably swinging.</li>
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<li>The neon sign should throw contrasting shadows.</li>
</ul>
<li>Toss in 150 cubic yards of  fog.</li>
</ol>
Notice how the unordered tag pair, <ul>...</ul>, is completely
contained between the ordered list items.

Dreamweaver Technique: Building Graphical Bullets
HTML unordered lists are functional and often useful, but
they’re not particularly decorative. A Web designer might very
well want to spice up a bulleted list of items with graphics.
Substituting a graphical bullet for the HTML versions is
practical and often desirable. Because a small, single image is
used repeatedly, the impact on a Web page’s size is negligible,
and the image downloads quickly. You can include graphical
bullets in two basic ways: inline and tables. Inline graphical
bullets put the bullet image right next to the text, whereas the
table technique keeps all the bullets in one column and the
bullet items in another. Which technique you use depends on
the length of the bulleted item. If your bulleted items are short
enough so that they won’t wrap, use the inline technique; on
the other hand, if the text is likely or definitely wrapping from
one line to the next, use the table technique.
To use graphic images as bullets in an inline technique, follow
these steps:
1. Create your image in a graphics editor such as Fireworks and

save the file so that it is accessible to your local site.
2. If  necessary, convert your unordered list to standard

paragraph format by selecting the entire list and deselecting
the Bullet button on the Property Inspector.

3. Choose Insert Image from the Objects palette and place the
graphic button before the first line item.

4. Select the correct vertical alignment for the image from the
Align list on the image Property Inspector. Although your
alignment choice may vary according to the height of your
text and your image, Absolute Middle works in many
situations.

5. If  necessary, add a nonbreaking space or two between the
image and the list item by pressing Ctrl+Shift+spacebar
(Control+Shift+spacebar).

6. Select the image and any added nonbreaking spaces.
7. Ctrl+drag (Control+drag) the selection to copy it to the

beginning of the next
8. line item, as shown on the figure below:
9. Repeat Step 7 for each line item.

Copying your graphic bullets after you’ve set the alignment
saves you many steps later.
If your text lines are too long, they wrap at the browser
window and-here’s the unsightly part-under the graphical bullet.
To avoid this wrapping problem, use the table technique,
detailed in the following steps:
1. Create your bullet in your favorite graphics program.
2. If  necessary, convert your unordered list to standard

paragraph format by selecting the entire list and deselecting
the Bullet button on the Property Inspector.

3. Position your cursor above the first line item and choose the
Insert Table object from the Objects palette.

4. In the Insert Table dialog box, set the Columns value to 2
and the Rows to the number of line items you have. If
desired, turn off the borders by setting Border value to 0.
Click OK when you’re done. The table is inserted in the
Document window.

5. Select the first column of  the table by dragging down its
length.

6. In the Property Inspector, set the Horiz ( horizontal
alignment) value to Right and the Vert (vertical alignment) to
Top.

7. Select the second column by dragging down its length.
8. In the Property Inspector, set the Horiz ( horizontal

alignment) value to Left and the Vert (vertical alignment) to
Top.

9. Select the Insert Image object and place your bullet image in
the first column, first row.

10.Select the first line item and drag it into the second column,
first row.

11.Copy the bullet image from the first cell and paste it into the
first column for every remaining row.

12.Repeat Step 10 for each of the remaining line items, putting
each on its own row.
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You may find it necessary to adjust the vertical alignment on
either the bullet or line item column to get the look you want.

Placing bullet items in a table enables you to keep an equal
spacing with longer, wrapping lines.

Notes
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Topics Covered
• Typefaces, legibility on screen, Type size, Case, Emphasis
• Dreamweaver - Setting up Tables, HTML table

fundamentals, Inserting tables in Dreamweaver, Modifying
tables, Selecting cells

Objectives
Upon completion of this lesson, you should be able to:
• Understand features of typefaces
• Specify typefaces
• Choose correct type size
• Character case
• Emphasis
• Setting up Tables
• Insert Tables in Dreamweaver
• Modify tables

Typefaces
Each typeface has a unique tone that should produce a
harmonious fit between the verbal and visual flow of your
content. With the first versions of HTML, Web authors had no
control over typefaces (“fonts” in personal computer
terminology). Fonts were set by the browser, so pages were
viewed in whatever font the user specified in his or her browser
preferences. The more recent versions of HTML and CSS allow
designers to specify the typeface. This is useful not only for
aesthetic reasons but also because of the differing dimensions
of typefaces. A layout that is carefully designed using one face
may not format correctly in another.
In specifying typefaces you should choose from the resident
default fonts for most operating systems. If you specify a font
that is not on the user’s machine, the browser will display your
pages using the user-specified default font. Bear in mind, too,
that users can set their browser preferences to ignore font tags
and display all pages using their designated default font.
Legibility on screen
Some typefaces are more legible than others on the screen. A
traditional typeface such as Times Roman is considered to be
one of the most legible on paper, but at screen resolution its
size is too small and its shapes look irregular. Screen legibility is
most influenced by the x-height (the height of a lowercase “x”)
and the overall size of the typeface.

Adapted traditional typefaces
Times New Roman is a good example of a traditional typeface
that has been adapted for use on computer screens. A serif
typeface like Times New Roman (the default text face in most
Web browsers) is about average in legibility on the computer
screen, with a moderate x-height. Times New Roman is a good
font to use in text-heavy documents that will probably be

printed by readers rather than read from the screen. The
compact letter size of Times New Roman also makes it a good
choice if you need to pack a lot of words into a small space.

Designed for the Screen
Typefaces such as Georgia and Verdana were designed specifically
for legibility on the computer screen; they have exaggerated x-
heights and are very large compared to more traditional
typefaces in the same point size. These fonts offer excellent
legibility for Web pages designed to be read directly from the
screen. However, the exaggerated x-heights and heavy
letterforms of these fonts look massive and clumsy when
transferred to the high-resolution medium of paper.

Choosing Typefaces
The most conventional scheme for using typefaces is to use a
serif face such as Times New Roman or Georgia for body text
and a sans serif  face such as Verdana or Arial as a contrast for
headlines. We generally set our text-laden Web pages in Times
New Roman because it produces a reasonable balance between
density of  information and overall legibility. Most readers
expect a serif font for long blocks of text and find Times New
Roman comfortable to read off-screen from paper printouts.
Various studies purport to show that serif type is more legible
than sans serif  type and vice versa. You can truly judge type
legibility only within the context of the situation - on the screen
- as users will see your Web page.
You may use either a variation of  the serif font or a contrasting
sans serif face for the display type. It is safest to use a single
typographic family and vary its weight and size for display type
and emphasis. If you choose to combine serif and sans serif
faces, select fonts that are compatible and don’t use more than
two typefaces (one serif, one sans serif) on a page.
The most useful fonts that ship with the Apple Macintosh and
Microsoft Windows operating systems are reproduced here (we
have omitted bitmap fonts and decorative or novelty typefaces):

LESSON 32:
CONTENT STRUCTURE-2
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Specifying Typefaces
The early versions of HTML did not allow designers to specify
a typeface for Web documents. With version 3.2 came several
new tags aimed at giving designers more control over the visual
properties of elements, among them the FONT tag. Many of
these have been “deprecated” by the World Wide Web
Consortium, which means that they may be dropped from
future versions of HTML. Although the added tags enable
designers to create more elegant-looking pages, they also result
in cumbersome code that is difficult to adapt and maintain.
You can still use the FONT tag to set the type in your
documents, but a better approach is to consolidate text
formatting in style sheets.
You can specify any typeface for your Web pages, but many
computers have only the default operating system fonts
installed. If the typeface you specify is not available on the user’s
computer, the browser will switch to the default font (generally
“Times New Roman” or “Times”). To increase the chances that
the reader will see a typeface you are happy with, you can specify
multiple fonts. The browser will check for the presence of each
font (in the order given), so you can specify three or four
alternates before the browser applies the default font, for
example, “Verdana, Geneva, Arial, Helvetica.” As a last-ditch

effort you can end your font declaration with a generic font
designation such as “sans serif.” That way, if  the browser
cannot find any of the listed fonts, it will display the text in any
available sans serif font.
P { font-family: “Times New Roman”, Georgia, Times, serif }
Notice that multiword fonts like “Times New Roman” must
appear within quotation marks.
A good way to make sure that your type settings are functioning
correctly is to set your browser’s default proportional font
setting to something that is obviously different from your
intended font. For example, set your browser’s default font to
Courier if you are not using Courier in your document. When
you view your page, anything that appears in Courier must not
be marked up properly.

Type Size
Setting the size of  type is a matter of some controversy. The
Web is supposed to be a universal medium where users of  all
kinds have equal access to information. As opposed to a printed
medium, where the layout and type are fixed, Web pages should
adapt to meet the needs of all comers, so that, for example,
low-vision users can set the type of  Web documents to display
at a size that they find legible. But these adjustments can skew a
page layout and send the designer, who diligently designed the
page around a specific size of type, into paroxysms. And
though variation thwarts the designer who worked to fashion
the layout, it is undeniable that the low-vision user ought to be
able to gain access to the content.
With the introduction of the FONT tag, designers also gained
the ability to set the font size. With CSS, designers have many
methods for setting type size, although, as with many other
CSS properties, all are not fully supported. The W3C
recommends that you let users set the base font size in their
browser and that you set all variations using the “em” unit. An
em in the Web context is the same as the font height, which
makes it a relative unit and therefore flexible. For example, if
the user-set default is 12-point, then a 2-em text indent would
be 24-point, but if the user used the text zoom feature of the
browser to change the size to 16-point, the indent would
change to 32-point to reflect the larger type size.
P { font-family: Verdana, Arial, Helvetica, sans-serif; font-size:
1em; text-indent: 2em }
As you might imagine, this flexibility can send page layouts into
disarray. If  you try this approach, use a flexible page layout that
will hold up to large type.
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You can also use points to define your type sizes, but bear in
mind that this carryover from the print medium has little
meaning on a computer screen. Because monitors display at
different resolutions, 12-point type on one screen could
approximate 14-point type on another. This can be particularly
problematic for small point sizes. For example, 6-point type is
legible on a Windows display, where the default resolution is 96
ppi, but on a Macintosh, at 72 ppi, it is illegible.

Still, points are familiar and, though variable, offer some means
of declaring the relative size of type elements.

H1 { font-family: Verdana, Arial, Helvetica, sans-serif; font-size:
14 pt }
P { font-family: Georgia, “Times New Roman”, Times, serif;
font-size: 12 pt }
Just remember that declaring your type in points does not
mean that the point size you specify is what will actually display
on the user’s monitor. And because this unit is not “fixed” -
that is, type set in points can be resized in the browser - this
approach also requires an adaptable layout.
If the integrity of your layout depends on specific type sizes,
the most dependable option right now - until there is better
CSS support - is to use pixel units in your style declarations.
Text defined using pixels will be the same size regardless of  the
browser’s default font size and resolution settings.
P { font-family: Georgia, “Times New Roman”, serif; font-size:
12px }
Although this option does offer more stability, be aware that
you may be shutting out those users who have good reasons
for specifying different font settings.

Case
Whether you choose uppercase or lowercase letters has a strong
effect on the legibility of your text. Indeed, words set in all
uppercase letters should generally be avoided - except perhaps
for short headings - because they are difficult to scan.
We read primarily by recognizing the overall shape of  words,
not by parsing each letter and then assembling a recognizable
word:

Words formed with capital letters are monotonous rectangles
that offer few distinctive shapes to catch the eye:

We recommend downstyle typing (capitalize only the first word
and any proper nouns) for your headlines, subheads, and text.
Downstyle is more legible because as we read we primarily scan
the tops of words:

Notice how much harder it is to read the bottom half of the
same sentence:

If you use initial capital letters in your headlines, you disrupt
the reader’s scanning of  the word forms:

Emphasis
A Web page of  solid body text is hard to scan for content
structure and will not engage the eye. Adding display type to a
document will provide landmarks to direct the reader through
your content. Display type establishes an information structure
and adds visual variety to draw the reader into your material.
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The key to effective display type is the careful and economic use
of typographic emphasis.
There are time-honored typographical devices for adding
emphasis to a block of  text, but be sure to use them sparingly.
If you make everything bold, then nothing will stand out and it
will seem as if you are shouting at your readers. A good rule of
thumb when working with type is to add emphasis using one
parameter at a time. If you want to draw attention to the
section heads in your document, don’t set them large, bold, and
all caps. If you want them to be larger, increase their size by one
measure. If you prefer bold, leave the heads the same size as
your body text and make them bold. You will soon discover
that only a small variation is required to establish visual
contrast.

Italics

Italicized text attracts the eye because it contrasts in shape from
body text. Use italics for convention - when listing book or
periodical titles, for example - or within text for stressed or
foreign words or phrases. Avoid setting large blocks of  text in
italics because the readability of italicized text, particularly at
screen resolutions, is much lower than in comparably sized
roman text.

Bold
Boldface text gives emphasis because it contrasts in color from
the body text. Section subheads work well set in bold. Boldface
text is readable on-screen, though large blocks of text set in
bold lack contrast and therefore lose their effectiveness.

Underlined

Underlined text is a carryover from the days of the typewriter,
when such options as italics and boldface were unavailable. In
addition to its aesthetic shortcomings (too heavy, interferes with
letter shapes), underlining has a special functional meaning in
Web documents. Most readers have their browser preferences
set to underline links. This default browser setting ensures that
people with monochromatic monitors or people who are color-
blind can identify links within text blocks. If you include
underlined text on your Web page it will certainly be confused
with a hypertext link.

Colored text

Although the use of color is another option for differentiating
type, colored text, like underlining, has a special functional
meaning in Web documents. You should avoid putting colored
text within text blocks because readers will assume that the
colored text is a hypertext link and click on it. Colored text does
work well as a subtle means to distinguish section heads,
however. Choose dark shades of color that contrast with the
page background, and avoid using colors close to the default
Web link colors of  blue and violet.

Capital letters
Capitalized text is one of the most common and least effective
methods for adding typographical emphasis. We recognize
words in two ways, by parsing letter groups and by recognizing
word shapes. Words or headlines set in all capital letters form
rectangles with no distinctive shape. To read a block of text set
In All Capital Letters We Must Parse The Letter Groups - Read
The Text Letter By Letter - Which Is Uncomfortable And

Significantly Slows Reading. As You Read The Following
Paragraph, Notice How Tiring The Process Is:
The Design Of The Site Will Determine The Organizational
Framework Of  Your Web Site. At This Stage You Will Make
The Essential Decisions About What Your Audience Wants
From You, What You Wish To Say, And How To Arrange The
Content To Best Meet Your Audience’s Needs. Although
People Will Instantly Notice The Graphic Design Of  Your Web
Pages, The Organization Of The Site Will Have The Greatest
Impact On Their Experience.

Spacing and Indentation
One of the most effective and subtle ways to vary the visual
contrast and relative importance of a piece of text is simply to
isolate it or treat it differently from the surrounding text. If you
want your major headers to stand out more without making
them larger, add space before the header to separate it from any
previous copy. Indentation is another effective means of
distinguishing bulleted lists, quotations, or example text (such
as the capitalization example above). HTML lists are
automatically indented (too far, in our estimation), and you can
use the BLOCKQUOTE tag to indent blocks of  text. You can
define your own indents using CSS.

Computer Lab

Dreamweaver

Setting Up Tables
Tables bring structure to a Web page. Whether used to align
numbers in a spreadsheet or to arrange columns of text on a
page, an HTML table brings a bit of order to otherwise free-
flowing content. Initially, tables were implemented to present
raw data in a more readable format. But it didn’t take long for
Web designers to take up tables as the most capable tool to
control page layout.
Dreamweaver’s implementation of  tables reflects this current
trend in Web page design. Drag-and-drop table sizing, easy
organization of rows and columns, and instant table
reformatting all help get the job done in the shortest time
possible. Table editing features enable you to select and modify
anything in a table from a single cell to multiple columns.
Moreover, using Dreamweaver commands, you can sort your
table in a variety of ways or completely reformat it.
Dreamweaver 4 introduces a new feature that takes table layout
to the next level of ease-of-use and power. With the Layout
view, designers are able to draw individual cells with a stroke of
the mouse and Dreamweaver automatically creates a borderless,
content-ready table. You can even add nested tables to maintain
design integrity. While you still need to know the basics of  table
functionality to make the most out of this new tool, Layout
view offers a fully backward-compatible technique for visually
structuring your Web page.

HTML Table Fundamentals
A table is basically a grid that expands as you add text or images.
Tables consist of three main components: rows, columns, and
cells. Rows go across a table from left to right, and columns go up
and down. A cell is the intersection of  a row and a column; it’s
where you enter your information. Cells expand to fit whatever
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they hold. If you have enabled the table border, your browser
shows the outline of the table and all its cells.
In HTML, all the structure and all the data of a table are
contained between the table tag pair, <table> and </table>.
The <table> tag can take numerous attributes, determining a
table’s width and height (which can be given in absolute
measurement or as a percentage of the screen) as well as the
border, alignment on the page, and background color. You can
also control the size of the spacing between cells and the
amount of padding within cells.
HTML uses a strict hierarchy when describing a table. You can
see this clearly in Listing given below, which shows the HTML
generated from a default table in Dreamweaver.

Code for an HTML Table

<table border=”1” width=”75%”>
<tr>
<td>&nbsp;</td>
<td>&nbsp;</td>
<td>&nbsp;</td>
</tr>
<tr>
<td>&nbsp;</td>
<td>&nbsp;</td>
<td>&nbsp;</td>
</tr>
<tr>
<td>&nbsp;</td>
<td>&nbsp;</td>
<td>&nbsp;</td>
</tr>
</table>
The &nbsp; seen in the table code is HTML for a nonbreaking
space. Dreamweaver inserts the code in each empty table cell
because some browsers collapse the cell without it. Enter any
text or image in the cell, and Dreamweaver automatically
removes the &nbsp; code.

Rows
After the opening <table> tag comes the first row tag <tr>.
Within the current row, you can specify attributes for horizontal
alignment or vertical alignment. In addition, browsers recognize
row color as an added option.

Cells
Cells are marked in HTML with the <td>...</td> tag pair. No
specific code exists for a column; rather, columns are seen as the
number of cells within a row. For example, in Listing 1-1,
notice the three sets of <td> tags between each <tr> pair. This
means the table has three columns. A cell can span more than
one row or column— in these cases, you see a rowspan=value
or colspan=value attribute in the
<td> tag.

Cells can also be given horizontal or vertical alignment
attributes; these attributes override any similar attributes

specified by the table row. When you give a cell a particular
width, all the cells in that column are affected. Width can be
specified in either an absolute pixel measurement or as a
percentage of the overall table.

Column/row headings
A special type of cell called a table header is used for column and
row headings. Information in these cells is marked with a <th>
tag and is generally rendered in boldface, centered within the cell.

Inserting Tables in Dreamweaver
You can control almost all of  a table’s HTML features through
Dreamweaver’s point and- click interface. To insert a
Dreamweaver table in the current cursor position, use one of
the following three methods:
1. Select the Insert Table button on the Objects panel.
2. Choose Insert->Table from the menus.
3. Use the keyboard shortcut: Ctrl+Alt+T

(Command+Option+T).
The Insert Table dialog box, shown in Figure below contains
the following default values when it is first displayed:

If you aren’t sure of the number of rows and/or columns you
need, put in your best guess-you can add or delete rows or
columns as necessary.

The default table is sized to take up 75 percent of the browser
window. You can alter this percentage by changing the value in



161

E
-M

E
D

IA
the Width text box. The table maintains this proportion as you
add text or images, except in two situations:
• When an image is larger than the specified percentage
• When the nowrap attribute is used for the cell or table row

and there is too much text to fit
In either case, the percentage set for the table is ignored, and the
cell and table expand to accommodate the text or image
If you prefer to enter the table width as an absolute pixel value,
as opposed to the relative percentage, type the number of pixels
in the Width text box and select pixels in the drop-down list of
width options.
Figure given below shows three tables: At the top is the default
table with the width set to  75 percent. The middle table, set to
100 percent, will take up the full width of  the browser window.
The third table is fixed at 300 pixels—approximately half of a
640×480 window.

The width of a table can be relative to the browser window or
set to an absolute width in pixels.

Modifying Tables
Most modifications to tables start in the Property Inspector.
Dreamweaver helps you manage the basic table parameters-
width, border, and alignment-and provides attributes for the
other useful but more arcane features of a table, such as
converting table width from pixels to percentage of the screen,
and vice versa.

Selecting Table Elements
As with text or images, the first step in altering a table (or any
of its elements) is selection. Dreamweaver simplifies the
selection process, making it easy to change both the properties
and the contents of entire tables, selected rows or columns, and
even nonadjacent cells. You can change the font size and color
of a row with a click or two of the mouse-instead of
highlighting and modifying each individual cell.

In Dreamweaver, you can select the following elements of a
table:

The entire table
• A single row
• Multiple rows, either adjacent or separate
• A single column
• Multiple columns, either adjacent or separate
• A single cell
• Multiple cells, either adjacent or separate
Once a table element is selected, you can modify its contents.

Selecting an Entire Table
Several methods are available for selecting the entire table,
whether you’re a menu or mouse-oriented designer. To select
the table via a menu, do one of the following:
• Choose Modify->Table->Select Table.
• With the cursor positioned in the table, choose Edit->Select

All or use the keyboard shortcut, Ctrl+A (Command+A).
• Right-click (Control+click) inside a table to display the

shortcut menu and choose Table->Select Table.
• To select an entire table with the mouse, use one of  these

techniques:
• Click the bottom or right border of  the table. You can also

click anywhere along the table border when the pointer
becomes a four-sided arrow.

• Select the <table> tag in the Tag Selector.
• Click immediately to one side of the table and drag the

mouse over the table.
However you select the table, the selected table is surrounded by
a black border with sizing handles on the right, bottom, and
bottom-right corner

Selecting a row or column
Altering rows or columns of table text without Dreamweaver is
a major time consuming chore. Each cell has to be individually
selected, and the changes applied. Dreamweaver has an intuitive
method for selecting single or multiple columns and rows,
comparable-and in some ways, superior-to major word
processing programs.
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A selected table can be identified by the black border outlining
the table and the three sizing handles.
As with entire tables, you have several methods for selecting
columns or rows. None of the techniques, however, use the
menus; row and column selection is handled primarily with the
mouse. In fact, you can select an entire row or column with one
click.
The one-click method for selecting a single column or row
requires that you position your pointer directly over the column
or to the left of the row you want to choose. Move the pointer
slowly toward the table-when the pointer becomes a single
arrow, with the arrowhead pointing down for columns and to
the right for rows, click the mouse. All the cells in the selected
column or row are bounded with a black border. Any changes
now made in the Property Inspector, such as a change in font
size or color, affect the selected column or row.
You can select multiple, contiguous columns or rows by
dragging the single arrow pointer across several columns or
rows. To select a number of  columns or rows that are not next
to one another, use the Ctrl (Command) key. Press the Ctrl
(Command) key while selecting each individual column, using
the one-click method. ( Not even Word 2000 can handle this
degree of complex table selection.)

Selecting Cells
Sometimes you need to change the background color of just a
few cells in a table, but not the entire row—or you might need
to merge several cells to form one wide column span. In these
situations, and many others, you can use Dreamweaver’s cell
selection capabilities. As with columns and rows, you can select
multiple cells, whether they are adjacent to one another or
separate.
Individual cells are generally selected by dragging the mouse
across one or more cell boundaries. To select a single cell, click
anywhere in the cell and drag the mouse into another cell. As
you pass the border between the two cells, the initial cell is
highlighted. If  you continue dragging the mouse across
another cell boundary, the second cell is selected, and so on.
Note that you have to drag the mouse into another cell and not

cross the table border onto the page; for example, to highlight
the lower-right cell of a table, you need to drag the mouse up or
to the left.

Editing a table’s contents
Before you learn how to change a table’s attributes, let’s look at
basic editing techniques. Editing text in Dreamweaver tables is
slightly different from editing text outside of tables. When you
begin to enter text into a table cell, the table borders expand to
accommodate your new data, assuming no width has been set.
The other cells appear to shrink, but they, too, expand once you
start typing in text or inserting an image. Unless a cell’s width is
specified, the cell currently being edited expands or contracts and
the other cells are forced to adjust their width. Figure given
below shows the same table (with one row and three columns)
in three different states. In the top table, only the first cell
contains text; notice how the other cells have contracted. In the
middle table, text has been entered into the second cell as well,
and you can see how the first cell is now smaller. Finally, in the
bottom table, all three cells contain text, and the other two cells
have adjusted their width to compensate for the expanding
third cell.

As text is entered into a cell, the cell expands; other cells contract,
even if they already contain text.
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Topics Covered
• Consistency, Cross  platform issues, Accessibility, Type

Graphics
• Dreamweaver -

Working with table
properties, Inserting
rows and columns,
Setting table borders
and backgrounds,
Merging and splitting
cell

Objectives
Upon completion of this
lesson, you should be able
to:
• Check cross platform

issues
• Add accessibility in

typography
• Understand the

significance of type
graphics

• work with table
properties

• set alignment in a table
• Insert rows and

columns
• Delete rows and columns
• Set table borders and backgrounds
• Work with cell spacing and padding
• Merge and split cells

Consistency
As in traditional print publishing, high-quality Web sites adhere
to established type style settings consistently throughout the
site. Consistency gives polish to a site and encourages visitors to
stay by creating an expectation about the structure of a text. If
sloppy, inconsistent formatting confounds this expectation, you
will confuse your readers and they may not return.
You should decide on such settings as fonts, inter-paragraph
spacing, the size of subheads, and so on and then create a
written style guide to help you maintain these settings as you
develop the site. This step is especially critical for large sites that
incorporate numerous pages.
If you choose to use CSS you will have powerful tools to
maintain the consistency of styles throughout your site. This is
particularly true if you opt to use a master style sheet for your
whole site via the “Link” option in CSS (see Cascading Style
Sheets).

Cross-platform Issues

Relative font sizes
The Macintosh and Windows operating systems display type
differently, even when the same typefaces are being used. In
general, type displayed on Windows Web browsers will look 2
to 3 points larger than the equivalent face on the Macintosh.
Thus a line of 12-point Times type on a Macintosh looks more
like 14 points in Times New Roman on a Windows machine.
This difference in font rendering can have a big impact on your
page layouts. The following table shows the major Microsoft
TrueType typefaces in their 12-point sizes, as displayed in both
Windows and on a Macintosh.

LESSON 33:
TYPE GRAPHICS

Example: Plain HTML page (opens in new window)
Example: Page with HTML and CSS (opens in new window)
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If you don’t have ready access to a machine with “the other”
operating system and you use Netscape Navigator, you can use
Netscape’s “Preferences / Fonts” box to change the default text
size from 12 to 14 (Mac users) or from 12 to 11 or 10
(Windows users). If you use Internet Explorer you can use the
“Larger” or “Smaller” controls on the button bar to manipulate
the default font size of the text.
Font faces
The basic fonts that come with Windows and the Macintosh
operating system are listed below. If  you are going to specify
fonts for your Web documents, you should probably use the
typefaces listed here, and you should always specify at least one
typeface from each operating system (for example: “Arial,
Geneva”) to avoid having the browser render your pages in the
default font:

Remember that many Macintosh users who have installed
Microsoft Office or Microsoft’s Internet Explorer Web browser
will have “Windows” fonts installed on their systems. If you
specify the fonts “Georgia, Times” in your font definitions,
many Macintosh users will see their text set in Georgia, just as
Windows users do.
Also note in the relative font sizes example on the preceding
page that although “Trebuchet” and “Trebuchet MS” are
basically the same typeface, the exact name you specify in the
font list matters. If you want both Macintosh and Windows
users to see the typeface Trebuchet, then use both names in
your font declaration.

Accessibility
When considering type, the main accessibility issues are size and
color. These attributes come into play for users who have vision
disabilities such as low vision or color blindness. Vision-
impaired users need to be able to transform text that they find
illegible into a format that they can read. Low-vision users need
to be able to increase the type size and set the text and page
background colors for maximum contrast. Colorblind users
also need control over text and background color. You need to

pay attention to the following type and layout attributes to
accommodate users with vision disabilities.

Scalable Text
Users cannot easily enlarge text that is set using absolute size
values, for example, text sized using pixels (see Type size). To
ensure scalability, use relative units such as the em unit to
control the typography - type size, margins and indents, leading
- on the page. Use text graphics sparingly, and always offer a
text-only equivalent. Text rendered to graphic form is no longer
text but image and cannot be manipulated - enlarged, colored -
as plain text can.

Structural Markup
Text formatting done using presentation-style markup instead
of style sheets limits users’ ability to transform a layout to meet
their needs. Some browsers have a feature that allows users to
override author-defined style sheets with their own style sheet.
This means that users can define a custom style sheet that meets
their viewing needs. For example, a low-vision user might
define a style sheet that renders all <P> text at 24 points, or a
colorblind user might set the background to white and the text
to black for maximum contrast. But these measures will not
work, or will only work partially, on pages that are formatted
using presentation markup. If  text color is set using <FONT
COLOR> and headings are set using <FONT SIZE> and
<B> for emphasis, the user-defined style sheet will have
nothing to apply itself to (no paragraph or heading tags). If
you set presentation properties using style sheets, users who
need to customize the page can do so.

Emphasis
If you use color alone to achieve typographic emphasis, users
who cannot distinguish the colors will miss the emphasis. To
emphasize text - for example, in headers or key phrases within
text - so that it won’t be overlooked, use bold formatting as
well as color. (Indeed, colored text for anything that is not a link
is a potential usability flaw that you might as well avoid
altogether. See Colored text, above.) Also be sure that there is
sufficient contrast between the background and text on your
page. Although contrast is particularly important for vision-
impaired users, all users will benefit from greater readability.

Adaptable Layouts
Most Web page layouts are not designed with large type in
mind. For example, fixed layouts that limit the text column to a
specified width are typically sized to accommodate 12-point type
or smaller. Indeed, at large type sizes a fixed text column may
contain only a few words, which makes the text awkward to
read. For adaptable pages, use a flexible layout that transforms
gracefully to accommodate larger type sizes. (For more on fixed
and flexible layouts, see Page Design, Page layout.)

Type Graphics
Typography cannot always be neatly separated from the graphics
of  your Web site. Graphic text can be tightly integrated with
images in ways that are impossible in HTML text:
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For aesthetic reasons you may choose to use graphical
representations of type rather than manipulate HTML type. In
either case you’ll need to understand how to best render type
within GIF (Graphics Interchange Format) and JPEG (Joint
Photographic Experts Group) graphics.

Anti-aliased Type
Antialiasing is a technique widely used in computer graphics to
optimize the look of graphics and typography on the display
screen. Antialiasing visually “smoothes” the shapes in graphics
and type by inserting pixels of intermediate colors along
boundary edges between colors. In typography, antialiasing
removes the jagged edges of  larger type characters. At normal
viewing distances antialiasing gives the impression that the type
is rendered at a higher resolution:

Creating Antialiased Type
Sophisticated image editing programs such as Adobe
Photoshop will create antialiased type automatically, and these
“paint” image editors are where most Web designers create their
graphic typography. If, however, you have a complex
arrangement of  typography and graphics (say, for a home page
banner), you may wish to work first in a drawing program such
as Adobe Illustrator or Macromedia FreeHand. Drawing
programs are better at laying out text and will let you edit the
text up to the final rendering into a paint (GIF or JPEG)
graphic to use on the Web page. Final rendering is usually done

by importing the graphic into Photoshop, where all text will
automatically become antialiased:

We often use graphic type within banner or navigational
graphics, but we rarely use graphic type simply as a stylistic
substitute for headlines or subheads within a Web page. Purely
graphic typography cannot be searched and indexed along with
the HTML-based text on a Web page. Your best option is to
repeat the textual content of  the graphic inside an ALT tag and
hope that search engines will pick up that content, too. Finally,
bear in mind that graphic type is far more difficult to edit or
update than HTML text.

When not to use antialiasing
Antialiasing is great for large display type, but it is not suitable
for small type sizes, especially type smaller than 10 points. The
antialiasing reduces the legibility of small type, particularly when
you import it into Photoshop from a drawing program like
Adobe Illustrator. If you need to antialias small type sizes, do it
in Photoshop:

For the anatomic illustration below we used non-antialiased 9-
point Geneva (a Macintosh screen font) for the illustration
labels:
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Working With Table Properties
The <table> tag has a large number of attributes, and most of
them can be modified through Dreamweaver’s Property
Inspector. As with all objects, the table must be selected before
it can be altered. Choose Modify->Table->Select Table or use
one of the other selection techniques previously described. Once
you’ve selected the table, if the Property Inspector is open, it
presents the table properties as shown in the figure below,
Otherwise, you can open the Table Property Inspector by
choosing Window->Properties Inspector.

The expanded Table Property Inspector gives you control over
all the table wide attributes.

Setting Alignment
Aligning a table in Dreamweaver goes beyond the expected left,
right, and center options-you can also make a table into a free-
floating object around which text can wrap to the left or right.
With HTML, you can align a table using two different methods,
and each gives you a different effect. Using the text alignment
method (Text->Align) results in the conventional positioning
(left, right, and center), and using the Table Property Inspector
method enables you to wrap text around your realigned table.
Figure given below compares some of the different results you
get from aligning your table with the two methods.
To align your table without text wrapping, follow these steps:
1. Select your table using one of the methods described earlier.
2. In the Property Inspector, make sure the Align option is set

to Default.
3. Select the Text->Align command and then choose one of

the three options: Left, Center, or Right.
Dreamweaver surrounds your table code with a division tag
pair, <div>...</div>, with an align attribute set to your chosen
value.

Tables can be centered, as well as aligned left or right—with or
without text wrapping.
To align your table with text wrapping, making your table into a
floating object, follow these steps:
1. Select the table.
2. In the Table Property Inspector, open the Align drop-down

list and choose one of the four options:
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Inserting Rows and Columns
The default Dreamweaver table configuration of three columns
and three rows can be changed at any time. You can add rows or
columns almost anywhere in a table, using various methods.
You have three methods for adding a single row:
Position the cursor in the last cell of  the last row and press Tab
to add a new row below the present one.
1. Choose Modify->Table->Insert Row to insert a new row

above the current row.
2. Right-click (Control+click) to open the shortcut menu and

select Table-> Insert Row. Rows added in this way are
inserted above the current row.

You have two ways to add a new column to your table:
1. Choose Modify->Table->Insert Column to insert a new

column to the left of the current column.
2. Right-click (Control+click) to open the shortcut menu and

select Table-> Insert Column from the shortcut menu. The
column is inserted to the left of the current column.

You can add multiple rows and columns in one of  two
different ways:
1. Increase the number of rows indicated in the Rows text box

of  the Table Property Inspector. All new rows added in this
manner appear below the last table row. Similarly, you can
increase the number of columns indicated in the Cols text
box of  the Table Property Inspector. Columns added in this
way appear to the right of the last column.

2. Use the Insert Rows or Columns dialog box.
The Insert Rows or Columns feature enables you to include any
number of rows or columns anywhere relative to your current
cursor position.
To add multiple columns using the Insert Rows or Columns
dialog box, follow these steps:
1. Open the Insert Rows or Columns dialog box by selecting

Modify->Table->Insert Rows or Columns or by choosing
Table->Insert Rows or Columns from the shortcut menu.

Use the Insert Rows or Columns feature to add several
columns or rows simultaneously.
2. Select either Rows or Columns.
3. Enter the number of rows or columns you wish to insert—

you can either type in a value or use the arrows to increase or
decrease the number.

4. Select where you want the rows or columns to be inserted.
• If you have selected the Rows option, you can insert

the rows either Above or Below the Selection (the
current row).

• If you have selected the Columns options, you can
insert the columns  either Before or After the Current
Column.

5. Click OK when you’re finished.

Deleting Rows and Columns
When you want to delete a column or row, you can use either
the shortcut menu or the Table Property Inspector. On the
shortcut menu, you can remove the current column or row by
choosing Delete Column or Delete Row, respectively. Using the
Table Property Inspector, you can delete multiple columns and
rows by reducing the numbers in the Cols or Rows text boxes.
Columns are deleted from the right side of the table, and rows
are removed from the bottom.

Setting Table Borders and Bbackgrounds
Borders are the solid outlines of the table itself. A border’s
width is measured in pixels; the default width is one pixel. This
width can be altered in the Border field of  the Table Property
Inspector.
You can make the border invisible by specifying a border of 0
width. You can still resize your table by clicking and dragging
the borders, even when the border is set to 0. When the View-
>Table Borders option is selected, Dreamweaver displays a thin
dashed line to represent the border.
When the border is visible, you can also see each cell outlined.
The width of the outline around the cells stays constant,
regardless of the width of the border. However, you can
control the amount of space between each cell with the
CellSpace value in the Table Property Inspector,
To change the width of  a border in Dreamweaver, select your
table and enter a new value in the Border text box. With a wider
border, you can see the default shading: The top and left side
are a lighter shade, and the bottom and right sides are darker.
This gives the table border a pseudo-3D appearance.
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Changing the width of the border can give your table a 3D
look.

Working With Cell Spacing and Cell Padding
HTML gives you two methods to add white space in tables. Cell
spacing controls the width between each cell, and cell padding
controls the margins within each cell. These values can be set
independently through the Table Property Inspector.

Merging and Splitting Cells
You have seen how cells in HTML tables can extend across
(span) multiple columns or rows. By default, a cell spans one
column or one row. Increasing a cell’s span enables you to
group any number of  topics under one heading. You are
effectively merging one cell with another to create a larger cell.
Likewise, a cell can be split into multiple rows or columns.
Dreamweaver enables you to combine and divide cells in two
different ways. If  you’re more comfortable with the concept of
merging and splitting cells, you can use two handy buttons on
the Property Inspector. If, on the other hand, you prefer the
older method of increasing and decreasing row or column span,
you can still access these commands through the main and
shortcut menus.
To combine two or more cells, first select the cells you want to
merge. Then, from the Property Inspector, select the Merge
Cells button or press the keyboard shortcut Ctrl+Alt+M
(Command+Option+M ); Windows users also have the
option of just pressing M. If the Merge button is not available,
multiple cells have not been selected.

You can add additional white space between each cell (cell
spacing) or within each cell (cell padding).
To divide a cell, follow these steps:
1) Position your cursor in the cell to split.
2) From the Property Inspector, select the Split Cell button or

press the keyboard shortcut, Ctrl+Alt+S
(Command+Option+S).

3) The Split Cell dialog box appears

Use the Split Cell dialog box to divide cells horizontally or
vertically.

5) Select either the Rows or Columns option to decide whether
the cell will be split horizontally or vertically.

6) Enter the Number of Rows or Columns in the text box or
use the arrows to change the value.

7) Select OK when you’re done.
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Setting cell, column, and row properties
In addition to the overall table controls, Dreamweaver helps
you set numerous properties for individual cells one at a time,
by the column or by the row. When attributes overlap or
conflict, such as different background colors for a cell in the
same row and column, the more specific target wins out. The
hierarchy, from most general to most specific, is as follows:
tables, rows, columns, and cells.
You can call up the specific Property Inspector by selecting the
cell, row, or column you want to modify. The Cell, Row, and
Column Property Inspectors each affect similar attributes. The
following sections explain how the attributes work in general
and-if any differences exist-specifically in regard to the cell,
column, or row.

This spreadsheet-like report was built using Dreamweaver’s
row- and column-spanning features.

Horizontal Alignment
You can set the Horizontal Alignment attribute, align, to specify
the default alignment, or Left, Right, or Center alignment, for
the element in the cell, column, or row. This attribute can be
overridden by setting the alignment for the individual line or
image. Generally, Left is the default horizontal alignment for
cells.

Vertical alignment
The HTML valign attribute determines whether the cell’s
contents are vertically aligned to the cell’s top, middle, bottom,
or along the baseline. Typically, browsers align cells vertically in
the middle by default. Select the Vertical Alignment option
arrow in the Cell, Column, or Row Properties dialog box to
specify a different alignment.

Top, Middle, and Bottom vertical alignments work pretty much
as you would expect. A Baseline vertical alignment displays text
near the top of the cell and positions the text-regardless of font
size-so that the baselines of  all the text in the affected row,
column, or cell are the same. You can see how images and text
of various sizes are displayed under the various vertical
alignment options in figure below:

You can vertically align text and images in several arrangements
in a table cell, row, or column.

Cell wrap
Normal behavior for any cell is to automatically wrap text or a
series of  images within the cell’s borders. You can turn off this
automatic feature by selecting the No  Wrap option in the
Property Inspector for cell, column, or row.

Table header cells
Quite often in tables, a column or a row functions as the
heading for that section of the table, labeling all the
information in that particular section. Dreamweaver has an
option for designating these cells: the Header option. Table
header cells are usually rendered in boldface and centered in each
cell. Figure given below  shows an example of a table in which
both the first row and first column are marked as table header
cells.

Table header cells are a good way to note a category’s label-either
for a row or a column, or both.
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Assignments
1. What are the different methods of Indenting paragraph?
2. What is Nested list? How can be automatically revoked

within Dreamweaver?
3. How do you build your own graphic bullets in

Dreamweaver?
4. Write the HTML code for inserting table? What is &nbsp

used for?
5. Explain the attributes connected with Table in HTML?
6. Build a checklist of cross platform issues for your website?
7. What is type graphics? Give two examples?
8. What alignments options Dreamweaver gives in Table

Property Inspector window?
9. How cell splitting and merging works in Dreamweaver?
10.What is a Table header?

Notes
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Topics Covered
• Introduction to Editorial style, Organizing your prose
• Dreamweaver – Designing with layout mode, Drawing cells

and tables, Modifying layouts

Objectives
Upon completion of this lesson, you should be able to:
• Organize your prose
• Design with layout mode
• Draw cells and tables
• Modify layouts

Editorial Style
First we thought the PC was a calculator. Then we found out
how to turn numbers into letters with ASCII - and we thought
it was a typewriter. Then we discovered graphics, and we
thought it was a television. With the World Wide Web, we’ve
realized it’s a brochure.
- Douglas Adams

Among The Many Web
induced trends, the emergence of a new writing genre designed
to accommodate the reading habits of  Web users is especially
notable. People read differently on the Web. One reason for this
is that reading text on-screen is unpleasant. Given the low
resolution of the computer screen and the clumsiness of the
scrolling page, many readers scan onscreen and print pages for
reading. Another reason is that Web reading is not a stationary
activity. Users roam from page to page collecting salient bits of
information from a variety of sources. They need to be able
quickly to ascertain the contents of a page, get the information
they are seeking, and move on. Also, because Web pages may be
accessed directly without preamble, they must be more
independent than print pages. Too many Web pages end up as
isolated fragments of information, divorced from the larger
context of  their parent Web sites through the lack of  essential
links and the simpler failure to inform the reader properly of
their contents.
One of  the most obvious characteristics of  Web writing is
hypertext links. Web authors use hypertext links to create or
supplement concepts: a list of related links can reinforce their
content or even serve as the focus of  their site. The problem
posed by links has little to do with the Web but is rooted in the
concept of hypertext: Can the quick juxtaposition of two
separate but conceptually related pieces of information
encourage a better understanding of the overall message? A
collection of links cannot create or sustain an argument or
deliver a collection of facts as efficiently or legibly as
conventional linear prose. When there is no sustained narrative,
readers are sent aimlessly wandering in their quest for
information. Links also become a maintenance issue, because
most Web pages are ephemeral. Broken links shake the reader’s
confidence in the validity and timeliness of content. Links

should be used sparingly and as a reinforcement of, not a
substitute for, content.

Organizing Your Prose
Documents written to be read online must be concise and
structured for scanning. People tend to skim Web pages rather
than read them word by word. Use headings, lists, and
typographical emphasis for words or sections you wish to
highlight; these are the elements that will grab the user’s
attention during a quick scan. Keep these elements clear and
precise - use your page and section heads to describe the
material. The “inverted pyramid” style used in journalism
works well on Web pages, with the conclusion appearing at the
beginning of a text. Place the important facts near the top of
the first paragraph where users can find them quickly.

That said, keep in mind that much content is not well suited to
the telegraphic style that works well for online documents. Web
authors often cut so much out of their presentations that what
remains would barely fill a printed pamphlet. Concise writing is
always better, but don’t “dumb down” what you have to say.
You can assume that readers will print anything longer than
half a page and read it offline. Simply make printing easy for
your readers and you can use the Web to deliver content
without cutting the heart out of what you have to say.
Another way to style online documents is to break up your
information into logical “chunks” connected by hypertext links,
but only where it makes sense (see Site Design, “Chunking”
information). Don’t break up a long document arbitrarily; users
will have to download each segment and will have difficulty
printing or saving the entire piece. The key to good chunking is

LESSON 34:
EDITORIAL
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to divide your information into comprehensive segments. That
way readers will have direct and complete access to the topics
they are interested in without having to wade through irrelevant
material or follow a series of links to get the whole picture.

Computer Lab

Dreamweaver

Designing With Layout Mode
As discussed earlier in this chapter, experienced Web designers
regard tables as one of their primary layout tools because,
outside of Dynamic HTML’s layers, tables are the only way for
you to get close to positioning your page elements the way you
want them to appear. It’s a lot of work to do this with raw
tables, but designers are a persistent group—and for good
reason: Persistence has a big payoff.
Although they share the same underlying HTML structure,
tables and cells created in Layout view differ from those created
in Standard view in the following ways:
1. Borders are set to zero and, thus, turned off.
2. Cell padding and cell spacing are also set to zero to enable

content to appear directly next to each other.
3. Layout tables optionally include a row for each column that

holds a one pixel  high transparent GIF image called a spacer.
4. Columns in a layout table are set to either a fixed pixel width

or designed to automatically stretch to the full width of the
page.

In addition to these physical differences, Layout view has a
different appearance. Each layout table is marked with a tab and
the column width is identified at the top of each column as
shown in the figure below:
Dreamweaver puts the entrance to Layout view right up front
on the Objects panel. At the bottom of the panel, two new
areas have been added for Dreamweaver 4. To switch modes,
click the Layout View button; to return to the traditional mode,
select the Standard View button. If the Objects panel is not
open, use the menu by choosing View->Table View->Layout
View or the keyboard shortcut Ctrl+F6 (Command+F6). Once
Layout view has been enabled, two buttons above the view
modes become active: Draw Cell and Draw Table.

In Layout view, tables and columns are immediately identifiable
and extremely flexible.

Drawing Cells and Tables
Although you can use the Layout view to modify the structure
of  existing pages, this mode is best when designing Web pages
from the ground-up. The Draw Cell and Draw Table
commands enable you to quickly layout the basic structure of
your page by defining the key document areas. For example,
with just four mouse moves in Layout view, I could design a
page with sections for a logo, a navigation bar, a copyright
notice, and a primary content area. Now I’m ready to fill out the
design with graphics, text, and other assets.

Here’s how it works:
1. On a blank page, choose the Layout View button from the

bottom of the Objects panel. When you first enter Layout
view, Dreamweaver displays a help screen to explain how the
new feature works. After you get the hang of working in
Layout view, feel free to select the Don’t Show Me This
Message Again option to prevent further appearances of the
dialog box. Select the Draw Cell button, directly above the
View modes. The cursor changes to a plus (+) sign.
Although it may seem backwards, it’s best to initially use the
Draw Cells rather than Draw Table. Dreamweaver
automatically creates the HTML table necessary to hold any
cells you draw, resulting in less tables and tighter code. The
Draw Table command is best used to make a nested table.

2. Move your cursor anywhere on the page and drag out a
layout cell, as shown in figure.
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Use the Draw Cell command to define the basic page structure
in Layout view.
3. Repeat Step 3 until your layout is complete.
As indicated earlier, the Draw Table command is best suited for
creating nested tables. A table is said to be nested when it is
placed within an existing table. Nested tables are useful when a
design requires that a number of elements, for example, a
picture and a related caption, remain stationary in relation to one
another while text on the page flows according to the size of
the browser window.
To create a nested table in Layout view, follow these steps:
1. Choose the Layout View button on the Objects panel.
2. Select the Draw Layout Table button, also from the Objects

panel.
3. When the cursor is over an area of the table unoccupied by a

layout cell, the cursor changes to a plus (+) sign and a layout
table can be dragged out. When not over a valid area, the
cursor is shown as a slashed circle—the universal sign for
“not allowed.” The new layout table is inserted as shown
below

4. To divide the nested layout table into multiple areas, choose
the Draw Cell button to drag out new cells.

5. As with the Draw Cell command, the Draw Table command
defaults to dragging one table at a time. To draw several
tables in a row, select Ctrl (Command) while dragging out a
layout table.

Nested tables are easily added with the Draw Layout Table
command.

Modifying Layouts
Layout view is not only a boon for creating the initial page
design, but it also makes the inevitable modifications more
straightforward. Cells are positionable within a layout table
much the same as layers on a page. However, one difference
exists; cells, unlike layers, cannot overlap. Resizing layout cells
and tables is also easier. Unlike in Standard view where any table
or cell border is draggable, in Layout view cells and tables have
sizing handles-much the same as a selected image.
To easily manipulate layout and cells, they have to be easily
selectable. Dreamweaver handles that chore with colorful flair.
Pass your cursor over any layout cell, when you pass the border
of a cell it changes from blue to red. Click once on the red
highlight and the cell is selected. A selected cell is notable by the
eight sizing handles placed on its perimeter. Once a cell is
selected, the Property Inspector displays the available attributes.
The Layout Cell Property Inspector offers six key attributes:
• Width: Enter a pixel value for a Fixed cell width or select the

Autostretch option to enable the cell to grow as needed.
(Autostretch is covered in the next section.) The width of
each cell is shown on top of  each column in Layout view.
The column width property is an important one and is
explained in greater detail later in this section.

• Height: Enter a pixel value for cell height. Percentages
cannot be entered in  Layout view.

• Horz: Select a horizontal alignment for the cell’s content; the
options are Default, Left, Center, and Right.

• No Wrap: When enabled, this option keeps content-text
and images-from wrapping to the next line, which, if the
column is in Autostretch mode, may alter the width of the
cell.

• Bg: Choose a background color for the cell.
• Vert: Choose a vertical alignment for the cell’s content; the

options are Default, Top, Middle, Bottom, and Baseline.
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Although similar to the standard Cell Property Inspector, the
Layout Cell Property Inspector offers a different set of options.
To reshape or resize a layout cell, drag any one of  the sizing
handles on the cell’s  border into the unused area of  a table.
Likewise, you can drag a cell into any open table area, for
example, any area of the table unoccupied by another cell.

Notes
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Topics Covered
• Online style, Prose  style, Other stylistic consideration
• Dreamweaver  - Using frames and framesets, columns and

rows, Quick framesets with frames objects,

Objectives
Upon completion of this lesson, you should be able to:
• Online style
• Different types of prose style
• learn about other stylistic consideration
• Use frames and framesets - The basics
• Create frames and framesets
• Using the menus
• Create frame objects using quick framesets

Online Style
For most Web writing you should assume that your carefully
crafted prose will not be read word by word. This is not the case,
of course, for texts such as journal articles or teaching materials:
in many cases these more complicated texts will be printed and
read offline. But most online information is best presented
using short segments of texts written in a clear, concise style
and with ample use of editorial landmarks.

Prose Style
Our writing style example below explains the steps involved in
creating a successful Web site. The first style is vague and
verbose. The second is concise: we simply list the facts. It is this
second writing style that is most suitable for Web documents.
Most Web readers are looking for information, and they find it
not by reading a Web page word by word but rather by scanning
the page for relevant items.
Vague and verbose. You must read every word in this paragraph in
order to understand the steps involved in creating Web sites:
Web site development is a complex process that involves many
steps and tasks that range from budgeting to design and
evaluation. First, you need to define the scope of your project
and determine a budget for site development. Then you need
to survey and map the structure of  your information. The next
step is to establish a look and feel for your site, and then comes
the actual construction of your site. Once your site is finished
you need to make sure people know that it’s there and how to
find it. Finally, you should spend time evaluating your site’s
effectiveness. As you embark on the process of developing a
Web site, keep these steps in mind and make sure that you have
the organizational backing, budget, and personnel you need to
make the project a success.
Concise and factual. In this version, we turned the wordy
explanation of the process into a concise list of steps to follow:

The process of  developing a Web site generally follows these
steps:
1. Site definition and budgeting
2. Information architecture
3. Site design
4. Site construction
5. Site marketing
6. Tracking and evaluation
Before beginning to develop a Web site, make sure you have the
organizational backing, budget, and personnel you need to
perform these steps successfully.

Other stylistic considerations
• Be frugal. Make sure that the text you present is worth

something to the reader. Avoid empty chatter like welcome
text or instructions on how to use the site. Users should be
able to determine who you are by your navigation and page
design, and your interface should be clear enough that it
doesn’t require instructions. Don’t use the first paragraph of
each page to tell users what information they’ll find there.
Instead, start with the information, written in the concise
and factual prose style shown above.

• Stick to the point. Write in easily understood sentences. Steer
clear of clever headings and catchy but meaningless phrases
that users must think about and explore further to
understand.

• Cultivate a voice. Web readers welcome a measure of
individuality from their information sources. With so many
competing sources, a unique voice may help distinguish your
pages, but beware of  going “over the top.” When it comes
to attitude, there is a fine line between engaging and
annoying.

• Think globally. Remember that you are designing documents
for the World Wide Web and that your audience may not
understand conventions specific to your little corner of the
world. For example, when including dates, use the
international date format of  day / month / year (e.g., 14
March 2001). Also, avoid metaphors and puns that may
make sense only in the context of your language and culture.

Using Frames and  Framesets
Frames constitute one of  the Webmaster’s major design tools.
A frame is a Web page that is subdivided into both static and
changing HTML pages. Not too long ago, the evolution of
frames was right where Dynamic HTML is today in terms of
general acceptance. The use of frames and framesets has become
even more widespread over the last year or so, and the
technology is now supported through every major browser
version. It’s safe to say that every Web designer today needs a
working knowledge of frames to stay competitive

LESSON 35:
FRAMES AND FRAMESETS
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Each frame was truly an independent Web page and that you
didn’t have to use only Web pages on your own site—you
could link to any page on the Internet. That was when I also
realized the amount of work involved in establishing a frame
Web site: Every page displayed on that site used multiple
HTML pages.
Dreamweaver takes the head-pounding complexity out of
coding and managing frames with a point-and-click interface.
You get easy access to the commands for modifying the
properties of the overall frame structure as well as each
individual frame. This chapter gives you an overview of  frames,
as well as all the specifics you need for inserting and modifying
frames and framesets. Special attention is given to defining the
unique look of frames through borders, scroll bars, and
margins.

Frames and Framesets: The Basics

It’s best to think of frames in two major parts: the frameset,
and the frames themselves. The frameset is the HTML
document that defines the framing structure- the number of
individual frames that make up a page, their initial size, and the
shared attributes among all the frames. A frameset by itself is
never displayed. Frames, on the other hand, are complete
HTML documents that can be viewed and edited separately or
together in the organization described by the frameset. A
frameset takes the place of the <body> tags in an HTML
document, where the content of  a Web page is found. Here’s
what the HTML for a basic frameset looks like:
<frameset rows=”50%,50%”>
<frame src=”top.html”>
<frame src=”bottom.html”>
</frameset>
Notice that the content of a <frameset> tag consists entirely of
<frame> tags, each one referring to a different Web page. The
only other element that can be used inside of a <frameset> tag
is another frameset> tag.

Columns and Rows

Framesets, much like tables, are made up of columns and rows.
The columns and rows attributes (cols and rows) are lists of
comma-separated values. The number of values indicates the
number of either columns or rows, and the values themselves
establish the size of the columns or rows. Thus, a <frameset>
tag that looks like this:
<frameset cols=”67,355,68”>
denotes three columns of widths, 67, 355, and 68, respectively.
And this frameset tag:
<frameset cols=”270,232” rows=”384,400”>
declares that two columns exist with the specified widths (270
and 232) and two rows with the specified heights (384 and 400).

Sizing Frames
Column widths and row heights can be set as absolute
measurements in pixels, or expressed as a percentage of the
entire screen. HTML frames also support an attribute that
assigns the size relative to the other columns or rows. In other
words, the relative attribute (designated with an asterisk) assigns

the balance of the remaining available screen space to a column
or row. For example, the following frameset:
<frameset cols=”80,*”>
sets up two frames, one 80 pixels wide and the other as large as
the browser window allows. This ensures that the first column
will always be a constant size—making it perfect for a set of
navigational buttons—while the second is as wide as possible.
The relative attribute can also be used proportionally. When
preceded by an integer, as in n*, this attribute specifies that the
frame is allocated n times the space it would have received
otherwise. So frameset code like this:
<frameset rows=”4*,*”>
ensures that one row is proportionately four times the size of
the other.

Creating a Frameset and Frames

Dreamweaver offers several ways to divide your Web page into
frames and make your frameset. The first method uses the
menus. Choose Modify->Frameset and, from the submenu,
select the direction in which you would like to split the frame:
left, right, up, or down. Left or right splits the frame in half
vertically; up or down splits it horizontally in half.
You can also create a frameset visually, using the mouse. To
create frames with this method, follow these steps:
1. Turn on the frame borders in your Dreamweaver Document

window by selecting View->Visual Aids->Frame Borders. A
3-pixel-wide inner border appears along the edges of your
Document window.

2. Position the cursor over any of the frame borders.
3. Press Alt (Option).
4. Drag the frame border into the Document window. Figure

below shows a four frame frameset being created.

After you’ve enabled the frame borders, you can drag out your
frameset structure with the mouse.
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Dreamweaver initially assigns a temporary filename and an
absolute pixel value to your HTML frameset code. Both can be
modified later, if you wish.
When the frameset is selected, Dreamweaver displays a black,
dotted line along all the frame borders and within every frame.
You can easily reposition any frameset border by clicking and
dragging it. If  you just want to move the border, make sure
you don’t press the Alt or Option key while dragging the
border; this action creates additional frames.

Adding more Frames
You’re not at all limited to your initial frame choices. In
addition to being able to move them visually, you can also set
the size through the Frameset Property Inspector, as described
in the next section. Furthermore, you can continue to split
either the entire frame or each column or row as needed. When
you divide a column or row into one or more frames, you are
actually nesting one frameset inside another.

Using the Menus
To split an existing frame using the menus, position the cursor
in the frame you want to alter and choose Modify-
>Frameset>Split Frame Left, Right, Up, or Down. Figure 16-2
shows a two-row frameset in which the bottom row was split
into two columns and then repositioned. The Frameset
Property Inspector indicates that the inner frameset (2 columns,
1 row) is selected. The direction in the command (Left, Right,
Up, and Down) indicates the frame the existing page will be
placed in. For example, I selected Split Frame Right for Figure
below, and the current page is placed in the right frame.

Use the Modify->Frameset menu option to split an existing
frame into additional columns or rows and create a nested
frameset.

You can clearly see the “nested” nature of the code in this
HTML fragment describing the frameset
<frameset rows=”163,333” cols=”784”>
<frame src=”file://Dev/UntitledFrame-34”>
<frameset cols=”115,663” rows=”*”>
<frame src=”file://Dev/UntitledFrame-57”>
<frame src=”file://Dev/UntitledFrame-35”>
</frameset>
</frameset>

Using the Mouse
When you need to create additional columns or rows that span
the entire Web page, use the mouse method instead of  the
menus. Alt+drag (Option+drag) any of  the current frame’s
borders that go across the entire page, such as one of the outer
borders
Figure below shows a new row added along the bottom of our
previous frame structure.

An additional frame row was added using the Alt+drag
(Option+drag) method.

Quick Framesets with the Frames Objects
Dragging out your frameset in Dreamweaver is a clear-cut
method of setting up the various frames. However, now
matter how easy it is, it can still be a bit of a chore to create even
simple framesets by clicking and dragging. To hasten the
development workflow, Dreamweaver uses Frame objects,
which can build a frameset with a single click.
Although a frame-based Web design could potentially be quite
complex with numerous nested framesets, most of the sites
using frames follow a more simple, general pattern.
Dreamweaver offers eight of the most common frameset
configurations in the Frames category of the Objects panel,
shown in the figure below Choose one of the basic designs,
and you’re ready to tweak the frame sizes and begin filling in the
content. It’s a great combination of  ease-of-use mixed with
design flexibility.
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The Frames category of the Objects panel holds eight of the
most commonly used frameset configurations.
The Frames category is roughly organized from simplest
framesets to most complex. You might notice that each of  the
icons on the panel shows an example frameset with one blue
section. The placement of the color is quite significant. The blue
indicates in which frame the current page will appear when the
frameset is constructed. For example, if I had begun to
construct my main content page, and then
decided to turn it into a frameset with a separate navigation
strip frame beneath it, I would choose the Bottom Frames
object.
The next Figure provides a before-and-after example with the
preframe content on the left and the same content after a
Bottom Frame object has been applied.
The eight different framesets available from the Frames category
are:
•  Left: Inserts a blank frame to the left of the current page.
•  Right: Inserts a blank frame to the right of the current page.
•  Top: Inserts a blank frame above the current page.
•  Bottom: Inserts a blank frame below the current page.
•  Left and Top: Makes a frameset with four frames where the

current page is in the lower right.
•  Left Top: Makes a frameset where the left spans the two

rightmost frames; a nested frameset is used to create the
right frames. The existing page is placed in the lower-right
frame.

•  Top Left: Makes a frameset where the top spans the
lower two frames; the lower frames are created using a nested
frameset. The existing page is placed in the lower-right frame.
•  Split: Creates a frameset with four equal frames and
moves the existing page to the lower right.
Using the Frames objects is quite literally a one-click operation.
Just select the desired frameset, and Dreamweaver automatically
turns on Frame Borders, if  necessary,  and creates and names
the required frames. For all Frames objects, the existing page is
moved to a frame where the scrolling option is set at Default,
and the size is relative to the rest of the frameset. In other
words, the existing page can be scrolled and expands to fill the
content. For this reason, it’s best to apply a Frames object to an
existing page only if it is intended to be the primary content
frame. Otherwise, it’s better to select the Frames object while a
blank page is open and then use the File->Open in Frame
command to load any existing pages into the individual frames.
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Before Bottom Frame object has been applied.

After Bottom Frame Object has been applied.
Existing content is incorporated in a new frameset when a Frames object is chosen.
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Topics Covered
• Titles and subtitles
• Dreamweaver - working with frameset property Inspector,

Resizing frames in a frameset, Manipulating frameset
borders, Modifying a frame, setting borders, Adding a scroll
bar, Handling frameless borders

objectives
Upon completion of this lesson, you should be able to:
• Build consistent interface using titles and subtitles
• Work in frameset property
• Resize frames in a frameset
• Save frame and framesets.
• Add a scroll bar
• Handle frameless

Titles and Subtitles
Editorial landmarks like titles and headers are the fundamental
human interface device in Web pages, just as they are in any
print publication. A consistent approach to titles, headlines, and
subheadings in your documents will help your readers navigate
through a complex set of  Web pages.

Text styles
The text styles we recommend:
Headline style: Bold, capitalize initial letters of words
• Document titles
• References to other Web sites
• Titles of documents mentioned in the text
• Proper names, product names, trade names
Down style: Bold, capitalize first word only
• Subheads
• References to other sections within the site
• Figure titles

Lists

Page titles
Web page titles are designated in the HTML document head
section with the TITLE tag. The title is crucial for several
reasons. Often the title is the first thing users with slow
Internet connections will see; it also becomes the text for any
bookmarks the reader makes to your pages. In addition, most
search engines regard the page title as the primary descriptor of
page content, so a descriptive title increases the chance that a
page will appear as the result of  a related search query.
The page title should:
• Incorporate the name of  your company, organization, or

Web site

• Form a concise, plainly worded reminder of the page
contents

• Always consider what your page title will look like in a long
list of bookmarks. Will the title remind the reader of what
he or she found interesting about your pages?

• Text formatting for web documents
Some points about text formatting specific to the Web:
• Excessive markup. Beware of  too much markup in your

paragraphs. Too many links or too many styles of typeface
will destroy the homogeneous, even “type color” that
characterizes good typesetting.

• Link colors. If you are including links in the body of your
text, choose custom link colors that closely match your text
color. Reading from the screen is hard enough without
struggling with distracting link colors scattered across the
page.

• Use the best tool. Write your text in a good word processing
program with spell-checking and search features. Transfer
your text to HTML only after it has been proofread.

• Style sheets in word processors. Don’t use the word
processor’s style sheets to produce “All capitals” or other
formatting effects. You will lose those special formats when
you convert to plain ASCII text for HTML use.

• Special characters. Don’t use the “smart quotes” feature.
Avoid all special characters, such as bullets, ligatures, and
typographer’s en and em dashes, that are not supported in
standard HTML text. Consult a good HTML guidebook (we
recommend several in the References) for the listing of
special and international characters supported through
HTML’s extended character formatting.

• No auto hyphens. Never use the automatic hyphenation
feature of  your word processor on text destined for the Web.
This may add nonstandard “optional hyphen” characters that
will not display properly in Web browsers.

References
Associated Press. 2000. The Associated Press stylebook and
briefing on media law. Cambridge, Mass.: Perseus.
Hale, Constance, and Jessie Scanlon. 1999. Wired style:
Principles of  English usage in the digital age. New York:
Broadway Books.
Krug, Steve. 2001. Don’t make me think! A common sense
approach to Web usability. Indianapolis, Ind.: Que.
Microsoft Corporation. 1995. The Microsoft manual of style for
technical publications. Redmond, Wash.: Microsoft Press.
Mullen, R. 1998. The HTML 4 programmer’s reference: All
platforms. Research Triangle Park, N.C.: Ventana Press.

LESSON 36:
FRAMES AND FRAMESETS–2



181

E
-M

E
D

IA
New York Times. 1999. The New York Times manual of  style
and usage. New York: Times Books.
Nielsen, Jakob. 1995. The alertbox: Current issues in Web
usability. http://www.useit.com/alertbox
———. 1999. Designing Web usability: The practice of
simplicity. Indianapolis, Ind.: New Riders.
Strunk, Jr., William, and E. B. White. 2000. The elements of
style, 4th ed. New York: Macmillan.
Zinsser, William. 1998. On writing well: An informal guide to
writing nonfiction. 6th ed. New York: HarperReference.

Computer  Lab

Dreamweaver

Working with the Frameset Property Inspector
The Frameset Property Inspector manages those elements, such
as the borders, hat are common to all the frames within a
frameset; it also offers more precise sizing control over
individual rows and columns than you can do visually. To access
the Frameset Property Inspector, choose Window->Properties,
if the Property Inspector is not already open, and then select any
of the frame borders.

Resizing frames in a frameset
With HTML, when you want to specify the size of a frame, you
work with the row or  column in which the frame resides.
Dreamweaver gives you two ways to alter a frame’s size: by
dragging the border or, to be more precise, by specifying a value
in the Frameset Property Inspector
As shown in Figure below, Dreamweaver’s Frameset Property
Inspector contains a Row/Column selector to display the
structure of the selected frameset. For each frameset, you select
the tab along the top or left side of the Row/Column selector
to choose the column or row you want to modify.

In the Frameset Property Inspector, you use the Row/Column
Selector tabs to choose which frame you are going to resize.
Whether you need to modify just a row, a column, or both a
row and a column depends on the location of the frame.
• If your frame spans the width of an entire page, select the

corresponding tab on the left side of the Row/Column
Selector.

• If your frame spans the height of an entire page, select the
equivalent tab along the top of the Row/Column Selector.

• If your frame does not span either height or width, you
need to select both its column and its row and modify the
size of each in turn.

Once you have selected the row or column, follow these steps
to specify its size:
To specify the size in pixels, enter a number in the Frameset
Property Inspector’s Value text box and select Pixels as the Units
option.
1. To specify the size as a percentage of  the screen, enter a

number from 1 to 100 in the Value text box and select
Percent as the Units option.

2. To specify a size relative to the other columns or rows, first
select Relative as the Units option. Now you have two
options:

• To set the size to occupy the remainder of  the screen,
delete any number that may be entered in the Value
text box; optionally, you can enter 1.

• To scale the frame relative to the other rows or
columns, type the scale factor in the Value text box.
For example, if you want the frame to be twice the
size of  another relative frame, put a 2 in the Value text
box.

Manipulating Frameset Borders
By default, Dreamweaver sets up your framesets so all the
frames have gray borders that are 6 pixels wide. You can alter the
border color, change the width, or eliminate the borders
altogether. All of the border controls are handled through the
Frameset Property Inspector.
If  you are working with nested framesets, it’s important that
you select the outermost frameset before you begin making any
modifications to the borders. You can tell that you’ve selected
the outermost frameset by looking at the Dreamweaver Tag
Selector; it shows only one <frameset> in bold. If you select an
inner nested frameset, you see more than one <frameset> in
the Tag Selector.

Eliminating Borders
When a frameset is first created, Dreamweaver leaves the
borders display up to the browser’s discretion. You can
expressly turn the frameset borders on or off through  the
Frameset Property Inspector. To eliminate borders completely,
enter a zero in the Border Width text box. Even if   no width
value is displayed, the default is a border 6 pixels wide. If you
turn off the borders for your frameset, you can still work in
Dreamweaver with View->Visual Aids->Frame Borders
enabled, which gives you quick access to modifying the frameset.
The borders are not displayed, however, when your Web page is
previewed in a browser.

Border Aappearance Options
You can control the appearance of  your borders to a limited
degree. In the Borders drop-down list of options, choosing
Yes causes browsers to draw the borders with a 3D appearance.
Select No, and the frameset borders are drawn as a single color.
Browsers generally interpret the three-dimensional look as the
default option.

Saving a frameset and frames
As mentioned earlier, when you’re working with frames, you’re
working with multiple HTML files. You must be careful to save
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not only all the individual frames that make up your Web page
but also the frameset itself.
Dreamweaver makes it easy to save framesets and included
frames by providing several special commands. To save a
frameset, choose File->Save Frameset to open the standard Save
File dialog box. You can also save a copy of  the current frameset
by choosing File->ve Frameset As. You don’t have to select the
frameset border or position your cursor in any special place to
activate these functions.
Saving each frame in the frameset can be a chore unless you
choose File->Save All Frames. The first time this command is
invoked, Dreamweaver cycles through each of the open frames
and displays the Save File dialog box. Each subsequent time
you choose File->Save All Frames, Dreamweaver automatically
saves every updated file in the frameset.
To copy an individual frame, you must use the regular File-
>Save As command.

Closing a frameset
There’s no real trick to closing a Dreamweaver frameset: just
choose File->Close. If the frameset is your last open file,
Dreamweaver asks if  you’d like to quit the program (unless
you’ve previously selected the Don’t Ask Me Again option).

Modifying a Frame
What makes the whole concept of  a Web page frameset work so
well is the flexibility of each frame.
• You can design your page so that some frames are fixed in

size while others are expandable.
• You can attach scroll bars to some frames and not others.
• Any frame can have its own background image, and yet all

frames can appear as one seamless picture.
• Borders can be enabled-and colored-for one set of frames

but left off for another set. Dreamweaver uses a Frame
Property Inspector to specify most of  a frame’s attributes.
Others are handled through devices already familiar to you,
such as the Page Properties dialog box.

Page Properties
Each frame is its own HTML document, and as such, each
frame can have independent page properties. To alter the page
properties of a frame, position the cursor in the frame and then
choose Modify’Page Properties. You can also use the keyboard
shortcuts, Ctrl+J or Command+J. Or you can select Page
Properties from the shortcut menu by right-clicking
(Control+clicking) any open space on the frame’s page.
From the Page Properties dialog box, you can assign a title,
although it is not visible to the user unless the frame is viewed
as a separate page. If you plan on using the individual frames as
separate pages in your <noframes> content , it’s good practice
to title every  page. You can also assign a background and the
various link colors by selecting the appropriate color swatch or
entering a color name into the correct text box.

Opening a Web page into a frame
You don’t have to build all Web pages in frames from scratch.
You can load an existing Web page into any frame. If  you’ve
selected a frame and the Frame Property Inspector is open, just

type the link directly into the Src text box or choose the folder
icon to browse for your file. Or you can position your cursor in
a frame (without selecting the frame) and choose File->Open in
Frame.

Setting Borders
You can generally set most border options adequately in the
Frameset Property Inspector; you can also override some of
those options, such as color, for each frame. These possibilities
have practical limitations, however. To set borders from the
Frame Property Inspector for a selected frame, you can make the
borders three-dimensional by choosing Yes in the Borders
drop-down option list, or use the monochrome setting by
choosing No. Leaving the Borders option at Default gives
control to the frameset settings. You can also change a  frame’s
border color by choosing the Border Color swatch in a selected
frame’s Property Inspector.
Now, about those limitations: They come into play when you
try to implement one of your border modifications. Because
frames share common borders, it is difficult to isolate an
individual frame and have the change affect just the selected
frame. As an example, Figure below shows a frameset in which
the borders are set to No for all frames except the one on the
lower right. Notice how the left border of the lower right frame
extends to the top, all the way over the upper frame. You have
two possible workarounds for this problem. First, you can
design your frames so that their borders do not touch, as in a
multi-row frameset. Second, you can create a background image
for a frame that includes a border design.

If you want to use isolated frame borders, you have to carefully
plan your Web page frameset to avoid overlapping borders.

Adding scroll bars
One of the features that has given frames the wide use they
enjoy is the capability to enable or disable scroll bars for each
frame. Scroll bars are used when the browser window is too
small to display all the information in the Web page frame. The
browser window size is completely user controlled, so the Web
designer must apply the various scroll bar options on a frame-
by-frame basis, depending on the look desired and the frame’s
content.
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Four options are selectable from the Scroll drop-down list on
the Frame PropertyInspector:
§ Default: Leaves the use of scroll bars up to the browser.
•  Yes: Forces scroll bars to appear regardless of  the amount

of content.
• No: Disables scroll bars.
• Auto: Turns scroll bars on if  the content of  the frame

extends horizontally or vertically beyond what the browser
window can display.

Figure below uses an automatic vertical scroll bar in the lower
frame; you can see it on the far right.

The top frame of  the Web page has the scroll bars turned off,
and the bottom-right frame has scroll bars enabled.

Resizing
By default, all frames are resizable by the user; that is, a visitor to
your Web site can widen, narrow, lengthen, or shorten a frame
by dragging the border to a new position. You can disable this
resizing capability, however, on a frame-by-frame basis. In the
Frame Property Inspector, select the No Resize option to turn
off the resizing feature.

Setting Margins
Just as you can pad table cells with additional space to separate
text and graphics, you can offset content in frames.
Dreamweaver enables you to control the left/right margins and
the top/bottom margins independently. By default, about 6
pixels of space are between the content and the left or right
frame borders, and about 15 pixels of space are between the
content and the top or bottom frame borders. You can increase
or decrease these margins, but even if  you set the values to zero,
some room still exists between the borders and the content. To
alter the left and right margins, change the value in the Frame
Property   Inspector’s Margin Width text box; to change the top
and bottom margins, enter a new value in the Margin Height
text box. If you don’t see the Margin Width and Height text
boxes, select the Property Inspector expander arrow.

Handling Frameless Browsers
Not all of  today’s browsers support frames. Netscape began
supporting frames in Navigator version 2.0; Microsoft didn’t
start until IE version 3.0—and a few of the earlier versions for
both browsers are still in use, particularly among AOL users.
Some less prevalent browsers also don’t support frames.
HTML has a built-in mechanism for working with browsers
that are not frame-enabled: the <noframes>...</noframes>
tag pair.
When you begin to construct any frameset, Dreamweaver
automatically inserts a <noframes> area just below the closing
</frameset> tag. If  a browser is not frames-capable, it ignores
the frameset and frame information and renders what is found
in the <noframes> section.
What should you put into the <noframes> section? To ensure
the widest possible audience, Webmasters typically insert links
to a nonframe version of the site. The links can be as obvious
or as discreet as you care to make them. Perhaps a more vital
reason is that most of the search engine indexing systems
(called spiders) don’t work with frames. If your frameset is
index.html and you want the spider to find the rest of your
site, you need to have a descriptive text from your home page as
well as a link to each page in the noframes content. Many
Webmasters also include links to current versions of Netscape
or Internet Explorer, to encourage  their nonframe-capable
visitors to upgrade.

Dreamweaver includes a facility for easily adding and modifying
the <noframes> content. Choose Modify->Frameset->Edit
NoFrames Content to open the NoFrames Content window.
As you can see in Figure 16-13, this window is identical to the
regular Dreamweaver Document window, with the exception of
the “NoFrames Content” in the title bar. In this window, you
have access to all the same objects and panels that you normally
do. When you have finished editing your <noframe> content,
choose Modify->Frameset->Edit NoFrames Content again to
deselect the option and return to the frameset.
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Through the Edit NoFrames Content command, Dreamweaver
enables you to specify what’s seen by visitors whose browsers
are not frame-capable.

Assignments
1. How do you enable the layout view in Dreamweaver?
2. Write the steps in creating a nested table in layout view?
3. Describe few commonly used online style of prose?
4. What is Frame and Framesets? Write its basic HTML code?
5. How do you create Frame and Framesets in Dreamweaver?

Explain the simplest method to do that?
6. What is Frame object in Dreamweaver? What is it used for?
7. What is Dreamweaver Tag Selector?
8. How do you build a Frameless Browser? Explain with each

step?

Notes
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Topics Covered
• Graphics, Color displays, Pixels and color depth, Graphic

files, Browser “safe” colors
• Dreamweaver - Including Flash and Shockwave  movies in

Dreamweaver projects, Designating Flash attributes, Creating
Flash buttons and crafting templates

Objectives
Upon completion of this lesson, you should be able to:
• Use Color displays cleverly
• Define Pixels
• Relate color depth and graphic files
• Know the browser “safe” colors
• Include flash and shockwave movies in Dreamweaver
• Designate  flash attributes
• Create flash buttons and craft templates

Graphics
We know that the tail must wag the dog,
for the horse is drawn by the cart;
But the Devil whoops, as he whooped of old:
”It’s clever, but is it Art?”-Rudyard Kipling, “The Conundrum
of  the Workshops”
IN THIS CHAPTER we show you techniques to optimize the
look and efficiency of  your Web page graphics. Although
electronic publishing frees you from the cost and limitations of
color reproduction on paper, you will still need to make careful
calculations (and a few compromises) if you wish to optimize
your graphics and photographs for various display monitors
and Internet access speeds.

Color Displays
Color monitors for desktop microcomputers are based on
cathode ray tubes (CRTs) or back-lighted flat-screen
technologies. Because monitors transmit light, displays use the
red-green-blue (RGB) additive color model. The RGB model is
called “additive” because a combination of the three pure colors
red, green, and blue “adds up” to white light:
The computer’s operating system organizes the display screen
into a grid of x and y coordinates, like a checkerboard. Each
little box on the screen is called a “pixel” (short for “picture
element”). Current Macintosh and Windows displays are
composed of these grids of pixels.
Pixels and color depth
To control the color of  each pixel on the screen, the operating
system must dedicate a small amount of memory to each pixel.
In aggregate this memory dedicated to the display screen is
often referred to as “video RAM” or “VRAM” (Video Random
Access Memory). In the simplest form of black-and-white
computer displays, a single bit of memory is assigned to each
pixel. Because each memory bit is either positive or negative (0

or 1), a 1-bit display system can manage only two colors (black
or white) for each pixel on the screen:

If more bits of memory are dedicated to each pixel in the
display, more colors can be managed. When 8 bits of memory
are dedicated to each pixel, each pixel could be one of 256
colors. (256 = 2 to the eighth power; in other words, 256 is the
maximum number of unique combinations of zeros and ones
you can make with 8 bits.) This kind of computer display is
called an “8-bit” or “256-color” display, and is common on
older laptop computers and desktop machines. Although the
exact colors that an 8-bit screen can display are not fixed, there
can never be more than 256 unique colors on the screen at once:

If still more memory is dedicated to each pixel, nearly
photographic color is achievable on the computer screen. “True-
color” or “24-bit” color displays can show millions of unique

LESSON 37:
GRAPHICS IN WEB PAGE
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colors simultaneously on the computer screen. True-color
images are composed by dedicating 24 bits of memory to each
pixel; 8 each for the red, green, and blue components (8 + 8 + 8
= 24):

The amount of VRAM dedicated to each screen pixel in the
display is commonly referred to as the “color depth” of the
monitor. Most Macintosh and Windows microcomputers sold
in recent years can easily display color depths in thousands (16-
bit) or millions (24-bit) of  simultaneous colors. To check your
computer system for the range of color depths available to you,
use the “Display” control panel (Windows) or the “Monitors”
control panel (Macintosh):

Color Depth and Graphics Files
The terminology and memory schemes used in color displays
are directly analogous to those used to describe color depth in
graphics files. In their uncompressed states, 8-bit, or 256-color,
image files dedicate 8 bits to each color pixel in the image. In 8-
bit images the 256 colors that make up the image are stored in
an array called a “palette” or an “index.” The color palette may
also be referred to as a “color lookup table” (CLUT). As

mentioned above, 8-bit images can never contain more than 256
unique colors:

True-color, or 24-bit, images are typically much larger than 8-bit
images in their uncompressed state, because 24 bits of memory
are dedicated to each pixel, typically arranged in three
monochrome layers - red, green, and blue:

“Browser-safe” Colors
The color management system currently used by Web browser
software is based on an 8-bit, 216-color (not 256) palette. The
browser-safe color palette is a solution devised by Netscape to
solve the problem of displaying color graphics in a similar way
on many kinds of display screens, with browsers running under
different operating systems (such as Macintosh, Windows, and
UNIX). Because a majority of  the Web audience years ago had
8-bit display screens, 256 colors was the upper limit for the color
palette. But the various versions of the Windows operating
system (which currently represent about 95 percent of the
microcomputer market) reserve 40 colors for displaying such
graphic interface elements as windows, menus, screen wallpaper,
icons, and buttons, which leaves just 216 colors to display
everything else. The 216 colors chosen by Netscape are identical
in both the Macintosh and Windows system palettes. Although
the browser-safe color scheme originated at Netscape, at present
both of  the dominant Web browsers (Netscape Navigator and
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Microsoft Internet Explorer) use the same color management
system.
Most Web users have computers and monitors set to
“thousands” or “millions” of colors, so the importance of the
so-called Web-safe palette has sharply diminished in the past
few years. When the user has a monitor set to thousands or
millions of  colors all colors display properly, so there is no
longer any need to restrict your color choices to the 216 Web-
safe colors.

Computer Lab

Dreamweaver

Inserting Flash And Shockwave Elements

Including Flash and Shockwave Movies in Dreamweaver

Projects

Dreamweaver makes it easy to bring Shockwave and Flash files
into your Web pages. The Objects panel provides an object for
each type of movie, both located in the Common category.
Because Shockwave and Flash objects insert both an ActiveX
control and a plug-in, Dreamweaver enables you to play the
movie in the Document window. First it displays a plug-in
placeholder icon

Dreamweaver includes many interface elements for working

with Shockwave and Flash.

Before you can successfully include a Shockwave file, you need to
know one small bit of information-the dimensions of your
movie. Dreamweaver automatically reads the dimensions of
your Flash file when you use the Insert Flash Movie object.
Unfortunately, if  you’re incorporating a Shockwave movie, you
still need to enter the dimensions by hand in the Shockwave
Property Inspector. To check the width and height of  your
movie in Director, load your file and then choose Modify-
>Movie->Properties to open the Movie Properties dialog box.
To include either a Shockwave or Flash file in your Web page,
follow these steps:
1. Position the cursor in the Document window at the point

where you’d like the movie to appear.
2. Insert the movie using any of these methods:
• Choose Insert->Media->Shockwave or Insert->Media-

>Flash from the menus.
• In the Common category of the Objects panel, select either

the Insert Shockwave or Insert Flash button.
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• Drag the movie object from the Objects panel to any
location in the Document window.

3. In the Select File dialog box, enter the path and the filename
in the File Name text box or select the Browse (Choose)
button to locate the file. Click OK. Dreamweaver inserts a
small plug-in placeholder in the current cursor position, and
the Property Inspector displays the appropriate information
for Shockwave or Flash.

4. Preview the Flash or Shockwave movie in the Document
window by selecting the Play button found in the Property
Inspector. You can also choose View-> Plugins->Play.

5. End the preview of your file by selecting the Stop button in
the Property

Inspector or selecting View->Plugins->Stop.

Designating Flash Attributes
Flash movies require the same basic parameters as their
Shockwave counterparts-and Flash movies have a few additional
optional ones as well. As it does for Shockwave files,
Dreamweaver sets almost all the attributes for Flash movies
through the Property Inspector. The major difference is that
several more parameters are available.
To set or modify the attributes for a Flash file, follow these
steps:
1. After your Flash movie has been inserted in the Document

window, make sure it’s selected. Dreamweaver automatically
inserts the correct dimensions for our Flash movie.

2. Set any attributes in the Property Inspector as needed for
your Flash movie.

Setting the scale in Flash movies

Be careful with your setting for the Scale parameter, in order to
avoid unexpected results. If you have to size a Flash movie out
of  its aspect ratio, the Flash player needs to know what to do
with any extra room it has to fill. Figure below demonstrates
the different results that the Scale attribute can provide. Only the
figure in the lower right is at its proper dimensions. The gray
box is the actual size of the authoring canvas.

Your setting for the Scale attribute determines how your movie
is resized within the plug-in width and height measurements.

Creating Flash Buttons and Crafting Templates

The primary argument against using Flash has always been,
“Not everyone has the Flash plug-in, so not everyone can see
Flash movies.” When Macromedia began promoting the 96.4
percent and above market penetration of the Flash Player, that
argument started to fade”. True, this almost universally installed
base applies to the Flash 2 player—as of this writing, over 88
percent of browsers have Flash 4 players and almost 40 percent,
Flash 5—but the basic ability to play back .swf  files is all that’s
necessary to display simple animations and enable sounds.
While Flash is often used to create standalone movies, cartoons,
and interactive games, it is also capable of making excellent
navigation aids. One feature of traditional user interfaces-audio
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feedback, the “click” that one hears when a button has been
chosen onscreen—has been long missing on the Web because
of the lack of a universally available sound engine. With
navigation buttons created in Flash, sound is very easy to
incorporate, as are animation effects and smooth blends. Best
of all, these effects are extremely low bandwidth and often
weigh less on a page than a comparable animated GIF file, even
without the sound.

Dreamweaver comes with 44 different Flash Button templates
with additional styles available at the Macromedia Exchange.
The buttons are primarily intended to be used as links to other
Web pages although some are designed as VCR-like player
controls. To insert a Flash Button, follow these steps:
1. Make sure that the current document has been previously

saved. If  you’re working on a new document, Dreamweaver
requires that you save it before adding a Flash Button.

2. Choose Insert Flash Button from the Common category of
the Objects panel or select Insert >Interactive Images->Flash
Button. The Insert Flash Button dialog box, shown in
figure below:

Choose Apply to test typeface and text size variations when
creating your Flash Button.
1. Select a button type from the Style list. The previews shown

in the Sample area are live demonstrations and will play as
designed when moused-over and/or clicked. There is,
however, one exception: no sound is heard in preview; you’ll
have to preview the Flash Button in the browser to get the
full effect.

2. If  it’s a navigation button, enter the custom text desired in
the Button Text field. The Button Text field is physically
limited to 50 characters, although for most practical
purposes, your text will be shorter. Certain symbols, such as
those in the Control group, ignore the text and font settings.

3. Select a typeface from the Font drop-down list. The fonts
listed are TrueType fonts found on your system. Most of  the
button templates have a preselected font and text size. If the
preselected font is not found on your system, a small alert
appears at the bottom of the dialog box.

4. Enter the desired font size, in points, in the Size field.
5. If the button is to link to another page, enter the absolute or

document relative URL in the Link field. Alternatively, you
can choose the Browse button to locate the file. Flash movies
don’t handle site root–relative links correctly, so your link
needs to either be absolute, such as www.idest.com/
contact.htm, or document relative. Use document relative
links only if the Flash Button is to be stored in the same
folder as the page referenced.

6. If working in a frame-based site or you want the link to
open in another page, select an option from the Target drop-
down list. The standard system targets-_blank, _self,
_parent, and _top-are always available. Additional frame
names appear if the Flash Button is inserted in an existing
frameset.

7. If the Flash Button is to be placed on a page or in a table
with a background color other than white, select the Bg
Color swatch to choose an appropriate background.
Alternatively, the hexadecimal color number or standard
color name may be entered directly into the Bg Color text
field.

8. Enter a path and filename for the Flash Button file. If you
like, you can use the suggested default name in the site root
or select the Browse button to choose a different location.

9. Choose Apply to insert the button in the cursor location on
the page.

10.Click OK when you’re done.
Once your Flash Button is inserted, it can be modified on the
page. Choose the Flash Button to activate the specific Property
Inspector that, along with standard Flash object parameters,
offers a couple of new controls: Edit and Reset Size. Selecting
Edit reopens the Insert Flash Button dialog box and allows
you to modify any of the settings. Use Reset Size if you have
altered the dimensions of  the Flash Button-by dragging one of
the sizing handles or entering new values in the Width and/or
Height fields-and want to return to the preset size.



190

E
-M

E
D

IA

Topics Covered
• Dithering, Dithering done by browser, Screen resolution,

Gamma
• Dreamweaver - working with flash text, Managing links,

Macromedia flash player controls

Objectives
Upon completion of this lesson, you should be able to:
• Define Dithering
• Know how dithering is done by the browser
• Cope with browser safe colors
• Define screen resolution
• Work with flash text
• Manage links in Flash movies
• Use Macromedia flash player controls

Dithering
Full-color photographs may contain an almost infinite range of
color values. Dithering is the most common means of reducing
the color range of images down to the 256 (or fewer) colors
seen in 8-bit GIF images.
Dithering is the process of juxtaposing pixels of two colors to
create the illusion that a third color is present. A simple example
is an image with only black and white in the color palette. By
combining black and white pixels in complex patterns a graphics
program like Adobe Photoshop can create the illusion of gray
values:

The same process softens the effect of reducing the number of
colors in full-color images:

Most images are dithered in a diffusion or randomized pattern
to diminish the harsh transition from one color to another. But
dithering also reduces the overall sharpness of an image, and it
often introduces a noticeable grainy pattern in the image. This
loss of image detail is especially apparent when full-color
photos are dithered down to the 216-color browser-safe palette:

LESSON 38:
FLASH COMPONENTS IN DREAMWEAVER
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Dithering done by the Browser
If  a reader of  your Web site has his or her display monitor set
to 256 colors (an increasingly rare occurrence these days), then
the Web browser will display images using the 216-color
browser-safe color palette. In this situation there is no way to
force the browser to display a color outside the browser-safe
palette. If any of your photographs, graphic design elements,
or background colors use hues outside the browser-safe palette,
the Web browser will automatically dither the displayed images
into the browser-safe colors. The effect of using “unsafe” colors
for your major graphic elements is that readers with 256-color
displays will see a lot of heavily dithered images. This may be
acceptable for some visual elements on the page, but if your
basic navigation buttons and background graphics are dithered,
parts of the page will be hard to read and the overall effect will
be amateurish:

Coping with browser-safe colors
Now that the vast majority of  Web users have more
sophisticated display screens most designers choose to use GIF
graphics with custom colors or full-color JPEG graphics and
just accept that they will dither on some small percentage of
display screens that are still set to 256 colors. One compromise
is to mix navigation graphics done in browser-safe colors with
full-color JPEG graphics. The full-color images will be dithered
on 256-color screens, but the navigation buttons will look the
same on all screens.

Screen Resolution
Screen resolution refers to the number of pixels a screen can
display within a given area. Screen resolution is usually
expressed in pixels per linear inch of screen. Most personal
computer displays have resolutions that vary from 72 to 96
pixels per inch (ppi). The resolution of the display screen is
dependent on how the monitor and display card are configured,
but it’s safe to assume that most users fall into the lower end
of the range, or about 72 to 80 ppi.
Images destined for print can be created at various resolutions,
but images for Web pages are always limited by the resolution
of the computer screen. Thus a square GIF graphic of 72 by 72
pixels will be approximately one inch square on a 72-ppi display
monitor. When you are creating graphics for Web pages you
should always use the 1:1 display ratio (one pixel in the image
equals one pixel on the screen), because this is how big the
image will display on the Web page. Images that are too large
should be reduced in size with a sophisticated image editor like
Adobe’s Photoshop to display at proper size at a resolution of
72 ppi.

Gamma
In computer imaging and display screens “gamma” refers to the
degree of contrast between the midlevel gray values of an
image. The technical explanations of gamma are irrelevant here -
the visual effect of changing gamma values is easy to see. If you
own a copy of Adobe ImageReady, open an image with an
average range of colors and contrasts and use the “Image:
Adjust: Gamma” control to change the gamma settings (see the
ImageReady manual for details). Images will change noticeably
with even minor changes in gamma settings. Gamma
considerations are particularly important if you are displaying
images with very long gray scales (such as medical diagnostic
images and fine black-and-white photography) or images in
which the exact color values are critical (such as works of art and
clinical medical photographs):



192

E
-M

E
D

IA

The default gamma settings for Macintosh (1.8 target gamma)
and Windows (2.2 target gamma) monitors are quite different,
and this can lead to unpleasant surprises when you first see your
images displayed on “the other” platform. Mac users will see
darker and more contrasting images on Windows displays;
Windows users will see flat and washed-out images on Mac
displays. Most Web designers opt for a middle-ground
solution, lightening images slightly if they work on the
Macintosh; darkening slightly and adding a little contrast if they
work in Windows.

Computer Lab

Dreamweaver

Working With Flash Text

The addition of  Flash Text to Dreamweaver goes a long way
toward solving one of  the Web designer’s most perplexing
problems: how to achieve good-looking text that uses non-
standard fonts. While standard HTML text allows font
families-a series of fonts offered in hopes that one of them is
installed on the user’s system- few designers stray outside of
tried and true options such as Arial, Helvetica, and Times New
Roman for the majority of their content. This is especially
grating to print designers coming to the Web who rely on
typography as a primary design tool. The advent of Dynamic
HTML promised to bring a wider selection of typefaces with
so-called dynamic font technology, but lack of  built-in cross-
browser support for any one system dashed those hopes.
The Flash Text feature is especially useful for creating headings
in a corporate approved typeface. Because it doesn’t involve
downloading a font resource as dynamic font technologies do,
there is no concern about the misuse of copyrighted fonts. The
only downside to Flash Text over a dynamic font technology is
that unlike dynamically created fonts, Flash Text cannot be
searched on a page. To overcome this limitation, Web designers
can include key phrases in <meta> tags.
To use the Flash Text object, follow these steps:
1. Make sure your page has been saved before proceeding.
2. Choose Insert Flash Text from the Common category of  the

Objects panel or select Insert->Interactive Images->Flash
Text. The Insert Flash Text dialog box appears, as shown in
Figure below

3. Select the desired typeface from the Font drop-down list.
4. Enter the font size desired in the Size field.
5. Choose Bold and/or Italic styles for your text.

6. Select the alignment on the page: left, center, or right.
7. Select a basic color from the color swatch or enter a

hexadecimal value or valid color name in the Color field.
8. If desired, choose a secondary color for the text to change to

when the user moves his or her mouse over the Flash Text
from the Rollover Color swatch.

 

Use the Insert Flash Text object to create headlines with a
nonstandard or custom font.
9. Enter the desired text in the Text field. There’s no real limit

to the amount of text that can be entered other than practical
considerations, and line returns are acceptable.

10.If  you want to see the text in the default font in the Text
field, disable the Show Font option.

11.If desired, enter an absolute or document relative URL in the
Link field. As with Flash Buttons, site relative links are not
available in Flash Text objects.

12.If  you’re working in a frame-based site or want the link to
open in a new browser window, choose the appropriate
Target from the drop-down list.

13.Optionally, choose a background color from the Bg Color
swatch.

14.Enter a filename and path to store the object in the Save As
field. Alternatively, select the Browse button to locate a
folder.  If  you’re using document relative links in the Flash
Text object, be sure to store the object in the same folder as
the current document.

15.Click Apply to preview what your button will look like in
your document and then click OK when you’re done.

As with Flash Buttons, you can resize a Flash Text object by
dragging the resizing handles; press the Shift key while dragging
to constrain the dimensions to their initial width and height
ratio. Click Reset Size on the Property Inspector to restore the
original dimensions. To edit a Flash Text object, choose Edit
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from the Property Inspector; alternatively, you can double-click
the object to open the Insert Flash

Text dialog Box Again.
When you create a Flash Text object, Dreamweaver makes a GIF
representation for display during layout-you may notice some
roughness in the lines, especially if  you resize the object. You
can, at any time, select Play from the Flash Text Property
Inspector (or choose Preview in Browser) to see the true Flash
object with its smooth vector shape.

Managing Links in Flash Movies with Dreamweaver
Many Web sites rely heavily on Flash movies, substituting
movies for entire pages that would otherwise be created with
HTML. Others take advantage of  Flash’s interactivity in their
main navigation buttons. Adding links to buttons in Flash is
easy, but embedding multiple URLs into multiple SWF files can
make modifying a site’s structure a nightmare, forcing you to re-
create every SWF file in your site. Luckily, Dreamweaver comes
to the rescue, with link management features that are SWF-
savvy.
Dreamweaver extends its link management to include the links
contained in Flash SWF movies. Edit links within a SWF file
manually in the Site Map, or move SWF files in the Site Files
view and let Dreamweaver clean up behind you.
Within the Site window, you can drag SWF files to new folders
just as you would an HTML file. Unless your Update Links
preference is set to Never, Dreamweaver will either modify the
links in the SWF file accordingly or prompt you for permission
to do so.
To modify the links in a SWF file manually, follow these steps:
1) Choose Window->Site Map to view the Site Map.
2) Choose View->Show Dependent Files (Site->Site Map

View->Show Dependent Files) to include dependent files
such as Flash movies in the Site Map.

3) Locate the SWF file that you want to modify. If  it contains
any links, a plus sign is shown next to its icon. Click the plus
sign to expand a branch of links from the SWF file, as
shown in Figure below

4) To change a link, select it and choose Site->Change Link
(Site->Site Map iew->Change Link) or use the key shortcut
Ctrl+L (Command+L). Alternatively, you can right-click
(Control+click) the link and choose Change Link from the
contextual menu. Dreamweaver displays a Select HTML File
dialog box.

5) Select a new file by navigating to an HTML file or entering an
URL. Click OK when you’re done.

Dreamweaver’s Site Map displays links contained in Flash SWF
movies.
Just as with HTML files, you can also remove links from a SWF
file by selecting the link and choosing Site->Remove Link (Site-
>Site Map View->Remove Link) or use the keyboard shortcut
Ctrl+Shift+L (Command+Shift+L).

Macromedia Flash Player Controls
One method of engaging your Web page visitors is to give
them more control over their viewing experience. Rather than
just displaying a movie from beginning to end, allow the viewer
to pause, rewind, and play the animation at will. Flash’s vector-
based nature even allows you to zoom in and out, without loss
of  image clarity. While all of  this functionality is available
through Flash ActionScripting, not all designs require the
controls to be maintained within a Flash movie. The Flash
Player Controls allow all of the common VCR-like
functionality-and then some- to be assigned to HTML elements
such as images or hotspots. When the JavaScript Integration
Kit is installed, 10 different behaviors are grouped under the
MM Flash Player Controls:
• Fast Forward Flash
• Go To Flash Frame
• Go To Flash Frame Based on Cookie
• Load Flash Movie
• Pan Flash
• Play Flash
• Rewind Flash
• Set Flash by List
• Stop Flash
• Zoom Flash
As with any other Dreamweaver behavior, the player controls
must be assigned to a target: a text link, an image map hotspot,
or a graphic with a link attached. Typically, such a graphic button
would use a false link, such as # or javascript:; so that it may act
as a trigger but not actually open a URL.
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You must have at least one Flash movie in the page before the
Flash Player Controls become available, as shown in figure
below, Once activated, the user interfaces for the Flash Player
Controls vary according to their function as detailed below.
With the Play, Stop, Rewind Flash behaviors, you just pick the
Flash movie you want to control from the drop-down list. All
the other behaviors include this option as well so you can affect
any movie on the page.

The Flash Player Controls become active once a Flash movie is
present in the current Dreamweaver document.
To use the Flash Player Controls, follow these steps:
1. Insert at least one Flash movie by choosing an animation

from the Assets panel or applying the Insert Flash object.
2. Enter a unique name in the ID field of the Flash Property

Inspector for each movie. A distinct ID avoids browser
compatibility problems; if one is not initially supplied,
Dreamweaver offers to make one for you when any of the
behaviors are applied.

3. Select the text link, hotspot, or image to trigger the behavior.
If  you’d like to apply the Set Flash by List behavior, select a
form list object.

4. Choose Window->Behaviors to open the Behaviors panel,
if  necessary. Alternatively, you can select the Show Behavior
icon from the Launcher or use the keyboard shortcut,
Shift+F3.

5. Choose the Add button from the Behaviors panel and select
the desired behavior under the MM Flash Player Controls
heading. The chosen behavior’s dialog box appears, similar
to the one shown in figure below:

6. Select the parameters for your behavior.

• For the Play Flash, Rewind Flash, and Stop Flash behaviors,
select the desired animation to affect from the Movie drop-
down list.

• For the Fast Forward Flash behavior, select the desired
animation to affect from the Movie drop-down list. In the
first blank field, enter the desired value you want the movie
to advance by. Select either Frames or Percent from the drop-
down list. For example, to advance the movie by 5 percent
each time the behavior is called, enter 5 in the first field and
choose Percent from the list.

• For the Go To Flash Frame behavior, select the desired
animation to  affect from the Movie drop-down list and
then enter the frame number to move to in the Go To
Frame field.

• For the Go To Flash Frame Based on Cookie behavior, select
the desired animation to affect from the Movie drop-down
list, enter the name of the cookie to read in the Cookie
Name field, enter the value to look for in the Cookie Value
field, and then enter the frame number to advance to when
the cookie name and value are read in the Go To Frame field.

• For the Load Flash Movie behavior, select the desired
animation to you want to replace from the Replace Movie
drop-down list. Enter the filename for the movie to load in
the With Movie field or locate the movie by selecting the
Browse button. Input the level to load the movie into in the
Level field.

To replace an existing movie with the loaded movie, enter a level
number that is currently occupied by another movie. To replace
the original movie and unload every level, choose 0 for the
Level. To begin playing the movie immediately, set the Play
option to Yes; otherwise, set Play to No.
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Topics Covered
• Graphics and Network bandwidth, Graphics and intranets,

Graphic file formats
• Dreamweaver - video on the web, The streaming media big

three, Real Media, Quick time, Windows media

Objectives
Upon completion of this lesson, you should be able to:
• Limitation of graphics with respect to network bandwidth
• Relate Graphics and intranets
• Add video to your web page
• Know about the streaming media big three which includes
• Real Media
• Quick time
• Windows media

Graphics and Network Bandwidth
Many Web users currently access their Internet service providers
via 56 kilobits per second (KBps) modems from their homes,
offices, or remote work sites. At 56 KBps the actual download
rate is only about 7 kilobytes (KB) per second (8 bits make a
byte). This means that a modest 36 KB graphic on your Web
page could take five seconds or longer to load into the reader’s
Web browser. Actual data transmission rates will vary
depending on the user’s modem, Web server speed, Internet
connection, and other factors, but the overall point is clear: the
more graphics you incorporate, the longer the reader will have to
wait to see your page. A full-screen graphic menu on your home
page plus background graphics could leave your modem-based
readers twiddling their thumbs for a full minute or more, even
if they have a state-of-the-art modem and a good Internet
connection. Look at your watch (better yet, hold your breath)
for a full minute, then decide whether you’re willing to ask your
users to wait this long when they visit your Web site.
A better strategy is to increase the graphics loading of your
pages gradually, drawing users into your site with reasonable
download times. As readers become more engaged with your
content, they will be more willing to endure longer delays,
especially if you give them notes about the size of graphics or
warnings that particular pages are full of graphics and will take
longer to download. At today’s average modem speeds most
pages designed for users dialing in from home should contain
no more than 50 to 75 kilobytes of graphics.

Graphics and intranets
Luckily for graphic designers, many Web sites are created
primarily for educational, organizational, and commercial users
who access their local intranets and the larger World Wide Web
from the school or office at Ethernet speeds or greater. Also,
increasing numbers of home users now have access to higher-
speed connections like DSL and cable modems. Graphics and
page performance are also an issue for these users, but it makes
little sense to restrict Web page graphics arbitrarily in the cause

of “saving network bandwidth.” The bandwidth gearheads
always miss the point: graphics are what drew most people to
the Web in the first place. If  you’ve got the access speed,
indulge!

Graphic file formats
Because of the bandwidth issues surrounding networked
delivery of information and because image files contain so
much information, Web graphics are by necessity compressed.
Different graphic file formats employ varying compression
schemes, and some are designed to work better than others for
certain types of graphics. The two primary Web file formats are
GIF and JPEG. A third format, PNG, has been available since
1995 but has been little used because of poor browser support.

GIF files
The CompuServe Information Service popularized the Graphic
Interchange Format in the 1980s as an efficient means to
transmit images across data networks. In the early 1990s the
original designers of  the World Wide Web adopted GIF for its
efficiency and widespread familiarity. The overwhelming
majority of  images on the Web are now in GIF format, and
virtually all Web browsers that support graphics can display GIF
files. GIF files incorporate a compression scheme to keep file
sizes at a minimum, and they are limited to 8-bit (256 or fewer
colors) color palettes. Several slight variants of the basic GIF
format add support for transparent color and for the interlaced
GIF graphics popularized by Netscape Navigator.

GIF file compression
The GIF file format uses a relatively basic form of file
compression (Lempel Zev Welch, or LZW) that squeezes out
inefficiencies in the data storage without losing data or
distorting the image. The LZW compression scheme is best at
compressing images with large fields of homogeneous color. It
is less efficient at compressing complicated pictures with many
colors and complex textures:

Improving GIF compression
You can take advantage of  the characteristics of  LZW
compression to improve its efficiency and thereby reduce the
size of your GIF graphics. The strategy is to reduce the number
of colors in your GIF image to the minimum number
necessary and to remove stray colors that are not required to

LESSON 39:
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represent the image. A GIF graphic cannot have more than 256
colors but it can have fewer colors, down to the minimum of
two (black and white). Images with fewer colors will compress
more efficiently under LZW compression.

Interlaced GIF
The conventional (non-interlaced) GIF graphic downloads one
line of pixels at a time from top to bottom, and browsers
display each line of the image as it gradually builds on the
screen. In interlaced GIF files the image data is stored in a
format that allows browsers that support interlaced GIFs to
begin to build a low-resolution version of the full-sized GIF
picture on the screen while the file is downloading. Many people
find the “fuzzy-to-sharp” animated effect of interlacing visually
appealing, but the most important benefit of interlacing is that
it gives the reader a preview of the full area of the picture while
the picture downloads into the browser.
Interlacing is best for larger GIF images such as illustrations and
photographs. Interlacing is a poor choice for small GIF graphics
such as navigation bars, buttons, and icons. These small
graphics will load onto the screen much faster if you keep them
in conventional (non-interlaced) GIF format. In general,
interlacing has no significant effect on the file size of GIF
graphics.

Transparent GIF
The GIF format allows you to pick colors from the color
lookup table of  the GIF to be transparent. You can use image-
editing software like Photoshop (and many shareware utility

programs) to select colors in a GIF graphic’s color palette to
become transparent. Usually the color selected for transparency
is the background color in the graphic.

Unfortunately, the transparent property is not selective; if  you
make a color transparent, every pixel in the graphic that shares
that particular color will become also transparent. This can cause
unexpected results:

Adding transparency to a GIF graphic can produce
disappointing results when the image contains antialiasing (see
Typography, Antialiased type). If  you use an image-editing
program like Photoshop to create a shape set against a
background color, Photoshop will smooth the shape by
inserting pixels of  intermediate colors along the shape’s
boundary edges. This smoothing, or antialiasing, improves the
look of  screen images by softening jagged edges. Trouble starts
when you set the background color to transparent and then use
the image on a Web page against a different background color.
The antialiased pixels in the image will still correspond to the
original background color. In the example below, when we
change the background color from white to transparent (letting
the gray Web page background show through), an ugly white
halo appears around the graphic:
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Transparency works best with simple diagrammatic graphics,
but it can also work with complex shapes. The GIF graphic of
the watercolor painting below (from the second edition of the
online version of this guide) can run across the scan column
and into the white background because we made the white
background of the sparrow painting transparent. We avoided
potential problems with a light halo around the leaves in the
gray scan column area by retouching the painting to remove the
white antialiased “halo” from the leaf edges:

info.med.yale.edu/caim/manual Animated GIF
The GIF file format allows you to combine multiple GIF
images into a single file to create animation. There are a number
of  drawbacks to this functionality, however. The GIF format
applies no compression between frames, so if you are
combining four 30-kilobyte images into a single animation, you
will end up with a 120 KB GIF file to push through the wire.
The load is lightened somewhat by the fact that animated GIF
files stream to the user, so the frames load and play even before
the entire file is downloaded. Another drawback of GIF
animations is that they are an imposition and a potential
distraction. Because there are no interface controls for this file
format, GIF animations play whether you want them to or not.
And if looping is enabled, the animations play again and again
and again. GIF animations are rarely used in a meaningful way,
and generally distract readers from the main content of the
page. If you are using GIF animation as content — to illustrate
a concept or technique where animation is really required — use
the technique sparingly.

JPEG graphics
The other graphic file format commonly used on the Web to
minimize graphics file sizes is the Joint Photographic Experts
Group (JPEG) compression scheme. Unlike GIF graphics,
JPEG images are full-color images (24 bit, or “true color”).

JPEG images have generated tremendous interest among
photographers, artists, graphic designers, medical imaging
specialists, art historians, and other groups for whom image
quality is paramount and where color fidelity cannot be
compromised by dithering a graphic to 8-bit color. A newer
form of JPEG file called “progressive JPEG” gives JPEG
graphics the same gradually built display seen in interlaced GIFs
. Like interlaced GIFs , progressive JPEG images often take
longer to load onto the page than standard JPEGs, but they do
offer the reader a quicker preview.
JPEG compression uses a sophisticated mathematical technique
called a discrete cosine transformation to produce a sliding scale
of graphics compression. You can choose the degree of
compression you wish to apply to an image in JPEG format,
but in doing so you also determine the image’s quality. The
more you squeeze a picture with JPEG compression, the more
you degrade its quality. JPEG can achieve incredible
compression ratios, squeezing graphics down to as much as one
hundred times smaller than the original file. This is possible
because the JPEG algorithm discards “unnecessary” data as it
compresses the image, and it is thus called a “lossy”
compression technique. Notice in the example below how
increasing the JPEG compression progressively degrades the
details of the image:

The checkered pattern and the dark “noise” pixels in the
compressed image are classic JPEG compression artifacts.
Another example of  JPEG compression is shown below. Note
the extensive compression noise and distortion present in the
bottom dolphin - the download time saved is not worth the
degrading of the images.

Save your original uncompressed images!
Once an image is compressed using JPEG compression, data is
lost and you cannot recover it from that image file. Always save
an uncompressed original file of your graphics or photographs
as backup.

JPEG image artifacts
The JPEG algorithm was optimized for compressing
conventional pictorial photographs and is also good at handling
complex illustrations. Photos and artwork with smooth color
and tonal transitions and with few areas of harsh contrast or
sharp edges are ideal for JPEG compression. Yet most page
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design elements, diagrams, typography within images, and
many illustrations are composed of hard-edged graphics and
bright color boundaries that are seldom encountered in
photographs. The illustration below shows what happens
when you compress an interface graphic (shown in a) in GIF
format (b, no compression artifacts) and JPEG compression (c,
with JPEG compression “noise” around the text and borders):

When compressed with JPEG, diagrammatic images such as
interface graphics show a noise pattern of compression artifacts
around the edges of shapes and text (c, above). The JPEG
algorithm is best at compressing smooth tonal transitions and
cannot properly reproduce the harsh transitions at the edges of
diagrammatic graphics.

PNG Graphics
Portable Network Graphic (PNG, pronounced “ping”) is an
image format developed by a consortium of graphic software
developers as a nonproprietary alternative to the GIF image
format. As mentioned earlier, CompuServe developed the GIF
format, and GIF uses the proprietary LZW compression
scheme owned by Unisys Corporation. Any graphics tool
developer who makes software that saves in GIF format must
pay a royalty to Unisys and CompuServe.
PNG graphics were designed specifically for use on Web pages,
and they offer a range of attractive features that should
eventually make PNG the most common graphic format. These
features include a full range of color depths, support for
sophisticated image transparency, better interlacing, and
automatic corrections for display monitor gamma. PNG images
can also hold a short text description of the image’s content,
which allows Internet search engines to search for images based
on these embedded text descriptions. Unfortunately, the PNG
graphic format is not yet widely supported, and the current
implementation of  PNG graphics in the major Web browsers
does not fully support all of  PNG’s features. This should
change over the next few years, but do not make a commitment
to PNG graphics until you are sure that most of your audience
is using browsers that support PNG.

Computer Lab

Dreamweaver

Adding Video to YOUR WEB PAGE
In a world accustomed to being entertained by moving images
50 feet high, it’s hard to understand why people are thrilled to
see a grainy, jerky, quarter-screen sized video on a Web page.
And in truth, it’s the promise of  video on the Web, not the
current state of  it, that has folks excited. Many of  the industry’s
major players, including Microsoft and Apple, are spending big
bucks to bring that promise a little closer to reality.
QuickTime and RealVideo are the most popular formats on the
Web, and both are cross-platform. Video can be downloaded to
the user and then automatically played with a helper application,
or it can be streamed to the user so that it plays while it’s
downloading.

Video on the Web
It may be hard for folks not involved in the technology of
computers  and the Internet to understand why the high-tech
Web doesn’t always include something as “low-tech” as video.
After all, television has been around forever, right? The
difficulties arise from the fundamental difference between the
two
media: television and radio signals are analog, and computers
are pure digital. Sure, you can convert an analog signal to a
digital one-but that’s just the beginning of  the solution.
The amount of information stored on a regular (analog) VHS
cassette is truly remarkable. Moving that amount of
information about in the ones and zeros of the digital world is
a formidable task. For example, storing the digital video stream
from any digital video camcorder uses up storage space at the
rate of about 1 gigabyte every five minutes, and that video is
already compressed. Large file sizes also translate into enormous
bandwidth problems when you are transmitting video over the
Web.
To resolve this issue of megasized files, industry professionals
and manufacturers have developed various strategies, or
architectures, for the creation, storage, and playback of digital
media. Each architecture has a different file format, and thus
each requires the user to have a playback system—whether a
plugin, ActiveX control, or Java applet—capable of handling
that particular format.
In an effort to keep file sizes as small as possible, Web videos
are often presented in very small dimensions. It’s not
uncommon to display a video at a puny 180 by 120 pixels.
Furthermore, you’ll notice a major difference between
conventional and Web-based video in terms of quality.
Television video displays at roughly 30 frames per second, film
at 24 frames per second; but the best Web video rarely gets
above 15 frames per second-virtually guaranteeing choppy
motion in scenes with any action in them. Lossy compression
also leads to artifacting-visible flaws introduced by the
compression itself.
Given all the restrictions that video suffers on the Web, why use
it at all? Simply because nothing else like it exists, and when you
need video, you have to use video. Take heart, though.
Advances are occurring at a rapid rate, both in the development
of  new video architectures and codecs and in new, higher-speed
Internet delivery systems, such as cable modems and DSL
phone lines. What you learn in this chapter enables you to
include video in your Dreamweaver-built Web pages today and
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gives you a good foundation for accommodating future
enhancements.

The Streaming Media Big Three
Technologies-and the companies that create them-come and go
on the Internet. Over the past few years, quite a few different
streaming media solutions have presented themselves and then
faded away, leaving us with the current “Big Three”: RealMedia,
QuickTime, and Windows Media. These three technologies
together represent almost the entire streaming media market,
and the vast majority of Internet users have at least one of the
corresponding players; many have two or even all three.

RealMedia
RealNetworks released the first streaming media system-
RealAudio-in 1995. Over the years, RealAudio has evolved into
RealMedia and now supports video, images, text, Flash movies,
and standard audio types such as AIFF and MP3. All of these
media types can be combined into a single presentation using
SMIL (Synchronized Multimedia Integration Language).
The three primary software components of RealMedia are as
follows:
•  RealPlayer: The client software for viewing RealMedia.

RealPlayer Basic is free, and RealPlayer Pro offers the user
more features for $30. Either one can view all RealMedia
content. A user who enjoys streaming media could quite
easily browse the Web with RealPlayer 8 because its many
Web links and ads, as well as the Flash navigation elements
that often surround presentations, offer the user a lot of
choices. RealPlayer 8 is available at www.real.com/player.

RealPlayer 8’s busy interface enables the user to forego a Web
browser completely when browsing for streaming media.
• RealProducer: Encoding software that turns standard

MPEG and QuickTime Video into RealMedia files, which
have the filename extension .rm. Again, you can pay for a free
RealProducer Basic and an enhanced Pro version, available at
www.realnetworks.com/products/producer.

• RealServer: Server software for serving RealMedia over
RTSP ( Real-Time Streaming Protocol). You can still offer
RealMedia to your users over the Web’s regular HTTP

without any special server software. RealServer Basic is
limited to 10 users; to upgrade from that, you pay by the
number of users. It’s available at www.realnetworks.com/
products/basicserverplus.

RealNetworks has led the way in cross-platform authoring and
playback. Versions of  RealPlayer are available for Windows,
Macintosh, Unix, Linux, and OS/2, and versions of
RealProducer for almost as many platforms. WebTV even plays
RealAudio 3.0. By contrast, QuickTime is limited to Windows
and Macintosh, and Microsoft’s streaming video solution is
basically Windows-only.
RealNetworks has also led the way in sheer numbers of
eyeballs; for years they were the only option for large-scale
streaming media sites. Even now, when they face the stiffest
competition they’ve ever had, their market share is still about 55
percent. RealPlayer is included with major browsers, as well as
with Windows, Mac OS and Red Hat Linux.

QuickTime
What “QuickTime” refers to is widely misunderstood. Some
people confuse the video format QuickTime Video with
QuickTime itself, but QuickTime Video is just one of the
things a QuickTime movie might contain. Sometimes the high-
profile QuickTime Player 4 is confused with QuickTime, but it
is just one dependent application.
The best way to explain QuickTime is to say that it’s a
multimedia operating system, enabling applications such as
CD-ROM titles to run on top of it and use the features it
provides. These features include support for audio, video,
images, 3D objects, MIDI music (including a software
wavetable synthesizer) and—with QuickTime 4—streaming
video, Flash movies, and MP3 audio. Once you have QuickTime
4 installed on your computer, suddenly Director can access
digital video. Flash 4 can export complete QuickTime
presentations, and otherwise pedestrian applications can
suddenly play synthesized music.
With the inclusion of streaming video in QuickTime, Apple
dressed up QuickTime 3’s MoviePlayer with an eye-catching
brushed aluminum look and changed its name to QuickTime
Player 4. Apple positioned itself as a competitor to
RealNetworks in the Web broadcasting field and now has
almost 35 percent of the streaming market. QuickTime movies
have a .mov filename extension.
Like RealMedia, QuickTime streaming has three main software
components:
QuickTime and QuickTime Player: All the viewing
goodness of QuickTime and QuickTime Player is free and is
available for Macintosh and Windows at www.apple.com/
quicktime. QuickTime is also included with all Macintosh
computers and installed on Windows by CD-ROM titles. Just
as they can with RealPlayer, users can spend more time in
QuickTime Player and less in a browser because of the favorites
storage and Flash navigation elements in many streaming
presentations.
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QuickTime Player has an uncluttered appearance that focuses the
eye on the content.
• QuickTime Pro and QuickTime Player Pro: For about

$30, Apple sells you a key code that unlocks the content
creation features of QuickTime and turns it into QuickTime
Pro, enabling QuickTime-dependent applications to create a
vast range of QuickTime content. QuickTime Player becomes
QuickTime Player Pro: a great piece of software that provides
easy content conversion and cut-and-paste video
compositing, although the interface is spartan and
sometimes hides functionality.

• QuickTime Streaming Server: QuickTime Streaming
Server delivers video over the Web using the standard RTSP,
just like RealPlayer. Apple released QuickTime Streaming
Server as open source software, and it is available completely
free—no per stream charge, either—for Mac OS X, Darwin,
and Linux. See www.apple.com/quicktime/products/qtss.

Windows Media
Microsoft has released a succession of media technologies over
the years in an effort to gain some sort of foothold in content
creation and delivery. The history of Microsoft multimedia is an
incredible story of acquisitions, rebranding, orphaned
technologies, and outright copying everybody else.
 With Windows Media, however, Microsoft has gone all out,
providing a solid-if unexciting-solution with lots of partners.
Still, Windows Media’s greatest asset is its automatic inclusion
with every Windows PC, virtually guaranteeing it a huge
installed base as time goes on. Windows Media files have
filename extensions of .asf or .asx.
The software involved in Windows Media includes:

• Windows Media Player: The supercharged Windows Media
Player (see Figure 24-3) received a complete face-lift for
version 7-and with the new changeable skins feature, it’s
quite the literal face-lift. In addition to Web streaming, the
Windows Media Player accesses many other media types
including audio CDs, Internet radio, and portable devices.
Currently only an earlier version, 6.3, is supported on the
Macintosh. The Windows Media Player home page is at
www.microsoft.com/windows/mediaplayer.

The Windows Media Player offers instant access to many media
types as well as switchable skins.
•  Content creation and server software: A directory of

tools for working with Windows Media can be found at
www.microsoft.com/windows/ windowsmedia. Most are
from Microsoft themselves, and all are Windows-only.

Assignments
1. What is pixels and color depth?
2. What is color look up table?
3. What are “Browser safe” colors?
4. What is the difference between a flash object and a

shockwave object?
5. What other parameters does flash object has besides the

common with shockwave?
6. What is dithering?
7. How is Dithering done by the browser?
8. What is gamma?’
9. What is flash text used normally for in Dreamweaver project?
10.How Dreamweaver does extend its link management for

flash swf files?
11.How graphics can be used in a intranet?
12.Write a short essay on usage of  video in internet?
13.Which of the streaming media formats is most commonly

used in the Internet?
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Topics Covered
• Imaging Strategies - Interface elements, Photographs as GIF;

JPEGs, Vector Graphics, Archiving your web graphics,
summary file formats.

• Dreamweaver - Working with video clip, linking to video,
embedded video, and Playing video with Dreamweaver.

Objectives
Upon completion of this lesson, you should be able to:
• Know imaging strategies
• Understand vector graphics
• Archive your web site graphics
• Know the advantages of various file formats
• Work with video clip
• Link to video
• Use embedded video
• Play video using Dreamweaver

Imaging Strategies

Interface elements
Small page navigation graphics, buttons, and graphic design
elements should be handled as non-interlaced GIF graphics.
The most conservative approach would be to use colors from
the 216-color browser (“Web safe”) palette so that they never
dither, even on 8-bit display screens. Or, if you choose to use a
color scheme for your interface that is not restricted to the Web
palette, check to see that the colors you choose default to
acceptable alternatives on 8-bit displays.

Photographs as GIFs
When you convert a full-color image into an 8-bit (256-color)
GIF file you could allow Photoshop to choose the 256 colors
that best fit that particular image. This results in the optimal
GIF image quality - often these images look almost as good as
their full-color originals - but the creation of a custom color
palette does have drawbacks. If the reader of your page has
their monitor set to show only 256 colors at one time then the
colors in your GIF images will appear distorted as the browser
forces them to display using the 216-color browser palette.
Forcing a GIF made from custom palette colors to display
within the limited system palette colors can result in ugly
distortions of  the image. A Web browser running on an 8-bit
display has no way to optimize your particular custom GIF
colors - it forces the picture to display in the nearest equivalent
colors in the browser palette. The result is often color banding,
or harsh distortions of the original colors, as seen in the
example below:

To get around this problem you could convert all your color
graphics to GIF files that use only the browser palette of 216
colors. This would ensure that your images look exactly the
same - in most cases, poor - no matter how the user’s display
screen is set up. A better approach is to apply custom palettes to
your images and accept that those readers using 8-bit display
monitors (a growing minority) will see distorted images. Or
you could use the JPEG file format instead.
The image compression in the GIF file format is less efficient
than JPEG compression. However, the compression
advantages of JPEG don’t apply to small to medium-size
images (say, up to 200 x 200 pixels). At these sizes GIF images
may be only slightly larger than JPEG files. With images larger
than 200 x 200 the compression advantages of the JPEG
format become more obvious.

Photographs as JPEGs
JPEG files are inherently full-color (24-bit) images, so
preserving the correct colors in the files themselves is not an
issue. However, there is no way to prevent JPEG images from
dithering when they are displayed on 8-bit screens — any
photographic image displayed on a 256-color display will dither.

LESSON 40:
IMAGING STRATEGIES



202

E
-M

E
D

IA

The dithering seen in JPEG images does not compromise
image quality any more than if you dithered the images to 256-
color GIFs yourself. If you standardize on JPEG images, the
majority of your audience will see full-color photographs and
illustrations. Standardize on the JPEG format for any
photographic or other full-color or grayscale image suitable for

JPEG Compression

Diagrams and illustrations as vector graphics

Most Web page graphics are raster images - often called
“bitmap” or “paint” images - composed of a grid of colored
pixels. Complex diagrams or illustrations, however, should be
created as vector graphics and then converted to raster formats
like GIF or JPEG for the Web. Vector graphics (also known as
“draw” or “PostScript” graphics) are composed of
mathematical descriptions of lines and shapes. Although these
graphics cannot (yet) be used directly to illustrate Web pages
without requiring users to have a special browser plug-in, there
are three major reasons for producing complex diagrams in
vector graphics programs:
1. Vector graphic illustrations are automatically antialiased when

imported into Photoshop or other raster imaging programs
and converted to raster graphics:

2. Vector graphics can be easily resized as they are imported:

3. Complex artwork created in such vector-based programs as
Adobe Illustrator and Macromedia FreeHand is a better
investment of your illustration budget, because vector

graphics also produce high-resolution images suitable for
print, as shown below. The illustrations below and
immediately above were produced from the same Illustrator
file:

Archiving your Web site Graphics
Always save a copy of your original graphics files, and make it a
standard practice to create separate new files every time you make
significant changes to an image, such as resizing it or changing
the file format. After the close of a project all photos and
artwork should be kept and stored at their full original
resolution and in a format that does not compromise the image
quality of the files through “lossy” image compression, as in
JPEG. We prefer to archive every image generated in a project.
Many small 8-bit GIF or JPEG illustrations on the finished
Web page, for example, start out as much larger high-resolution
files in Photoshop format. We save all the intermediate pieces,
not just the original and final files. This will save you a lot of
time if you later change your mind about the best file format
for a graphic or need to modify it. If you have archived the full-
color Photoshop version of the graphic, you can easily create a
new version in a different format. If you save only the final
GIFs , you will have lost your full-color version. If you save
only the final JPEGs, you will no longer have images without
compression artifacts, and recompressing an image that already
has JPEG compression noise usually yields poor results.

Summary: File formats

Uses for GIF and JPEG Files
Netscape Navigator, Microsoft Internet Explorer, and most
other browsers support both GIF and JPEG graphics (as of
this writing, PNG graphics are not adequately supported). In
theory, you could use either graphic format for the visual
elements of  your Web pages. In practice, however, most Web
developers will continue to favor the GIF format for most page
design elements, diagrams, and images that must not dither on
8-bit display screens. Designers choose the JPEG format mostly
for photographs, complex “photographic” illustrations, medical
images, and other types of images in which the compression
artifacts of the JPEG process do not severely compromise
image quality.

Advantages of GIF files
• GIF is the most widely supported graphics format on the

Web
• GIFs of diagrammatic images look better than JPEGs
• GIF supports transparency and interlacing

Advantages of JPEG images
• Huge compression ratios mean faster download speeds
• JPEG produces excellent results for most photographs and

complex images
• JPEG supports full-color (24-bit, “true color”) images
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Dreamweaver

Working With Video Clips
If  you have short video clips you’d like to put on the Web, you
may not need the industrial strength-or the hassle and expense-
of a streaming media solution. Short video clips can be
included in a Web page just by linking to them or embedding
them. Depending on the viewer’s software setup, video clips
either download completely and then start playing, start playing
right away and stutter as they wait for data, or start playing as
soon as enough of the video has arrived that uninterrupted
playback is possible, as shown in figure below:

QuickTime Player starts playing video clips when it has
downloaded enough that playback will be uninterrupted.
Video clips come in a few common formats, detailed in Table
below.  In addition to the video format itself, what codec
(encoder/decoder) a particular video clip uses is also important.
A codec provides video compression and is required for the
decompression at playback time. Many codecs are included with
Windows and with QuickTime, so codecs are not usually a
problem, unless you’re authoring for platforms other than
Windows and Macintosh.

MPEG, QuickTime Video, or AVI clips are good candidates for
linking or embedding due to the wide variety of players on
multiple platforms that can play them. QuickTime movies are
best aimed squarely at the QuickTime Player because of the
multiple media types that they contain.

Linking to Video
To include a video clip in your Dreamweaver Web page, follow
these steps:
1) Select the text or image that you want to serve as the link to

the video file. If you use an image as a link, you might want
to use a frame from the video clip in order to provide a
preview.

2) In the Property Inspector, enter the name of the video file in
the Link text box or select the folder icon to browse for the
file.

3) Because video files can be quite large, it’s also good practice to
note the file size next to the link name or enter it in the Alt
text box, as shown in figure below:
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Embedding video
You can gain more control over the way your video clip plays by
embedding it in the Web page with the <embed> tag.
Modifying the attributes of the <embed> tag enables you to
modify how the video is presented. Video clips inserted this
way play back in whatever players are available, just as linked
video clips do.
To embed a simple video clip in a Web page, follow these steps:
1. Choose Insert->Plugin or select the Plugin object from the

Common pane of the Objects palette, or drag the file from
the Movies category of the Assets panel to a location on your
Web page.

2. If you inserted a Plugin object, enter the path to the video
clip in the Plugin Src text box of the dialog box, or select the
folder icon to browse for the file. Movies dragged onto the
page from the Asset panel already include the source path.
The plugin placeholder is displayed as a 32×32 icon.

3. In the Plugin Property Inspector, enter the dimensions of
your video clip in the width and height boxes, marked W
and H, respectively.

Playing Videos Within Dreamweaver
Dreamweaver can access and use Netscape plugins to display
video right in the Document window at design-time. These
plugins can be installed in Netscape’s Plugins folder, in Internet
Explorer’s Plugins folder, or in Dreamweaver’s own Plugins
folder. Dreamweaver checks all three every time it starts up.
Installing the correct plugins into Netscape and enabling
Dreamweaver to use them from there can make maintaining
your plugins easier because many come with browser specific
installation programs that are hard to adapt to Dreamweaver.
Whenever a file is embedded for playback via a plugin, a green
Play button appears  in the Property Inspector. To play a
particular video in Dreamweaver’s Document window, all you
have to do is select the plugin placeholder and click the Play
button. The video begins playing, and the green Play button,
shown in figure below, becomes a red Stop button. To stop
playback-surprise-just click the Stop button.
You can also use the menus and the corresponding keyboard
shortcuts to control the digital video in the Document window:
View->Plugins->Play or Ctrl+Alt+P (Command+Option+P),
and View->Plugins->Stop or Ctrl+Alt+X
(Command+Option+X). If you have multiple videos inserted
on the age, you can play them all by choosing View->Plugins-
>Play All or by using the keyboard shortcut Ctrl+Alt+Shift+P
(Command+Option+Shift+P), and stop them with View->
Plugins >Stop All or Ctrl+Alt+Shift+X
(Command+Option+Shift+X).

Playing video within Dreamweaver is as simple as having the
right plugin installed and clicking Play.

Notes
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Topics Covered
• Images on the screen, The screen versus printed color

artwork, Complex illustration or photographs
• Dreamweaver - Streaming with Real Media, Creating Real

media metafiles, Inserting Real media in your web page,
Using <embed>.

Objectives
Upon completion of this lesson, you should be able to:
• Means of distributing color photography
• Differentiate between screen and print color artwork
• Understand complex illustration or photograph
• Create Real Media Meta files
• Insert Real Media in your web page
• Use <embed>

Images On The Screen
The primary challenge in creating images for Web pages is the
relatively low resolution of  the computer screen. But today’s
computer screens can display thousands or millions of colors,
and this wealth of color minimizes the limitations of screen
resolution. Complex graphics or color photographs often look
surprisingly good on Web pages for two reasons:
• True-color (24-bit) or high-color (16-bit) displays show

enough colors to reproduce photographs and complex art
accurately

• The light transmitted from display monitors shows more
dynamic range and color intensity than light reflected from
printed pages

Digital publishing is color publishing: on the Web there is no
economic penalty for publishing in color. Web pages may in fact
be the best current means of distributing color photography —
it’s a lot cheaper than color printing, and it’s also more
consistent and reliable than all but the most expert (and costly)
color printing.
The screen versus printed color artwork
Relative to printed pages the computer screen is a low-
resolution medium. When you look at illustrations,
photographs, and other sophisticated imagery, however, the
differences in quality between conventional four-color printing
and the computer screen are not as great as you might expect.
In terms of resolution, the computer screen is limited to about
72 to 92 dots per inch of resolution (see Screen resolution). But
most four-color magazine printing is done at 150 dpi, or only
about four times the resolution of the computer screen (150
dpi is four times the resolution of 75 dpi because resolution is
measured over area, 150 x 150 per square inch):

Regarding color reproduction, four-color printed images are
separated into four subtractive printing colors (cyan, magenta,
yellow, and black). These four inks combined produce the
illusion of a full range of colors on the printed page, but
ultimately the typical magazine or textbook image is composed
of only four colors. By comparison, as mentioned, current
computer monitors can display millions of colors, producing a
richness of  color that easily rivals the best quality color printing.
Also, computer screens display transilluminated images - the
colored light shines out from the screen. Transilluminated
images deliver a much greater range of contrast and color
intensity than images printed on opaque paper, which depend
on reflected light. Finally, computer displays show color images
using the additive RGB (red-green-blue) color system, which
can display a much broader and subtler range of colors than
conventional four-color printing.
Bottom line: the computer screen is lower in resolution, but
because of the other advantages of computer displays, images
on Web pages can easily rival color images printed on paper.

Complex Illustrations or Photographs
The anatomic graphic below was originally painted at much
higher resolution in Adobe Photoshop (1000 x 2000 pixels, 24-
bit RGB file). We then reduced a copy to the size above and
used Photoshop’s “Unsharp Mask” filter (at 60 percent) to
restore sharpness. Although this small version of the painting
has lost some resolution and color detail, it still shows all the
major anatomic landmarks. The extra detail and subtle nuances
of high-resolution artwork are not entirely lost when the
graphic is reduced to Web page size.

LESSON 41:
STREAMING MEDIA IN DREAMWEAVER



206

E
-M

E
D

IA

We chose the JPEG file format for the anatomic painting
because the artwork is relatively large for a Web page graphic.
JPEG compression can be used for paintings or photographs
with text labels if  you choose the right compression setting.
The painting above was compressed in Photoshop at “good”
quality, which is the medium-quality setting (“excellent, good,
poor”). If you choose the “good” or “excellent” JPEG
compression settings, text labels should look acceptable, at least
on 16-bit or 24-bit displays. Note that in the anatomic
illustration example shown above the text labels are clear and
legible, even though close inspection would certainly turn up
JPEG noise around the characters.

Computer Lab

Dreamweaver

Streaming With Realmedia
If you’ve ever downloaded a few minutes of digital video over
a slow modem connection, you know the reason why streaming
video was invented. In an age when immediacy rules, waiting
until the complete video file is transferred and then loaded into
the video player can seem to last an eternity. Streaming, on the
other hand, enables the multimedia content to begin playing as
soon as the first complete packet of information is received, and
then to continue playing as more digital information arrives.
Video is just one form of media to get the streaming
treatment: You can also stream audio, animation, text, and
other formats.
Regardless of which streaming video protocol you use, the
procedure for incorporating the file on your Web page is
basically the same, although the details (such as filename
extensions) differ. In order to demonstrate the general
technique and still offer some specific information you can use,
the next section details how to include streaming RealMedia
clips with Dreamweaver. Check with the developer of the
streaming video format you plan to use to get the precise
installation details. Typically, lots of  information is available for
free on the developers’ Web sites.

A RealMedia example
When incorporating RealMedia into your Web pages, you have a
variety of  playback options. You can set the video so that a free-
floating RealPlayer is invoked, or you can specify that the video
appears inline on your Web page. You can also customize the
controls that appear on your Web page so that only the ones
you want-at the size you want-are included.

Creating RealMedia Metafiles
RealMedia uses its own specialized server software called
RealServer to transmit encoded video files. Rather than call this
server and the digital video file directly, RealMedia uses a system
of  metafiles to link to the RealMedia server and file. A metafile is
an ordinary text file containing the appropriate URL pointing to
the RealServer and video file.
The metafiles are distinguished from the media files by their
filename extensions:
•  RealMedia files: .rm, .ra, .rp, .rt, .swf
•  Metafile that launches the independent RealPlayer: .ram
•  Metafile that launches the RealPlayer plugin: .rpm
To create the metafile, open your favorite text editor and insert
one or more lines pointing to your server and the video files.
Instead of using the http:// locator seen with most URLs,
RealMedia files address the RealServer with an rtsp:// ( Real-
Time Streaming Protocol) indicator. The contents of the file
should take the following form:
rtsp://hostname/path/file
where hostname is the domain name of the server where the
RealMedia files are stored, path is the path to the file, and file is
the name of the RealMedia file. For example, to display a
training video, the metafile contents might look like the
following:
rtsp://www.trainers.com/videos/training01.rm
You can include multiple video clips by putting each one on its
own line, separated by a single return. RealMedia plays each clip
in succession, and the user can skip from one clip to another.

Inserting RealMedia in your Web page
Once you’ve created both the encoded RealMedia file and the
metafiles, you’re ready to insert them into your Web page. You
have two basic techniques for including RealMedia: as a link and
using the <embed> tag.

Using a link
Generally, if  you want to invoke the free-floating RealPlayer, you
use a link; the href attribute is set to an address for a metafile,
like this:
<a href=”videos/howto01.ram”>Demonstration</a>
When the link is selected, it calls the metafile that, in turn, calls
the video file on the RealServer. As the file begins to download
to the user’s system, the RealPlayer program is invoked and
starts to display the video as soon as possible through the
independent video window, as shown in figure below. The link
can be inserted in Dreamweaver through either the Text or
Image Property Inspector.
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You can set up your RealMedia clip so that it plays in its own
RealPlayer window. This is RealPlayer’s “Compact” view

Using <embed>
If, on the other hand, you’d like to make the video appear inline
with the Web page’s text or graphics, you use Dreamweaver’s
Plugin object to insert an <embed> tag. Position the pointer
where you want the RealMedia to be displayed, and either
choose Insert’Plugin or select Insert Plugin from the Objects
palette. After theInsert Plugin dialog box appears, enter the
path and filename for the video’s metafile in the Plugin Source
text box.
When the Plugin object representing the RealMedia clip is
selected, you can enter values for the <embed> tag in the
Property Inspector. The only attributes required for a RealMedia
clip, as with the QuickTime Player object, are the file source and
the width and height of the movie. And, as you can with
QuickTime Player, you can choose from a healthy number of
attributes to control your RealMedia movie. Enter attributes by
selecting the Parameters button on the Plugin Inspector and
entering attributes and their values in the Parameters dialog box

Notes
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Topics Covered
• Diagrams for the computer screen, HTML and graphics,

Accessibility
• Dreamweaver - Digital audio fundamentals, file formats,

Making audio files lighter, mp3 mini primer, Linking to
audio files

Objectives
Upon completion of this lesson, you should be able to:
• Design correct diagrams for the computer screen
• Use of proper backgrounds in the HTML page
• Maintain legibility on background colors
• Define image maps
• Know Digital audio fundamentals
• Classify file formats
• Make audio files lighter
• Link web document to audio files

Diagrams For The Computer Screen
Basic diagrams also work well on the computer screen if they are
carefully designed to match the grid of pixels on the screen.
Graphics built with orthogonal lines (straight horizontal or
vertical lines) or diagonal lines at 45-degree angles work best for
the screen, as this enlarged view illustrates:

Complex icons are hard to interpret, and they look mushy and
confusing on the screen. Keep icons and navigation graphics as
simple as possible:

Simple isometric perspective graphics also work well because
they depend on straight lines and 45-degree diagonals.
Although the restrictions of working within fixed line angles
make the technique unsuitable for many diagrammatic graphics,
it is possible to build complex illustrations using this technique.
The regularity of the isometric line work and the absence of the
complexities of perspective bring order to graphics that might
otherwise be too complex for Web page presentation:

Another benefit of keeping diagrammatic art and maps simple
is that graphic simplicity is ideally suited to the LZW encoding
compression algorithm used in GIF graphics (see GIF files).
This 450 x 306-pixel GIF graphic is large for a Web page, but it
compresses to a mere 8 KB because the contents are well suited
to LZW compression:

LESSON 42:
DIGITAL AUDIO IN DREAMWEAVER
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Be careful about choosing the proper sizes for this type of
illustration. Graphics carefully built to match the pixel grid
cannot be resized automatically in Photoshop - they must be
redrawn by hand to larger or smaller sizes to avoid a mushy,
fuzzy look that destroys their effectiveness:

The low resolution of the computer screen is insufficient for
displaying diagrams that incorporate many curves or angles;
lines that do not follow the pixel grid appear jagged. To
optimize these kinds of  diagrams for Web pages you’ll need to
use antialiasing to smooth the boundaries and make the jagged
edges less apparent:

At great magnification antialiased graphics may have fuzzy
boundaries, but at normal magnification antialiasing produces
smooth, natural-looking line work.

Html and Graphics

Height and width tags
All your page graphics source tags (even small button or icon
graphics) should include HEIGHT and WIDTH tags. These
tags tell the browser how much space to devote to a graphic on
a page, and they instruct the browser to lay out your Web page
even before the graphics files have begun to download.
Although this does not speed up downloading (only a faster
data connection can do that), it does allow the user to see the
page layout more quickly. The text blocks will fill out first and
then the graphics files will “pour” into the allotted spaces. This
means that the user can start to read your page while the
graphics are downloading.

Colored backgrounds
Web background colors offer a “zero-bandwidth” means to
change the look of your pages without adding graphics. They
also allow you to increase the legibility of your pages, tune the
background color to complement foreground art, and signal a
broad change in context from one part of your site to another.
A List Apart uses background colors as an easy way to enliven
the visual impact of their otherwise low-bandwidth pages:
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Picking the background color is easy in WYSIWYG (what you
see is what you get) graphic Web page layout programs.
Unfortunately, picking a color without one of  these Web page
editors is a procedure only a propellerhead could enjoy. The
color is specified in the tag in hexadecimal code, in which the six
elements give the red, green, and blue values that blend to make
the color. In the tag, the hex code is always preceded by a “#”
sign: (#RRGGBB). Because this whole business is now
handled visually by the new generation of WYSIWYG page
editors and image editors like Adobe Photoshop, we will not
delve further into the arcana of hexadecimal RGB color
selection.

Background Colors and Legibility
The Web is rife with pages whose legibility is marginal due to
poorly chosen background color – text color combinations. Text
that is hard to read is a hindrance for a fully sighted reader, and
certain color combinations make pages unreadable for
colorblind users (10 percent of males are partially colorblind).
The legibility of type on the computer screen is already
compromised by low screen resolution. The typical Macintosh
or Windows computer screen displays text at 72 to 80 dots per
inch (about 5,200 dots per square inch), or almost 300 times
lower resolution than a typical magazine page (1,440,000 dots
per square inch). Black text on a white (or very slightly tinted)
background yields the best overall type contrast and legibility.
Black backgrounds are significantly less legible than white
backgrounds, even when white type is used for maximum
contrast. Colored backgrounds can work as an alternative to
plain browser-default gray if the colors are kept in very muted
tones, and low in overall color saturation (pastels, light grays,
and light earth tones work best).

Background Patterns
Early in 1995 Netscape Navigator version 1.1 gave Web page
authors the ability to use small tiled GIF or JPEG graphics (or a
single large graphic) to form a background pattern behind the
Web page. The feature is controversial in Web design
discussions, because pages that use large background images

take longer to download and because the background patterns
tend to make pages harder to read unless they are carefully
designed.
To be suitable for use as a background texture, the graphic
should be a small GIF or JPEG, ideally no more than about
100 x 100 pixels in size. In our experience, JPEG background
patterns load slightly faster than equivalent GIF graphics.
Typical graphics used for background patterns are
homogeneous textures:

The image will repeat both horizontally and vertically to fill the
browser window.
How you might use background graphics depends entirely on
your goals for your Web site, the access speeds that are typical
for your target audience, and whether a graphic background
matches the aesthetic goals of  your Web site. It is foolish to use
large or visually complex background textures on any page that
is heavily accessed by busy people looking for work-related
information - the long download times, amateurish aesthetics,
and poor legibility will simply annoy your users. That said, in
the hands of  a skilled graphic designer who is creating Web
pages designed for graphic impact, the option to use
background textures opens up many interesting visual design
possibilities. This is particularly true in universities and
commercial organizations where fast network access is
commonplace and bandwidth is not the obstacle it is to many
modem-based users.

Imagemaps
Imagemaps offer a way to define multiple “live” link areas
within a graphic on a Web page. Imagemaps have become a
standard feature of most professionally designed Web sites
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because they offer an effective combination of visual appeal and,
when used properly, space-efficient functionality. Imagemaps are
particularly effective when incorporated into moderately sized
“splash” graphics at the top of home pages or into the
“signature” graphics or logos that define your pages. For
example, Palm uses a space-efficient imagemap menu on its
home page. The graphic is more than a menu; it helps define
the signature “look” of  pages within the Palm Web site:

Imagemaps are the only way to incorporate multiple links into a
graphic illustration, as in this anatomic example:

Imagemaps are also the ultimate way to overcome the vertical,
list-oriented, graphically inflexible norms of conventional Web
pages built with standard HTML tags. With imagemaps you
can abandon HTML page layout and build links into large
graphics, just as you might in CD-ROM authoring programs.

Keep in mind, however, that such designs are suitable only for
audiences with high bandwidth access to the Web or the local
intranet.

Accessibility
Whenever you introduce nontext elements to your Web design
you reduce the accessibility of your pages. For the purposes of
universal access, text is the ultimate content type: it can be most
widely adapted for use with different devices and assistive
technologies. But the Web is a visual medium, and access to
images and other nontext materials is one of the reasons why
people turn to the Web over other information sources. As a
Web page designer, you should keep this restriction in mind
and take measures to ensure that your design decisions do not
exclude disabled users from your Web page content.

Text Alternates
Your site navigation can be supplied using graphics such as
buttons, imagemaps, or animations, but it is critical that you
design your navigation system for all users. If  your site’s
navigation interface uses graphic menus, always provide an
alternate navigation route using basic text links. Users without
graphics capabilities, such as those using text-only browsers or
visually impaired users, will not be able to use your site if you
provide only graphic menus.

ALT-text
HTML has several built-in fallbacks designed to allow your
content to degrade gracefully under different viewing
conditions. One of these is ALT, an attribute of the IMG tag.
The ALT attribute allows you to supply an alternate text
description with any images you place on your page. Users who
cannot see your images for whatever reason will see or hear the
text you supply using the ALT attribute:
<IMG SRC=”banner.gif ” HEIGHT=”30" WIDTH=”535"
ALT=”Web Style Guide”>
In the above example, users accessing the Web Style Guide page
with graphic loading turned off will see the alternate text “Web
Style Guide” in place of the banner graphic. Visually impaired
users using assistive technology to access Web pages will hear
the text “Web Style Guide” read aloud. This way you can use a
graphic banner to establish site identity, but users who do not
see images will still know what site they are visiting.
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Writing good ALT-text is an epigrammatic art, challenging your
ability to describe the content and function of an image in just a
few words. Browsers do not currently wrap ALT-text, so users
reading ALT-text from the screen will normally see only a few
words, though users who are read ALT-text by software will
hear the entire description. Think not only about what the
image is but also how it functions on the page. What does the
image say? What is its purpose? Is it there to identify your
organization? If  so, write ALT-text that identifies your
organization. Does it provide navigation options? Write ALT-
text that describes where the user will go after clicking on the
image. Think about the primary purpose of the graphic and
attempt to convey it in ten words or fewer.
<IMG SRC=”up.gif ” HEIGHT=”10" WIDTH=”10"
ALT=”Go to top of  page”>
Also include ALT-text describing link destinations for
imagemap menus so that users who cannot see the graphic
menu will know where they will go if they select an imagemap
link.
At times ALT-text is not useful - for example, for interface
images like custom bullets or for invisible spacer graphics -and
in those cases you should include an empty ALT attribute
(ALT=””) in your IMG tag. An empty ALT attribute hides the
graphic from text-only browsers and assistive technologies like
screen readers. If  you leave out the ALT-text, users could hear
the words “image, image, image, image” because most software
is designed to let the user know when there is an undescribed
image on the page. If  instead you include an empty ALT
attribute, the software knows to skip the image.

Computer Lab

Dreamweaver

Using Audio On Your Web Page
Web sites tend to be divided into two categories: those totally
without sound, and those that use a lot of  it— there’s not
much middle ground. Many music and entertainment sites rely

heavily on both streaming audio and downloadable audio files
such as MP3.
In this chapter, you learn how to use audio in the Web pages
you design with Dreamweaver. We look at traditional digital
audio formats such as AIFF and WAV, and how you can turn
these into files suitable for publishing on the Web, in formats
such as MP3 and RealAudio. We also look at music formats
such as Standard MIDI files and QuickTime Music.

Digital Audio Fundamentals
Digital audio files are digitized representations of sound waves.
While not as heavy as digital video, digital audio files-even those
that have been compressed-are still a strain for today’s Web. As
usual, minimizing file sizes wherever possible makes for a
better experience for users of  your Web site.

File formats
Many different formats for digital audio files are in use today
across the various computer platforms. The most common
formats are described in Table below and can be identified by
their unique filename extensions and/or by their icons on
Macintosh systems.
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Which audio format should you choose? That depends on a
combination of factors, including your target audience, available
bandwidth, and the purpose of the audio’s content.
Although most browsers can play standard digital audio files
such as AIFF and WAV, the sheer uncompressed bulk of  these
files makes them unsuitable for the Internet, now that so many
highly compressed formats exist. In the early days of the Web,
with slower computers and less advanced compression
technologies, these uncompressed audio files were the only
game in town. But today, fast computers are capable of  easily
decoding MP3 and RealAudio, and free players for those
formats are common.
A live Internet broadcast dictates a streaming solution such as
RealAudio, QuickTime, or Windows Media. If  you’re offering
complete songs for download, you may not have to look any
further than MP3. It’s not uncommon to offer a sound file in
multiple formats. Although many users have more than one
player, offering your audio in a few formats gives you a better
chance of  reaching everybody. Converting one audio file format
to another typically involves opening the source file in an audio
editor that can read the format and exporting it in another
format. If you lack a professional audio editor such as
SoundForge or Peak, a simple alternative is to use QuickTime
Pro; it reads and writes a lot of  formats. You can also easily  cut
and paste sections of files, to remove or add a few seconds of
silence, for example.

Making audio files lighter
As well as categorizing by file format, we can also think of
audio on the Web as being in one of  two categories:
uncompressed and compressed.

Uncompressed files
AIFF and WAV audio files come in compressed and
uncompressed formats, but only the uncompressed versions
play in Web browsers. If  you can’t compress an audio file in
some way, the only way to lower its file size is to lower its
quality in one of three ways:
• Convert a stereo file into a mono file: A stereo file has

two audio channels, while a mono file has only one.
Converting a stereo file to mono halves its file size.

• Lower the bit depth: A lower bit depth-for example, from
16-bit to 8-bit- reduces the accuracy of the stored audio
waveforms.

• Lower the sample rate: From 44 kHz to 22 kHz, for
example. This lowers the range of audio frequencies in the
recording, chopping off the “high end” or treble frequencies.

You can make the preceding conversions by opening the audio
file in an application such as QuickTime Player Pro and
exporting the file with new properties, as shown in the figure
below:

Exporting an AIFF as a WAV in QuickTime Player Pro.
Converting stereo to mono, 16-bit to 8-bit, and lowering the
sample rate from 44.1 kHz to 8 kHz lowers the file size but
drastically lowers the quality.

MP3 Mini-Primer
The MP3 audio format has quite simply taken the Web—and
the world-by storm. While other downloadable music formats
come with caveats such as ownership by one company or built-
in limitations on how users can use the files they purchase, MP3
just did the work and got the job done. MP3 software players
are common. A range of manufacturers offers MP3 hardware,
such as home, car, and personal stereos.
Generally, the MP3 “scene” has shown interest in new and/or
unusual artists, offered a selection of dynamic, full-featured
players , and maintained an attitude of music appreciation.
Conversely, non-MP3 downloadable music has generally
featured bland players, corporate music, proprietary
technologies, and an unhealthy fascination with watermarking
and controlling content. It’s not hard to see why the market
chose MP3.
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Many standalone MP3 players feature dynamic looks that can
even be changed by applying a new “skin.”

Linking to Audio Files
The simplest way to add sound to a Web page is to create a link
to an audio file. You enter the path to your audio file in the
Link text box in the Text or Image Property Inspector, or select
the folder icon to browse for the file. When the user clicks that
link, the sound file downloads, and whatever program has been
designated to handle that type of file opens in a separate
window. The exception to this is the QuickTime Plugin.
Instead of opening linked audio files in the QuickTime Player,
it opens them within the browser window, as if  they were a
new Web page. To get back to your Web page, the user clicks the
browser’s Back button.
Netscape Navigator 4.x’s LiveAudio player is the only major
audio player that does not yet support MP3, but Netscape has
also shipped with RealPlayer G2 for quite some time now,
which does play MP3, as shown in Figure below:

A link to an MP3 file in this Web page downloaded and then
opened the file in RealPlayer, which was specified as a helper
application for MP3 files.
To create a link to an audio file in Dreamweaver, follow these
steps:
1. Select the text or image that you want to serve as the link to

the audio file.
2. In the Property Inspector, enter the name of the audio file in

the Link text box, or select the folder icon to browse for the
file.

3. Because audio files can be large, it’s good practice to note the
file size next tothe link name or enter it in the Alt text box
for your image.

When you use the link technique for incorporating sound, you
have no control over the position or appearance of the player.
However, you can control these factors and more by embedding
your audio.

Assignments
1. Identify the differences in photographs as GIF and JPEGs?
2. What are vector graphics?
3. How can you archive your web graphic files?
4. What is a codec? Explain with examples from both windows

and mackintosh platform?
5. What is a embedded video? Why is it standalone and

platform independent?
6. How is screen resolution different from computer screen

display?
7. What is Real Server? What is it used for?
8. How do you insert real media to your web page? Explain

with the steps required to do so?
9. How can be complex graphic be properly viewed on a

computer screen, explain in terms of rescaling methods?
10.Write the importance of  legibility of written text in a colored

background. What measures should be taken to maintain
clarity?

11.What are image maps?
12.Name four uncompressed and compressed audio format?
13.Is Mp3 still comes for free? Name the audio formats which

are right now coming for free?

Notes



215

E
-M

E
D

IA

Topics Covered
• Introduction to Multimedia, Application for multimedia
• Dreamweaver - Embedding sounds and music, Playing

background music, Targeting specific plug-in ,
Installing RealAudio, Using Real Audio object

Objectives
Upon completion of this lesson, you should be able to:
• Know about the various application for multimedia
• Embed sound and music
• Play background music
• Target specific plug-in
• Install streaming Audio
• Use Real Audio object

Multimedia
It’s as large as life, and twice as natural!
- Lewis Carroll, Through the Looking-Glass
PERHAPS THE MOST POWERFUL aspect of  computing
technology is the ability to combine text, graphics, sounds, and
moving images in meaningful ways. The promise of
multimedia has been slow to reach the Web because of
bandwidth limitations, but each day brings new solutions.
Although there are numerous methods for creating Web
multimedia, we recommend using stable technology that works
for the great majority of client machines. Plug-ins that extend
the capabilities of  your Web pages are a mixed blessing. You
risk losing your audience if you require them to jump through
hoops to view your content.

Applications for multimedia
Web designers must always be considerate of  the consumer. A
happy customer will come back, but one who has been made to
wait and is then offered goods that are irrelevant is likely to
shop elsewhere. Because multimedia comes with a high price
tag, it should be used sparingly and judiciously.
All too often Web authors include visual or moving elements
on the page for the purpose of  holding the user’s attention.
This approach is based on the assumption that Web users have
short attention spans, which in many cases may be true.
However, the solution is not to add gratuitous “eye candy” to
your Web presentation, which may, in fact, command too much
of  the user’s attention and detract attention from the main
content of your page. When thinking about adding media to
your Web pages, consider first and foremost the nature of  your
materials. Use images, animations, video, or sound only when
relevant to your message.

info.med.yale.edu/intmed/cardio/imaging
Bear in mind, too, that there are technical limitations to the
delivery of  audiovisual content via the Web. For example, long-
duration video and video requiring smooth motion or clear
details require large amounts of bandwidth to deliver and may
tax the playback capacity of  the user’s machine. A significant
amount of downsampling and compression is required to
create a file that is small enough to be delivered via the Web. In
some cases, these compromises may be too significant to
warrant the effort. When you are considering adding
multimedia to your pages, make sure the technology can meet
the demands of  your content. You don’t want users to spend
extra time and energy retrieving files that cannot be illustrative
owing to limitations of  the technology.
Also be wary of fledgling technologies. Plug-ins that allow
users to see new and exciting things using their favorite browser
software are constantly being introduced. This is especially true
of multimedia; the options for encoding and delivering audio,
animations, and video are dizzying. Although designers may be
tempted to create files that employ the functionality offered by
custom plug-ins, they should bear two things in mind. First,
the bother and potential confusion of downloading and
installing plug-ins will deter many users. Second, it is not
prudent to create content in a custom file format that could
quickly become obsolete. It is best to create your multimedia
content in the standard formats for operating systems and
browser software.

LESSON 43:
APPLICATIONS FOR MULTIMEDIA
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This somewhat conservative discussion of multimedia
considerations needs one important qualification. If you are
creating a site for a specific audience and not for global interests
you will probably have more flexibility and can ask more from
your users. You can require them to use specific browser
software and plug-ins, and you can include data-intensive
multimedia elements in your presentation. Say, for example,
that your site is academic and your audience is a group of
students or faculty with specialized interests. You are charged
with the task of creating a custom site that fully addresses these
interests, so function should define form. A foreign-language
teaching site, for example, could contain bandwidth-intensive
audio and video elements because the students who visit the
site will use these multimedia elements to improve their
abilities with the language. These students are not casual
visitors; they are invested in the content, so they will tolerate
lengthy download times and more demanding site interaction.
And because your audience is defined and finite, you can take
steps to ensure that they know what to expect and are prepared
when they visit your site.

Computer Lab

Dreamweaver

Embedding Sounds And Music

Embedding a sound file truly integrates the audio into your
Web page. Embedding the sound files also gives you a much
higher degree of control over the presentation of the audio
player itself, including the following:
•  The clip’s play volume
•  Which part, if  any, of  the player’s controls is visible
•  The starting and ending points of the music clip
As with any other embedded object, you can present the visual
display inline with other text elements—aligned to the top,
middle, or bottom of the text, or blocked  left or right to
enable text to flow around it. Dreamweaver controls all of these
parameters through two different objects: the Plugin object and
the ActiveX object.
Each type of object calls a specific type of player. For example,
the default Plugin object calls the LiveAudio Plugin in a
Netscape browser and the Windows Media Player control in
Internet Explorer. Calling the Windows Media Player as an
ActiveX object explicitly enables you to modify a great number
of parameters for Internet Explorer—which are completely
ignored by Navigator. You learn all of  your embedding
options, including techniques for cross-browser audio, in the
next few sections.
As with the basic video file, Dreamweaver uses the generic
Plugin object to embed audio in your Web page. The object
requires only three parameters: the source of the audio file, the
width and the height of  the object. To embed an audio file in
your Web page, follow these steps in Dreamweaver:
1. Position the cursor where you want the control panel for the

audio file to appear.
2. Insert the Plugin object by choosing Insert->Media->Plugin

or by selecting the Plugin object from the Special category of
the Objects panel.

3. In the Select File dialog box that appears, choose the audio
file.

4. Use either of the following techniques to size the Plugin
placeholder:

• Enter the appropriate values in the W (Width) and the H (
Height) text boxes of the Property Inspector.

• Or click the resizing handles on the Plugin placeholder and
drag it out to a new size.

For a default audio Plugin, use a width of 144 pixels and a
height of 60 pixels. These dimensions are slightly larger than
necessary for Internet Explorer’s audio controls, as shown in
the figure below, but they fit Navigator’s controls perfectly, and
the control panel does not appear to be “clipped” when viewed
through any browser.

Windows Media Player needs less space than Netscape’s
LiveAudio for its controls, so it fills the rest with a crushed
version of  its logo.

Playing Background Music
Background music, played while the user is viewing online
material, is one of  the Web’s hidden treasures. When used
tastefully, background music can enhance the
overall impact of the page. Making a regular embedded sound
into a background sound is as simple as adding a few
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parameters to the embed tag: hidden tells the browser not to
display any controls, autostart tells it to start playback
automatically, and loop tells it to play the audio continuously.
Although you can add these attributes to the embed tag
manually in Code View, or in the Code Inspector, it’s easier to
add them using the Parameters button of the embed tag
Property Inspector.
Follow these steps to embed background music in a Web page:
1. Position the cursor near the top of  your Web page. Choose

Insert->Media-> Plugin or select the Plugin object from the
Special category of the Objects panel.

2. Enter the path to your audio file in the Plugin Source text
box or select Browse to locate the file.

3. In the Property Inspector, enter 2 in both the H ( Height)
and W (Width) text boxes.

4. Click Parameters.
5. In the Parameters dialog box, select the add (+) button and

enter hidden inthe Parameter column. Press Tab and enter
true in the Value column.

6. Enter autostart as the next parameter and give it the value
true.

7. To make the audio clip repeat, enter loop as the next
parameter, and in the Value column, enter the number of
times you want the sound to repeat. To make the audio
repeat indefinitely, enter true as the value.

8. Click OK to finish.

Targeting Specific Plugins
You can exercise a much finer degree of  control of the audio in
your pages by calling specific Plugins. The trade-off,
unfortunately, is that by designating a Plugin, you reduce the

size of your potential audience. Some Plugins are specific to a
browser or browser version. Moreover, Plugins that aren’t
distributed with the major browsers face an uphill battle in
terms of market penetration. If you use a Plugin, you can
always expect some folks to be resistant to downloading the
necessarysoftware. Before you incorporate any Plugin, you must
weigh these issues against your overall design plan.

Installing Streaming Audio
Although audio files are not as time consuming as video,
downloading them can take a long time. Audio-on-demand-or
streaming audio-is an alternative to such lengthy downloads.

Using the RealAudio object
Embedding a streaming audio file has been greatly simplified
with the introduction of the RealAudio object. As with
RealVideo, you can have the RealAudio player appear either free-
floating or embedded in the Web page. Embedding a
RealAudio file is explained in the next section. To insert a
RealAudio streaming audio file with a free-floating player,
follow these steps:
1. Select the link or image that you want to use to begin the

RealAudio file.
2. In the Property Inspector, enter the path to the RealAudio

metafile in the Link text box or select Browse to locate the
file. Make sure that the metafile has the .ram extension.
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Topics Covered
• Web Multimedia strategies- Audio only, Slide shows
• Dreamweaver - Using Dreamweaver templates,

Understanding templates, Creating your own templates,
Using editable regions, Inserting  a new editable region,
locking and existing region

Objectives
Upon completion of this lesson, you should be able to:
• Know the various web multimedia strategies
• Use Dreamweaver templates
• understand templates
• Create your own templates
• Use Editable regions
• Lock an editable region

Web Multimedia Strategies
Simply because we can digitize hours’ worth of analog video
and stream it out over the Web doesn’t mean that we should.
The value of  having the text of  Paradise Lost on computer is not
in making it available for reading - most people prefer to read
the work in print. We digitize texts in order to use the strengths
of computing, such as searching and linking, to enhance our
understanding of the material. This holds true for multimedia,
too: we need to consider how best to use the computer and not
simply translate analog video and audio content to the
computer screen. Networked multimedia requires scaling and
compression, which means that much of the content created for
analog delivery does not work well on the Web. The key to
successful Web multimedia is to tailor your content for Web
delivery.

Audio only
Audio is an extremely efficient way to deliver information.
Consider a training video on measuring and weighing chemical
compounds. Which track - audio or video - would be the most
important in conveying information? In the sound track a
narrator explains the procedure, and in the video track someone
is measuring and weighing compounds. Which track would you
remove if necessary? Which could stand alone? The audio track.
Consider enhancing your presentation with an audio
component. Audio can be captured and optimized fairly easily,
and it compresses well.
When recording original audio, take the time to do it right.
Low-frequency background noises, such as the hum of a
ventilation system, will be inseparable from your audio track; no
amount of tweaking will eliminate it altogether. Remember,
too, that the downsampling and compression you will have to
perform to make your audio Web deliverable will emphasize
any flaws in your recording.
Slide shows
Slide shows are another method for delivering multimedia on
the Web. In a slide show, you synchronize audio with still

images. Through this approach you provide information via
audio and add visual emphasis with still images. As an
example, to present the training video mentioned above as a
slide show, you would use video editing software to
synchronize the narration with still images of the weighing and
measuring procedure. Still images compress much more
efficiently than video, and because slide shows do not require
smooth motion, the movie frame rate can be low. This in turn
means that you can devote more data to image quality and size.

Computer Lab

Dreamweaver

Using Dreamweaver Templates
Let’s face it: Web design is a combination of  glory and grunt
work. Creating the initial design for a Web site can be fun and
exciting, but when you have to implement your wonderful new
design on 200 or more pages, the excitement fades as you try to
figure out the quickest way to finish the work. Enter templates.
Properly using templates can be a tremendous time-saver.
Moreover, a template ensures that your Web site has a
consistent look and feel, which, in turn, generally means that it’s
easier for users to navigate. In Dreamweaver, new documents
can be produced from a standard design saved as a template, as
in a word processing program. Furthermore, you can alter a
template and update all the files that were created from it earlier;
this capability extends the power of the repeating element
Libraries to overall page design. Templates also form the bridge
to one of the hottest technologies shaping the Web-XML (
Extensible Markup Language).
Dreamweaver makes it easy to access all kinds of templates-
everything from your own creations to the default blank page.
This chapter demonstrates the mechanism behind
Dreamweaver templates and shows you strategies for getting
the most out of them.

Understanding Templates
Templates exist in many forms. Furniture makers use master
patterns as templates to create the same basic design repeatedly,
using new wood stains or upholstery to differentiate the end
results. A stencil, in which the inside of a letter, word, or design
is cut out, is a type of template as well. With computers,

LESSON 44:
USING TEMPLATES IN DREAMWEAVER
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templates form the basic document into which specific details
are added to create new, distinct documents. Dreamweaver
templates, in terms of  functionality, are a combination of
traditional templates and updateable Library elements. Once a
new page is created from a template, the new document remains
attached to the original template unless specifically separated or
detached. Because the new document maintains a connection to
previous pages in a site, if the original template is altered, all the
documents created from it can be automatically updated. This
relationship is
also true of
Dreamweaver’s
repeating
elements
Libraries. In fact,
templates can
even include
Library elements.
Templates are
composed of
two types of
regions: locked
and editable.
Every element
on the Web page
template falls
into one category
or the other.
When a template
is first created, all
the areas are
locked. Part of
the process of
defining a
template is to
designate and
name the
editable regions. Then, when a document is created from that
template, the editable regions are the only ones that can be
modified. Naturally, templates can be altered to mark additional
editable areas or to relock editable areas. Moreover, you can
detach a document created from a template at any point and edit
anything in the document-you cannot, however, reattach the
document to the template without losing newly inserted
content. On the other hand, a document based on one template
can be changed to a completely different look but with the same
content, if another template with identical editable regions is
applied.
Dreamweaver ships with a tutorial that illustrates the power of
templates. The tutorial, found in the Dreamweaver/Tutorial
folder, is based on an example Web site for a travel company
called Compass. Previewing the site in a browser shows that all
the sample pages for the different trips in the Destinations
section are basically the same-only the destination title,
description, and Flash movie vary. The layout, background, and
navigation controls are identical on every page. Each of these
pages was created from the template page shown in figure
below. Notice the highlighting surrounding certain areas; in a
template, the editable regions are highlighted, and the locked

areas are not. A tab further identifies each editable region to
make it easier to add the right content in the right area

Creating Your Own Templates
You can use any design that you like for your own template.
Perhaps the best course to take is to finalize a single page that
has all the elements that you want to include in your template.
Then, convert that document to a template and proceed to
mark all the changeable areas-whether text or image-as editable
regions.

In this sample template from the Dreamweaver tutorial,
editable regions are highlighted.Before saving your file as a
template, consider these points when designing your basic page:
• Use placeholders where you can. Whether it’s dummy text

or a temporary graphic, placeholders give shape to your page.
They also make it easier to remember which elements to
include. If you are using an image placeholder, set a
temporary height and width through the Property Inspector
or by dragging the image placeholder’s sizing handles; of
course, you can also just insert a sample graphic.

• Finalize and incorporate as much content as possible in
the template. If you find yourself repeatedly adding the
same information or objects to a page, add them to your
template. The more structured elements you can include, the
faster your pages can be produced.

• Use sample objects on the template. Often you have to
enter the same basic object, such as a plug-in for a digital
movie, on every page, with only the filename changing. Enter
your repeating object with all the preset parameters possible
on your template page as an editable region, and you only
have to select a new filename for each page.
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• Include your <meta> information. Search engines rely on
<meta> tags to get the overview of  a page and then scan the
balance of  the page to get the details. You can enter a
Keyword or Description object from the Head panel of the
Objects palette so that all the Web pages in your site have the
same basic information for cataloging Editable regions

• Apply all needed behaviors and styles to the template.
When a document is saved as a template, all the code in the
<head> section is locked. Because most behaviors and CSS
(Cascading Style Sheet) styles insert code here, documents
created from templates cannot easily apply new behaviors or
create new styles.

You can create a template from a Web document with one
command: File->Save As Template. Dreamweaver stores all
templates in a Templates folder created for each defined site,
with a special file extension, .dwt. After you’ve created your page
and saved it as a template, notice that Dreamweaver inserts
<<Template>> in the title bar to remind you of  the page’s
status. Now you’re ready to begin defining the template’s
editable regions.

Using Editable Regions
As noted earlier, when you convert an existing page into a
template via the Save As Template command, the entire
document is initially locked. If you attempt to create a
document from a template at this stage, Dreamweaver alerts
you that the template doesn’t have any editable regions, and
you cannot change anything on the page. Editable regions are
essential to any template.

Marking existing content as editable
Two techniques exist for marking editable regions. First, you can
designate any existing content as an editable region. Second, you
can insert a new editable region anywhere you can place your
cursor. In both cases, you must give the region a unique name.
Dreamweaver uses the unique name to identify the editable
region when entering new content, applying the template, and
exporting or importing XML.

To mark an existing area as an editable region, follow

these steps:

1. Select the text or object that you wish to convert to an
editable region. The general rule of thumb with editable
regions is that you need to select a complete tag pair, such as
<table>...</table>. This has several implications. For
instance, while you can mark an entire table or a single cell as
editable, you can’t select multiple cells, a row, or a column to
be so marked. You have to select each cell individually
(<td>...</td>). Also, you can select the content of  a layer to
be editable and keep the layer itself locked (so that its
position and other properties cannot be altered), but if you
select the layer to be editable, you can’t lock the content.

2. Choose Modify->Templates->New Editable Region. You
can also use the keyboard shortcut Ctrl+Alt+W
(Command+Option+W ), or right-click (Control+click) the
selection and choose Editable Regions->New Editable
Region from the shortcut menu. Dreamweaver displays the
New Editable

Region dialog box. If you want the flexibility of adding
returns to your editable region, make sure it includes at least
one return. The easiest method is to select the <p> tag in
the Tag selector. If  just text is selected, Dreamweaver does
not allow any returns, although line breaks are accepted.

3. Enter a unique name for the selected area. Click OK when
you’re done or Cancel to abort the operation.

Dreamweaver outlines the selection with the color picked in
Preferences on the Highlighting panel. The name for your newly
designated region is displayed on a tab marking the area; the
region is also listed in the Modify->Templates submenu. If  still
selected, the region name has a checkmark next to it in the
Templates submenu. You can jump to any other editable region
by selecting its name from this dynamic list.

Inserting a new editable region
Sometimes it’s helpful to create a new editable region where no
content currently exists. In these situations, the editable region
name doubles as a label identifying the type of content
expected, such as {Catalog Price}. Dreamweaver always puts
new region names in curly braces as just shown and highlights
the entry in the template.

To insert a new editable region, follow these steps:

1. Place your cursor anywhere on the template page.
2. Choose Modify->Templates->New Editable Region. You

can also use the keyboard shortcut Ctrl+Alt+V
(Command+Option+V), or right-click (Control+click) the
selection and choose New Editable Region from the shortcut
menu. Dreamweaver displays the New Editable Region
dialog box.

3. Enter a unique name for the new region. Click OK when
you’re done or Cancel to abort the operation. Dreamweaver
inserts the new region name in the document, surrounded
by curly braces, marks it with a named tab and adds the name
to the dynamic region list (which you can display by choosing
Modify->Templates).

Locking an Editable Region
Inevitably, you’ll mark a region as editable that you’d prefer to
keep locked, or you may discover that every page constructed to
date has required inputting the same content, so it should be
entered on the template and locked. In either event, converting
an editable region to a locked one is a simple operation.
To lock an editable region, follow these steps:
1. Place your cursor in the editable region you want to lock.
2. Choose Modify->Templates->Remove Editable Region.

The Unmark Editable Region dialog box, , appears with the
selected region highlighted.

3. Click OK in the Unmark Editable Region dialog box to
confirm your choice. The editable region highlight is
removed, and the area is now a locked region of the
template.
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Convert an editable region to a locked one with the Unmark
Editable Region command.

Notes
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Topics Covered
• More web multimedia strategies - Video, Animation
• Dreamweaver - Working with Dreamweaver in the asset

panel, Creating a blank template, Deleting and opening
template, Applying template, Updating template

Objectives
Upon completion of this lesson, you should be able to:
• Know about other multimedia strategies like video and

animation.
• Work with Dreamweaver in Assets panel
• Create a  blank template
• Delete and open existing template
• Update template

Video
Video is the most challenging multimedia content to deliver via
the Web. One second of  uncompressed NTSC (National
Television Standards Committee) video, the international
standard for television and video, requires approximately 27
megabytes of disk storage space. The amount of scaling and
compression required to turn this quantity of data into
something that can be used on a network is significant,
sometimes so much so as to render the material useless. If at all
possible, tailor your video content for the Web.
• Shoot original video; that way you can take steps to create

video that will compress efficiently and still look good at low
resolution and frame rates.

• Shoot close-ups. Wide shots have too much detail to make
sense at low resolution.

• Shoot against a simple monochromatic background
whenever possible. This will make small video images easier
to understand and will increase the efficiency of
compression.

• Use a tripod to minimize camera movement. A camera
locked in one position will minimize the differences between
frames and greatly improve video compression.

• Avoid zooming and panning. These can make low frame-rate
movies confusing to view and interpret and can cause them
to compress poorly.

• When editing your video, use hard cuts between shots.
Don’t use the transitional effects offered by video editing
software, such as dissolves or elaborate wipes, because they
will not compress efficiently and will not play smoothly on
the Web.

• If you are digitizing material that was originally recorded for
video or film, choose your material carefully. Look for clips
that contain minimal motion and lack essential but small
details. Motion and detail are the most obvious
shortcomings of  low-resolution video.

Animation
Most Web animation requires special plug-ins for viewing. The
exception is the animated GIF format, which is by far the most
prevalent animation format on the Web, followed closely by
Macromedia’s Flash format. The animation option of  the GIF
format combines individual GIF images into a single file to
create animation. You can set the animation to loop on the page
or to play once, and you can designate the duration for each
frame in the animation.

Animated GIFs have several drawbacks. One concerns the user
interface. GIF animations do not provide interface controls, so
users have no easy way to stop a looping animation short of
closing the browser window. They also lack the means to replay
nonlooping animation. Second, the animated GIF format does
not perform interframe compression, which means that if you
create a ten-frame animation and each frame is a 20 KB GIF ,
you’ll be putting a 200 KB file on your page. And the final
drawback is a concern that pertains to animations in general.
Most animation is nothing more than a distraction. If you place
animation alongside primary content you will simply disrupt
your readers’ concentration and keep them from the objective
of your site. If you require users to sit through your spiffy
Flash intro every time they visit your site, you are effectively
turning them away at the door.
There is a place for animation on the Web, however. Simple
animation on a Web site’s main home page can provide just the

LESSON 45:
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right amount of visual interest to invite users to explore your
materials. There, the essential content is typically a menu of
links, so the threat of distraction is less than it would be on an
internal content page. Also, subtle animation such as a rollover
can help guide the user to interface elements that they might
otherwise overlook. Animation can also be useful in illustrating
concepts or procedures, such as change over time. When you
have animation that relates to the content of your site, one way
to minimize the potential distraction is to present the
animation in a secondary window. This technique offers a
measure of viewer control: readers can open the window to
view the animation and then close the window when they’re
through.

Computer Lab

Dreamweaver

Working With Templates In The Assets Panel
As a site grows, so does the number of templates it employs.
Overall management of your templates is conducted through
the Templates category of  the Assets panel. You can open the
Templates palette by choosing Windows->Templates or by
pressing the keyboard shortcut Ctrl+F11 (Command+F11).
The Templates category, shown in Figure below, displays a list
of  the current site’s available templates in the lower pane and a
preview of the selected template in the upper pane.
The Templates palette has five buttons along the bottom of  its
window:
• Apply-Creates a document derived from the currently

selected template if the current document is blank, or, if the
current document is based on a template, changes the locked
regions of the document to match the selected template.

• Refresh Site List-Displays the list of all the templates
currently in the site.

Use the Templates category of the Assets panel to preview,
delete, open, create, or apply your current site’s templates.
• New Template-Creates a new blank template.
• Edit-Loads the selected template for modification.
• Delete-Removes the selected template.

The Assets panel’s context menu offers all of  these options and
more as explained in Table below:

Creating a blank template
Not all templates are created from existing documents. Some
Web designers prefer to create their templates from scratch. To
create a blank template, follow these steps:
1. Open the Templates category of the Assets panel by selecting

its symbol or by choosing Window->Templates.
2. From the Templates category, select New Template. A new,

untitled template is created.
3. Enter a title for your new template and press Enter (

Return).
4. While the new template is selected, press the Edit button.

The blank template opens in a new Dreamweaver window.
5. Insert your page elements.
6. Mark any elements or areas as editable regions using one of

the methods previously described.
7. Save your template.

Deleting and opening templates
As with any set of files, there comes a time to clean house and
remove files that are no longer in use. To remove a template,
first open the Templates category of  the Assets panel. Next,
select the file you want to remove and choose the Delete
button.
You can edit a template-to change the locked or editable
regions-in several ways. To use the first method, choose
File’Open and, in the Select File dialog box, change the Files of
Type to Template Files (*.dwt) on Window systems and choose
Template Files from the Show drop-down list on Macintosh
systems. Then, locate the Templates folder in your defined site
to select the template to open. The second method of opening
a template for modification uses the Templates category of  the
Assets panel. Select a template to modify and choose the Edit
button. You can also double-click your template to open it for
editing. Finally, if  you’re working in the Site window, open a
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template by selecting the Templates folder for your site and
open any of the files found there.

Applying Templates
Dreamweaver makes it easy to try a variety of different looks for
your document while maintaining the same content. Once
you’ve created a document from a template, you can apply any
other template to it. The only requirement is that the two
templates have editable regions with the same names. When
might this feature come in handy? In one scenario, you might
develop a number of  possible Web site designs for a client and
create templates for each different approach, which are then
applied to the identical content. Or, in an ongoing site, you
could completely change the look of a catalog seasonally but
retain all the content. Figure given below shows two radically
different schemes for a Web site with the same content.
To apply a template to a document, follow these steps:
1. Open the Templates category of  the Assets panel.
2. Make sure the Web page you want to apply the style to is the

active document.
3. From the Templates category, select the template you want to

use and click the Apply button. You can also drag onto the
current page the template you’d like to apply or choose
Modify->Templates->pply Template to Page from the
menus.

4. If content exists without a matching editable region,
Dreamweaver displays the Choose Editable Region for
Orphaned Content dialog box. To receive the content, select
one of the listed editable regions from the template being
applied and click OK.

The new template is applied to the document, and all the new
locked areas replace
all the old locked areas.

You can apply a template to a document created from another
template to achieve different designs with identical content.

Updating Templates
Anytime you save a change to an existing template-whether or
not any documents have been created from it-Dreamweaver

asks if  you’d like to update all the documents in the local site
attached to the template. As with Library elements, you can also
update the current page or the entire site at any time. Updating
documents based on a template can save you an enormous
amount of time-especially when numerous changes are
involved.
To update a single page, open the page and choose Modify-
>Templates->Update Current Page or select the same
command from the context menu of the Assets panel. Either
way, the update is instantly applied.
To update a series of  pages or an entire site, follow these steps:
1. Choose Modify->Templates->Update Pages. The Update

Pages dialog box, shown in figure below,

1. Any changes made to a template can be automatically applied
to the template’s associated files by using the Update Pages
command.

2. To update all the documents using all the templates for an
entire site, choose Entire Site from the Look In option and
then select the name of the site from the accompanying
drop-down list.

3. To update pages using a particular template, choose Pages
Using from the Look In option and then select the name of
the template.

4. To view a report of  the progress of the update, make sure
that the Show Logoption is enabled.

5. Click Start to begin the update process.
The log window displays a list of the files examined and
updated, the total number of files that could not be updated,
and the elapsed time.

Changing the Default Document
Each time you open a new document in Dreamweaver-or even
just start Dreamweaver-a blank page is created. This blank page
is based on an HTML file called Default.html that is stored in
the Configuration\Templates folder. The default page works in
a similar fashion to the templates in that you can create new
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documents from it, but no editable or locked regions exist-
everything in the page can always be altered.
The basic blank-page document is an HTML structure with only
a few properties specified: a document type, character set, and
white background for the body:
<html>
<head>
<title>Untitled Document</title>
<meta http-equiv=”Content-Type” content=”text/html;
charset=iso-8859-1”>
</head>
<body bgcolor=”#FFFFFF”>
</body>
</html>
Naturally, you can change any of  these elements-and add many,
many more- after you’ve opened a page. But what if you want
to have a <meta> tag with creator information in every page
that comes out of  your Web design company? You can do it in
Dreamweaver manually, but it’s a bother, and chances are that
you’ll forget.
Luckily, Dreamweaver provides a more efficient solution. In
keeping with its overall design philosophy of  extensibility,
Dreamweaver enables you to modify the Default.htm file as you
would any other file. Just choose File-> Open and select the
Configuration\Templates\Default.htm file. As you make your
changes, save the file as you would normally. Now, to test your
modifications choose File->New-your modifications should
appear in your new document.

Assignments
1. How can your embed sound and music in a web document?
2. What is Real Audio object? Explain its significance in

Streaming Audio?
3. What is a template? How can it be effective in web

designing?
4. How do your create your own template in Dreamweaver?
5. What are the drawbacks of GIF animation?
6. Write the steps to create a bland template?
7. Write the steps to a default document into a template?

Notes
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Topics Covered
• Preparing Multimedia - Processing, Audio processing, Video

processing
• Dreamweaver - Final touches to your personal home page

Objectives
Upon completion of this lesson, you should be able to:
• Prepare multimedia
• Process Audio
• Process Video
• Give final touches to your personal home page

Preparing Multimedia
Multimedia places high demands on the network, the
computer, and the user. The challenge thus lies in preparing files
that are small enough to be accessible to the broadest possible
audience yet are of  sufficient quality to be worth the effort. To
balance quality against accessibility you’ll need to understand
both the characteristics of different media formats and the
limitations of delivering media in a networked environment,
and you must be ready to compromise.

Processing
Analog source generally comes with certain established
characteristics. For example, CD-quality audio is sampled at 44.1
KHz, 16-bit stereo sound, and video is usually 640 x 480 pixels
in dimension and plays at 30 frames per second (fps). However,
analog source digitized at full resolution would require
enormous amounts of disk storage and is far too large to be
used on a network. One way to prepare media for network
delivery is to reduce the data by, for example, downsampling the
audio material to 11.025 KHz, 8-bit mono sound. This reduces
file size but also substantially reduces quality. Another way to
reduce file size is to apply compression.
Compression first eliminates redundant data from a file and
then removes less important data to shrink file size still further.
This process is achieved using algorithms, or “codecs” (short
for compressors-decompressors), that handle the media
compression and the decompression when it is played. The
codecs that are used for Web delivery use lossy compression: the
process removes data from the original source material. You
should never compress material multiple times, because each
process will lower the video quality.
In preparing media for Web delivery, you should aim for files
that can be managed by the average network connection and
desktop machine of your target audience. The key measure is
the data rate, normally measured in kilobytes per second
(KBps), which is the amount of data that is used to represent
one second of movie playback. For users to play your files in
real time without hiccups or delays, you need to set a data

transmission rate that is slightly lower than the throughput of
your users’ connections.

Audio processing
• Normalize. Audio files may lose amplitude and clarity in the

digitizing process. To compensate you can use software to
normalize your audio. This process finds the highest peak in
a file and then amplifies the entire file to make that peak’s
volume 100 percent. This ensures that you are working with
the loudest possible audio signal.

• Boost the midrange. Another way to enhance your Web
audio is to use software with an equalizer function to boost
the midrange frequencies slightly.

• Frequency. Reducing the frequency reduces the data required
to represent the material, for example, from 44.1 KHz to
22.050 KHz.

• Depth. Sixteen-bit samples provide greater dynamic range
but take up more space. Reducing the depth to 8-bit will
reduce the file size.

• Channel. Be sure not to use stereo settings for a mono
source. If  your source does have stereo audio, you might
consider switching to mono to reduce the data rate.

• Codec. Applying compression to an audio track may allow
you to keep higher-quality audio frequency and depth
settings.

Video Processing
• Process the audio. Perform the audio normalizing and

equalizing mentioned above.
• Trim clips. Make sure that your movie begins and ends with

frames that make sense as still images. The first frame will
appear on the user’s screen while the movie is loading, and
the last frame will remain on screen when the movie has
finished. Take care that these images do not seem awkward
out of the context of the movie.

• Crop. Use video editing software to crop out unwanted
noise or borders from the movie image.

LESSON 46:
PREPARING MULTIMEDIA
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• Scale. Most Web video is sized to quarter-screen (320 x 240
pixels) or smaller.

• Image quality. Reducing the image-quality setting of  a movie
reduces the data that is stored for each frame.

• Frame rate. Standard NTSC video has a frame rate of 30 fps.
Most Web video is set to about 10 fps.

• Codec. Some codecs compress more efficiently than others
do, though usually at the expense of  image quality.

• Custom filters. Compression software provides filters that
reduce the differences between frames, permitting more
efficient compression.

• Audio. The audio track of  video can be downsampled and/
or compressed to reduce the overall movie data rate.

Computer Lab

Publishing A Website
The HTML files you create are not available over the world wide
web until you put them on a web server. To make web sites
available to the world, you need to place all the HTML and
image files on a computer set up with web server software.
There are several web servers
Examples of  Web Servers on Campus:
http://www.raidunivesity.edu
An account is set up for you on one of  the web servers and you
will be given a username and password to access the account.
How you publish the web pages depends on the type of  server
you are using. Web sites that are held on a UNIX server, will
typically use FTP to transfer their html files and images to the
server. Web servers running on a Windows NT Server may not
allow FTP for transferring files. Some web creation packages will
handle publishing for you after you set it up initially.

Transferring files using FTP
In order for the web pages that you created during this course
to be viewable over the web, they must be placed within your
web server account. All of  your HTML & image files must be
moved from your computer to this account.
The software used to move files from your desktop computer
to a server is FTP. FTP stands for ‘File Transfer Protocol’. You
use FTP software to publish your website to the world wide
web or, in other words, or move your files to your web server
account.
There are many FTP software packages available as shareware or
freeware. The examples below are shown using WS-FTP LE.
The examples can be applied to other types of software

programs as well. WS-FTP LE is available as freeware for
Windows 95 & 98
FTP File Tranfer Example:
Step 1:
1. Launch WS_FTP or other FTP software. You should see

something similar to the screen below.
1. Enter your web server’s Host Name/Address.
2. Enter your username for your web server account.
3. Select the ‘OK’ button.
4. The FTP program should now attempt to log into the web

account.
5. Once connected successfully, you will be asked to enter a

password.
6. The system will check your username/password. If the login

is successful, the system will automatically place you within
your user account. You should see something similar to the
screen below. If  you need assistance, contact the web server
administrator for more information.

7. Double click on your public_html subdirectory.
public_html
On most webservers, your website is placed within subdirectory
called ‘public_html’ within your user account. This subdirectory
will hold all the files used within your website — .html, .jpg,
.gif, .cgi, etc...
Only files or other subdirectories placed within the public_html
folder will be viewable over the internet.
Step 2:
1. Now move to the left portion of the FTP window. This side

of  the screen represents your computer’s harddrive.
2. You need to locate your website folder or subdirectory on

your computer’s harddrive.
3. Double click on the green arrow and two periods to move

down a directory level on your hardrive. See the illustration
below

5. Locate the website folder that contains all your files for your
web site on your local computer.

6. Select each of the HTML files & image files. Select multiple
files by selecting & holding down the ‘CTRL’ key.

7. Move the files from your local computer to your web server
account by selecting the right arrow in the center of the
screen. See illustration below:
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8. All of your web site files should now be stored in the
public_html subdirectory within your account on the web
server.

9. View your website in your web browser. You may need to
select ‘Refresh’ or ‘Reload’ on your browser to refresh the
screen.

Uploading your first Web page
When you are done creating your website in HTML, you should
upload it using a File Transfer Protocol (FTP) client such as
CuteFTP or WS_FTP, both for Windows or Fetch for the
Macintosh. All of these are available for download at http://
www.tucows.com as they are all shareware programs.

Setting up your FTP Client
Once you have downloaded your FTP client and installed it, you
are ready to set up the client to connect to your FTP site. Most
FTP clients require the following information:
Hostname: Typically www.yourdomain.com
User ID: Use the same user ID as that set up in the control
panel PLUS the domain name separated by a % sign. For
example, if the user ID was yourname, then in the user ID field
you would put yourname%yourdomain.com
Password: This is initially same password as the one you use to
login to the Control Panel. You can change the password by
following the FTP Manager link.
We also highly recommend that you read the File Transfer
Protocol guide and How to FTP guide which contain more in-
depth information about using FTP.

Test your FTP client
You should launch the FTP client and try to connect to your
FTP account to make sure it works. Test to make sure that you
can upload files from your computer (client) to the server (host)
and download in the opposite direction as well.
If  you are on an NT Server and created your site using
Microsoft FrontPage, you must use FrontPage to upload your
site. Using FrontPage and FTP in tandem to publish your site
on an NT Server can potentially disable your FrontPage
extensions and corrupt your FrontPage-based website by
accidentally destroying internal files used by FrontPage.

Test your Web Page
Once you have completed all the steps in this document, it is
important that you test all the settings to ensure that you are
fully online and ready to start marketing yourself on the
Internet. Ideally, you should test your e-mail and make sure that
your Web pages look the way you want them to.
To ensure that your Web site has been set up properly, all you
have to do is open up a browser and type in the URL for your
Web site. Typically, it will be something like http://
www.yourdomain.com/.
The following are some factors you may need to consider when
testing your Web pages:
1. If you can, use as many different types of browsers you may

have on your computer to look at your Web page. Different
browsers interpret more specialized HTML differently. For
example, the <BLINK> tag works only on Netscape
Navigator.

2. Use a variety of screen settings. Remember, although the
most common screen resolution is 800 X 600, some
computer users may have the larger 1024 X 768 or the
smaller 640 X 480 resolutions. This affects the intended
display of  your Web page. Assuming that you have used a
standard resolution of 800 X 600, a user loading up your
page on a smaller screen may be frustrated if parts of it are
cut off.

3. Find out how long your web page takes to load. Some users
may not be connected to the Internet with high-speed
services and a graphics intensive page may take a lot longer to
load - it may deter customers from coming back to your
website.

If  you make your Web page accessible to all, after testing all the
different factors, you will have reached more happy customers
who will inevitably come back to you for repeat business. You
could also get your friends to help you test out your Web pages
and ask for feedback.
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Topics Covered
• Preparing Multimedia - Delivery, streaming, Downloading
• Dreamweaver – testing of HTML  code and final publishing

Objectives
Upon completion of this lesson, you should be able to:
• Prepare multimedia
• Streaming
• Downloading
• Testing the coding of  your personal home page
• Final publishing of your web document

Delivery
The technology of networked media consists of three main
components: the server, the network, and the client machine.
These three components must work in tandem to deliver good
Web multimedia to the desktop. It makes no difference how
high-end your video server and network are if  your users are
running low-end desktop machines that cannot handle the
demands of playback.
The wildest of all these wild cards is bandwidth. If you
purchase a high-end media server, you can expect a certain level
of  performance. You can predict playback performance on
desktop machines. These elements are somewhat measurable.
But unless you are working with a dedicated network,
bandwidth will be hugely variable and difficult to predict. Issues
regarding bandwidth run from the basic configuration of your
connection to the network to the amount of network traffic at
any given time.
Given these variables, the parameters for creating and delivering
Web multimedia are not easily defined. They will vary
depending on the scope and content of your project. If you are
creating a Web site for a corporate intranet, for example, your
media can be more technologically demanding than if you send
it worldwide over the Internet. The key is to be well acquainted
with the configuration of your client base and prepare
accordingly.

Streaming
Streaming technology sends data to the desktop continuously
but does not download the entire file. In the optimal scenario,
the content is stored on a media server, which maintains a
constant conversation with the client to determine how much
data the user can support. Based on this information, the server
adjusts the data stream accordingly and sends just enough data
to the client.

Streaming offers many benefits, the first of which is random
access. Streaming technology permits movies to be viewed at
any point in the video stream. If your reader is accessing an
hour’s worth of  video and wishes to view only the last five
minutes, he or she can use the controls to move forward to the
desired starting point. Another benefit is a lower storage
demand on the client machine. Streaming media plays directly to
the display; it is not stored in memory or on the hard drive.
The strengths of  streaming are also its shortcomings. To play a
movie in real time the player software needs to keep up with the
incoming data sent from the server. As a result, if  there are
glitches in the network or if the client machine cannot handle
playback, the data may simply be lost. Streaming playback
requires significant processing power, so playback may be
suboptimal if the processor has to drop frames to keep up with
the incoming stream. Also, streaming media needs to be heavily
compressed to create a file small enough to play in real time.

Downloading
Downloadable media is temporarily stored on the client
machine in memory or on the hard drive. Most downloadable
media is progressive, which means that the information
necessary for playback is stored at the beginning of the file.
Progressive download allows playback before the entire file has
downloaded. Downloadable media is sent to the client using
the same HTTP protocol as a Web page, so no special server is
required. As long as the download speed stays above the data
rate of the movie, playback will be uninterrupted.

LESSON 47:
CUTE FTP–FINAL UPLOADING
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The quality of downloadable media is generally higher than that
of streaming media. Because the data rate is not required to
remain low enough to play the material in real time, more data
can be devoted to image quality and motion. Downloadable
media also has integrity: all the data in the original movie is
contained in the downloaded version. This means that playback
is predictable and that you can download the data onto your
disk for future use.
The main drawback of downloadable media is the storage
demand it places on the client machine. Even videos of short
duration require many megabytes of storage. The other
problem is that downloadable media does not allow random
access. If you want to view only the last few minutes of a long
clip you must wait for the entire clip to download. One
solution to both of these problems is to split longer media
segments into smaller chunks. This reduces the demands on
the client machine and allows users more direct access to the
material they want.

Computer Lab

Cute Ftp
This is the initial screen of  CuteFTP.   To start the upload
process click the connect button.  It is the second one from the
left and is labeled with lightning bolt.
To continue this tutorial click the connect button in the
screenshot below.

Once the connect button has been clicked a connection bar will
appear just below.  There are three pieces of  information that
need to be entered here: the host (domain), the username, and
the password for the hosting account.
Also note that there is now a second connect button labeled
with a lightning bolt.  It appears on the connection bar just after
the hosting account settings.  Once the settings have been filled
in this button will become active.  To connect click this button.
To continue this tutorial click the new connection button in the
screenshot below.
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CuteFTP now does the work of connecting to the hosting
server.  The steps it goes through will be displayed in the
dialogue box shown below.  If  there is a problem connecting,
such as an authentication error, this screen will give you some
clue as to what might be going on.
Once the connection has been established click the ‘OK’
button.  To continue this tutorial click ‘OK’ in the screenshot
below.
 

Once CuteFTP has successfully connected,  the connection bar
will disappear and you should see a view similar to the one
shown below.  The left side will display the files on your
computer while the files on the hosting server appear on the
right. 

To move a file to the hosting server first locate it on the left and
then double-click it.  To continue this tutorial click on
‘default.htm’ in the screenshot below.
 

The progress of the transfer will be displayed in the bottom
pane.  If a firewall is interfering with the upload process this is
the phase in which an error will likely occur.  Again, CuteFTP
may display messages here as it did in the connection dialogue
that provide some clue as to what is going wrong.

Most likely all that will be necessary at this stage is to wait. 

Once the transfer is successful the file will appear in both the left
and the right panes of the program, as it now exists on both
computers.  If CuteFTP is unable to perform the transfer and
the Internet connection is intact, then a firewall may be
interfering. 
To fix this problem it is usually necessary to adjust the passive
transfers setting within CuteFTP.  The following screens show
how this is done.  The first step is to open the ‘Settings’
dialogue box under the ‘Edit’ dropdown menu.

To continue this tutorial click ‘Edit’ in the screenshot
below.
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CuteFTP’s settings may be accessed by clicking ‘Settings’ at the bottom of  the ‘Edit’ dropdown menu.
To continue this tutorial click ‘Settings’ in the screenshot below.
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Topics Covered
• Design and Multimedia, inform your user, Provide content,

Accessibility, Alternate versions, References
• Dreamweaver – Uploading your web document

Objectives
Upon completion of this lesson, you should be able to:
• Design and Multimedia
• Inform your user
• Provide content
• Add  Accessibility
• Provide Alternate versions

Design and Multimedia
The combination of low-bandwidth considerations and
primitive interface options creates interesting design challenges
for Web developers who wish to incorporate multimedia
elements into their sites. Designers need to inform users when
they are entering a high-bandwidth area and give them the tools
they need to control their experience once in the area.

Inform your Users
One aspect of  the Web is that you don’t always know where
you’re going or what you’ll find there. For some this uncertainty
is exciting. For many, it is annoying, particularly when a long
wait is involved. Most frustrating, perhaps, is when you finally
receive the requested page only to find that is not what you
expected or that it contains materials in a format you are not set
up to view. With content that is as technologically demanding as
multi-media, it is especially important to give users enough
information to make an informed decision before they click, so
that they know what to expect and are prepared to receive your
materials.

High-demand content such as large multimedia files should not
be part of your basic page design. These materials should
appear on secondary pages that are described and can be accessed
from the main pages of your site. Make the menu page a plain
HTML page that loads quickly and does not require special
software. Include descriptive information about the materials

along with previews such as still shots from the video. Include
the run time for time-based media, and include the file size for
materials that download. In addition, fully explain any special
software requirements for accessing the materials and provide a
download link. Your users should have a clear idea of what
your materials are before they begin to download. With a menu
interface, users can confirm that their systems are properly
configured and that they have enough bandwidth, time, and
patience to load the materials.

Provide Controls
Be sure to give users status information and controls when you
are presenting multimedia materials. The QuickTime controller
bar is an extremely effective interface element that provides both
controls and status information. It allows users both to adjust
the volume control and to play, stop, and scrub through a
movie, and it provides information about the movie’s
download status.

If you don’t include controls, users will hit your page with no
way to control their viewing environment. For example, if a
visitor is looking at your page at a public workstation and you
have looping bird calls as a background sound without any
control options, the visitor will experience an unsettling (and
potentially embarrassing) moment when he or she cannot
control interaction with your site. Many users in this situation
will simply close the browser window to make the sound stop,
which means that they never get to see the page content.
When designing a media interface, let interaction with your
media be entirely user-driven. Always include user controls, such
as a media controller bar, and make sure that users have a way to
turn it off. Avoid prescribed playback options like auto play or
looping that take control from the user. With auto play, for
example, media files begin playing when a Web page is loaded.
If the page has other elements, such as descriptive text, the user
who wants just the text will find the video distracting. Design
your media interface so that files play only when the user
explicitly elects to initiate playback.

Accessibility
It is nearly impossible to construct a multimedia presentation
that will be accessible by every user on the World Wide Web.
Whenever you put multimedia content on your Web pages you
potentially shut out users. For example, vision-impaired users
cannot see content such as graphics, video, or animations. To
access visual content, they need a text alternative that can be

LESSON 48:
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spoken by a screen reader. Hearing-impaired users rely on
content they can see, and so they need a visual alternative to any
audible materials. Initiatives such as Section 508 and the Web
Accessibility Initiative (WAI) have produced guidelines and
mandates requiring that nontext content be rendered in an
alternate format that is accessible to disabled users, such as text
captions for audible content and text descriptions of visual
content. This is why it is particularly important when planning
for multimedia content to consider users with disabilities: both
technology-disabled users who are connecting to the Internet
via slow modems on outdated machines and physically disabled
users for whom multimedia content may be out of reach.

Alternate Versions
The best way to ensure that your materials are accessible is to
provide alternate versions designed to accommodate different
users. For example, when creating Web video using QuickTime,
developers can link different versions of their movie saved at
varying levels of quality and compression. Then, when a user
requests the movie via a Web page, QuickTime sends the
version that the user’s network connection can best
accommodate. This approach supports divisions in technology
resources, but alternate views also benefit those who are
excluded from multimedia for physical reasons. By providing
alternate views of your multimedia content, your information
becomes accessible to people who cannot appreciate it in its
native format because of physical limitations.
Text is the most widely accessible content there is. For physically
disabled users, text can be magnified or read by special software
or rendered by a braille reader. For those with technology
limitations, text loads quickly and can be viewed on
nongraphical browsers. Another strength of text over media
content is that it can be read and indexed by search engines and
translated into other languages. The best alternate, then, to
multimedia content is the written word. For instance, if you are
providing video content on your site, the simplest alternate to
include is a text transcript of the audio track for hearing-
impaired users. An even better approach would be to use the
text as captions synchronized with the video. To address the
needs of visually impaired users, you could also include a text
description of the video track, either as a separate audio track or
as text. Or simplify the materials by reducing the video track to a
series of still images synchronized with the audio for users with
reduced vision or cognitive difficulties.

At minimum, you can use basic HTML to give disabled users
information about multimedia content. For example, you can
use the ALT parameter to include a short description of  the
animation in your applet or animated GIF HTML code.
Because almost all browsing devices can handle text, if you
include this basic descriptive text, users who have their Web
pages read to them will at least be able to understand the
function of the visual content.
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Computer Lab

Cute Ftp (Continued)

Cuteftp’s Firewall Settings Appear In The ‘Connection’ Area.
To continue this tutorial click the ‘+’ beside the connection entry
in the screenshot below.

 

To access the firewall settings click on ‘Firewall’ in the left pane
of the dialogue box.  ‘Firewall’ must be highlighted in order for
the settings within to display on the right. 
The passive transfer option is labeled PASV and is checked by
default inside the program.  If you are having trouble
transferring files after successfully connecting then it might be
helpful to uncheck this option, click ‘OK,” and try again.
To continue this tutorial click ‘OK’ in the screenshot
below.
 

Clicking ‘OK’ within the settings dialogue box will return a
person to the main screen.  Disconnect, reconnect, and try to
transfer the file again. 
To return to the tutorial list click the ‘Next’ button below.

 

End Note
This is the end of E-media – 1, by now, you must have
uploaded your website. Now we evaluate our work and wait for
the feedback. In the next E-media 2, we go for more focused
course ware, where we will be concentrating more on the
content and we shall also learn more advanced technology.
All the best for your exams.
Notes
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